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1 Introduction & Overview

The Chapter presents an overview of the NetClock 9400 Series Time
Server, its capabilities, main technical features and functions.

The following topics are included in this Chapter:

1.1 Getting Started 2
1.2 Introduction 2
1.3 NetClock 9483 Overview 3
1.4 NetClock 9489 Overview 4
1.5 Inputs & Outputs 5
1.6 NetClock 9400 Series Front Panels 6
1.7 NetClock 9400 Series Rear Panels 6
1.8 Front Panel Status Indicator LEDs 8
1.9 Specifications 10
1.10 NetClock 9483—Available Option Modules 16
1.11 Regulatory Compliance 17



1.1 Getting Started
Welcome to this User Reference Guide for your NetClock unit. Whether you read this online,
on paper, or in a pdf document, we sincerely hope you'll quickly find your way around.

Depending on what your objective is today, here are our recommendations on what to do
next:

If you want to install and configure a NetClock, and have no or little experience with this
technology, we suggest you

a. browse through CHAPTER 1 first, and then

b. familiarize yourself with the installation procedure and its variations—see "Install
ation and Setup Summary" on page 20.

If you plan on installing a NetClock unit and you are familiar with the basic technical con
cepts of time and frequency synchronization, as well as network administration, we sug
gest you start here:

"Installation and Setup Summary" on page 20.

If your unit is up and running, and you consider changing a specific setting—or learning
more about its features and functions—the easiest way to find the information you are
looking for is

the TABLE OF CONTENTS, or

the INDEX.

Should you experience technical problems, refer the following information sources:

a. "Troubleshooting" on page 315

b. "INDEX" on page i

c. Spectracom Online Knowledge Base

d. "Technical Support" on page 376.

1.2 Introduction
The NetClock® 9400 Series combines Spectracom’s precision Time Server/Master Clock tech
nology and secure network-centric approach with a compact modular hardware design to
bring you a powerful time & frequency reference and synchronization system at the lowest cost
of ownership.

The NetClock 9400 product series is ideally suited for a variety of communications applic
ations such as Emergency Communications Centers that require extremely accurate timing and
frequency synchronization for their mission-critical systems, networks, and devices. The
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NetClock 9400 product series consists of two variants: The model 9483 is fully compliant with
the National Emergency Number Association (NENA) master clock standard, and the model
9489.

1.3 NetClock 9483 Overview
The NetClock 9483 has been designed specifically for these environments, and when using
GPS as its timing reference, the UTC (Coordinated Universal Time) time standard is employed,
thus allowing the NetClock 9483 to provide legally traceable time and frequency syn
chronization services for various related environments and equipment, such as the following:

9-1-1 and PSAP communication center telephony

Computer network synchronization

VOIP/voice and video recording

CAD

ANI/ALI controllers

Radio consoles and communications equipment

Display clocks

Security & building access systems, fire alarm systems

The NetClock 9483 also includes backwards-compatibility support with all previous generation
NetClock products; thus providing a bridge from legacy devices and equipment to network-
based systems.

The NetClock 9483 series is a truly flexible Time Server/Master Clock, which in addition to
providing highly accurate network time synchronization, also supports a variety of timecodes
(including all NENA formats) and signals to synchronize specific devices. The built-in network
port can be supplemented to include 3 additional Gigabit Ethernet (10/100/1000Base-T) ports
for synchronizing isolated networks, or for restricting administration to a specific management
network. Precise 10-MHz and 1-Pulse-per-second (1PPS) signals are standard features, and
additional optional features include support for T1/E1 signals are available for synchronizing
telecom systems and equipment, and Precision Timing Protocol (PTP) I/O support.

The unit is housed in a 19” rack unit chassis and offers an integrated power supply. DC power
is available as back-up to AC power, or as the primary input power source.

Note: All features described are not available on all NetClock 9400 Series vari
ants.

Initial setup of the NetClock 9483 can be done via its front panel serial port interface, and fur
ther management and configuration can be performed via NetClock’s Web-based user inter
face.

1.3  NetClock 9483 Overview
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1.3.1 NENA Standards Compliance & Support
The NetClock Model 9483 is designed to meet or exceed the following NENA standards and
criteria:

NENA PSAP Master Clock Standard #04-002

NENA Security for Next-Generation 9-1-1 Standard (NG-SEC) #75-001

Note: Information regarding the configuration of the NetClock’s NENA module
can be found under "NENA-Compliant Module" on page 282.

1.3.2 Security Enhancements
In addition to fully supporting the NENA Security Standard #75-001, the NetClock 9400 series
are security-hardened network appliances designed to meet rigorous network security stand
ards and best practices. They ensure accurate timing through multiple references, tamper-proof
management, and include extensive logging capabilities for auditing purposes. All features,
interfaces, ports, and protocols can be enabled or disabled based on your network policies.

1.4 NetClock 9489 Overview
Spectracom’s NetClock Model 9489 delivers the same high precision timing benefits of the
NetClock 9483, and is ideally suited for delivering highly precise NTP timing for syn
chronizing systems, devices, and other communications equipment and devices.

In addition to providing a secure, high precision NTP platform, NetClock 9489 also provides
one (1) 1PPS output, and two (2) RS-485 outputs.

Note: There are a number of commonly shared features between both the NetC
lock 9483 and 9489 models.
However, the NetClock Model 9489 is designed to function primarily as an NTP
server, and therefore is somewhat less complex than the NetClock Model 9483.
Also, NetClock 9489 is not fully compliant to NENA master clock technical
requirements.

As such, a majority of this document applies to the NetClock Model 9483, except
where otherwise noted.
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1.5 Inputs & Outputs
Spectracom NetClock provides multiple outputs for use in networked systems and devices. GPS-
equipped NetClocks can track up to thirty-two GPS satellites simultaneously and synchronize to
the satellite’s atomic clocks. This enables NetClock-equipped computer networks to synchronize
all elements of network hardware and software over LANs or WANs – anywhere on the planet.

1.5.1 NetClock 9483: Standard Outputs
Standard outputs are:

Type Connector

(1) Ethernet 10/100Base-T RJ-45 (auto-sensing)

(1) RS-232 Serial Connector DB9 female

(1) RS-485 Once-per-Second 3.81 mm Terminal Block

(1) IRIG B/E, IEEE 1344/C37.118-2005 (AM/TTL) output BNC

(1) 1 Pulse Per Second (1PPS) output BNC

(1) 10 MHz Frequency output BNC

(2) Relay / Alarm Outputs 3.81 mm Terminal Block

1.5.2 NetClock 9483: Optional Outputs
Several Option Modules are available for NetClock 9483, providing additional outputs and
functionality:

Type Connector

(3) 10/100/1000Base-T [Multi-Ethernet] RJ-45 (auto-sensing)

(1) 1.544 or 2.048 MHz
(2) 1.544 or 2.048 MHz
[T1/E1 Balanced]

3.81 mm Terminal Block

(1) PTP (IEEE 1588) RJ-45

For more information, see "NetClock 9483 Option Modules" on page 276.

1.5.3 NetClock 9489 Standard Inputs and Outputs
I/O Type Connector

I/O (1) Ethernet 10/100Base-T RJ-45 (auto-sensing)

Output (1) 1 Pulse Per Second (1PPS) BNC

Outputs (2) RS-485 Once-per-Second 3.81 mm Terminal Block

For more information, see "NetClock 9489 Outputs" on page 312.

1.5  Inputs & Outputs
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1.6 NetClock 9400 Series Front Panels

1.6.1 NetClock 9483 Front Panel
The front panel of the NetClock 9483 unit consists of the following:

Three status LED indicator lights (“Power”, “Sync” and “Fault”). See also "Front Panel
Status Indicator LEDs" on page 226.

Keypad buttons, for performing operations from the front panel.

LCD display, showing status information or currently selected menu items (display
options are configurable via the product web interface, such as position information,
time and date, Day of Year, GPS information, network settings, etc.).

LED time display.

An RS-232 serial port interface for serial cable connections.

Figure 1-1: NetClock 9483 Series Front Panel Display

1.6.2 NetClock 9489 Front Panel
The front panel of the NetClock 9489 unit consists of the following:

Three status LED indicator lights (“Power”, “Sync” and “Fault”). See also "Front Panel
Status Indicator LEDs" on page 226.

An RS-232 Serial port interface connection.

Figure 1-2: NetClock 9489 Front Panel

1.7 NetClock 9400 Series Rear Panels

1.7.1 NetClock 9483 Rear Panel
The NetClock 9483 rear panel provides several different outputs for interfacing the unit to vari
ous systems. The rear panel has an AC connection for power input (DC Power is optional), Eth
ernet and USB connections, 1PPS and 10 MHz outputs, IRIG, ASCII, and Relay/Alarm outputs,
and GPS Antenna connector.
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Figure 1-3: NetClock 9483 rear panel

AC power connector: Input for the AC power and provides and AC power ON/OFF
switch. This connector is only installed if NetClock was ordered with AC input power
option.

DC power port connector: Only installed if the NetClock was ordered with DC input
power option. Note: DC input power does not have an ON/OFF switch.

Ethernet connector: Provides an interface to the network for NTP synchronization and to
obtain access to the NetClock product web interface for system management. It has two
small indicator lamps, “Good Link” (green LED), and “Activity” (orange LED). The “Good
Link” link light indicates a connection to the network is present. The “Activity” link light
will illuminate when network traffic is detected.

Table 1-1: Status indicators, rear panel

Ethernet Yellow On
Off

LAN Activity detected.
No LAN traffic detected.

Ethernet Green On
Off

LAN Link established, 10 or 100 Mb/s.
No link established.

USB connector is reserved for future expansion.

1PPS output: Provides a once-per-second square-wave output via BNC output connector.
The 1PPS output can be configured to have either the rising or falling edge of the signal
to be coincident with the system’s on-time point.

10 MHz output: Provides a 10 MHz sine-wave output via BNC output connector.

IRIG output: Supports IRIG A/B/G/E, IEEE 1344/C37.118-2005 (AM/TTL).

RS-232 output: for serial connections.

Relay/Alarm outputs.

RS-485 output for serial connection.

1.7  NetClock 9400 Series Rear Panels
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GNSS antenna connector: GNSS input for GNSSS antenna and coax cabling (type “N”
connector).

Note: Pin numbers for the RS-485 outputs are defined starting with Pin 1 to
Pin 10, arranged from left to right, as shown below:

Figure 1-4: Rear panel of NENA-compliant module (NetClock 9483)

For detailed information on the connectors, see:

"NetClock 9483 Rear Panel" on page 6.

1.7.2 NetClock 9489 Rear Panel
The NetClock 9489 rear panel provides:

an AC connection for power input,

an Ethernet port,

(1) 1PPS output,

(2) RS-485 outputs

a GNSS antenna connector.

Figure 1-5: Rear panel of NetClock model 9489

For detailed information on the connectors, see:

"NetClock 9489 Outputs" on page 312.

1.8 Front Panel Status Indicator LEDs
Three Status LEDs are located on the unit's front panel:
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POWER: Green, always on while power is applied to the unit

SYNC: Tri-color LED indicates the time data accuracy

FAULT: Two-color, three-state LED, indicating if any alarms are present.

At power up, the unit automatically performs a brief LED test run during which all three LEDs
are temporarily lit.

1.8  Front Panel Status Indicator LEDs
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Table 1-2: Front panel status indications

LED Label Activity/Color Description

POWER
Off Both AC, and DC input popwer are disconnected.

OR: The unit's AC input switch is turned OFF, and DC input is not
present.

On/solid green AC and/or DC Power are supplied; the unit detects all power
inputs.

Red The unit is configured for two power inputs, but detects only one
power input. OR: Detects a power configuration error.

Green & blinking
orange 1/sec.

Power Error — general power configuration fault.

SYNC
Red Time Sync Alarm:

1) The unit has powered up, but has not yet achieved syn
chronization with its inputs.
2) The unit was synchronized to its selected input references, but
has since lost all available inputs (or the inputs were declared
invalid) and the Holdover period has since expired.

Solid green The unit has valid time and 1PPS reference inputs present and is syn
chronized to its reference.

Orange The unit is in Holdover Mode: It was synchronized to its selected
input references, but has since lost all available inputs (or the inputs
are not declared valid).The time and frequency outputs will remain
useable until the Holdover period expires.

FAULT
Off No alarm conditions are currently active.

Blinking orange A GNSS antenna alarm has been asserted and is currently active.
A short or open circuit has been detected in the GNSS antenna
cable. The light will automatically turn off once the alarm condition
clears.
To troubleshoot this condition, see "Troubleshooting via Web
UI Status Page" on page 319.

Solid orange A Minor Alarm condition (other than an antenna problem alarm)
has been asserted and is currently active.
To troubleshoot this condition, see "Minor and Major Alarms"
on page 317.

Red A Major Alarm condition has been asserted and is currently active.
To troubleshoot this condition, see "Minor and Major Alarms"
on page 317.

1.9 Specifications

Note: The specifications listed herein are for the base NetClock 9483 unit (not
including option modules or other options chosen at the time of purchase), except
where otherwise noted, and are based on “standard” operation, with NetClock

10 CHAPTER 1 • NetClock User Reference Guide Rev. 12

1.9  Specifications



synchronized to valid Time and 1PPS input references (in the case of GPS input,
this is with the GPS receiver operating in Stationary mode).

Specifications for the available option modules are provided under "NetClock
9483 Option Modules" on page 276.

1.9.1 GNSS Receiver
Compatible signals:

GPS L1 C/A Code transmissions at 1575.42 MHz

GLONASS L1 0F transmissions centered at 1602.0 MHz

QZSS L1-SAIF (1575.42 MHz)

BeiDou B1 (center frequency 1561.098 MHz)

Galileo-ready E1B/C (firmware upgrade required)

Satellites tracked: Up to 72 simultaneously

Update rate: Up to 2Hz (concurrent)

Acquisition time: Typically < 27 seconds from cold start

Antenna requirements: Active antenna module, +5V, powered by NetClock, 16 dB gain
minimum

Antenna connector: Type N, female

1.9.2 RS-232 Serial Port (Front Panel)
Function: Accepts commands to locally configure the IP network parameters via CLI for
initial unit configuration.

Connector: DB9F, pin assignments conform to EIA/TIA-574 standard, data com
munication equipment.

Character Structure: ASCII, 9600 baud, 1 start, 8 data, 1 stop, no parity.

1.9.3 RS-232 Serial Port (Rear Panel; NetClock 9483 Only)
Outputs: RS-232, ASCII time code data input/output; 1PPS output.

Connector: DB9F

Accuracy: ±100-1000 μs (format-dependent)

1.9  Specifications
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1.9.4 RS-485 Serial Port
Outputs: RS-485, and Alarm/Relay (NetClock 9483 only)

Signal Type and Connector: (1) RS-485 terminal block

Accuracy: ±100-1000 μs (format-dependent)

1.9.5 10/100 Ethernet Port
Function: 10/100 Base-T, auto-sensing LAN connection for NTP/SNTP and remote mon
itoring, diagnostics, configuration and upgrade.

Connector: RJ-45, Network IEEE 802.3.

1.9.6 IRIG Output (NetClock 9483 Only)
Outputs: (1) IRIG Output

Signal Type and Connector: IRIG A, B, G, E, NASA 36, Amplitude Modulated (0V to
5VP-P into 50 Ω on BNC) or DC Level Shift (unmodulated), user selectable.

Accuracy: ±2 to 200 microseconds (IRIG Format-dependent)

1.9.7 Protocols Supported
NTP: NTP Version 4 (Installed: Version 4.2.8p6). Provides MD5, Stratum 1 through 15
(RFC 5905). Note that NTP Autokey is currently not supported, for more information,
see http://bugs.ntp.org/show_bug.cgi?id=3005.

NTP throughput:
ETH0: 7000-7200 NTP requests per second;
ETH1-3 (NetClock 9483 only: equipped with 1204-06/Option 16 Gigabit Ethernet
Option Module): 8800-9000 NTP requests per second.
For additional information, please contact Spectracom.

Clients Supported: The number of users supported depends on the class of network and
the subnet mask for the network. A gatewayS greatly increases the number of users.

TCP/IP application protocols for browser-based configuration and monitoring: HTTP,
HTTPS

FTP/SFTP: For secure remote upload of system logs and files (RFC 959).

Syslog: Provides remote log storage (RFCs 3164 and 5424).

SNMP: Supports v1, v2c, and v3.

Telnet/SSH: For limited remote configuration.

Security Features: Up to 32-character password, Telnet Disable, FTP Disable, Secure
SNMP, SNMP Disable, HTTP/HTTPS Disable, SCP, SSH, SFTP.

Authentication: LDAP v2 and v3, RADIUS, MD5 Passwords, NTP Autokey Protocol.
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1.9.8 1PPS Output
Signal: One pulse-per-second square wave (ext. reference connected to GNSS receiver)

Signal level: TTL compatible, 4.3 V minimum, base-to-peak into 50 Ω

Pulse width: Configurable pulse width (200 ms by default)

Pulse width range: 20 ns to 900 ms

Rise time: <10 ns

Accuracy: Positive edge within ±50 ns of UTC when locked to a valid 1PPS input ref
erence

Connector: BNC female

Table 1-3: 1PPS Output accuracies

Oscillator Type Accuracy to UTC
(1 sigma locked to GPS)

Holdover (constant temp. after 2 weeks of GPS lock)

After 4 hours After 24 hours

Rubidium ±25 ns 0.2 μs 1μs

OCXO ±50 ns 1μs 25 μs

TCXO ±50 ns 12 μs 450 μs

1.9.9 10 MHz Output (NetClock 9483 Only)
Signal:10 MHz sine wave

Signal Level: +13 dBm ±2dB into 50 Ω.

Harmonics: -40 dBc minimum.

Spurious: -70 dBc minimum TCXO

Connector: BNC female

Signature Control: This configurable feature removes the output signal whenever a
major alarm condition or loss of time synchronization condition is present. The output is
restored when the fault condition is corrected.

Oscillator Types & Accuracy:

1.9  Specifications
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Table 1-4: 10 MHz output — oscillator types and accuracies

Oscillator Type Accuracy

Rubidium 1x10-12 typical 24-hour average locked to GPS

1x10-11 per day (5x10-11 per month) typical aging unlocked

OCXO 2x10-12 typical 24-hour average locked to GPS

1x10-9 per day typical aging unlocked

TCXO 1x10-11 typical 24-hour average locked to GPS

1x10-8 per day typical aging unlocked

Note: Oscillator accuracies are stated as fractional frequency (i.e. the rel
ative frequency departure of a frequency source), and as such are dimen
sionless.

Table 1-5: 10 MHz output — oscillator stability

Oscillator
Type

Medium-Term Stability
(without GPS after 2 weeks of

GPS lock)

Short-Term Stability (Allan vari
ance)

Temperature
Stability

(p˗p)1 sec. 10 sec. 100 sec.

Rubidium 5x10 - 11 /month (3x10 - 11 /month
typical)

2x10-11 2x10-12 2x10-12 1x10-10

OCXO 5x10-10/day 5x10-10 5x10-11 1x10-11 5x10-9

TCXO 1x10-8/day 2x10-9 1x10-9 3x10-10 1x10-6

1.9.9.1 10 MHz Output — Oscillator Phase Noise (dBc/Hz)

Oscillator Type @ 1Hz @ 10 Hz @ 100 Hz @ 1KHz @ 10 KHz

Rubidium ˗80 ˗98 ˗120 ˗140 ˗140

OCXO ˗95 ˗123 ˗140 ˗145 ˗150

TCXO ./. ./. ˗110 ˗135 ˗140

1.9.10 Input Power Specifications
AC Power Source: 100 to 240 VAC, 50/60 Hz, ±10% and 100-120 VAC 400 Hz, ±10%
via an IEC 60320 connector (power cord included).
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DC Input (Option):

12-17 VDC -15%, +20%, or

21-60 VDC -15%, +20%, secure locking device.

Note: No DC power option is available for NetClock Model 9489.

Maximum Power Draw:

OCXO oscillator installed: -40 W normal (50 W start-up)

Rubidium (Rb) oscillator installed: -50 W normal (80 W start-up)

1.9.11 Mechanical and Environmental Specifications
Dimensions:

Designed for EIA 19” rack mount:
16.75” W x 1.72” H [1U] x 14.00” D actual
(425 mm W x 44 mm H x 356 mm D) actual

Weight:

6.0 lbs (2.72 kg)

6.5 lbs. (2.95 kg) with Rubidium Oscillator option

Temperature:

0°C to 50°C operating range

+55°C for Rubidium option (NetClock 9483 only)

-40° to 85°C storage range

Humidity: 10% - 95% relative humidity, non-condensing @ 40°C

Altitude:

100-240 VAC - 6560 ft (2000 m) operating range

100-120 VAC - 13123 ft (4000 m) operating range

45000 ft (13700 m) storage range

Shock:

15g/0.53 oz, 11 ms, half sine wave operating range

50g/1.76 oz, 11 ms, half sine storage range

Vibration:

0-55 Hz/0.07 g, 55-500 Hz/1.0g operating range

10-55 Hz/0.15 g, 55-500 Hz/2.0g storage range

MIL-STD-810F: 501.4, 502.4, 507.4, 500.4, 516.5, 514.5

1.9  Specifications
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1.10 NetClock 9483—Available Option Modules
The NetClock 9483 product can be customized and enhanced via the addition of up to two (2)
additional option modules, detailed in this section.

Note: In some cases, the number of option modules of any one type that can be
installed may be limited (see “Maximum number of cards” for each type of mod
ule).

For additional information on available option modules, including configuration and usage
with your product, "NetClock 9483 Option Modules" on page 276.

1.10.1 T1 (1.544 MHz) and E1 (2.048 MHz) Module
Outputs:

T1 mode:

1.544 MHz (square wave) frequency output

(2) 1.544 Mb/sec data rate outputs:

Outputs are DS1 framed all ones.

Supports Super Frame (SF or D4) and Extended Super Frame (ESF).

SSM support.

E1 mode:

2.048 MHz (square wave) frequency output

(2) 2.048 Mb/sec data rate outputs:

Outputs are E1 frame all ones.

Supports CRC4 and CAS Multiframe.

SSM support.

Maximum Number of Cards: 1

Ordering Information:

Option 13: T1/E1 Balanced

(1) E1 (75 Ω) module

(2) T1 and E1 (100/120 Ω) module

1.10.2 Multi-Port Gigabit Ethernet Module
Inputs/Outputs: (3) Gigabit Ethernet (10/100/1000 Base-T)

Signal Type and Connector: RJ-45
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Management: Enabled or Disabled (NTP server only)

Maximum Number of Cards: 4

Ordering Information: Option 16: Multi-port Ethernet (3X) Module

1.10.3 PTP I/O Module
Inputs/Outputs: (1) PTP

Signal Type and Connector: RJ-45

Maximum Number of Cards: 4

Ordering Information: Option 12: PTP I/O

1.11 Regulatory Compliance
This product has been found to be in conformance with the following regulatory publications.

FCC

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when
the equipment is operated in a commercial environment. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the user
documentation, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in
which case the user will be required to correct the interference at his/her own expense.

Safety

EN 60950 -1:2006/A11:2009: Safety of Information Technology Equipment, including Elec
trical Business Equipment

This product has been tested and meets the requirements specified in:

UL 60950-1, 1st Edition

CSA C22.2 No. 60950-1-07, 2nd Edition

UL Listing no. E311040

EMC, CE:

EN 55022:2006/A1:2007: Class A: EC Emissions Standard

EN 55024:1998/A2:2003: EC Generic Immunity Standard

EN 61000-3-2:2006: Harmonic Current Emissions

EN 61000-3-3:1995/A2:2005: Voltage Fluctuations and Flicker

1.11  Regulatory Compliance
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The product complies with the requirements of the Low Voltage Directive 2006/95/EC
and the EMC Directive 2004/108/EC.

Note: This is a Class A product. In a domestic environment this product
may cause radio interference in which case the user may be required to
take adequate measures.

EMC, ICES-003 and AS/NZS CISPR 22:

This Class (A) digital apparatus complies with Canadian ICES-003, Issue 4.

This Class (A) digital apparatus complies with AS/NZS CISPR 22 for radiated and con
ducted Emissions.
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2.1 Installation and Setup Summary
This section provides an outline of the NetClock installation process. The exact installation pro
cedure of your unit depends on several factors:

a. The power source(s) your NetClock is configured for.

b. Your existing infrastructure and how you plan on integrating NetClock into it (for
example, integrating it into an existing Ethernet network, or setting-up a standalone
installation.)

c. How you would like to configure your NetClock unit:

Via the front panel keypad and information display

Using a Personal Computer (PC) with a Command-Line Interpreter (CLI), con
nected to NetClock via the serial port in front of the unit

Using the NetClock Web User Interface ("Web UI").

The latter is the recommended configuration tool, since it offers access to ALL con
figuration options. For this, you will need a PC with a standard Web browser, such as
Google Chrome®, Mozilla Firefox®, or Microsoft Internet Explorer®.

You can connect your PC to NetClock either…

…directly by means of an Ethernet cable, or

…indirectly through your existing Ethernet network (using a network hub).

d. The options configuration of your unit: Is your NetClock equipped with any options? If
so, they need to be configured separately via the NetClock Web UI, once the network
configuration is complete.

2.1.1 Main Installation Steps
The following list is a recommendation. Deviations are possible, depending on the actual
application and system configuration.

1. Unpack the unit, and take inventory: "Unpacking and Inventory" on the facing page.

2. Obtain required tools and parts: "Required Tools and Parts for Installation" on the
facing page.

3. Mount the unit: "Rack Mounting" on page 26.

4. Read the Safety instructions: "SAFETY" on page 22.

5. Connect your power supply/-ies: "Power Connection" on page 27.

6. Connect Input References such as your GNSS antenna, and network cable(s): "Con
necting Reference Inputs, and Network Interfaces" on page 30.

7. Power up the unit: "Powering up the Unit" on page 32.
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8. Configure the unit…

i. …via front panel keypad and information display (NetClock 9483 only): "Net
work Configuration via Front Panel (NetClock 9483 Only)" on page 38

ii. …or via serial port, using a PC with a CLI: "Network Configuration via Serial
Port" on page 39

iii. …or via Ethernet, using a PC with a Web browser, and the NetClock Web UI:
"DHCP Network Configuration" on page 35.

9. Register your product: "Product Registration" on page 44.

2.2 Unpacking and Inventory

Caution: Electronic equipment is sensitive to Electrostatic Discharge (ESD).
Observe all ESD precautions and safeguards when handling the unit.

Unpack the equipment and inspect it for damage. If any equipment has been damaged in
transit, or you experience any problems during installation and configuration of your Spec
tracom product, please contact Spectracom (see "Technical Support" on page 376.)

Note: Retain all original packaging for use in return shipments if necessary.

The following items are included with your shipment:

NetClock Unit

QuickStart Guide (printed version)

This instruction manual, and other relevant documentation as pdf files on a CD

Purchased Optional Equipment

Ancillary kit (except for rack mounting items, contents of this kit, such as an AC line cord,
will vary based on equipment configuration)

Any option modules on the original purchase order have been pre-installed.

2.3 Required Tools and Parts for Installation
Phillips screwdriver to install the unit’s rack-mount ears.

Screwdriver to mount the unit in a standard 19-inch rack.

Ethernet cables (see "Ethernet Connection" on page 31)

2.2  Unpacking and Inventory
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For DC power supply (if applicable), Spectracom recommends an external ON/OFF
switch.

2.4 SAFETY

2.4.1 Safety: Symbols Used

Figure 2-1: Do not ignore the Safety Instructions!
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Table 2-1: Safety symbos used by Spectracom in this document, or on the product

Symbol Signal word Definition

DANGER!
Potentially dangerous situation which may lead to personal
injury or death! Follow the instructions closely.

CAUTION!
Potential equipment damage or destruction!
Follow the instructions closely.

NOTE
Tips and other useful or important information.

ESD
Risk of Electrostatic Discharge!
Avoid potential equipment damage by following ESD Best
Practices.

CHASSIS GROUND
This symbol is used for identifying the functional ground of an
I/O signal. It is always connected to the instrument chassis.

Analog Ground
Shows where the protective ground terminal is connected
inside the instrument. Never remove or loosen this screw!

Recycle
Recycle the mentioned components at their end of life. Follow
local laws.

2.4.2 SAFETY: Before You Begin Installation
This product has been designed and built in accordance with state-of-the-art standards and the
recognized safety rules. Nevertheless, its use may constitute a risk to the operator or install
ation/maintenance personnel, if used under conditions that must be deemed unsafe, or for pur
poses other than the product's designated use, which is described in the introductory technical
chapters of this guide.

Before you begin installing and configuring your NetClock unit, carefully read the following
important safety statements. Always ensure that you adhere to any and all applicable safety
warnings, guidelines, or precautions during the installation, operation, and maintenance of
your product.

DANGER! — INSTALLATION OF EQUIPMENT:

Installation of this product is to be done by authorized service personnel
only. This product is not to be installed by users/operators without legal author
isation.

Installation of the equipment must comply with local and national electrical codes.

2.4  SAFETY
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DANGER! — DO NOT OPEN EQUIPMENT, UNLESS AUTHORIZED:

The interior of this equipment does not have any user serviceable parts. Contact
Spectracom Technical Support if this equipment needs to be serviced. Do not
open the equipment, except to retrofit option cards, or replacement of battery. Fol
low Spectracom Safety Instructions, and observe all local electrical regulatory
requirements.

IF THE EQUIPMENT MUST BE OPENED:
Never remove the cover or blank option card plates with power applied to this
equipment. Ensure all power sources are removed from the unit prior to installing
any option cards by removing both the AC and DC power cords connected to the
equipment.

This unit will contain more than one power source if both the AC and DC power
options are present. In this case, turning off the rear panel power switch will not
remove all power sources.

DANGER! — FUSING:

The equipment has Double Pole/Neutral Line Fusing on AC power.
For continued protection against risk of fire, replace fuses only with same type
and rating of fuse.

DANGER! — GROUNDING: This equipment must be EARTH GROUNDED. Never
defeat the ground connector or operate the equipment in the absence of a suit
ably installed earth ground connection. Contact the appropriate electrical inspec
tion authority or an electrician if you are uncertain that suitable grounding is
available.

The AC and DC power connectors of this equipment have a connection to the
earthed conductor of the AC and DC supply earthing conductor through the AC
and DC power cords. The AC source outlet must contain a protective earthing con
nection. This equipment shall be connected directly to the AC power outlet earth
ing pin or DC supply system earthing electrode conductor.
The DC supply source is to be located within the same premises as this equipment:
The equipment shall be located in the same immediate area (such as, adjacent
cabinets) as any other equipment that has a connection to the earthing conductor
of the same AC or DC supply circuit earthing conductor, and also the point of
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earthing of the AC or DC system. The AC or DC system shall not be earthed else
where.

Switches or other disconnection devices shall not be in the earthed circuit con
ductor between the AC and DC source and the point of the connection of the
earthing electrode conductor to NetClock’s AC and DC input power connectors
earthing pin.

DANGER! — BATTERY: Replace the battery only with the same or equivalent type
recommended by the manufacturer. Follow Spectracom Instructions — there is a
danger of a new battery exploding if it is incorrectly installed. Discard used bat
teries according to the manufacturer's instructions.

Caution: Electronic equipment is sensitive to Electrostatic Discharge (ESD).
Observe all ESD precautions and safeguards when handling Spectracom equip
ment.

2.4.3 SAFETY: User Responsibilities
The equipment must only be used in technically perfect condition. Check components for
damage prior to installation. Also check for loose or scorched cables on other nearby
equipment.

Make sure you possess the professional skills, and have received the training necessary
for the type of work you are about to perform.

Do not modify the equipment.

Use only spare parts authorized by Spectracom.

Always follow the instructions set out in this User Reference Guide, or in other Spec
tracom documentation for this product.

Observe generally applicable legal and other local mandatory regulations.

2.4.4 SAFETY: Other Tips
Keep these instructions at hand, near the place of use.

Keep your workplace tidy.

Apply technical common sense: If you suspect that it is unsafe to use the product, do the
following:
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Disconnect the supply voltage from the unit.

Clearly mark the equipment to prevent its further operation.

2.5 Rack Mounting
If installing the unit in a rack, install the rack-mount ears on the two sides of the front panel and
mount the unit in a standard 19-inch rack cabinet. The unit is intended to be installed in one ori
entation only. The unit should be mounted so the front panel interface keys are to the left of the
display area.

The NetClock unit will install into any EIA standard 19-inch rack. NetClock occupies one rack
unit of space for installation, however, it is recommended to leave empty space of at least one
rack unit above and below the NetClock unit to allow for best ventilation.

Rack mounting requirements:

The maximum ambient operating temperature must be observed. See "Mechanical and
Environmental Specifications" on page 15 for the operating temperature range spe
cified for the type of oscillator installed in your NetClock unit.

If the NetClock unit is to be installed in a closed rack, or a rack with large amounts of
other equipment, a rack cooling fan or fans should be part of the rack mount install
ation.

Installation of the unit in a rack should be such that the amount of air flow required for
safe operation of the equipment is not compromised.

Follow the mounting directions described below to prevent uneven mechanical loading,
possibly resulting in a hazardous condition.

Do not overload power supply circuits. Use only supply circuits with adequate overload
protection. For power requirements, see "Specifications" on page 10.

Reliable grounding of rack-mounted equipment must be maintained. Particular attention
must be given to supply connections other than direct connections to the branch circuit
(e.g., use of power strips).

The NetClock ancillary kit will contain the following parts needed for rack mounting:

2 each 1165-1000-0714 rack mounting brackets

2 each MP09-0003-0030 equipment rack handles

4 each H020-0832-0406 #8-32 flat head Phillips screws

6 each HM20R-04R7-0010 M4 flat head Phillips screws

one (1) CA0R-1513-0001 AC POWER CORD.

The following customer supplied items are also needed:
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4 each #10-32 pan head rack mount screws

1 each #2 Phillips head screwdriver

1 each 3/32" straight screwdriver

To rack mount the NetClock unit:

1. Attach an MP09-0003-0030 equipment rack handle to the front of each 1165-1000-
0714 rack mounting bracket, using the holes nearest the right angle bend of the 1165-
1000-0714 rack mounting bracket, with the #2 size Phillips screwdriver, using 2 each of
the H020-0832-0406 #8-32 flat head Phillips screws.

2. Attach the 1165-1000-0714 rack mount brackets to the sides of the NetClock with the
rack mounts ears facing outward, aligned with the front edge of the NetClock front
panel. Use the #2 Phillips screwdrivers, using 3 each of the HM20R-04R7-0010 M4 flat
head Phillips screws.

3. Secure the rack mount brackets to the rack using the #10-32 rack mount screws and #2
Phillips head screwdriver, 2 each per side of the rack. 

Caution: For safety reasons, the NetClock unit is intended to be operated in a
HORIZONTAL POSITION, RIGHT-SIDE-UP, that is with the keypad to the left side
and the 4-line information display and the time display on the right side.

2.5.1 Desktop Operation
NetClock units can also be operated on a desktop in a HORIZONTAL, RIGHT-SIDE-UP position.
The location needs to be well-ventilated, clean and accessible.

2.6 Power Connection
This section includes details on the NetClock’s AC and/or DC power systems (Note: DC power
available with NetClock 9483 systems only).

Depending on the equipment configuration at time of purchase, NetClock can be powered
from an AC input, a DC input or with both AC and DC input (DC input is an option for NetC
lock 9483 units only). Supplying both AC and DC input power provides redundant and auto
matic power switchover in case one or the other input power sources is lost.

Before connecting power to the unit, be sure that you have read all safety information detailed
in section "SAFETY" on page 22.

2.6.1 Input Power Selection
As long as the AC input power is present, and the NetClock 9483 is equipped with the DC
redundancy option, it will utilize the AC power source over DC power.

2.6  Power Connection
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If AC and DC power are both applied, AC power is used.

If DC power is applied, but AC power is not, then DC power will be used.

If AC and DC power are both present, but AC power is subsequently lost, NetClock will
automatically switch to using the DC power input.

DANGER! — This unit will contain more than one power source if both the AC
and DC power options are present. Turning off the rear panel power switch will
NOT remove all power sources.

The following sections discuss AC and DC power input. Connect AC and/or DC power, as
desired.

2.6.2 Using AC Input Power
Connect the AC power cord supplied in the NetClock ancillary kit to the AC input on the rear
panel and the AC power source outlet. The AC input is fuse-protected with two fuses located in
the AC power entry module (line and neutral inputs are fused). The AC power entry module
also contains the main power switch for the AC power applied to the equipment.

Caution: This equipment has Double Pole/Neutral Line Fusing on AC power.

Note: Important! NetClock is earth grounded through the AC power connector.
Ensure NetClock is connected to an AC outlet that is connected to earth ground
via the grounding prong (do not use a two prong to three prong adapter to
apply AC power to NetClock).

2.6.3 Using DC Input Power (NetClock 9483 Only)
If the rear panel DC port is present, connect DC power, per the voltage and current as called
out on the label that resides above the DC power connector.

Note: DC power is an option chosen at time of purchase. The rear panel DC
input port connector is only installed if the DC input option is available. Different
DC power input options are available (12 VDC with a voltage range of 12 to 17 V
at 7 A maximum or 24/48 VDC input with a voltage range of 21 to 60 V at 3 A
maximum). Review the DC power requirement chosen, prior to connecting DC
power (when the DC port is installed, a label will be placed over the connector
indicating the allowable DC input voltage range and the required current).
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DANGER! GROUNDING: NetClock is earth grounded through the DC power con
nector. Ensure that the unit is connected to a DC power source that is connected to
earth ground via the grounding pin C of the NetClock DC power plug supplied
in the ancillary kit.

Caution: The DC input port is both fuse and reverse polarity protected. Reversing
polarity with the 24/48 VDC option will not blow the fuse, but the equipment will
not power- up. Reversing polarity with the 12 VDC option will likely blow the
internal fuse.

A DC power connector to attach DC power to NetClock is included in the ancillary kit provided
with the equipment. A cable of 6 feet or less, using 16AWG wire, with adequate insulation for
the DC voltage source should be used with this connector. The cable clamp provided with the
DC power plug for strain relief of the DC power input cable should be used when DC power is
connected to NetClock.

Note: Spectracom recommends to use a dedicated DC power supply switch to
energize/de-energize NetClock externally.

DC power connector pin-out:

NetClock units can be ordered in a DC version that includes the following DC plug on the back
panel: DC Plug, 3-pin, chassis mount: Amphenol P/N DL3102A10SL-3P

The DC ancillary kit includes, among other things, the following connector parts:

Mating DC Connector, circular, 3-pin, solder socket, 16AWG,13A,300V: Amphenol
P/N DL3106A10SL-3S; (Spectracom part no. P240R-0032-002F)
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Cable Clamp, circular: Amphenol part no. 97-3057-1004(621); (Spectracom part no.
Spectracom part no. MP06R-0004-0001)

Pinout description, DC connector
Pin B goes to the most positive DC voltage of the DC source. For +12 V or +24/48 V this would
be the positive output from the DC source. For a -12 V or -24/48 VDC source this would be the
ground or return of the DC source.

Pin A goes to the most negative voltage of the DC source. For +12 V or +24/48 V this would
be the ground or return output from the DC source. For a –12 V or –24/48 VDC source this
would be the negative output from the DC source.

Pin C goes to the Earth ground of the DC source.

2.7 Connecting Reference Inputs, and Network Interfaces
NetClock can synchronize to an external GNSS reference signal, and/or an NTP input ref
erence.

Depending on the desired operation and your specific NetClock configuration, connect the
GNSS antenna to your unit, as outlined below (NTP input reference and User-Set Time are soft
ware configurations that require no additional physical connection to NetClock).
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2.7.1 Connecting GNSS Input
1. Install the GNSS antenna, surge suppressor, antenna cabling, and GNSS preamplifier

(if required). Refer to the documentation included with the GNSS antenna for additional
information regarding GNSS antenna installation.

2. Connect the GNSS cable to the rear panel antenna input jack.
In the event that NO antenna is connected to the rear panel jack, NetClock will—once it
gets powered up (see "Powering up the Unit" on the next page)—activate the Antenna
Problem alarm, causing the front panel “Fault” light to be blinking orange (the Antenna
Problem alarm indicates an open or short exists in the antenna cable.)
Unless there is an open or short in the antenna cable, the "Fault" light should stop flash
ing orange once the GNSS antenna and coax cable are connected to the rear panel. If
the "Fault" light does not stop flashing after connecting the antenna, refer to
"Troubleshooting GNSS Reception" on page 321.

Initial synchronization with GNSS input may take up to 5 minutes (approximately) when used
in the default stationary GNSS operating mode. If using GNSS, verify that GNSS is the syn
chronization source by navigating to MANAGEMENT/OTHER/Reference Priority : Confirm
that GNSS is Enabled, and its Status for TIME and 1PPS is valid (green).

2.7.2 Ethernet Connection
NetClock provides a base 10/100 Ethernet port for full NTP functionality, as well as a com
prehensive Web-based user interface for configuration, monitoring and diagnostic support.
Additional network ports are available with the Gigabit Ethernet option card (1204-06).

The Ethernet port is provided on the back panel for easy connection to routers, switches, or
hubs.

1. Determine if you want to configure your NetClock unit using a computer connected to
the network, or a computer connected directly to your NetClock unit.

When connecting to a hub, router, or network computer, use a straight-through
wired, shielded CAT 5, Cat 5E or CAT 6 cable with RJ-45 connectors. Connect
one end to the Ethernet port on the NetClock rear panel, and the opposite end of
the cable to a network hub or switch.

When connecting directly to a stand-alone Personal Computer (PC), use a net
work cable. Connect the cable to the NIC card of the computer.
Since no DHCP server is available in this configuration both NetClock, and the
PC must be configured with static IP addresses that are on the same subnet
(10.1.100.1 and 10.1.100.2 with a subnet value of 255.255.255.0 on both
devices, for example). For more information on configuring static IP addresses,
please refer to "Network Configuration Without DHCP" on page 37, and to the
product documentation for the version of the operating system that you are using
on the PC.
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2. With input references connected, once NetClock is powered up (see: "Powering up the
Unit" below), verify that the green link light on the Ethernet port is illuminated. The amber
“Activity” link light may periodically illuminate when network traffic is present.

2.8 Powering up the Unit
1. After installing your NetClock unit, verify that power is connected, turn ON the unit using

the switch on the rear panel, and wait for the device to boot up.

Note: NetClock 9483 only: DC input power is not switched, so NetClock will be
powered up with DC input connected, unless you installed an external power
switch.

Note: As the front panel cooling fan is internal temperature controlled, the fan
may not always be in operation. However, the fan may momentarily turn on each
time NetClock is power-cycled.

2. Observe that all of the front panel LEDs momentarily illuminate (the Power LED will then
stay lit) and that the Information display LCD back light illuminates.

NetClock 9483 only:

The time display will reset and then start incrementing the time. About 10 seconds after
power-up, “Starting up NetClock” will be displayed in the information display. After
approximately 2 minutes, the information display will then show the current network set
tings.

The 4-line information display shows the unit’s hostname, IPv4 address, mask, and gate
way.
The time display shows the current time: UTC, TAI, GPS or local timescale, as configured.
Current time will be displayed in UTC by default.

Figure 2-2: NetClock front panel
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3. Check the front panel status LED indicators:

The Power lamp should be solid green.

The Sync lamp will probably be red, since synchronization has not yet been
achieved.

The Fault lamp should either be off, or solid orange, indicating a minor alarm.

For additional information, see "Front Panel Status Indicator LEDs" on page 226 and "Status
Monitoring via Front Panel" on page 226.

2.9 Using the Keypad and Information Display

Note: This Section applies to NetClock 9483 only.

To simplify operation and to allow local access to NetClock, a keypad and LCD information
display are provided on the front panel of the unit.

Among other things, the keypad and information display can be used to carry out basic net
work configuration tasks, such as en-/disabling DHCP, or entering an IP address and subnet
mask; see below for details.

2.9.1 Keypad Description

The NetClock front panel keypad has six buttons for making certain configuration changes or
viewing status information on the LCD display. The functions of each are as follows:

ENTER: Select a menu item or load a parameter when editing

BACK: Return to previous display or abort an edit process

LEFT/RIGHT arrows: Select a new item to the left or right, respectively

UP/DOWN arrows: Scroll through parameter values in edit displays

2.9.2 Navigating the Information Display
After power initialization, press any key to go to the “Home” display. As shown in the illus
tration "Keypad menu tree" on the next page, several status and setup displays are accessible
from the main “Home” menu. To navigate through the menus, use the arrow keys to highlight a
selection and then press the ENTER button.

2.9  Using the Keypad and Information Display
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The main menu options and their primary functions are as follows:

Display: Used to configure the information display

Clock: Displaying and setting of the current date and time

System: Displaying version info, system halt and reboot, reset spadmin password

Netv4: Network interface configuration

Lock: Locks the front panel keypad to prevent inadvertent operation.

2.9.3 Keypad Menu Tree
Using the front panel keypad, the 4-line information display on the unit can be configured to
display various indications, including the network settings, System Status, GNSS position,
GNSS signal information or the current date and time (or, it can even be configured to remain
blank, if desired). The figure "Keypad menu tree" below illustrates Menu Tree navigation.

Figure 2-3: Keypad menu tree

To modify a parameter, highlight the menu option and press the ENTER button. The “O” data is
the current old setting and the “N” data is the new setting. You can only change the “N” setting
in all menus. Use the UP and DOWN arrow keys to scroll through all possible parameter val
ues.

When editing a sequence of numbers, use the LEFT and RIGHT arrow keys to select other digits.
When the parameter is correct, press ENTER to load the new value. You will be asked to con
firm the setting change. Press ENTER to accept or BACK to cancel the parameter change. All
entered values are stored in memory and restored after a power cycle.
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2.9.4 Unlocking the Front Panel Keypad
If the front panel keypad is locked, the following sequence will locally unlock the keypad for
use. Alternatively, the front panel can also be locked/unlocked via the NetClock Web UI, see
"Locking/Unlocking the Front Panel Keypad" on page 179.

2.10 DHCP Network Configuration

2.10.1 Opening the Web UI
On a network using DHCP, NetClock's IP address will be assigned automatically once it is con
nected to the DHCP server. This address and other network information are displayed on the
front panel when the device boots up.

1. On a computer connected to the NetClock network, start a Web browser, and enter the
above-mentioned IP address of your NetClock into the address field of the browser.

2. Log in as an administrator (see: "The Administrator Login Password" on page 215).

Note: "Cookies" must be enabled. You will be notified, if Cookies are disabled
in your browser.

Unless you are using DNS in conjunction with DHCP (with the client configured using NetC
lock's hostname instead of IP address), Spectracom recommends to disable DHCP for NetClock,
and change the IP address to a static address. Failure to do this will result in a loss of time syn
chronization, should the DHCP server assign a new IP address to NetClock.

If you choose to use DHCP for your NetClock, the basic network configuration is complete, and
you may proceed to "Product Configuration via the Web UI" on page 46, in order to proceed
with the configuration of your NetClock. Otherwise, proceed to "Replacing a Dynamic with a
Static IP Address" on the next page

Note: Unless the user opens the Web UI using the default DNS name of “Spec
tracom” (instead of using the IP address to access NetClock), the SSL cer
tificate/security pop-up window will continue to be displayed each time the user
opens the Web UI.

To prevent the security pop-up window from opening each time, a new SSL cer
tificate needs to be created using the assigned IP address of NetClock during the
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certificate generation. See "Configuring HTTPS" on page 66 for more inform
ation on creating a new SSL certificate.

Note: When configuring NetClock without DHCP, or to configure a NetClock unit
that has not been assigned an IP address for other reasons, see "Network Con
figuration Without DHCP" on the facing page.

2.10.2 Replacing a Dynamic with a Static IP Address

Note: During configuration it may be necessary to power down or restart NetC
lock. In this case a HALT command should be issued prior to removing power
from the unit. Failure to do so may cause NetClockto take longer to boot on the
next power up cycle. After the HALT command is issued via the front panel
keypad, or the Web UI, wait until the information display reads ‘Power off NetC
lock’ before removing power.

Spectracom recommends assigning a static IP address to NetClock, even if it is connected to a
DHCP server. While this can be accomplished using the front panel keypad, or a PC connected
to NetClock's serial port, the most convenient way is using the NetClock Web user interface
("Web UI"): The dynamic IP address assigned to your NetClock unit by DHCP will allow you to
readily access the Web UI, in order to carry out the desired changes.

Before continuing, obtain the following network information from your network administrator:

Available static IP Address

This is the unique address assigned to the NetClock unit by the network admin
istrator. Make sure the chosen address is outside of the DHCP range of your
DHCP server. The default static IP address of the NetClock unit is 10.10.20x.1 (x=
dependent on ETH port, if Ethernet Gigabit option card 1204-06 is installed).

Subnet mask (for the network)

The subnet mask defines the number of bits taken from the IP address that are used
in the network portion. The number of network bits used in the net mask can range
from 8 to 30 bits.

Gateway address

The gateway (default router) address is needed if communication to the NetClock
is made outside of the local network. By default, the gateway is disabled.

To replace DHCP network settings with a static IP address:
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1. Enter the IP address shown on the front panel information display of your NetClock unit
into your browser (on a computer connected to your network). If the network supports
DNS, the hostname may also be entered instead (the default hostname is "Spectracom").
The start screen of the NetClock Web UI will be displayed.

2. Log into the Web UI as an administrator. The factory-default user name and password
are:
Username: spadmin
Password: admin123

3. Disable DHCP, see: "Configuring Network Ports" on page 50.

4. Manually enter the desired static IP address, subnet mask, and gateway address (if
required), see: "Configuring Network Ports" on page 50. For subnet mask values, see
table "Subnet mask values" on page 41.

5. Enter the static IP address you assigned to your NetClock unit, and again log into the
Web UI in order to continue with the configuration; see: "Product Configuration via the
Web UI" on page 46.

Note: Make sure you are assigning a static IP address to your NetClock unit that
is outside of the DHCP range defined for the DHCP server. Your system admin
istrator will be able to tell you what this range is.

2.11 Network Configuration Without DHCP

Note: During configuration it may be necessary to power down or restart NetC
lock. In this case a HALT command should be issued prior to removing power
from the unit. Failure to do so may cause NetClockto take longer to boot on the
next power up cycle. After the HALT command is issued via the front panel
keypad, or the Web UI, wait until the information display reads ‘Power off NetC
lock’ before removing power.

2.11.1 Assigning a Static IP Address
To configure a NetClock that has not yet been assigned an IP address (because your network
does not support DHCP, for example), there are two ways to enter the desired static IP address,
subnet mask, and gateway address.:

The front panel keypad and 4-line information display, or

A personal or laptop computer, connected via serial cable to the serial port on the NetC
lock front panel.

The keypad is the simplest method to configure the network settings. See "Using the Keypad
and Information Display" on page 33 for information on using the keypad. See "Configuring
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Network Ports" on page 50 for steps to disable the factory-default DHCP setting, and to con
figure the IP address, subnet mask and gateway address.

Before continuing, obtain the following network information from your network administrator:

Available static IP address

This is the unique address assigned to the NetClock unit by the network admin
istrator. Make sure the chosen address is outside of the DHCP range of your
DHCP server. The default static IP address of the NetClock unit is 10.10.20x.1 (x=
dependent on ETH port, if Ethernet Gigabit option card 1204-06 is installed).

Subnet mask (for the network)

The subnet mask defines the number of bits taken from the IP address that are used
in the network portion. The number of network bits used in the net mask can range
from 8 to 30 bits.

Gateway address

The gateway (default router) address is needed if communication to the NetClock
is made outside of the local network. By default, the gateway is disabled.

2.11.2 Network Configuration via Front Panel (NetClock 9483 Only)
A. First, disable DHCP:

1. Press the ü key.

2. Using the arrow key, select Netv4 from the menu.
(To select a menu item, highlight it using the arrow keys, then press the ü key.)

3. Select the Ethernet interface for which DHCP is to be disabled, such as eth0.

4. Delect DHCP from the next menu. The display will show State= Enabled
and Action=Disabled.
Press the ü key once to select the action, then again to apply it.
(The State is the current DHCP setting and the Action is the action to take. You can
only change the Action setting.)

5. Press the ü key once to select the action, then again to apply it.

B. Then, enter IP Address and Subnet Mask:

1. Still on the Home/Netv4/eth[0-3] menu, select IP Address, and
change "N=010.010.201.001/16” to the value of the static IP address and
subnet mask/network bits to be assigned (refer to the table "Subnet mask values"
on page 41 for a list of subnet mask values).

2. Press the ü key once to enter the setting, then again to apply the new setting.

C. Lastly, enter the Gateway Address (if required).

After all addresses are entered, press the front panel key three times to return to the main
display. It should now resemble the following example:
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DNS: The Primary and Secondary DNS servers are set automatically if using DHCP. If DHCP is
not available, they can be configured manually in the NetClock Web UI via the Net
work/General Setup screen.

Note: The remainder of the configuration settings will be performed through the
NetClock Web UI (accessed through a Web browser such as Firefox ® or
Chrome®). For more information, see "Product Configuration via the Web UI" on
page 46.

2.11.3 Network Configuration via Serial Port
Next to the keypad and 4-line information display, the front panel also contains a DB9 serial
port that can be used to communicate with NetClock. The serial port connector is a standard
DB9 female connector. Communication with the serial port can be performed using a terminal
emulator program (such as HyperTerminal or Procomm) using a pinned straight-thru standard
DB9M to DB9F serial cable.

The serial port can be used to make configuration changes (such as the network settings),
retrieve operational data (such as the GNSS receiver information) or to perform operational
processes (such as resetting the admin password).

The serial port is account and password protected. Login via the serial port using the same user
names and passwords as would be used to log into the NetClock Web UI. Users with “admin
istrative rights” can perform all available commands. Users with “user” permissions only can
perform “get” commands that retrieve data, but cannot perform any “set” commands or
change/reset any passwords.

Refer to "Setting up a Terminal Emulator" on page 328 for more information on the serial port
connection, and "CLI Commands" on page 329 for a list and description of the available com
mand line (CLI) commands that can be issued.

To configure NetClock’s network settings using the front panel serial port:

1. Connect a serial cable to a PC running HyperTerminal, and to your NetClock.

2. Login to NetClock with a user account that has “admin” group rights, such as the default
spadmin account (the default password for spadmin is admin123).

3. To disable DHCP, type: dhcp4set 0 off <Enter>.
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Note: If your NetClock is configured with an Ethernet option card, use 0, 1, 2, 3
for eth0 – eth3.

4. To configure the IP address and subnet mask, type:

ip4set 0 xxx.xxx.xxx.xxx yyy.yyy.yyy.yyy <Enter>
(where 0 is the desired interface, “xxx.xxx.xxx.xxx” is the desired IP
address for NetClock, and “yyy.yyy.yyy.yyy” is the full subnet mask for the
network (refer to the table "Subnet mask values" on the facing page for a list of
subnet mask values).

5. Type gw4set 0 zzz.zzz.zzz.zzz <Enter>
(where 0 indicates which interface routing table to add the default gateway for, and
“zzz.zzz.zzz.zzz” is the default gateway address).

Note: If your NetClock is configured with an Ethernet option card, use 0, 1, 2, 3
for eth0 – eth3.

NetClock is now configured with a static IP address, subnet mask and gateway address. Pro
ceed to "Product Configuration via the Web UI" on page 46.
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Table 2-2: Subnet mask values

Network Bits Equivalent Netmask Network Bits Equivalent Netmask

30 255.255.255.252 18 255.255.192.0

29 255.255.255.248 17 255.255.128.0

28 255.255.255.240 16 255.255.0.0

27 255.255.255.224 15 255.254.0.0

26 255.255.255.192 14 255.252.0.0

25 255.255.255.128 13 255.248.0.0

24 255.255.255.0 12 255.240.0.0

23 255.255.254.0 11 255.224.0.0

22 255.255.252.0 10 255.192.0.0

21 255.255.248.0 9 255.128.0.0

20 255.255.240.0 8 255.0.0.0

19 255.255.224.0

2.12 Typical Post-Installation Configurations

2.12.1 Displaying Local Time (NetClock 9483 Only)
After physical product installation, a commonly requested scenario is for NetClock to display
local time on the front panel (rather than UTC time). To learn more about this configuration, see
"Editing the System Time" on page 167, and "Front Panel Configuration" on page 176.

2.12.2 Synchronizing Network PCs
Frequently, network PCs have to be synchronized to NetClock via the Ethernet port, using NTP
(Network Time Protocol). A detailed description on how to synchronize Windows PCs can be
found online in the Spectracom Technical Note Synchronizing Windows Computers on the Spec
tracom website . This document also contains information and details about using the Spec
tracom PresenTense NTP client software.

2.12.3 Configuring an External Display Clock
Another commonly requested configuration is to connect and configure a remote Spectracom
TimeView® Display Clock to a NetClock unit.
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Figure 2-4: Spectracom TV400 series display clock

The following procedure applies to Spectracom display clocks, models TV400W, and
TV210W.

1. Set up a Local Clock: In the Web UI, navigate to Management > Time Management, and
click the PLUS icon to add a new Local Clock.
Name the new Local Clock, and configure it (for more information, see "Setting up a
Local Clock" on page 172).

2. Navigate to the INTERFACES menu, and select ASCII Output 1 (the RS-485 Output). In
the window that opens, click the EDIT button:
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3. In ASCII Output 1 Configuration window, select:

Under Format Group: Spectracom

Under Format 1: Spectracom Format 0, and

Under Timescale: the Local Clock that you created in Step 1.

For additional information on the other settings, see "Configuring an ASCII Time Code
Output (RS-232 or RS-485)" on page 289.

4. Click Submit. The RS-485 output has not been setup to supply the correct time and format
for the display clock.

5. Connect the NetClock RS-485 output to the display clock input.
Do not forget to install the 120 Ω terminating resistor (included with the display clock
ancillary kit) between Pin 1 and Pin 2 of the terminal block of the display clock.

Figure 2-5: Wiring the RS-485 signal
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Note: The TV400W series display clock can be daisy chained from Input to Input,
up to a total of 32 devices in a single chain. The terminating resistor should be
installed in only the last clock in the daisy chain.

6. TESTING: When the TV400W synchronizes, the seconds will stop flashing and the time
will read the Local Time configured in your NetClock. If this does not happen, check the
configuration, wiring and sync status of the NetClock 9483. The TV400W will not syn
chronize unless the GNSS is connected to your NetClock, and the unit is In Sync.

2.13 Product Registration
Spectracom recommends that you register your NetClock so as to allow our Customer Service
and Technical Support to notify you of important software updates, or send you service bul
letins, if required.

Upon initial start of the NetClock Web UI (see "Opening the Web UI" on page 35), you will be
prompted to register your new product. It is also possible to register at a later time via the HELP
menu item, or directly on the Spectracom website.

2.14 Selecting the UI Language
Spectracom continues to localize the NetClock Web UI into languages other than English e.g.,
French. Additional languages will be displayed under the Language button in the top- right
corner of the screen as they become available.

Once you selected a language preference, it will be maintained across logins.
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This chapter covers information on how to integrate NetClock 9400
Series Time Server into your existing infrastructure by configuring it
in accordance with the requirements of your application.

The following topics are included in this Chapter:
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3.1 Product Configuration via the Web UI
Once you have setup and connected NetClockto your network, the Web User Interface
(throughout this document referred to as “Web UI”) allows you to configure and monitor the
unit.

Note: Should it ever be necessary, you can restore your NetClock's configuration
to the factory settings at any time. See "Resetting the Unit to Factory Con
figuration" on page 217.

3.1.1 The Web UI's Main Screen

Note: Screens displayed in this manual are for illustrative purposes. Actual
screens may vary depending upon the configuration of your NetClock unit (e.g.,
whether or not certain option cards are installed).

The Primary Navigation Menu at the top of the Web UI Main screen provides access to all of the
Web UI's pages. The menu options are:

HOME: Return to the Main screen

INTERFACES: Access the configuration pages for …

… references (e.g., GPS, NTP)

… outputs (e.g. 10 MHz, PPS, NTP) and

… installed option cards (e.g., GPS, PPS).
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MANAGEMENT: Access the NETWORK setup screens, and OTHER setup screens, e.g. to
configure Reference Priorities, System Time, and the Oscillator.

TOOLS: Opens a drop-down menu for access to the system maintenance screens and sys
tem logs.

HELP/MONITORING: Opens a drop-down menu for access to system help and inform
ation on how to contact Spectracom for further help.

3.1.2 Default and Recommended Configurations
The factory default configuration settings were chosen for ease of initial setup. Some of the
default settings may deviate from best practices recommendations, though. The following table
outlines the differences between default and recommended configuration settings for your con
sideration:

3.1  Product Configuration via the Web UI
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Table 3-1: Default and recommended configurations

Feature Default Setting Recommended Setting Where to
Configure

HTTP Enabled Disabled Web UI
or CLI

HTTPS Enabled (using customer-generated certificate and key or default Spectracom self-
signed certificate and common public/private key SSH/SCP/SFTP enabled with
unit unique 1024-bit keys)

Web UI

SNMP Enabled Disabled or Enabled (with SNMP v3 w/
encryption*)

Web UI

NTP Enabled (with no MD5 values entered) Enabled (use MD5 authentication with
user-defined keys)

Web UI

Daytime
Protocol

Disabled Disabled Web UI

Time
Protocol

Disabled Disabled Web UI

Command Line Interface

Serial
Port

Available Available n/a

Telnet Enabled Disabled (use SSH instead) Web UI

SSH Enabled (default private keys provided) Enabled Web UI

File Transfer

FTP Enabled Disabled (use SFTP or SCP) Web UI

SCP Available Disabled (use SFTP or SCP) Web UI

SFTP Available Disabled (use SFTP or SCP) Web UI

* Spectracom recommends that secure clients use only SNMPv3 with authentication for secure
installations.

3.2 Network Configuration
The Network Setup pages are used to configure NetClock's network connectivity. They can be
accessed via the MANAGEMENT drop-down menu, under NETWORK.

3.2.1 The Network Management Screen
The Network Management screen allows you to configure your Ethernet settings and monitor
your Ethernet status.

To access the Network Management screen:
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1. Navigate to MANAGEMENT > NETWORK.

2. The Network Management screen will display. It is divided into three panels:

The Actions panel provides:

General Settings: Allows quick access to the primary network settings necessary to con
nect NetClock to a network. See "Network Configuration" on the previous page.

Web Interface Settings:

Web interface timeout: Determines on how long a user can stay logged on. For
more information, see "Changing the Web UI Timeout" on page 273.

Access Control: Allows the configuration of access restrictions from assigned net
works/nodes.

Login Banner: Allows the administrator to configure a custom banner message to be dis
played on the NetClock Web UI login page (NOTE: There is a 2000 character size
limit).

SSH: This button takes you to the SSH Setup window. For details on setting up SSH, see
"Configuring SSH" on page 76.

HTTPS: This button takes you to the HTTPS Setup window. For details on setting up
HTTPS, see "Configuring HTTPS" on page 66.
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System Time Message: Setup a once-per-second time message to be sent to receivers via
multicast. For details, see .

The Network Services panel is used to enable (ON) and disable (OFF) network services, as well
as the Web UI display mode, details see: "Network Services: En-/Disabling" on page 65.

The Ports panel is used to set up and manage NetClock’s network ports via three buttons:

INFO button: Displays the Ethernet port Status window for review purposes.

GEAR button: Displays the Ethernet port settings window for editing purposes.

TABLE button: Displays a window that allows adding, editing, and reviewing Static
Routes.

3.2.2 Network Ports

3.2.2.1 Configuring Network Ports

To configure a network port:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. The Ports panel displays a list of the available Ethernet ports, and their connection status.
Locate the port you want to configure and select the GEAR button.
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Note: The eth0 port is the built-in NetClock Ethernet port.

3. If the port is not already enabled, in the Edit Ethernet Ports Settings window, click the
Enable check box. The Edit Ethernet Ports Settings window will expand to show the
options needed to complete the port setup.

4. Fill in the fields as required:

Domain—This is the domain name to be associated with this port.

Enable DHCPv4—Check this box to enable the delivery of IP addresses from a
DHCP Server using the DHCPv4 protocol. This box is checked by default. When
DHCP is disabled (the box is unchecked), the following fields will display and
must be completed:

Static IPv4 Address—This is the unique address assigned by the network
administrator. The default static IP address of the NetClock unit is
10.10.201.1. In the format “#.#.#.#” with no leading zeroes or spaces,
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where each ‘#’ is a decimal integer from the range [0,255].

Table 3-2: Default IP addresses

ETH port
Default "static lease"

IP address

ETH0 10.10.201.1

ETH1 10.10.201.2

ETH2 10.10.201.3

ETH3 10.10.201.4

Note: The default subnet is: 255.255.0.0

Netmask—This is the network subnet mask assigned by the network admin
istrator. In the form “xxx.xxx.xxx.xxx.” See "Subnet mask values" on
page 41 for a list of subnet mask values.

IPv4 Gateway—The gateway (default router) address is needed if com
munication to the NetClock is made outside of the local network. By
default, the gateway is disabled.

DNS Primary—This is the primary DNS address to be used for this port.
This is set automatically if DHCP is enabled. When DHCP is disabled,
DNS Primary is set manually. In the format "#.#.#.#" with no leading
zeroes or spaces, where each ‘#’ is a decimal integer from the range
[0,255].

DNS Secondary—This is the secondary DNS address to be used for this
port. This is set automatically if DHCP is enabled. When DHCP is dis
abled, DNS Secondary is set manually. In the format “#.#.#.#” with no
leading zeroes or spaces, where each ‘#’ is a decimal integer from the
range [0,255].

Enable DHCPv6—Check this box to enable the delivery of IP addresses from a
DHCP Server using the DHCPv6 protocol.

Note: Unless you are using DNS in conjunction with DHCP (with the
client configured using NetClock’s hostname instead of IP address),
DHCP should be disabled and the IP address should be changed to
a static address once NetClock is properly configured.

Failure to do this will result in a loss of NTP time synchronization if
the DHCP server assigns a new IP address to NetClock. Verify your
setup before synchronizing the network PCs via NTP.

IPv6 addresses may be added and deleted by clicking the Edit IPv6 Address button at the bot
tom of the screen:
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Enable SLAAC—Check this box to enable stateless address auto configuration.

IPv6 Gateway—The gateway (default router) address is needed if communication to the
NetClock is made outside of the local network. By default, the gateway is disabled. In
the format “####.####.####.####.####.####.####.####,” where each
‘#’ is a hexadecimal value.

MTU—Maximum Transmission Unit. Range (for Ethernet v2): Default: 1500 bytes. Smal
ler packages are recommended, if encapsulation is required, e.g. to meet encryption
needs, which would cause the maximum package size to be exceeded.

To apply your changes, click Submit (the window will close), or Apply.

3.2.2.2 Viewing Network Port Settings

To view the settings of a network port:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. The Ports panel displays a list of the available Ethernet ports, and their connection status.
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3. Locate the port you want to configure and click the INFO button. The Ethernet Port Status
window will display:

The following configurations can be viewed:

The port number (the built in NetClock is designated eth0). The status will be one of:

CONNECTED (showing the connection speed) in green.

DISABLED in orange.

CABLE UNPLUGGED (the port is enabled but there is not cable attached) in
orange.

Domain—This is the domain name associated with this port.

DNS Primary—This is the primary DNS address used for this port. This is set auto
matically if DHCP is enabled. When DHCP is disabled, DNS Primary is set manually.

DNS Secondary—This is the secondary DNS address used for this port. This is set auto
matically if DHCP is enabled. When DHCP is disabled, DNS Secondary is set manually.

DHCPv4—This will show either “on” (“ENABLED” in green) or “off” (“DISABLED” in
orange).

Static IPv4 Address—This is the unique address assigned to the NetClock unit by the net
work administrator to be used when DHCP is disabled.

Mask—This is the network subnet mask assigned to the NetClock unit by the network
administrator to be used when DHCP is disabled.
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Gateway IPv4—The gateway (default router) address is needed if communication to the
NetClock is made outside of the local network to be used when DHCP is disabled. By
default, the gateway is disabled.

DHCPv6—This will show either “on” (“ENABLED” in green) or “off” (“DISABLED” in
orange).

SLAAC—This will show either “on” (“ENABLED” in green) or “off” (“DISABLED” in
orange).

Gateway IPv6—When a DHCP server is not requested or is requested but not available
and DHCPv6 is enabled, the server will use this Default Gateway.

MTU—Maximum Transmission Unit. Default: 1500 bytes. Smaller packages are recom
mended, if encapsulation is required, e.g.to meet encryption needs, which would cause
the maximum package size to be exceeded.

3.2.2.3 Viewing the Status of a Network Port

To view the connection status of a network port:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. The Ports panel displays a list of the available Ethernet ports, and their connection status.

The connection status can be:

Green: CONNECTED (showing the connection speed)

Yellow: CABLE UNPLUGGED (the port is enabled but there is no cable attached)

Red: DISABLED.

3.2.3 Static Routes

3.2.3.1 Viewing Static Routes

To view NetClock’s Static Routes:
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1. Navigate to the MANAGEMENT > NETWORK screen..

2. The Ports panel displays the available Ethernet ports, and their connection status.

3. In the Ports panel, click the TABLE icon in the upper right-hand corner.
The Static Routes table for your unit will be be displayed:

3.2.3.2 Adding Static Routes to the Routing Table

To add a static route to NetClock’s routing table:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. The Ports panel displays the available Ethernet ports, and their connection status.

3. In the Ports panel, click the TABLE button in the row representing the port for which you
wish to create a static route. The Static Routes window will be displayed:
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Note: The eth0 port is the default port for static routing on NetClock. If a
port is not given its own static route, all packets from that port will be sent
through the default.

4. In the Add Route panel, fill in the fields.

Note: Do not use the same route for different Ethernet port; NetClock will
reject a route that has been used elsewhere.

Net Address—This is the router to which the port connects.

Prefix—This is the subnet mask in prefix form. See "Network Configuration
Without DHCP" on page 37 for information on subnet masks.

Router Address—This is the IPv4 Gateway address.

5. Click the Add Route button at the bottom of the screen.

Note: To set up a static route, the Ethernet connector must be physically con
nected to the network.

3.2.3.3 Viewing a Port’s Routing Table

To view a port’s routing table:
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1. Navigate to the MANAGEMENT > NETWORK screen.

2. The Ports panel displays the available Ethernet ports, and their connection status.

3. Locate the port you want to configure, and click its TABLE button. The Static Routes win
dow will open, with the Static Routes panel displaying the port’s routing table:

3.2.3.4 Assigning a Static Route to a Port

To add or edit an interface route to a port’s routing table:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. The Ports panel lists all available Ethernet ports, and their connection status:
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3. In the Ports panel, locate the port you want to configure, and click the TABLE button. The
Static Routes window will display:

4. Fill in the fields as required:

Note: Do not use the same route for different Ethernet ports; NetClock will
reject a route that has been used elsewhere.

Net Address—This is the router to which the port connects.

Prefix—This is the subnet mask in prefix form. See "Network Configuration
Without DHCP" on page 37 for information on subnet masks.

Router Address—This is the IPv4 Gateway address.

5. Click the Add Route button at the bottom of the screen.

Note: In order for you to set up a static route, the Ethernet connector must
be physically connected to the network.

3.2.3.5 Deleting a Static Route

1. To delete a static address, navigate to the MANAGEMENT > NETWORK screen.

2. In the Ports panel on the right, click the TABLE icon in the top-right corner.

3. Click the Delete button on the right for the port you wish to delete.
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3.2.4 Access Rules

3.2.4.1 Configuring Network Access Rules

To configure access restrictions from assigned networks or nodes:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. In the Actions panel on the left, click on Access Control.

3. The Network Access Rules window displays:

4. In the Allow From field, enter a valid IP address. The address entered can be IPv4, IPv4
CIDR, IPv6, or IPv6 CIDR addresses (meaning individual IP addresses or IP address
ranges). It is not possible, however, to add direct IP addresses, but instead they must be
input as blocks, i.e. you need to add /32 at the end of an IP address to ensure that only
that address is allowed. Example: 10.2.100.29/32 will allow only 10.2.100.29
access.

I P a d d r e s s n o m e n c l a t u r e :

IPv4—10.10.0.0/16, where 10.10.0.0 is the IP address and 16 is the subnet mask in prefix form.
See "Network Configuration Without DHCP" on page 37 for information on subnet masks.

IPv6—2001:db8::/48, representing 2001:db8:0:0:0:0:0:0 to 2001:d-
b8:0:ffff:ffff:ffff:ffff:ffff.
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5. Click the Add button in the Action column.

6. The established rule appears in the Network Access Rules window.

3.2.4.2 Deleting Network Access Rules

To delete access restrictions from assigned networks or nodes:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. In the Actions panel on the left, click on Access Control.

3. In the Network Access Rules window, locate the rule you want to delete and click Delete:

3.2.5 Login Banner

3.2.5.1 Configuring the Login Banner

To configure a custom banner message to be displayed on the NetClock login page:
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1. Navigate to the MANAGEMENT > NETWORK screen.

2. In the Actions panel, click Login Banner.

3. The Network Access Banner screen will display.

4. Select the Enable Custom Banner box.

5. In the Plain Text Banner text box, type in the custom text you wish to appear on the NetC
lock login screen.

Note: The plain text banner is used for all interactive login interfaces (Web
UI, telnet, SSH, FTP, SFTP, serial, etc.). It is not required to include HTML
tags. The Web UI banner is used to include a Web UI specific banner that
can include HTML tags and be more complex than would be effective on
other interactive interfaces.
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6. Click the Submit or Apply button at the bottom of the window.

7. To test your new banner:

Log out using the LOG OUT button at the top of the Web UI.

Click the LOG IN button at the top of the Web UI.

The banner will appear above the USERNAME and PASSWORD fields:

You can also set up a Web UI banner that does not require HTML tagging.

To set up a Web UI banner:

1. Follow steps 1 through 5 above.

2. On the Network Access Banner screen, select on the Enable Web Interface Banner but
ton at the bottom of the screen.

3. The Web UI text box will display.
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4. Enter the text you wish to appear on the Web UI login screen.

5. Click the Apply button to see a preview of your entered text at the bottom of the win
dow.

6. To test your new banner:

Log out using the LOG OUT button at the top of the Web UI.

Click the LOG IN button at the top of the Web UI.
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The banner will appear above the USERNAME and PASSWORD fields.

3.2.6 Network Services: En-/Disabling

The following Network Services can be toggled ON/OFF through the Network Services panel,
which is accessible via MANAGEMENT > NETWORK:

System Time Message: A once-per second Time Message sent out via Multicast; for
details, see "System Time Message" on page 85.

Daytime Protocol, RFC867: Network testing and measurement

Time Protocol, RFC 868: Provision of machine-readable, site-independent date and time

Telnet: Remote configuration

FTP server: Access to logs

SSH: Secure Shell cryptographic network protocol for secure data communication

3.2  Network Configuration

CHAPTER 3 • NetClock User Reference Guide Rev. 12 65



HTTP: Hypertext Transfer Protocol

HTTPS: Hypertext Transfer Protocol Secure

Classic UI: This toggle switch allows the NetClock Classic Interface (as used in NetClock
Web UI Version 4.x and older) to be enabled or disabled. [Default: ENABLED]
To disable, select the OFF position, and refresh the browser window (the refresh may
take a moment). The CLASSIC INTERFACE button in the upper right hand corner of the
main screen will disappear.

tcpdump: A LINUX program that can be used to monitor network traffic by inspecting tcp
packets. Default = ON.
If not needed, or wanted (out of concern for potential security risks), tcpdump can be dis
abled permanently: Once toggled to OFF, and after executing a page reload, tcpdump
will be deleted from the system: The toggle switch will be removed, and the function can
not be enabled again (even after a software upgrade).

iptables

Since Software Version 5.4.1, iptables is supported, allowing for customizable access restric
tions. Note that iptables is always ON, and its policies can only be accessed via the Command
Line Inteface (see "CLI Commands" on page 329) in combination with the pseudo command.
Please also note that you need to have admin user rights to run this command.

Note: A listing of network settings recommendations can be found under "Default
and Recommended Configurations" on page 47.

3.2.7 Configuring HTTPS

3.2.7.1 Accessing the HTTPS Setup Screen

To access the HTTPS Setup screen:

1. Navigate to MANAGEMENT > NETWORK: HTTPS Setup, or in the MANAGEMENT >
NETWORK Actions panel, select HTTPS.
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2. The HTTPS Setup window will appear:

The window contains 4 tabs:

Certificate Request Parameters—A GUI interface that uses the OpenSSL library to create
certificate Requests and self-signed certificates.

Certificate Request—A holder for the certificate request generated under the Certificates
Request Parameters tab. This request is sent to the Certificate Authority.

Upload X509 Certificate—The certificate returned by the Certificate Authority is
uploaded under this tab.

Edit X509 PEM Certificate—The certificate used by the NetClock is stored here.
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Note: You can exit the HTTPS Setup window by clicking on the X at the top right
of the window or by clicking anywhere outside the window.

If you exit the HTTPS Setup window while filling out the Certificate Request Para
meters form before you have hit the Submit button, any information you entered
will not be retained. If you switch between tabs with the HTTPS Setup window, the
information you have entered will be retained until you either leave the HTTPS
Setup window or click the Submit button.

3.2.7.2 Using HTTPS

HTTPS provides secure/encrypted, web-based management and configuration of NetClock
from a PC. An SSL certificate is required to be in NetClock in order to make this secure HTTPS
connection.

NetClock uses OpenSSL library with a simple GUI interface to create certificate requests and
self-signed certificates. Users can then send these certificate requests to an external Certificate
Authority (CA) for the creation of a third party verifiable certificate, or use an internal cor
porate Certificate Authority. If a Certificate Authority is not available, you can use the self-
signed certificate that comes with the unit until it expires, or create your own self-signed cer
tificate.

Each NetClock comes with a default Spectracom self-signed SSL certificate. The typical life span
of a certificate is about 10 years. HTTPS is available using this certificate until this certificate
expires.

Note: If deleted, the HTTPS certificate cannot be restored. A new certificate will
need to be generated.

Note: If the IP Address or Common Name (Host Name) is changed, you may wish
to regenerate the security certificate. Otherwise you may receive security warn
ings from your web browser each time you login.

The OpenSSL library provides the encryption algorithms used for secure HTTP (HTTPS). The
OpenSSL package also provides tools and software for creating X.509 Certificate Requests,
Self Signed Certificates and Private/Public Keys. For more information on OpenSSL, please
see www.openssl.org.

NetClock’s software supports X.509 DER and PEM and P7 PKCS#7 PEM and DER formatted cer
tificates. The user can create a customer specific X.509 self-signed certificate, an RSA private
key and X.509 certificate request using the web interface. RSA private keys are supported
because they are the most widely accepted (at this time, DSA keys are not supported).
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3.2.7.3 Creating an HTTPS Certificate Request

To create an HTTPS Certificate Request:

1. Navigate to MANAGEMENT > NETWORK: HTTPS Setup, or in the MANAGEMENT >
NETWORK Actions panel, select HTTPS.

2. Choose the Certificate Request Parameters tab (this should be the default page).

3. Fill in the available fields:

Create Self-Signed Certificate—Check this box if the Certificate you are creating is a
self-signed certificate.

Signature Algorithm—Choose the algorithm to be used from:

MD4

SHA1

SHA256

SHA512

Private Key Pass Phrase—This is the RSA decryption key. This must be at least 4 char
acters long.

RSA Private Key Bit Length—2048 bits is the default. Using a lower number may com
promise security and is not recommended.
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Two-Letter Country Code—This code should match the ISO-3166-1 value for the country
in question.

State Or Province Name—From the address of the organization creating up the cer
tificate.

Locality Name—Locale of the organization creating the certificate.

Organization Name—The name of the organization creating the certificate.

Organization Unit Name—The applicable subdivision of the organization creating the
certificate.

Common Name (e.g. Hostname or IP)—This is the name of the host being authenticated.
The Common Name field in the X.509 certificate must match the hostname, IP address, or
URL used to reach the host via HTTPS.

Email Address—This is the email address of the organization creating the certificate.

Challenge Password—Valid response password to server challenge.

Optional Organization Name—An optional name for the organization creating the cer
tificate.

Self-Signed Certificate Expiration (Days)—How many days before the certificate
expires. The default is 7200.

You are required to select a signature algorithm, a private key passphrase of at least 4 char
acters, a private key bit length, the certificate expiration in days, and the rest of the remaining
fields.

It is recommended that you consult your Certificate Authority for the required fields in an
X 509-certificate request. Spectracom recommends all fields be filled out and match the inform
ation given to your Certificate Authority. For example, use all abbreviations, spellings, URLs,
and company departments recognized by the Certificate Authority. This helps to avoid prob
lems the Certificate Authority might otherwise have reconciling certificate request and company
record information.

If necessary, consult your web browser vendor’s documentation and Certificate Authority to see
which key bit lengths and signature algorithms your web browser supports.

Spectracom recommends that when completing the Common Name field, the user provide a
static IP address, because DHCP-generated IP addresses can change. If the hostname or IP
address changes, the X.509 certificate must be regenerated.

It is recommended that the RSA Private Key Bit Length be a power of 2 or multiple of 2. The key
bit length chosen is typically 1024, but can range from 512 to 4096. Long key bit lengths of up
to 4096 are not recommended because they can take hours to generate. The most common key
bit length is the value 1024.

Note: The default key bit length value is 2048.

If using only self- signed certificates (see "Creating a Self-Signed Certificate" on the facing
page), the user should choose values based on the company’s security policy.
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4. When the form is complete, click the Submit button. Clicking the Submit button auto
matically generates the Certificate Request in the proper format for submission to the Cer
tificate Authority.

Note: It may take several minutes for the NetClock to create the certificate request
and the private key. The larger the key, the longer amount of time is required. If a
system is rebooted during this time, the certificate will not be created.

The generated request can be seen by choosing the Certificate Request tab in the HTTPS Setup
window.

Note: If you switch between tabs while filling out the Certificate Request Para
meters form, the information you entered will be retained until you exit the HTTPS
Setup window or hit the Submit button.

If you exit the HTTPS Setup window, the information you entered will not be
retained.

3.2.7.4 Creating a Self-Signed Certificate

To create a Self-Signed Certificate:

1. Under the Certificate Request Parameters tab in the HTTPS Setup Window, complete the
form (see "Creating an HTTPS Certificate Request" on page 69).

2. Check the box marked Create Self Signed Certificate at the top of the form.

3. Click the Submit button at the bottom of the form.
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A Self Signed Certificate will be generated simultaneously with the Certificate Request that is
generated and then displayed under the Certificate Request tab. You may use Self Signed Cer
tificate while waiting for the HTTPS Certificate from the Certificate Authority.

3.2.7.5 Requesting an HTTPS Certificate

To request an HTTPS Certificate:

1. Create the HTTPS Certificate Request by completing the Certificate Request Parameters
form in the MANAGEMENT/NETWORK/HTTPS Setup Window (see "Creating an
HTTPS Certificate Request" on page 69) and click the Submit button.

2. Select the Certificate Request tab in the HTTPS Setup window. Clicking the Submit but
ton at the bottom of the Certificate Request Parameters form will have generated your
Certificate Request. You can view the Certificate Request in Certificate Request window.

Note: If you wish to create a different or additional Certificate Request,
you may fill out a new form under the Certificate Request Parameters tab,
and the NetClock will automatically generate the new Certificate Request.

The newly generated Certificate Request will replace the Certificate
Request previously generated. Therefore, if you wish to retain your pre
viously generated Certificate Request for any reason, you will need to
copy that request and save it in text document before you generate your
new Certificate Request.

3. Copy the generated Certificate Request from the Certificate Request window and submit
it per the guidelines of the Certificate Authority. The Certificate Authority will issue a veri
fiable, authenticable third party certificate.
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Until this certificate is received, the user’s self-signed certificate may be used (see "Creating a
Self-Signed Certificate" on page 71).

When the NetClock Web UI is accessed from a Windows computer while the self-signed cer
tificate is being used, the user’s web browser will present a popup window. The certificate can
be viewed by the user and installed through this pop up window. Other operating systems may
vary in how they install and accept certificates. External Internet access may be required by
your Certificate Authority to verify your third party certificate.

3.2.7.6 Uploading the X509 PEM Certificate

After the HTTPS Certificate has been issued by the Certificate Authority (see "Creating an
HTTPS Certificate Request" on page 69, and "Requesting an HTTPS Certificate" on the previous
page), the certificate needs to be loaded onto the NetClock system. To upload the certificate:

1. Store the Public Keys File provided to you by the Certificate Authority in a location
accessible from the computer on which you are running the Web UI.

2. Access the MANAGEMENT/NETWORK/HTTPS Setup window.

3. Choose the Upload X.509 PEM Certificate tab.

4. Click the Choose File button and locate the Public Keys File provided by the Certificate
Authority in its location where you stored it in step 1.

5. Click the Submit button.

Once the X.509 PEM Certificate has been loaded, it can be viewed by choosing the Edit X.509
PEM Certificate tab in the HTTPS Setup window.

Note: The text inside the text box under the Edit X.509 PEM Certificate tab is edit
able. However, changes should not be made to a certificate once it is imported.
Instead, a new certificate should be requested. An invalid certificate may result in
denial of access to the NetClock through the Web UI. If this occurs, see "If a
Secure Unit Becomes Inaccessible" on page 223.
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3.2.7.7 Loading a Non-X.509 PEM Format HTTPS Certificate

After the HTTPS Certificate has been issued by the Certificate Authority (see "Creating an
HTTPS Certificate Request" on page 69, and "Requesting an HTTPS Certificate" on page 72),
the certificate may not be in the X.509 PEM format. To upload an HTTPS Certificate that is not
in the X.509.PEM format:

1. Store the Public Keys File provided to you by the Certificate Authority in a location
accessible from the computer on which you are running the Web interface.

2. Navigate to the MANAGEMENT/NETWORK/HTTPS Setup window.

3. Choose the Upload X.509 PEM Certificate tab.

4. Choose the Certificate Type for the HTTPS Certificate supplied by the Certificate Author
ity from the Certification Type drop-down:

Note: The user may choose one of the following alternate certificate types:

DER
PKCS7 PEM
PKCS7 DER

5. Click the Browse… button and locate the Public Keys File provided by the Certificate
Authority in its location where you stored it in step 1.

6. Click Submit.

Note: NetClock will automatically format the certificate into the proper format.

Once the X.509 PEM Certificate has been loaded, it can be viewed by choosing the Edit X.509
PEM Certificate tab in the HTTPS Setup window.
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Note: The text inside the text field under the Edit X509 PEM Certificate tab is edit
able. However, changes should not be made to a certificate once it is imported.
Instead, a new certificate should be requested. An invalid certificate may result in
denial of access to the NetClock through the Web UI. If this occurs, see "If a
Secure Unit Becomes Inaccessible" on page 223.

3.2.7.8 Manually Inserting HTTPS Certificate from Text File

Many certificate authorities simply provide you with a certificate in the form of a plain text file.
If your certificate is provided in this manner, and the certificate is in the X.509 PEM format, you
may simply copy and paste the text into the web interface:

1. Navigate to the MANAGEMENT/NETWORK/HTTPS Setup window.

2. Choose the Edit X.509 PEM Certificate tab.

3. Copy the text of the certificate and paste it into the Update X.509 PEM Certificate File
text field.

Note: Only X.509 PEM Certificates can be loaded in this manner.

Note: The text inside the text field under the Edit X.509 PEM Certificate tab is edit
able. However, changes should not be made to a certificate once it is imported.
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Instead, a new certificate should be requested. An invalid certificate may result in
denial of access to the NetClock through the Web UI. If this occurs, see "If a
Secure Unit Becomes Inaccessible" on page 223.

3.2.8 Configuring SSH

3.2.8.1 Accessing the SSH Setup Screen

To access the SSH Setup screen, navigate to MANAGEMENT > NETWORK > SSH Setup, or,
in the MANAGEMENT > NETWORK > Actions panel, select SSH.

The SSH Setup pop-up window will display.

The window contains 2 tabs:

Host Keys—SSH uses Host Keys to uniquely identify each SSH server. Host keys are
used for server authentication and identification.

Public Key—This is a text field interface that allows the user to edit the public key files
authorized_keys file.
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Note: You can exit the SSH Setup Window by clicking on the X at the top right of
the window or by clicking anywhere outside the window.

If you exit the SSH Setup window while filling out the Certificate Request Para
meters form before you have hit the Submit button, any information you entered
will not be retained. If you switch between tabs with the SSH Setup window, the
information you have entered will be retained until you either leave the SSH
Setup window or click the Submit button.

3.2.8.2 Using SSH

The SSH tools supported by NetClock are:

SSH—Secure Shell

SCP—Secure Copy

SFTP—Secure File Transfer Protocol

NetClock implements the server components of SSH, SCP, and SFTP.

For more information on OpenSSH, please refer to www.openssh.org.

SSH uses Host Keys to uniquely identify each SSH server. Host keys are used for server authen
tication and identification. A secure unit permits users to create or delete RSA or DSA keys for
the SSH2 protocol.

Note: Only SSH2 is supported. SSH1 protocol is not supported, due to vul
nerabilities.

The user may choose to delete individual RSA or DSA host keys.

If the user chooses to delete the RSA or DSA key, the SSH will function, but that form of server
authentication will not be available. If the user chooses to delete both the RSA and DSA keys,
SSH will not function. In addition, if SSH Host Keys are being generated at the time of dele
tion, the key generation processes are stopped, any keys created will be deleted, and all key
bit sizes are set to 0.

The user may choose to delete existing keys and request the creation of new keys, but it is often
simpler to make these requests separately.

The user may create individual RSA and DSA Host Public/Private Key pairs. Host keys must first
be deleted before new Host Keys can be created.

NetClocks have their initial host keys created at the factory. RSA host key sizes can vary
between 768 and 4096 bits. The recommended key size is 1024. Though many key sizes are
supported, it is recommended that users select key sizes that are powers of 2 or divisible by 2.
The most popular sizes are 768, 1024, and 2048. Large key sizes of up to 4096 are sup
ported, but may take 10 minutes or more to generate. DSA keys size support is limited to 1024
bits.
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Host keys are generated in the background. Creating RSA and DSA keys, each with 1024 bits
length, typically takes about 30 seconds. Keys are created in the order of RSA, DSA, RSA1.
When the keys are created you can successfully make SSH client connections. If the unit is
rebooted with host key creation in progress, or the unit is booted and no host keys exist the key
generation process is restarted. The key generation process uses either the previously specified
key sizes or if a key size is undefined, the default key bit length size used is 2048. A key with a
zero length or blank key size field is not created.

The SSH client utilities SSH, SCP, and SFTP allow for several modes of user authentication.
SSH allows the user to remotely login or transfer files by identifying the user’s account and the
target machines IP address. Users can be authenticated either by using their account passwords
or by using a Public Private Key Pair. Users keep their private key secret within their work
stations or network user accounts and provide the NetClock a copy of their public key. The
modes of authentication supported include:

Either Public Key with Passphrase or Login Account Password

Login Account Password only

Public Key with Passphrase only

SSH using public/private key authentication is the most secure method of authenticating users
for SSH, SCP or SFTP sessions.

Users are required to create private and public key pairs on their workstation or within a
private area in their network account. These keys may be RSA or DSA and may be any key bit
length as supported by the SSH client tool. These public keys are stored in a file in the .ssh
directory named authorized_keys. The file is to be formatted such that the key is followed
by the optional comment with only one key per line.

Note: The file format, line terminations, and other EOL or EOF characters should
correspond to UNIX conventions, not Windows.

3.2.8.3 Changing Key Length Values

The user may change the key length of the RSA host key, the DSA host key and/or the ECDSA
host key.

To change the key length of a host key:

1. To access the SSH Setup screen, choose MANAGEMENT/NETWORK/SSH Setup. The
window will open to the Host Keys tab by default.
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2. Select the value of the key length you want to change.

It is recommended that users select key sizes that are powers of 2 or divisible by 2. The most
popular sizes are 768, 1024, and 2048. Large key sizes of up to 4096 are supported, but
may take 10 minutes or more to generate. DSA keys size support is limited to 1024 bits.

3. Click the Submit button at the bottom of the screen. The new values will be saved.

Note: Changing the values and submitting them in this manner DOES NOT gen
erate new host public/private key pairs. See "Creating Host Public/Private Key
Pairs" on the next page for information on how to create new host public/private
key pairs.

3.2.8.4 Deleting Host Keys

The user may choose to delete individual RSA or DSA host keys. To delete a key:

1. To access the SSH Setup screen, choose MANAGEMENT/NETWORK/SSH Setup. The
window will open to the Host Keys tab by default.
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2. Select Delete in the field for the key you wish to delete.

3. Press the Submit button at the bottom of the page.

Note: You can exit the SSH Setup Window by clicking on the X at the top
right of the window or by clicking anywhere outside the window.

If you exit the SSH Setup window before you have hit the Submit button,
any information you entered will not be retained. If you switch between
tabs with the SSH Setup window, the information you have entered will be
retained until you either leave the SSH Setup window or click the Submit
button.

3.2.8.5 Creating Host Public/Private Key Pairs

The user may create individual RSA and DSA Host Public/Private Key pairs. Host keys must first
be deleted before new Host Keys can be created. To create a new set of host keys:

1. To access the SSH setup screen, choose MANAGEMENT/NETWORK/SSH Setup. The
window will open to the Host Keys tab by default.

2. If you want to change the key length of any host key, enter the desired length in the text
field corresponding to the length you wish to change. See "Deleting Host Keys" on the
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previous page.

3. Check the Regenerate All Keys box.

4. Click the Submit button at the bottom of the page.
The Key Type/Status/Action table will temporarily disappear while the NetClock regen
erates the keys. The Host keys are generated in the background. Creating RSA and DSA
keys, each with 1024 bits length, typically takes about 30 seconds. Keys are created in
the order of RSA, DSA, ECDSA. NetClock will generate all 3 host keys, the RSA key, the
DSA key and the ECDSA key.

5. Delete any of the keys you do not want. See "Deleting Host Keys" on page 79.

Note: If the unit is rebooted with host key creation in progress, or the unit
is booted and no host keys exist, the key generation process is restarted.
The key generation process uses the previously specified key sizes.

If a key size is undefined, the default key bit length size used is 2048. A
key with a zero length or blank key size field is not created.

When you delete a host key and recreate a new one, SSH client sessions will warn you that the
host key has changed for this particular IP address. The user will then either have to:

1. Override the warning and accept the new Public Host Key and start a new connection.
This is the default. This option allows users to login using either method. Whichever
mode works is allowed for logging in. If the Public Key is not correct or the Passphrase
is not valid the user is then prompted for the login account password.
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2. Remove the old Host Public Key from their client system and accept the new Host Public
Key. This option simply skips public/private key authentication and immediately prompts
the user for password over a secure encrypted session avoiding sending passwords in
the clear.

3. Load a public key into NetClock. This public key must match the private key found in the
users account and be accessible to the SSH, SCP, or SFTP client program. The user must
then enter the Passphrase after authentication of the keys to provide the second factor for
2-factor authentication.

Please consult your specific SSH client’s software’s documentation.

3.2.8.6 Public Keys: Viewing, Editing, Loading

The authorized_keys file can be viewed and edited, so as to enable adding and delet
ing Public Keys. The user may also retrieve the authorized_keys file from the .ssh dir
ectory Using FTP, SCP, or SFTP.

If a user wants to completely control the public keys used for authentication, a correctly format
ted authorized_keys file formatted as indicated in the OpenSSH web site can be loaded
onto NetClock. The user can transfer a new public key file using the Web UI.
To view and edit the authorized_keys file:

1. To access the SSH setup screen, choose MANAGEMENT/NETWORK/SSH Setup. The
window will open to the Host Keys tab by default.

2. Select the Public Key tab. The authorized_keys file appears in the Public Keys File
window:
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3. Edit the authorized_keys file as desired.

4. Click the Submit button or Apply button.

The file is to be formatted such that the key is followed by an optional comment, with only one
key per line. The file format, line terminations, and other EOL or EOF characters should cor
respond to UNIX conventions, not Windows.

Note: If a user deletes all Public Keys, Public/Private Key authentication is dis
abled. If the user has selected SSH authentication using the “Public Key with Pass
phrase” option, login and file transfers will be forbidden. The user must select a
method allowing the use of account password authentication to enable login or
file transfers using SCP or SFTP.

3.2.8.7 Editing the "authorized_key" File via CLI

Secure shell sessions using an SSH client can be performed using the admin or a user-defined
account. The user may use Account Password or Public Key with Passphrase authentication. The
OpenSSH tool SSH-KEYGEN may be used to create RSA and DSA keys used to identify and
authenticate user login or file transfers.

The following command lines for OpenSSH SSH client tool are given as examples of how to
create an SSH session.

Creating an SSH session with Password Authentication for the admin account

ssh spadmin@10.10.200.5

spadmin@10.10.200.5's password: admin123

The user is now presented with boot up text and/or a “>” prompt which allows the use of the
Spectracom command line interface.

Creating an SSH session using Public Key with Passphrase Authentication for the admin
account

The user must first provide the secure Spectracom product a RSA public key found typically in
the OpenSSH id_rsa.pub file. The user may then attempt to create an SSH session.
ssh -i ./id_rsa spadmin@10.10.200.5

Enter passphrase for key './id_rsa': mysecretpassphrase

Please consult the SSH client tool’s documentation for specifics on how to use the tool, select
SSH protocols, and provide user private keys.
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3.2.8.8 Secure File Transfer Using SCP and SFTP

NetClock provides secure file transfer capabilities using the SSH client tools SCP and SFTP.
Authentication is performed using either Account Passwords or Public Key with Passphrase.

Example output from OpenSSH, SCP, and SFTP client commands are shown below.

Perform an SCP file transfer to the device using Account Password authentication

scp authorized_keys scp@10.10.200.5:.ssh

spadmin@10.10.200.135's password: admin123

publickeys 100%
|***************************************************| 5 00:00

Perform an SCP file transfer from the device using Public Key with Passphrase authen
tication.

scp -i ./id_rsa spadmin@10.10.200.5:.ssh

Enter passphrase for key './id_rsa': mysecretpassphrase

publickeys 100%
|***************************************************| 5 00:00

Perform an SFTP file transfer to the device using Account Password authentication.

sftp spadmin@10.10.200.5

spadmin@10.10.200.135's password: admin123

sftp>

The user is presented with the SFTP prompt allowing interactive file transfer and directory nav
igation.

Perform an SFTP file transfer from the device using Public Key with Passphrase authen
tication

sftp -i ./id_rsa spadmin@10.10.200.5

Enter passphrase for key './id_rsa': mysecretpassphrase

sftp>

The user is presented with the SFTP prompt allowing interactive file transfer and directory nav
igation.
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3.2.8.9 Recommended SSH Client Tools

Spectracom does not make any recommendations for specific SSH clients, SCP clients, or SFTP
client tools. However, there are many SSH based tools available to the user at low cost or free.

Two good, free examples of SSH tool suites are the command line based tool OpenSSH run
ning on a Linux or OpenBSD x86 platform and the SSH tool suite PuTTY.

The OpenSSH tool suite in source code form is freely available at www.openssh.org though
you must also provide an OpenSSL library, which can be found at www.openssl.org.

PuTTY can be found at: http://www.chiark.greenend.org.uk/~sgtatham/putty/.

3.2.9 System Time Message
The System Time Message is a feature used for special applications that require a once-per-
second time message to be sent out by NetClock via multicast. This time message will be trans
mitted before every 1PPS signal, and can be used to evaluate accuracy and jitter.

To set up and enable a System Time Message:

1. Navigate to MANAGEMENT > NETWORK > Actions panel, and select System Time
Message. The Settings window will pop-up.

2. Populate the fields Multicast Address, Port Number and Message ID, and click Submit.

3. In the Network Services panel, enable the System Time Message.

3.2.9.1 System Time Message Format

This message contains the time when the next 1PPS discrete will occur. It is sent once per second
prior to the 1PPS discrete.

Word Byte 3 Byte 2 Byte 1 Byte 0

1 Msg ID
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Word Byte 3 Byte 2 Byte 1 Byte 0

2 Msg Size

3 Seconds

4 nSec

5 EOM

Table 3-3: System Time Message format

Data Name Data Description Range Resolution Units

Message ID UID of the message; programmable Unsigned 32 bit
integer

1 n/a

Message
Size

Total message size in bytes Unsigned 32 bit
integer

1 Bytes

Seconds Seconds since epoch (00:00:00 Jan 1, 1970
UTC)

Unsigned 32 bit
integer

1 Seconds

NSec NSec within the current second Unsigned 32 bit
integer

1 nsec

EOM End-of-message -1 1 n/a

Table 3-4: System Time Message field descriptions

3.2.10 Configuring SNMP and Notifications
SNMP (Simple Network Management Protocol) is a widely accepted application-layer protocol
for managing and monitoring network elements. It has been defined by the Internet Architecture
Board under RFC 1157 for exchanging management information between network devices,
and is part of the TCP/IP protocol.

SNMP agents must be enabled and configured so that they can communicate with the network
management system (NMS). The agent is also responsible for controlling the database of con
trol variables defined in the Management Information Base (MIB).

NetClock’s SNMP functionality supports SNMP versions V1, V2c and V3 (with SNMP Version 3
being a secure SNMP protocol).

3.2.10.1 Accessing the SNMP Setup Screen

To access the SNMP Setup screen, navigate to MANAGEMENT > NETWORK: SNMP Setup.

The SNMP screen will display:
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The SNMP screen is divided into 3 panels:

1. The Main panel, which is subdivided into 3 displays:

SNMP V1/V2—This panel allows configuration of SNMP v1 and v2c com
munities (used to restrict or allow access to SNMP). This tab allows the con
figurations for SNMP v1 and v2c, including the protocols allowed, permissions
and Community names as well as the ability to permit or deny access to portions
of the network. Clicking on the “+” symbol in the top-right corner opens the
SNMP V1/V2c Settings for Access Screen. See "Configuring SNMP V1/V2 Com
munities" on the next page.

SNMP V3—This panel allows configuration of SNMP v3 functionality, including
the user name, read/write permissions, authorization passwords as well as priv
ilege Types and Passphrases. Clicking on the “+” symbol in the top-right corner
opens the SNMP V3 Screen. See "Configuring SNMP V3 Users" on page 89.

SNMP Traps—This panel allows the ability to define up to five different SNMP
Managers that SNMP traps can be sent to over the network. This allows for SNMP
Managers in different geographical areas to receive the same SNMP traps that
Managers in other areas also receive. Clicking the PLUS icon in the top-right
corner opens the SNMP Traps Settings Screen. See "Defining SNMP Traps (Noti
fications)" on page 91.

2. The Actions panel, which contains the Restore Default SNMP Configuration button.

3. The SNMP Status panel, which offers:

An SNMP ON/OFF switch.

An Authentication Error Trap ON/OFF switch.

SysObjID—The System Object ID number. This is editable in the SNMP Status
panel (see "Configuring SNMP Status Settings" on page 93).

Contact Information—The email to contact for service. This is editable in the
SNMP Status panel (see "Configuring SNMP Status Settings" on page 93).
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Location—The system location. This is editable in the SNMP Status panel (see
"Configuring SNMP Status Settings" on page 93).

Description—A simple product description. This is not editable in the SNMP
Status.

3.2.10.2 Configuring SNMP V1/V2 Communities

Creating Communities

1. Navigate to the MANAGEMENT/NETWORK/SNMP Setup screen.

2. In the SNMP V1/V2 panel click the PLUS icon in the top-right corner.

3. The SNMP V1/V2c Settings for Access window will display.

4. Enter the required information in the fields provided

The IP Version field provides a choice of IPv4, IPV6 or both IPv4 and IPv6 (=
default).

The choices offered below will change in context with the choice made in the IP
Version field.

If no value is entered in the IPv4 and/or IPv6 field, NetClock uses the system
default address.

SNMP Community names should be between 4 and 32 characters in length.

Permissions may be Read Only or Read/Write

The Version field provides a choice of V1 or V2c.

5. Click the Submit button at the bottom of the window. Cancel any changes by clicking the
X-icon in the top-right corner (any information entered will be lost).
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6. The created communities will appear in the SNMP V1/V2 panel.

Editing and Deleting Communities

To edit or delete a community you have created:

1. Click the row of the SNMP V1/V2 panel that displays the community you wish to edit or
delete. The cursor will change from an arrow icon to a pointing finger to indicate that
the entry is clickable.

2. The SNMP V1/V2c Settings for Access window will display.

Note: The options available for editing in the SNMP V1/V2c Settings for
Access window will vary contextually according to the information in the
entry chosen.

3. To edit the settings, enter the new details you want to edit and click the Submit button.

4. OR: To delete the entry, click the Delete button.

3.2.10.3 Configuring SNMP V3 Users

Creating Users

1. Navigate to the MANAGEMENT/NETWORK/SNMP Setup screen.

2. In the SNMP V3 panel, click the PLUS icon in the top-right corner.

3.2  Network Configuration

CHAPTER 3 • NetClock User Reference Guide Rev. 12 89



3. The SNMP V3 Settings window will display.

4. Enter the required information in the fields provided.

SNMP User Names and passwords are independent of users that are configured
on the Tools/Users page.

User names are arbitrary. SNMP User Names should be between 1 and
31 characters in length.

The User Name must be the same on NetClock and on the management sta
tion.

The Auth Type field provides a choice between MD5 and SHA.

The Auth Password must be between 8 and 32 characters in length.

The Priv Type field provides a choice between AES and DES.

The Priv Passphrase must be between 8 and 32 characters in length.

The Permissions field provides a choice between Read/Write and Read Only.

5. Click the Submit button at the bottom of the window. Cancel any changes by clicking the
X-icon in the top-right corner (any information entered will be lost).

6. The created user will appear in the SNMP V3 panel.

Editing and Deleting Users

To edit or delete a user you have created:

1. Click the row of the SNMP V3 panel that displays the community you wish to edit or
delete. The cursor will change from an arrow icon to a pointing finger to indicate that
the entry is clickable.
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2. The SNMP V3 Settings window will display:

3. To edit the settings, enter the new details you want to edit and click the Submit button.
Cancel any changes by clicking the X-icon in the upper right-hand corner (any inform
ation entered will be lost).

4. OR: To delete the entry, click the Delete button.

3.2.10.4 Defining SNMP Traps (Notifications)

1. Navigate to the MANAGEMENT/NETWORK/SNMP Setup screen.

2. In the SNMP Traps panel, click the PLUS icon in the top-right corner.

3. The SNMP Traps Settings window will display.
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4. Enter the required information in the fields provided. (Note that the options available for
editing will vary contexturally according to the users's choice in the Version field.)

The Version field provides a choice between v1, v2c and v3 (the default)

SNMP User names should be between 4 and 32 characters in length.

Destination IP Version is a choice between IPv4 and IPv6.

Destination IP is destination address for the notification to be sent. The default
Port is 162.

Engine Id must be a hexadecimal number (such as 0x1234).

Auth Type provides a choice between MD5 (the default) and SHA.

The Auth Password must be between 8 and 32 characters in length.

The Priv Type field provides a choice between AES and DES.

The Priv Passphrase must be between 8 and 32 characters in length.

5. Click the Submit button at the bottom of the window. Cancel any changes by clicking the
X-icon in the top-right corner (any information entered will be lost).

6. The SNMP trap you created will appear in the SNMP Traps panel.

Each row of the SNMP Traps panel includes the version of the SNMP functionality, the User
/Community name for the trap, the IP address/Hostname of the SNMP Manager and values
applicable only to SNMP v3, which include the Engine ID, the Authorization Type, the Privilege
Type.

You may define up to five different SNMP Managers to whom SNMP traps can be sent over
the network. This allows for SNMP Managers in different geographical areas to receive the
same SNMP traps.

Note: Spectracom has been assigned the enterprise identifier 18837 by the IANA
(Internet Assigned Numbers Authority). Spectracom’s product MIBs reside under
the enterprise identifier @18837.3.

For detailed descriptions of the objects and traps supported by the NetClock, please refer to
the Spectracom NetClock MIB files. See "Accessing the SNMP Support MIB Files" on page 94.

3.2.10.5 About SNMP Traps

NetClock can provide SNMP traps when events occur to provide remote indications of status
changes. SNMP Traps are one way to remotely monitor NetClock status.
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The SNMP traps indicate the status change that caused the trap to be sent and may also include
one or more objects, referred to as variable-bindings, or varbinds. A varbind provides a cur
rent NetClock data object that is related to the specific trap that was sent. For example, when a
Holdover trap is sent because NetClock either entered or exited the Holdover mode, the trap
varbind will indicate that NetClock is either currently in Holdover mode or not currently in Hol
dover mode.

For testing purposes, a command line interface command is provided. This command,
testevent, allows one, several, or all of the traps defined in the NetClock MIB to be gen
erated. Refer to "CLI Commands" on page 329 for command details.

3.2.10.6 Restoring the Default SNMP Configuration

To restore the NetClock to its default SNMP configuration:

1. Navigate to the MANAGEMENT/NETWORK/SNMP Setup screen.

2. In the Actions panel, click the Restore Default SNMP Configuration button.

3. Confirm that you want to restore the default settings in the pop-up message.

3.2.10.7 Configuring SNMP Status Settings

The SNMP Status Settings include the sysObjectID, sysContact, and sysLocation.

To configure SNMP Status Settings:

1. Navigate to the MANAGEMENT > NETWORK: SNMP Setup screen.

2. In the SNMP Status panel on the left-hand side of the screen, click the GEAR icon in the
top-right corner of the panel.
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3. The SNMP Status pop-up window will display:

The following settings can be configured in this window:

In the sysObjectID field, enter the SNMP system object ID.

In the sysContact field, enter the e-mail information for the system contact you wish to
use.

In the sysLocation field, enter the system location of your NetClock unit.

4. Submit your changes by clicking the Submit button in the lower right-hand corner.
Cancel any changes by clicking the X-icon in the top-right corner (any information
entered will be lost).

3.2.10.8 Accessing the SNMP Support MIB Files

Spectracom’s private enterprise MIB files can be extracted via File Transfer Protocol (FTP) from
NetClock using an FTP client such as Microsoft FTP, CoreFTP, or any other shareware/freeware
FTP program.

To obtain the MIB files from NetClock via FTP/SFTP:

1. Using an FTP program, log in as an administrator.

2. Through the FTP program, locate the Spectracom MIB files in the /home/spec-
tracom/mibs directory.

3. FTP the files to the desired location on your PC for later transfer to the SNMP Man
ager.

4. Compile the MIB files onto the SNMP Manager.

Note: When compiling the MIB files, some SNMP Manager programs may
require the MIB files to be named something other than the current names for the
files. The MIB file names may be changed or edited as necessary to meet the
requirements of the SNMP Manager. Refer to the SNMP Manager documentation
for more information on these requirements.

Note: In addition to the Spectracom MIB files, there are also some net-snmp MIB
files provided. Net-snmp is the embedded SNMP agent that is used in the
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NetClock and it provides traps to notify the user when it starts, restarts, or shuts
down. These MIB files may also be compiled into your SNMP manager, if they
are not already present.

Spectracom’s private enterprise MIB files can be requested and obtained from the Spectracom
Customer Service department via email at techsupport@spectracomcorp.com.

Note: By default, techsupport@spectracomcorp.com is the address in the
sysContact field of the SNMP Status panel of the SNMP Setup page.

3.3 Network Time Protocol (NTP)
Network Time Protocol (NTP) and Simple Network Time Protocol (SNTP) are client-server pro
tocols for synchronizing time on IP networks. NTP provides greater accuracy and error check
ing than does SNTP.

NTP and SNTP are used to synchronize time on any computer equipment compatible with the
Network Time Protocol. This includes Cisco routers and switches, UNIX machines, and Win
dows machines with suitable clients. To synchronize a single workstation, several freeware or
shareware NTP clients are available on the Internet. The software running on the PC determines
whether NTP or SNTP is used.

When the NTP service is enabled, NetClock will “listen” for NTP request messages from NTP cli
ents on the network. When an NTP request packet is received, NetClock will send an NTP
response time packet to the requesting client. Under typical conditions, NetClock can service at
least 9,000 NTP requests per second without MD5 authentication enabled, and at a somewhat
lower rate with MD5 authentication enabled.

The user can either enable or completely disable the NTP Service. When NTP is disabled, no
NTP time packets will be sent out to the network. When enabled, per default the NTP Service
operates in Unicast mode, i.e. the NTP Service responds to NTP requests only. Also supported
are a Broadcast mode in which NetClock sends an NTP time packet to the network broadcast
address, as well as an Anycast mode (see "NTP over Anycast" on page 106.)

Note: In order to configure NTP, you need to access the NTP Setup screen which
requires ADMINISTRATOR rights.

Often, it is not necessary to modify the NTP factory default configuration settings. However,
most of the settings can be changed by the user in order to support specific NTP applications
which may require a non-standard configuration: These features include the ability to use either
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MD5 authentication or NTP Autokey, to block NTP access to parts of the network and to broad
cast NTP data to the network’s broadcast address.

Most of these topics listed below can also be accessed through "The NTP Setup Screen" below,
which is a good starting point for 'how-to' instructions. Additional information on system mon
itoring can be found under "NTP Status Monitoring" on page 243.

3.3.1 The NTP Setup Screen
The NTP Setup screen provides access to all NTP configuration settings.

1. To open the NTP Setup screen, navigate to MANAGEMENT > NETWORK: NTP Setup.

2. The NTP Setup screen will be displayed; it is divided into 5 panels:

The NTP Servers and Peers panel on the right-hand side of the NTP screen is divided into 2 sub-
panels:

NTP Servers: In this display you can view the NTP Servers that NetClock detects in your
network. It is through this display that you configure external NTP references. See "NTP
Servers: Adding, Configuring, Deleting" on page 117.

NTP Peers: In this display you can view the NTP Peers that NetClock detects in your net
work. It is through this display that you configure NTP Peer reference inputs. See "NTP
Peers: Adding, Configuring, Deleting" on page 118.

For more information on NTP servers, peers, and stratums see "NTP Servers & Peers (Stratum
Synchronization)" on page 98.
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The NTP Throughput panel shows two graphs depicting the rate of NTP traffic from Clients and
Server/Peers.

The INFO icon opens a window showing the maximum per second traffic rate from each.

The graphs maybe saved and downloaded (> ARROW icon), or deleted (> TRASH CAN icon).

This data is currently only displayed for NTP, and not for TimeKeeper.

The Actions panel in the top left-hand corner of the NTP screen comprises the following buttons:

Symmetric Keys: Click here to set up your symmetric keys for MD5 authentication. For
more information on Symmetric Keys, see "Symmetric Keys (MD5 Authentication)" on
page 105.

Access Restrictions: Click here to view, change or delete access restrictions to the NTP
network. (See also "Configuring NTP Access Restrictions" on page 123.)
Fields in the NTP Access Restrictions table include:

Type

IP Version

IP

IP Mask

Auth only

Enable Query

View NTP Clients: Click here to reveal a table of all the clients your NetClock is ser
vicing. (See also "Viewing NTP Clients" on page 125.)
Information for each client includes:

Client IP

Received Packets

Mode

Version

Restriction Flags

Avg Interval

Last Interval

NTP Anycast: Click here to enable and configure Anycast. See also "NTP over Anycast"
on page 106.

Restore Default NTP Configuration: Click here to restore NetClock’s NTP settings to the
factory default. Any settings you have created previously will be lost. See "Restoring the
Default NTP Configuration" on page 126.

The NTP Services panel is the second panel on the left-hand side of the NTP screen. It has two
switches:
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NTP ON/OFF: This switch enables and disables NTP. See "Enabling and Disabling
NTP" on page 126.

Note: When the NTP timescale is changed or when you have changed any
NTP configurations, use this switch to disable and then enable NTP.

Expert Mode: Turning this switch ON enables direct access to the NTP.conf file, thus
bypassing the NetClock Web UI. [Default =OFF] See "NTP Expert Mode" on page 113.

Note: Spectracom Tech Support does not support the editing of the NTP
configuration files in Expert Mode. For additional information on editing
the NTP.conf file, please refer to http://www.ntp.org.

Other NTP Services that can be configured via the NTP Services panel by clicking the GEAR
icon are:

Broadcast (see "Enabling/Disabling NTP Broadcasting" on page 126)

Autokey (see "Configuring NTP Autokey" on page 127)

Stratum 1 (see "NTP Stratum Configuration" on page 129)

The NTP Status Summary panel provides a realtime overview of your key NTP network para
meters. See "NTP Status Monitoring" on page 243.

3.3.2 NTP Servers & Peers (Stratum Synchronization)
Other available NTP servers can be configured as potential input time references for System
Time synchronization. A group of NTP servers at the same Stratum level (Stratum 1 time servers
for example) are listed as NTP peers to each other. NTP Servers at a higher Stratum than
another are configured as NTP Servers instead (Internet Time Servers should be configured as
NTP Servers and not as NTP peers).

Note: IMPORTANT: In order for other NTP servers to be a valid reference, “NTP”
must be enabled in the Reference Priority table (see "Configuring Input Reference
Priorities" on page 152).

It is recommended to use one or more NTP Peers when you desire to provide mutual backup.
Each peer is normally configured to operate from one or more time sources including reference
clocks or other higher stratum servers. If a peer loses all reference clocks or fails, the other
peers continue to provide time to other clients on the network.

NetClock can be configured to receive time from one or more available NTP servers (NetC
locks, or different models). The other NTP servers can then be valid input references for System
Time synchronization. This is commonly referred to as NTP Peering.
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When NetClock is configured to obtain time from other NTP servers at the same Stratum level
(configured as NTP Peers) but is currently using another input reference other than the NTP
server(s) as its selected reference, NetClock will report to the network (in the NTP time stamps)
that it is a Stratum 1 time server. But, at some point, if all other input references besides the
other NTP server(s) become unavailable, NetClock will then drop to a Stratum 2 time server
(with System Time being derived from the NTP time packets being received from the other NTP
Peers.

When NetClock is configured to obtain time from other NTP servers at a higher stratum than it
is (configured as NTP Servers) and is using the NTP server as its selected reference, NetClock
will report to the network (in the NTP time stamps) that it is one less Stratum than its selected ref
erence NTP server (i.e., if NetClock is configured to receive time from one or more Stratum 1
NTP Servers, with no other higher priority input references available, NetClock will report to
the network that it is a Stratum 2 time server).

In order for NetClock to use other NTP servers as a valid time reference to synchronize the Sys
tem Time, the input Reference Priority Setup table must be configured to allow NTP as an avail
able reference. For more information on the input Reference Priority table, refer to
"Configuring Input Reference Priorities" on page 152.

If NetClock is synchronized to another NTP server and the other NTP server subsequently loses
sync or becomes unavailable (with no other higher priority input references being present and
valid) NetClock will then go into the Holdover mode until any enabled and valid input ref
erence becomes available again (or until the Holdover period expires, whichever one occurs
first). During Holdover mode, NTP will remain at the same Stratum level it was before entering
the Holdover mode and can continue to be the reference to the network. However, if no input
reference becomes available before the Holdover period expires, Time Sync will be lost and
shortly thereafter, NTP will report to the network that it is now at Stratum 15. A status of
Stratum 15 will cause the network to ignore NetClock as an NTP time reference. Refer to "Hol
dover Mode" on page 192 for information on obtaining or configuring the allowable Hol
dover period.

3.3.2.1 The NTP Servers and NTP Peers Panels

The NTP Servers and NTP Peers panels (see also "The NTP Setup Screen" on page 96) display
which servers in the network are set up at a higher stratum (Servers) or at an equal stratum
(Peers).

The NTP Servers panel and NTP Peers panel display the following information:
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IP/HOST

REF ID—The type of input reference (for example, “GPS” indicates the reference can use
GPS for its synchronization). Below is a list of potential REF IDs reported by the timing
system (others may be reported by other NTP peers or servers):

GPS—GNSS reference

IRIG—IRIG reference

HVQ—HAVE QUICK reference

FREQ—Frequency reference

PPS—External 1PPS reference

PTP—PTP reference

ATC—ASCII time code reference

USER—User provided time

LOCL—Local reference (synced to itself)

INIT—NTP on server/peer is initializing

STEP—NTP on server/peer is performing initial synchronization step and restart
ing

AUTH STATUS—Indicates if the selected reference is using MD5 authentication. “None”
indicates authentication not being used.

LAST—The number of seconds it’s been since this reference was last polled for its time.

POLL—The poll interval, how often NetClock is polling this NTP reference for its time.

DELAY (ms)—The measured one-way delay between NetClock and its selected reference.

Note: NTP clients of the NetClock are viewable through the View NTP Clients
option In the Actions panel of the NTP Setup screen.

Note: In order for other NTP servers to be a valid reference, “NTP” must be
enabled as both the Time and 1PPS references in the Reference Priority table. See
"Configuring Input Reference Priorities" on page 152.

To remove a server (and its associated configurations), select the “Clear” option at the end of
its row to “Enabled” and click Submit. That particular row will then be immediately cleared.

Note: In order for NTP configuration changes to take effect, NTP should be dis
abled and then enabled after any configurations changes have been made. NTP
can be stopped and restarted from the MANAGEMENT/NETWORK/NTP Setup
page, in the NTP Service panel on the left-hand side of the page.
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In the “NTP service” field, select “Disabled’, then click Submit to disable NTP, then
Select “Enabled” and click Submit again to re-enable NTP. Changes made will
now take effect and NTP operation will be restored shortly after this operation is
performed.

If NetClock has no valid Timing System Reference, NTP Server or NTP Peers, the NTP Stratum
value is automatically increased to Stratum 15. This ensures no NTP clients can use it as a time
reference when unsynchronized. This feature utilizes automatic enabling and disabling of the
Local Clock Reference driver to force Stratum 15. The automatic Local Clock Reference mode is
disabled in NTP Expert mode if the user configures a Local Clock Reference Driver, or if the
comment # DISABLE_AUTO_LOCAL is added to the NTP configuration file.

3.3.3 NTP Output Timescale
The timescale for the time that is provided to the network nodes via the NTP time stamps is
determined by the Timescale selected in the NetClock System Time Setup Page, accessed
through the Web UI at MANAGEMENT/OTHER/Time Management . See "The Time Man
agement Screen" on page 166. If the Timescale in System Time Setup is selected as “UTC”, the
network PCs will receive UTC time via NTP. If “GPS” is selected instead, the network PCs will
receive GPS time via NTP. When the Timescale is set to “GPS”, the GPS-to-UTC offset on the
Setup/Time Management page must be set correctly. Typically, UTC is the desired Timescale
for network synchronization.

Note: IMPORTANT: Make sure the desired timescale for the NTP output is selected
in the System Time Setup.

Having the incorrect timescale selected can result an undesired time error in the
NTP clients that are synchronizing to NetClock via NTP. As of July 2015, the offset
between UTC and GPS time is 17 seconds.

Note: IMPORTANT: Configuration changes made to NetClock’s NTP con
figurations do not take effect until the NTP Service is Disabled and then Enabled
(or until NetClock is rebooted/power cycled). The NTP service can be stopped
and started from the MANAGMENT/NTP Setup in the NTP Services panel. Once
NTP has been re- enabled, NTP will be available again for network syn
chronization within a few minutes.

The MANAGEMENT/NETWORK/NTP Setup page allows NTP broadcast capability to be
enabled (this feature very rarely needs to be enabled) and allows the network access of the
NTP time stamps to be limited to only certain clients on the network (this feature is also rarely
used).
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3.3.4 NTP Timing System: Reference Selection and Preference
If desired, Time and PPS References for the NTP service can be configured as Preferred. This
provides additional “weighting” to that particular NTP input reference during the selection pro
cess, while NTP is deciding which reference it should select as its source (though “prefer” does
not guarantee that reference will become the selected reference).

The Timing System Reference/Preferred (Enabled/Disabled) option configures NTP to
“weight” the Timing system input heavier than input from other NTP servers for its selec
tion (The Timing System inputs are normally more accurate than other NTP servers).
However, if the Timing System inputs are not normally available (such as with intermittent
GNSS reception or no other inputs are available), it may be desired not to prefer the
Timing System over an NTP reference, in which case this box should not be checked.

The Timing System 1PPS Reference (Enabled/Disabled) option determines whether or
not NTP uses the 1PPS input from the Timing System. The 1PPS input to NTP needs to cor
relate with its “Time” input. If the Time and PPS inputs are originating from the same
source, they will be correlated. However, if the time is originating from another NTP
server, but the 1PPS is being derived by the Timing System, the two inputs may not
always correlate. Without this correlation, NTP performance will be degraded. In this
scenario, it is best not to use the System Time’s 1PPS as a reference.

Normally, the NTP service will obtain its Time and PPS reference inputs from the Timing System
(the Timing System is the time as derived from the GNSS, IRIG, ASCII data inputs, etc.).
However, if desired, NTP can also obtain time from other NTP server(s). When the Timing Sys
tem references are normally available to NetClock, the “Timing System 1PPS reference” should
be enabled and the “Timing System Reference” should be Preferred (both of the boxes at the
top of the page enabled). This provides NTP with the most accurate references.

In the case of Stratum synchronization (only syncing NetClock to other NTP servers, instead of
the Timing System, so that is can operate as a Stratum 2 time server, for example), the Timing
System inputs are not going to be available, as the only available input will be other con
figured NTP servers. In this scenario, it is best to uncheck both options at the top of the page so
that the Timing System is not preferred over a configured NTP server and to keep the Timing
System’s 1PPS from affecting the operation of NTP (as its 1PPS will not correlate with the NTP
time input being received from the other NTP servers).

Note: It is not normally recommended to enable the Timing System Reference Pre
ferred checkbox in addition to enabling any of the Preferred boxes in the NTP
Servers table.

Normally, either select the Prefer Timing System Reference and none of the Pre
ferred boxes in the NTP servers table (if the Timing System inputs are normally
available) or de-select the Prefer Timing System Reference and enable Preferred on
one of the NTP servers in the NTP Servers table (if the Timing System inputs are
not normally available).
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It is not normally recommended to select more than one NTP Server in the NTP Servers table as
being Prefer. Typically, only one NTP server in the table should be selected as Prefer (and
should only be selected if the box Prefer Timing System Reference: is not checked).

The maximum number of NTP Peers (or NTP Servers) that can be configured as time references
is twelve (12). For best results, more than four NTP time servers are recommended. As few as
one NTP time server may be used, however, depending on your needs and network timing
architecture. A specific NTP server is recommended to be configured as the preferred time ref
erence by selecting the preferred checkbox.

For both NTP Peers and NTP Servers the Minimum and Maximum Poll rate for NTP packets can
be configured. Both NTP Peers and NTP Servers support either manually configured Symmetric
Key-ID/Key string pairs or the use of Auto-Key. However, these choices are mutually exclusive
and must be identically configured on both the NetClock and the NTP Peer or NTP Server. If the
Symmetric Key-ID/Key string pair method is selected the Key-ID must be first defined on the Sym
metric Key page.

The entry for NTP Peer or NTP Server can be deleted by selecting the Clear checkbox and
pressing Submit.

The grids on the NTP Peers and Servers tabs allow the user to define, by IP address or host
name, the locations of other NTP servers to use as time references (instead of, or in addition to,
the configured NetClock’s primary reference) and the locations of other NTP servers to use as
peers. The maximum number of Peers allowed is twelve (12).

3.3.5 NTP Keys

3.3.5.1 NTP Autokey

Note that, as of spring 2016, NTP Autokey is currently not supported; for more information,
see http://bugs.ntp.org/show_bug.cgi?id=3005.

NTP Autokey—Support & Limitations
Currently, NetClock supports only the IFF (Identify Friend or Foe) Autokey Identity Scheme. The
NetClock product web interface automates the configuration of the IFF using the MD5 digests
and RSA keys and certificates. At this time the configuration of other key types or other digests
is not supported.

Note: When you configure NTP Autokey, you must disable the NTP service first,
and then re-enable it after Autokey configuration is completed.

NTP Autokey—IFF Autokey Support
The IFF Autokey Support is demonstrated in the figure below. The IFF identity scheme is used
with Multiple Stratum NTP Time Servers. The example below shows 3 Stratum layers. Stratum 1
NTP Servers are close to the physical time references. All Stratum 1 servers can be Trusted
Hosts. One of them is used to generate the IFF Group/Client Key. This defines the IFF Group.
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All other group members generate Group Certificate and RSA public/private keys using MD5
digest. Each group member must share the common IFF Group/Client Key (recommended).
Stratum 2 NTP servers are also members of the Group. All NTP Stratum 1 servers are Trusted
Hosts. The NTP servers closest to the actual time reference (Stratum 1) should be designated trus
ted. A single Stratum 1 NTP server generates the IFF Group/Client Keys. There is NO group
name feature supported. The Group can use the same passphrase (password) or different pass
phrases for each client.

An NTP Server Group member is configured by enabling Autokey and creating certificate and
public/private key pair while not enabling the Client Only selection. A Client Only NTP server
is configured by enabling Autokey and creating certificate and public/private key pair and
enabling the Client Only selection.

Note: Passphrases can be identical for all group members and Client NTP Serv
ers. Or passphrases can be the same for group members and a different pass
phrase shared between the Client Only NTP Servers.
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Figure 3-1: IFF Autokey configuration example

3.3.5.2 Symmetric Keys (MD5 Authentication)

NetClock supports authenticated NTP packets using an MD5 authenticator. This feature does not
encrypt the time packets, but attaches an authenticator, which consists of a key identifier and an
MD5 message digest, to the end of each packet. This can be used to guarantee that NTP pack
ets came from a valid NTP client or server, and that they were not tampered with during trans
mission. The Symmetrical Keys tab allows NTP to be configured to use MD5 authentication. To
configure Symmetric Keys, see "Configuring NTP Symmetric Keys (MD5 Authentication)" on
page 120.
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3.3.6 NTP over Anycast
NTP (Network Time Protocol) is a packet network based synchronization protocol for syn
chronizing a client clock to a network master clock (see also "Network Time Protocol (NTP)" on
page 95.)

Anycast is a network routing protocol in which messages are routed to one of a group of poten
tial receivers via a single Anycast address, thus avoiding the need to configure every client indi
vidually.

NTP over Anycast, as implemented in NetClock, is a combination of the two concepts, allowing
NetClock to:

I. Associate one of its network ports to an Anycast IP address, and

II. Remove itself as an available time source if its reference is lost or degraded, and vice
versa.

To learn more about NTP over Anycast, see also the respective Spectracom Technology Brief
(PDF).
Please note that NetClock utilizes the OSPF (Open Shortest Path First) protocol for internal rout
ing, and BGP (Border Gateway Protocol) for external routing..

E X A M P L E :

If an active NetClock NTP server has removed itself as an available time source from the Anycast-cap
able network, the OSPF router will send a request for replacement to the next nearest NTP server,
serving under the same NTP over Anycast address.

As soon as the first NetClock server obtains a valid reference again, it will make itself available to
the OSPF router, which will then use it as a time source again, based on the principle of shortest path
available.

Figure 3-2: All NTP servers are synchronized
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Figure 3-3: NTP server 1 is out of sync

3.3.6.1 Configuring NTP over Anycast (General Settings)

To setup the NTP over Anycast functionality:

1. Confirm that your existing network infrastructure is Anycast capable. Determine network
specifics, such as the Anycast address and port.

2. In the NetClock Web UI, navigate to MANAGEMENT > Network > NTP Setup.

3. In the Actions Panel, click NTP over Anycast.

4. In the NTP Anycast window, select the General tab.

5. On the General tab, select the IP Version you will be running Anycast service for. The
options are IPv4, IPv6, or both.

6. Configure the Anycast Address to be used.

7. Select the port to associate the Anycast service with (depending on the option card con
figuration of your unit, there may be only ETH0 available). If you desire IPv6 func
tionality, you must also select the IPv6 port address since there may be multiple IPv6
addresses on a single port.

8. Click Submit.

Note: IMPORTANT: For Anycast to function, NetClock must be in sync to a valid
reference, or to itself.

3.3.6.2 Configuring NTP over Anycast (OSPF IPv4)

To setup the NTP over Anycast functionality, using OSPF IPv4:

1. Confirm that your existing network infrastructure is Anycast capable, and uses OSPF Ver
sion 2 (IPv4). Determine the OSPF area.

2. In the NetClock Web UI, navigate to MANAGEMENT > Network > NTP Setup.

3. In the Actions Panel, click NTP over Anycast.

4. In the NTP Anycast window, select the General tab.

3.3  Network Time Protocol (NTP)

CHAPTER 3 • NetClock User Reference Guide Rev. 12 107



5. On the General tab, select IPv4 as the IP Version.

6. Configure the Anycast Address to be used.

7. Select the port to associate the Anycast service with (depending on the option card con
figuration of your unit, there may be only ETH0 available).

8. In the NTP Anycast window, navigate to the OSPF tab.

9. On the OSPF tab, check Enable.

10. Setup the OSPF area.

11. Click Submit.

12. Select the port address to associate the Anycast service with (because there may be mul
tiple addresses on a single port), and click Submit. If no addresses appear, an IP
address must be added to the port (see "Configuring Network Ports" on page 50).

13. Next, specify the maximum TFOM Setting (Time Figure of Merit), and the Holdover
Timeout value. These two parameters determine NetClock's accuracy "tolerance win
dow": A small window will cause NetClock to deliver a more accurate time window, but
also will cause it to quickly withdraw from the Anycast server pool, i.e. declare itself an
invalid reference. (To find out more about TFOM, see "Oscillator Disciplining Setup" on
page 189.)
Navigate to Management > Disciplining, and click the GEAR icon in the top-right corner
of the Status panel.

14. Set the value Maximum TFOM for Sync to 4 (this will make NetClock to go out of sync if
the phase error is greater than 1μs).

15. Set the value for Holdover Timeout to 10 s, to allow NetClock to exit holdover quickly.

16. Leave the Phase Error Limit at 0, and do not check any of the checkboxes (or, for more
information, see "Oscillator Disciplining" on page 185).

3.3.6.3 Configuring NTP over Anycast (OSPF IPv6)

To setup the NTP over Anycast functionality, using OSPF IPv6:

1. Confirm that your existing network infrastructure is Anycast capable, and uses OSPF Ver
sion 3 (IPv6). Determine the OSPF area.

2. In the NetClock Web UI, navigate to MANAGEMENT > Network > NTP Setup.

3. In the Actions Panel, click NTP over Anycast.

4. In the NTP Anycast window, select the General tab.

5. On the General tab, select IPv6 as the IP Version.

6. Select the port to associate the Anycast service with (depending on the option card con
figuration of your unit, there may be only ETH0 available).
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7. Select the port address to associate the Anycast service with (because there may be mul
tiple IPv6 addresses on a single port), and click Submit. If no addresses appear, an IPv6
address must be added to the port.

8. In the NTP Anycast window, navigate to the OSPF tab.

9. On the OSPF6 tab, check Enable.

10. Setup the OSPF6 area.

11. Click Submit.

12. Select the port address to associate the Anycast service with (because there may be mul
tiple addresses on a single port), and click Submit. If no addresses appear, an IP
address must be added to the port (see "Configuring Network Ports" on page 50).

13. Next, specify the maximum TFOM Setting (Time Figure of Merit), and the Holdover
Timeout value. These two parameters determine NetClock's accuracy "tolerance win
dow": A small window will cause NetClock to deliver a more accurate time window, but
also will cause it to quickly withdraw from the Anycast server pool, i.e. declare itself an
invalid reference. (To find out more about TFOM, see "Oscillator Disciplining Setup" on
page 189.)
Navigate to Management > Disciplining, and click the GEAR icon in the top-right corner
of the Status panel.

14. Set the value Maximum TFOM for Sync to 4 (this will make NetClock to go out of sync if
the phase error is greater than 1μs).

15. Set the value for Holdover Timeout to 10 s, to allow NetClock to exit holdover quickly.

16. Leave the Phase Error Limit at 0, and do not check any of the checkboxes (or, for more
information, see "Oscillator Disciplining" on page 185).

3.3.6.4 Configuring NTP over Anycast (BGP)

To configure NTP over Anycast, using BGP (Border Gateway Protocol):

1. Confirm that your existing network infrastructure is Anycast capable, and uses BGP.
Determine the network specifics, such as your Autonomous System (AS) number, Neigh
bor’s address and Neighbor’s AS number.

2. In the NetClock Web UI, navigate to MANAGEMENT > Network > NTP Setup.

3. In the Actions Panel, click NTP over Anycast.

4. In the NTP Anycast window, select the General tab.

5. On the General tab, select your desired IP Version. This selection automatically com
municates with the BGP tab and displays the neighbor address field based on your
needs.

6. Select the port to associate the Anycast service with (depending on the option card con
figuration of your unit, there may be only ETH0 available). If you desire IPv6 func
tionality, you must also select the IPv6 port address since there may be multiple IPv6
addresses on a single port.
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7. In the NTP Anycast window, navigate to the BGP tab.

8. On the BGP tab, check Enable.

9. Input your AS number.

10. Input the neighbor’s address.

11. Input the neighbor’s AS number.

12. Click Submit.

13. Select the port address to associate the Anycast service with (because there may be mul
tiple addresses on a single port), and click Submit. If no addresses appear, an IP
address must be added to the port (see "Configuring Network Ports" on page 50).

14. Next, specify the maximum TFOM Setting (Time Figure of Merit), and the Holdover
Timeout value. These two parameters determine NetClock's accuracy "tolerance win
dow": A small window will cause NetClock to deliver a more accurate time window, but
also will cause it to quickly withdraw from the Anycast server pool, i.e. declare itself an
invalid reference. (To find out more about TFOM, see "Oscillator Disciplining Setup" on
page 189.)
Navigate to Management > Disciplining, and click the GEAR icon in the top-right corner
of the Status panel.

15. Set the value Maximum TFOM for Sync to 4 (this will make NetClock to go out of sync if
the phase error is greater than 1μs).

16. Set the value for Holdover Timeout to 10 s, to allow NetClock to exit holdover quickly.

17. Leave the Phase Error Limit at 0, and do not check any of the checkboxes (or, for more
information, see "Oscillator Disciplining" on page 185).

3.3.6.5 Configuring Anycast via NTP Expert Mode

Advanced Anycast configuration is possible via the NTP Expert Mode (see also "NTP Expert
Mode" on page 113), which allows you to write directly into the Anycast configuration files
(zebra.conf; ospfd.conf; ospf6d.conf and bgpd.conf).

The zebra.conf file is required for both IPv4, and IPv6 Anycast. The ospfd.conf file is
required for IPv4 Anycast only, the ospf6d.conf file is required for IPv6 Anycast only, and
the bgpd.conf file has multiprotocol functionality, hence it can be used for both IPv4, and
IPv6 Anycast.

Caution: Expert Mode should only be utilized by advanced users, as incorrectly
altering the Anycast files can cause Anycast to stop working.

Caution: Any configurations made in Expert Mode will be lost as soon as Expert
Mode is disabled.
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1. To access Expert Mode, navigate to MANAGEMENT > NTP Setup.

2. Enable the switch for Expert Mode in the panel NTP Services.

3. Once it is enabled, click NTP Anycast in the Actions Panel. The Expert mode window
will appear, with a separate tab for each of the three configuration files.

4. To enable OSPF IPv4 Anycast, check Enable under the OSPF tab. To enable OSPF IPv6
Anycast, check Enable under the OSPF6 tab. To enable BGP Anycast, check Enable
under the BGP tab. Then click Submit.

When the NTP Anycast Expert Mode window is opened, the files displayed are the con
figuration files in their current states. If no configuration was done outside of Expert Mode,
these will be the factory default files. If Anycast configuration was already done from the Web
UI, you will be able to edit the existing Anycast setup.
When editing zebra.conf in expert mode, you should ensure that the first line under an
interface line is an ip address line declaring an IPv4 address (if there is one for the inter
face), and that the next line is an ipv6 address line declaring an IPv6 address (if there is
one for the interface). No other lines or variations in spacing should be inserted before or
between these lines. No editing restrictions exist on ospfd.conf or ospf6d.conf files.

Example zebra.conf file with both IPv4, and IPv6 configured on the same port:

(Interface eth0 line, followed by IPv4 line and then IPv6 line)

*****************************************************

!

interface eth0

ip address 10.2.100.157/16

ipv6 address 2000:10:2::157/64

!

interface lo

ip address 10.10.14.1/32

ipv6 address 2000:10:10::1/64

*****************************************************

Example zebra.conf file with IPv4, and IPv6 configured on different ports:

(Interface eth0 line, followed by only IPv4 line, because no IPv6 address is configured on that
port. Interface eth1 line, followed by only IPv6 line, because no IPv4 address is configured on
that port)

*****************************************************

!

interface eth0

ip address 10.2.100.157/16

interface eth1
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ipv6 address 2000:10:2::157/64

!

interface lo

ip address 10.10.14.1/32

ipv6 address 2000:10:10::1/64

*****************************************************

Example zebra.conf file showing the default file with no addresses configured:

(Interface eth0 line, with no lines following it because no addresses are configured on the port)

*****************************************************

!

interface eth0

!

interface lo

*****************************************************

Example ospfd.conf file:

*****************************************************!

router ospf

ospf router-id 10.2.100.157

network 10.2.0.0/16 area 0.0.0.0

redistribute connected

distribute-list default out connected

!

access-list default permit 10.10.14.1/32

access-list default deny any

*****************************************************

Example ospf6d.conf file:

*****************************************************

!

interface eth0

!

router ospf6

router-id 10.2.100.157

interface eth0 area 0.0.0.0

redistribute connected
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!

*****************************************************

Example bgpd.conf file:

*****************************************************!

router bgp 12

bgp router-id 172.17.1.12

network 172.17.0.0/16

neighbor 172.17.1.1 remote-as 3

!

redistribute connected

*****************************************************

3.3.6.6 Testing NTP over Anycast

Note: A detailed Anycast test procedure is available from Spectracom upon
request. Please contact techpubs@spectracom.com.

3.3.7 NTP Expert Mode
Advanced NTP configuration is possible via the NTP Expert Mode, which allows users to write
directly into the NTP.conf file (the syntax is similar to the one used with CISCO routers).

Caution: NTP Expert Mode should only be utilized by advanced users, as incor
rectly altering the NTP.conf file can cause NTP to stop working (if NTP is con
figured as an input reference, NetClock could lose synchronization).

To access the NTP Expert Mode, navigate to MANAGEMENT > NTP Setup. The switch for the
NTP Expert Mode is in the panel NTP Services.

Caution: Any configurations made in NTP Expert Mode will be lost as soon as
NTP Expert Mode is disabled.

NTP utilizes the NTP.conf file for its configuration. Normally, configuration of the NTP.-
conf file is indirectly performed by a user via the supplied configuration pages of the NetC
lock Web UI. However, it may be desired in certain circumstances to edit this file directly,
instead of using the web-based setup screens. When Expert Mode is enabled, the user has dir
ect access to the NTP.conf file.
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Caution: Spectracom Tech Support does not support the editing of the NTP con
figuration files while in the Expert Mode. For additional information on editing
the NTP.conf file, please refer to http://www.ntp.org/.

Note: IMPORTANT: If an undesirable change is made to the NTP.conf file that
affects the NTP operation, the NTP.conf file can be manually changed back as
long as the previous configuration was known.

The NTP.conf file can be reset back to the factory default values by either
using the procedure to restore all of the NetClock factory default settings (see
"Restoring the Default NTP Configuration" on page 126) or editing the file back
to the original configuration as shown in the factory default configuration below.

Caution: If changes are made to the NTP.conf file while in the Expert mode,
Expert mode should remain enabled from that point forward. Disabling Expert
mode after changes being made to this file may result in loss of this configuration
information.
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Factory default NTP.conf file:

restrict 127.0.0.1

restrict ::1

restrict default noquery nomodify

restrict -6 default noquery nomodify

keys /etc/ntp/keys/ntp.keys

controlkey 65533

requestkey 65534

trustedkey 65533 65534

server 127.127.45.0 prefer minpoll 4

server 127.127.22.0 minpoll 4

fudge 127.127.22.0 stratum 0

peer 10.10.128.35 minpoll 3 maxpoll 3 autokey

keysdir /etc/ntp/keys/

crypto pw admin123 randfile /dev/urandom

driftfile /etc/ntp/ntp.drift

logfile /home/spectracom/log/ntp.log

statsdir /home/spectracom/log/ntpstats/

statistics loopstats peerstats clockstats

filegen loopstats file loopstats type day enable

filegen peerstats file peerstats type day enable

filegen clockstats file clockstats type day enable

Prior to Expert mode being enabled, the Network/NTP Setup page will contain various tabs
for configuring different options of the NTP Service. To prevent inadvertent changes from being
made to a user-edited NTP.conf file via the web pages, these NTP configuration tabs are
removed from the web browser view as long as the Expert mode remains enabled (only the
Expert Mode tab is visible in Expert Mode; all other tabs will no longer be present). Disabling
the Expert mode restores these tabs to the Edit NTP Services window.
To enable the Expert Mode to edit the NTP.conf file directly:
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1. Navigate to the MANAGEMENT/NETWORK/NTP Setup screen.

2. In the NTP Services panel locate the Expert Mode switch:

When enabled, the NTP Service operates in Unicast mode. In Unicast mode, the NTP Service
responds to NTP requests only. The NTP Service supports a broadcast mode in which it sends a
NTP time packet to the network broadcast address.

3. Click the Expert Mode switch.

4. Click OK in the dialogue box that displays.

5. Click the GEAR icon.

6. In the Edit NTP Services window, edit the file as desired in the text box under the Expert
Mode tab.

7. Click the Submit button to save any changes that were made.

8. First disable and then re-enable the NTP service using the NTP ON/OFF switch in the
NTP Services panel. NetClockwill now use the new NTP configuration per the manually
edited file.

Caution: Any configurations made in NTP Expert Mode will be lost as soon as
NTP Expert Mode is disabled.

Additional information about configuring Anycast via the NTP Expert Mode can be found
under "Configuring Anycast via NTP Expert Mode" on page 110.

3.3.8 Spectracom Technical Support for NTP
Spectracom does not provide technical assistance for configuring and installing NTP on Unix-
based applications. Please refer to www.ntp.org for NTP information and FAQs. Another help
ful source is the Internet newsgroup at news://comp.protocols.time.ntp.

Spectracom can provide support for Microsoft® Windows-based time synchronization. See
spectracom.com for additional information, or contact Spectracom Technical Support.

Spectracom also offers an alternate Windows NTP client software package called PresenTense.
PresenTense software provides many features and capabilities not included with the limited
functionality of the Windows W32Time program, including alert notification and audit trails
for the PC’s time.
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For more information on PresenTense, please visit spectracom.com or contact your local Spec
tracom Sales Representative.

3.3.9 NTP Servers: Adding, Configuring, Deleting

1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. The NTP Setup screen appears. The NTP Servers panel displays a list of recognized NTP
servers. Click the GEAR icon in the upper right-hand corner of the NTP Servers panel.

3. The NTP Servers pop-up window opens.

Note: Should the list be empty, no servers have been added yet. In the event that
added servers are not displayed in the NTP Setup screen/NTP Servers panel,
they could not be resolved. Verify the IP address.

System servers cannot be edited or deleted.

To ADD a new server, click the PLUS icon in the upper right-hand corner, and proceed to
the next step.
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To EDIT an existing server, click the corresponding ACTION GEAR button, or double-
click anywhere on the row, and proceed to the next step.

To DELETE an existing server, click the corresponging ACTION X-button, or double-click
anywhere on the row, then confirm by clicking OK.

4. The NTP Server Edit window displays. Enter the required information into the fields:

Host—Enter is the IP address for the server to be used as host.

Enable Symmetric Key—Click to enable Symmetric Key, and then select an option
from the drop down that displays.

Max Poll Interval—Select a value from the drop down.

Min Poll Interval—Select a value from the drop down.

Note: Before you can choose an option in the Key field, you must
first set up symmetric keys through the Actions Panel. See "Sym
metric Keys (MD5 Authentication)" on page 105. Conversely, you
may check the Autokey box below the Key field.

Enable Autokey—Click here if you want to use Autokey with this server. See "NTP
Autokey" on page 103.

Note: When you configure NTP Autokey, you must first disable the
NTP service in the NTP Services panel, and then re-enable it after
Autokey configuration is completed.

Enable Burst—This tells NTP to send a burst to the remote server when the server is
reachable.

Enable Iburst—This tells NTP to send a burst to the remote server when the server
is not reachable.

Mark as Preferred—Click here to make this server the preferred server. See "NTP
Timing System: Reference Selection and Preference" on page 102.

Note: It is not normally recommended to select more than one NTP
Server in the NTP Servers table as being preferred. Typically, only
one NTP server should be selected as preferred.

5. Click the Submit button at the bottom of the window, or press Enter.

3.3.10 NTP Peers: Adding, Configuring, Deleting
To add, edit, or delete an NTP Peer:
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1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. The NTP Setup screen appears. The NTP Peers panel displays a list of recognized NTP
peers.

Note: Should the list be empty, no servers have been added yet. In the
event that added peers are not displayed, they could not be resolved.
Verify the IP address

To EDIT the settings of an NTP Peer, click the GEAR button next to it, and proceed
to Step 3 below.

To ADD a new NTP Peer, click the PLUS icon in the top right corner of the NTP
Peers panel.

To DELETE an existing NTP Peer, click the X button next to it.

3. The NTP Peers edit window opens:

Enter the required information in the fields:

Host: Enter is the IP address for the server to be used as host.

Min Poll Interval: Select a value from the drop down.

Max Poll Interval: Select a value from the drop down.
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Enable Symmetric Key: Click the check box to enable/disable Symmetric Key. See also:
"Symmetric Keys (MD5 Authentication)" on page 105.

Note: Before you can edit the Key field, you must set up Symmetric Keys
through the Actions Panel. See "Configuring NTP Symmetric Keys (MD5
Authentication)" below. Conversely, you may check the Autokey box below
the Key field.

Enable Autokey: Click the check box to enable/disable Autokey. See "NTP Autokey" on
page 103 for more information on Autokey.

Note: When you configure NTP Autokey, you must first disable the NTP ser
vice in the NTP Services panel, then re- enable it after Autokey con
figuration is completed.

Mark as Preferred: Check this box to to prefer this NTP Peer over other NTP Peers ("NTP
Peer Preference"). This will result in NetClock synchronizing more frequently with this
Peer.
Please note that it is not advisable to mark more than one NTP Peer as Preferred, even
though NetClock will not prevent you from doing so.

For additional information on NTP Preferences, see "NTP Timing System: Reference
Selection and Preference" on page 102.

3.3.11 Configuring NTP Symmetric Keys (MD5 Authentication)
Symmetric Keys are an encryption means that NTP may utilize for authentication purposes. See
also: "Symmetric Keys (MD5 Authentication)" on page 105.

To create, edit, or delete Symmetric Keys:

1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. In the Actions panel, click the Symmetric Keys button:
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3. The NTP Symmetric Keys window will display:

To CREATE a Symmetric Key, click the PLUS icon in the top-right corner, and proceed to
Step 4.

To EDIT an existing key pair, click the corresponding Change button, and proceed to
Step 4.

To DELETE a key pair, click the corresponding Delete button, and click OK in the dialog
box to confirm and complete the procedure.

4. The NTP Symmetric Key window will display:

Fill in, or edit the fields:

Trusted (checkbox)—Check this box to use MD5 authentication with trusted key ID.

Note: To use the MD5 authentication with trusted key ID, both the
NTP client and the NetClock must contain the same key ID/key string
pair and the client must be set to use one of these MD5 pairs.

Key ID—The key ID must be a number between 1 and 65532.

Digest Scheme—Choose one of the options from the drop-down list. The avail
able options are:

3.3  Network Time Protocol (NTP)

CHAPTER 3 • NetClock User Reference Guide Rev. 12 121



MD5 (the default)

SHA1

SHA

MDC2

MDC2

RIPEMD160

MD4

Key Str—The key string must be readable ASCII and between 1 and 16 char
acters long.

5. Click the Submit button: The changes will be reflected in the table of the NTP Symmetric
Keys window, which is displayed after clicking the Submit button.

6. The key(s) you have set up will now appear as options in the Symmetric Key field in
both the NTP Server screen, and the NTP Peer screen.
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Duplicate key IDs are not permitted. NTP requests received by that do not contain an authen
ticator containing a valid Key ID and MD5 message digest pair will be responded to, but no
authentication will be performed. An NTP request with valid authenticators results in a valid
NTP response with its own valid authenticator using the same Key ID provided in the NTP
request.

The user may define the trusted Symmetric Keys that must be entered on both NetClock, and
any network client with which NetClock is to communicate. The maximum number of Key-
ID/Key String pairs is 15. Only those keys for which the “Trusted” box has been checked will
appear in the dropdown menus on the NTP References screen.

Note: In order for NTP configuration changes to take effect, NTP should be dis
abled and then enabled after any configurations changes have been made.
NTP can be enabled and disabled through the NTP Services panel on the
MANAGEMENT/NETWORK/NTP Setup page. See "Enabling and Disabling
NTP" on page 126.
Changes made will take effect and NTP operation will be restored shortly after
this operation is performed.

3.3.12 Configuring NTP Access Restrictions
Next to encrypted authentication by means of Symmetric Keys, NTP supports a list-based means
of access restriction, the use of which is also recommended to prevent fraudulent or inadvertent
manipulation of a time server.

To configure NTP Access Restrictions:

1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. In the Actions panel, click Access Restrictions:
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3. The NTP Access Restrictions Status window will display:

To ADD or EDIT an access restriction, click the PLUS icon or the Change button,
respectively, and proceed to Step 4. below.

To DELETE an access restriction, click the corresponding Delete button, and con
firm by clicking OK.

4. The NTP Access Restrictions window will display:

Fill in the fields:

Restriction Type—Choose either Allow or Deny.
If you select “Deny”, the configured portion of the network will not have
NTP access to NetClock, but the rest of the network will have access to
NetClock. If you select “allow”, the configured portion of the network will
have NTP access to NetClock, but the rest of the network will not have
access to NetClock.

IP Version—Choose IPv4 or IPv6

IP Address—Enter the appropriate hostname.

Subnet Mask—Enter the appropriate IP mask.
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Require Authentication (checkbox)—Check this box if you want the addi
tional security of authorized access. NetClock to accept only authenticated
requests (MD5 or Autokey) from this user or network segment.

Allow NTP Queries (checkbox)—Check this box if you would like to allow
NTPDC or NTPQ client access. NTPDC and NTPQ are utilities for con
trolling NTP servers and gathering performance data from NTP servers.
Modification or control of a NetClock’s NTP service through NTPDC or
NTPQ is not supported.

5. Click the Submit button.

3.3.13 Viewing NTP Clients
To view the NTP clients being served by NetClock:

1. Navigate to MANAGEMENT> NETWORK: NTP Setup.

2. In the NTP Actions panel, click View NTP Clients:

3. The NTP Clients window will display, showing a table of the clients that are syn
chronizing to NetClock via NTP:

You can search any of the fields for specific information in the Search field at the
top of the window.

A limit of 10 entries will appear on the screen at any one time. If you have more
than 10 clients, you can move through the table using the First, Previous , Next
and Last navigation buttons at the bottom of the screen.
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3.3.14 Restoring the Default NTP Configuration
To restore NetClock to the default NTP configuration:

1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. In the NTP Actions panel, click Restore Default NTP Configuration.

3. In the dialog window that displays, click OK.

3.3.15 Enabling and Disabling NTP
After changing any of the NTP configurations, the NTP daemon needs to be disabled and then
enabled for the changes to take effect.

Changes made to NTP configurations will also take effect after NetClock is either rebooted or
power cycled.

To enable or disable NTP:

1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. In the NTP Services panel, select the ON/OFF switch.

3. A 10-second pop-up notification window will confirm the status change. Clicking the X-
button in the notification window will close it before the 10 seconds elapsed.

3.3.16 Enabling/Disabling NTP Broadcasting
NetClock allows NTP service to be configured to broadcast the NTP time to the network’s broad
cast address at scheduled intervals. To enable NTP broadcasting:

Note: The NTP Broadcast mode is intended for one or a few servers and many cli
ents.
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As most NTP clients do not normally just “listen” for NTP data on the broadcast
address (because NTP broadcast isn’t as accurate as requesting time), this cap
ability is seldom required and rarely used.

1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. On the NTP Services panel, click the GEAR icon.

3. The Edit NTP Services window will display. Check the Broadcast box.

4. Select a Broadcast Interval. When NTP broadcasting is selected, in addition to still
responding to NTP time requests sent from network appliances, NetClock will also send
unsolicited NTP time packets to the local broadcast address at a user-specified interval.

5. To utilize MD5 Authentication, select a Symmetric Key (see "Symmetric Keys (MD5
Authentication)" on page 105; to create symmetric keys, see "Configuring NTP Sym
metric Keys (MD5 Authentication)" on page 120).

6. Click the Submit button.

If you want to disable NTP broadcasting, click the Broadcast box to remove the check, and
then click the Submit button.

3.3.17 Configuring NTP Autokey

Note: As of spring 2016, NTP Autokey is currently not supported; for more inform
ation, see http://bugs.ntp.org/show_bug.cgi?id=3005.

To configure NTP Autokey:
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Note: Changing an Autokey will not take effect until the NTP Service is Disabled
and then Enabled (or until NetClock is rebooted/power cycled).

The NTP service can be stopped and started from the MANAGMENT/NTP Setup
in the NTP Services panel.

1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. Click the GEAR icon in the top-right corner of the NTP Services panel.

3. The Edit NTP Services window will display.

4. Click the Autokey tab.

5. Check the Autokey box.

6. Fill in the Passphrase field by creating a passphrase (for a Trusted server—see Cer
tificate Type below), or by using the existing passphrase of your trusted server (for
Server and Client certificates).

7. Select the Certificate Type for your server, by clicking the appropriate radio button for
Server, Client, or Trusted.

T R U S T E D S e r v e r :

Before a server can be designated Client or Server status, one server must be designated as
Trusted. When designating a server as Trusted:

1. Choose the Trusted radio button.

2. Click the Submit button.

A Groupkey is then generated for the network. This Groupkey will be pasted into the Group
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key box to designate another server on the network as Client or Server.

8. To designate a NetClock as Trusted, click the Submit button. This will generate a new
Groupkey.

9. To designate a NetClock as a Client or a Server, paste the generated Groupkey into the
Groupkey box, and click the Submit button.

3.3.18 NTP Stratum Configuration

3.3.18.1 Configuring Stratum-1 Status

To designate NetClock’s Stratum-1 status:

Note: Configuration changes made to NetClock’s NTP configurations do not take
effect until the NTP Service is Disabled and then Enabled (or until NetClock is
rebooted/power cycled). The NTP service can be stopped and started from the
MANAGMENT/NTP Setup in the NTP Services panel.
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1. Navigate to MANAGEMENT > NETWORK: NTP Setup.

2. Click the GEAR icon in the NTP Services panel.

3. The Edit NTP Services window will display. Click the Stratum 1 tab.

4. Choose among three options:

Enable Stratum 1 Operation

Prefer Stratum 1

Enable Stratum 1 1PPS.

You may choose combination of 1, 2 or three settings. See "NTP Timing System: Refer
ence Selection and Preference" on page 102 for information on timing systems in NTP
networks.

5. Click the Submit button to confirm your setup.

3.3.18.2 Configuring a Stratum-1 Server as Trusted Host

To configure an NTP Stratum-1 Server as Trusted Host with IFF Group/Client key:

1. Define the Hostname of all NTP servers before proceeding. See "NTP Servers: Adding,
Configuring, Deleting" on page 117.

2. Disable NTP.

Ensure the time is accurate to a few seconds. Use NTP or manually set the clocks to
set the system time.

3. Verify this NetClock is, in fact, NTP Stratum1, and its Time, and 1PPS synchronization to
GNSS are valid.

4. Under the Autokey tab of the Edit NTP Services window:

Enable Autokey—Check the box.

Autokey Passphrase—Enter your Group members NTP Autokey password.

Select Certificate Type to Generate—Do NOT enable Client.
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Select Trusted.

Click Submit.

5. Observe the IFF Group/Client Key appearing.

This is the common IFF Group/Client Key. This key is shared between all Group
members using this NTP Servers passphrase for ALL group members.

6. Configure NTP as requiring authentication.

7. Enable NTP in the NTP Services panel.

8. Verify that NTP reaches occur, and that NTP eventually reaches Stratum 1.

3.3.18.3 Creating a Stratum-1 Group Member Server

To configure an NTP Stratum-1 Server, which is a Group Member, using a Client key:

1. Define the Hostname, making sure it is not the same as the trusted root server. See "NTP
Servers: Adding, Configuring, Deleting" on page 117.

2. Disable NTP if enabled.

3. Manually set the time or use NTP to set the system time.

4. Under the Autokey tab of the Edit NTP Services window, enable:

Enable Autokey—Check the box.

Autokey Passphrase—Enter your Group members NTP Autokey password.

Select Certificate Type to Generate—Do NOT enable Client

5. Using the NTP Server containing the IFF Group/Common Key generate a Client Key
using this NTP Server’s passphrase.

6. Cut and paste the Client Key into the Autokey Groupkey text box.

7. For all NTP Stratum-2 servers and higher stratum numbers, disable the following items
under the Stratum-1 tab in the Edit NTP Services window:

Prefer Stratum 1.

Enable Stratum-1 1PPS.

8. In the NTP Servers panel of the main window, add an NTP server and enable the
Autokey option box. See "NTP Servers: Adding, Configuring, Deleting" on page 117.

9. Enable NTP in the NTP Services panel.

10. Wait for NTP to synchronize to the NTP References provided.

3.3.18.4 Creating a Stratum-1 Client Only Server

To create an NTP Stratum-1 'Client Only' Server with a Client key:
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1. Define the Hostname, making sure that it is different from its trusted group server. See
"NTP Servers: Adding, Configuring, Deleting" on page 117.

2. Disable NTP if enabled.

3. Manually set the time or use NTP to set the system time.

4. Under the Autokey tab of the Edit NTP Services window, enable:

Enable Autokey—Check the box.

Autokey Passphrase—Enter your Group members NTP Autokey password.

Select Certificate Type to Generate—Select Client to enable Client only.

5. Using the NTP Server containing the IFF Group/Client Key, copy the Group/Client key.

6. Paste this Group/Client key into the Autokey Groupkey text box.

7. For all NTP Stratum-2 servers and higher stratum numbers, under the Stratum-1 tab in the
Edit NTP Services window configure the NTP Stratum-1 references:

Disable Enable Stratum 1 Operation.

Disable Enable Stratum 1 1PPS.

8. In the NTP Servers panel of the main window, add an NTP server and enable the
Autokey option box. See "NTP Servers: Adding, Configuring, Deleting" on page 117.

9. Wait for NTP to synchronize to the NTP References provided.

3.4 OTHER Setup Pages

3.4.1 Authentication

3.4.1.1 User Account Management

User accounts can be created and managed from the Users page.

1. To access the Users page, navigate to MANAGEMENT > OTHER: Authentication.

2. The Users window will open, showing a list of all user accounts, including theirUser
name, the Group to which that user account is assigned to, and any Notes about the
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user account:

NetClock has two default user accounts:

1. The default administrator account (spadmin), and

2. the factory service (spfactory) account.

Additional user accounts may be added and deleted as desired.

Note: The password for the spadmin account can be changed (and it is recom
mended to do so for security reasons). However, the spadmin account name
cannot be changed, and the account cannot be removed from NetClock.

Note: The spfactory account is for use by Spectracom service personnel.
While the spfactory account can be deleted by an administrator, it should
be noted that this may potentially limit remotely provided technical support.

User accounts can be created to have either limited user or full administrator rights. Each user
can be assigned its own login password.

To ADD a user account, click the PLUS icon in the top-right corner of the Users screen.

To DELETE a user account, click the Delete button in that account’s entry on the Users
screen.

To APPLY CHANGES to a user account, click the Change button next to the desired user
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account.

When either the Change button or the PLUS icon is clicked, the Add or Change User window
appears:

To add a user account:

1. Enter a Username. The user name can be any combination of lower-case characters only
(lower-case only; no upper-case characters, punctuation symbols and numbers are not
allowed). Minimum length = 3 characters, maximum length = 32 characters.

2. Enter a Password. The password can be any combination of upper- and lower-case char
acters. Minimum password length = 8 characters, maximum length = 32 characters.

3. Repeat the new Password.

4. In the Group field, choose the permission group to which you want the user to belong to:

There are two available permission groups for each user account: user and admin. The
user permission level assigns permission to access and change all settings, with the excep
tion of the following capabilities, which are limited to the admin permission level only.

Changing network settings

Adding and deleting user accounts

Upgrading NetClock system software

Resetting the NetClock configuration
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Clearing log files

Changing Disciplining Setup options

Changing configuration options for the following protocols or features:

NTP

HTTPS, SSH

LDAP/RADIUS

SNMP (with the exception of configuring SNMP notifications).

To change an existing user account:

1. In the Add or Change User window the Username field will be populated.

a. To change it, type the new name.

b. To change the user account’s password, type the new password in the Password
field and confirm it in the Repeat New Password field.

c. To change the user account’s user permission group, select the group from the
drop-down menu.

3.4.2 Managing Password Security
To manage password security:

1. Access the Authentication page by navigating to MANAGEMENT > OTHER: Authentic
ation.

2. In the Actions panel, click Security Policy.
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3. The Password Security pop-up window will display. Fill in the fields and click Submit.

3.4.3 Configuring LDAP Authentication
LDAP (Lightweight Directory Access Protocol) authentication provides the means to use an
external LDAP server to authenticate the user account credentials when logging in to NetClock.
LDAP allows the login password for user-created accounts to be stored and maintained in a
central LDAP or server on the network. This function greatly simplifies password management.
Instead of having to change the password in many network appliances when a password needs
to be changed, if a user password is changed in the LDAP server, it automatically changes the
login password for all of the appliances that are using the LDAP server to authenticate a user
login.

In order to use the LDAP authentication capability of the NetClock, it needs to first be con
figured with the appropriate settings in order to be able to communicate with the LDAP server(s)
on the network.

Caution: If you plan on using LDAP, configure it with diligence. If not needed,
Spectracom recommends to keep LDAP disabled.

To configure LDAP authentication:
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1. Navigate to MANAGEMENT/OTHER/Authentication.

2. In the Actions panel, click the LDAP Setup button.

3. The LDAP Setup window will display.

4. There will be 5 tabs from which to choose:

Settings—This is where you set up the general LDAP Distinguished Name and
Bind settings.

Security—This is where you upload and manage the CA server certificate, CA cli
ent certificate and CA client key.

Group—This is where you enable/disable group-based authentication.

Advanced—This is where you set up your search filter(s) and login attribute.

Servers—This is where you identify the LDAP server to be used.

3.4.3.1 LDAP Settings

Under the LDAP Settings tab, set:
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Server Type—This must be the correct type—check with your LDAP server administrator if
you are not sure which you are using. You have a choice of:

Active Directory—This will be used when the LDAP server is a Windows server.

Open LDAP—This will be used when the LDAP server is a Linux/UNIX server.

Server Base DN—Specifies the default base distinguished name to use for searches. This
is the base name to use in the database search. Typically, this is the top-level of the dir
ectory tree structure. Your LDAP server administrator will provide this information.

Bind DN—Enter the Distinguished Name used to bind to (this is an optional field if the
database allows anonymous simple authentication). You are able to use any same level
of the tree and everything below.

The bind DN is the user that is permitted to search the LDAP directory within the
defined search base. Most of the time, the bind DN will be permitted to search the
entire directory. The role of the bind DN is to query the directory using the LDAP
query filter (as specified under the Advanced tab) and search base for the DN
for authenticating users. When the DN is returned, the DN and password are
used to authenticate the user.

Bind Password—Enter the password to be used to bind with the LDAP Server. Leave this
field empty for anonymous simple authentication.

NSS Password—Enter the password to be used for nss_base and nss_shadow.
Example: ou=People,dc=example,dc=com?one.

3.4.3.2 LDAP Security Settings

Under the LDAP Security tab, you can upload and install the SSL required certificates and NTP
client key.
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You may upload a server certificate, a client certificate, or a client key.

For each:

a. If necessary, create the desired certificate or client key. See "Creating an HTTPS Cer
tificate Request" on page 69 for information on creating certificates and "NTP
Autokey—IFF Autokey Support" on page 103 for information on client keys.

b. Click the INFO icon for the certificate you wish to upload.

c. In the Certificate pop-up window, click the Choose File button.

d. Locate and upload the certificate or client key file.

e. Click the Submit button.

The SSL certificates and/or client key you upload will be installed in the /home/spec-
tracom/xfer/cert/ directory.

3.4.3.3 LDAP Group Settings

Under the LDAP Group tab, you can filter access by group.
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To enable group authentication:

a. Select the Enable group filter checkbox.

b. Enter information for:

Required Group—Enter the required group. Example. : ou=Group,
dc=example, dc=com.

Group Attribute—Enter the group attribute. Example: member.

NSS base group—Enter the nss_base group. Example: ou=Group, dc=example,
dc=com?one.

c. Click the Submit button.

3.4.3.4 LDAP Advanced Settings

Under the LDAP Advanced tab, you can set the search filter and the LDAP login attribute.

Fill in the following fields, as desired:

Search filter—This is the LDAP search filter. Example: objectclass=user.

Login Attribute—This is the LDAP login attribute. Example: sAMAccountName.

Verify Certificate (checkpeer)—Select this checkbox if you wish to turn on checkpeer
authentication.

3.4.3.5 LDAP Servers Settings

Under the Servers tab, you manage the LDAP server(s) to be accessed:
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Under the LDAP Servers tab, the window displays:

Server—The hostname(s) or IP address(es) of the LDAP server(s) that have been added.

Action—After a server has been listed, it can be removed by clicking the X-button.

LDAP Server Status—This will display one of the following states:

PASS (green)—An LDAP server that has been set up is available and is able to
pass data.

CONFIGURATION MISSING (red)—No configuration files are available.

FAILED TO READ DATA (red)—An LDAP server is available but no data was
passed.

FAILED NOT REACHABLE (red)—No LDAP server could be reached.

LDAP DISABLED—The Enabled checkbox under the Settings tab as not been selec
ted.

Add additional server—Enter the hostname or IP address of the LDAP server to be quer
ied. You may list multiple servers.

3.4.4 RADIUS Authentication
RADIUS authentication provides the means to use an external RADIUS server to authenticate the
user accounts when logging in to NetClock. RADIUS allows the login password for user-created
accounts to be stored and maintained in a central RADIUS or server on the network. This func
tion greatly simplifies password management. Instead of having to change the password in
many network appliances when a password needs to be changed, if a user password is
changed in the RADIUS or RADIUS server, it automatically changes the login password for all
of the appliances that are using the RADIUS server to authenticate a user login.

In order to use the RADIUS authentication capability of the NetClock, it needs to first be con
figured with the appropriate settings in order to be able to communicate with the RADIUS
server(s) on the network.

3.4.4.1 Configuring RADIUS Authentication

To configure RADIUS authentication:
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1. Navigate to MANAGEMENT > OTHER: Authentication.

2. In the Actions panel, click the RADIUS Setup button.

3. The Radius Setup window will display:

If desired, select the HTTP/HTTPS checkbox to enable HTTPS.

In the Retransmit Attempts field, select the number of retries for NetClock to com
municate with the RADIUS server.

3.4.4.2 Adding a RADIUS Server

To add a RADIUS server:
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1. Navigate to MANAGEMENT > OTHER: Authentication.

2. In the Actions panel, click the RADIUS Setup button.

3. The Radius Setup window will display.

4. Populate the following fields as needed:

Host—Enter either the hostname or IP address of the RADIUS server on the net
work with which you wish NetClock to authenticate.

Port—Defines the RADIUS Port to use. The default RADIUS Port is 1812, but this
can be changed, as required.

Secret key—Enter the secret key which is shared by NetClock and the RADIUS
server (the key is used to generate an MD5 hash).

Timeout—Defines the Timeout that NetClock will wait to communicate with the
RADIUS server.

5. Click the Add Server button.
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3.4.4.3 Viewing the Status of a RADIUS Server

To view the status of a RADIUS server:

1. Navigate to MANAGEMENT > OTHER: Authentication.

2. In the Actions panel, click the RADIUS Setup button.

3. The Radius Setup window will display.
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For each RADIUS server, the following information will display:

Host—The hostname or IP address of the RADIUS server.

Port—The RADIUS port used to access the RADIUS server.

Timeout—The timeout that has been set for the RADIUS server.

Status—One of the following statuses will display:

UNREACHABLE (red, blinking)—The server is not available on the net
work.

UNAUTHORIZED (red)—The server is available on the network but access
was denied.

REACHABLE (green)—The server is available on the network and access
was allowed.

DISABLED (yellow)—The server is available on the network but RADIUS
authentication is disabled on the server.

Actions—Click the X-button to remove a server.

3.4.4.4 Removing a RADIUS Server

To remove a RADIUS server:

1. Navigate to MANAGEMENT > OTHER: Authentication.

2. In the Actions panel, click the RADIUS Setup button.
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3. The Radius Setup window will display. Click the X-button next to the RADIUS server you
wish to remove.

3.4.5 Input Reference Priorities
NetClock can be synchronized to different time and frequency sources that are referred to as
Input References or, sometimes just References.

References can be GNSS receivers, or other sources delivered into your NetClock unit via ded
icated (mostly optional) inputs. It is even possible for the user to enter a system time manually,
which NetClock then will synchronize to.

Note: Should you be installing new option cards, you will need to either manu
ally set up the new card in the Reference Priority Table, or use the Reset to Defaults
option in the Actions panel, in order to update the table with the new reference
information.

In order for NetClock to declare synchronization, it needs both a valid PPS , and Time ref
erence.

The concept of Reference Priority allows the ranking of multiple references for redundancy. This
allows NetClock to gracefully fall back upon a lower ranking PPS or Time reference, in case a
source with a higher priority becomes unavailable or invalid. The priority order you assign to
your available references typically is a function of their accuracy and reliability.
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Note: The References shown on your screen may look different from the ones in
the screenshot below, depending on your NetClock 9400 Series Time Server
model and hardware configuration.

Each available type of Time and PPS input reference is assigned a “title” to be used in the
Reference Priority table. The title defines the type of reference it is (e.g., “GPS 0” indicates
GNSS input). These reference titles are defined in following table:

Title Reference

ASCII Timecode ASCII serial timecode input

External 1PPS input External 1PPS input

Frequency External Frequency input

GPS GNSS input

PTP PTP input

IRIG IRIG timecode input

Local System Built-in clock OR internal 1PPS generation

NTP NTP input

User Host (time is manually set by a user)

HAVEQUICK HAVEQUICK input

Table 3-5: Reference priority titles

Note: The number displayed indicates the number of feature inputs of that type
presently installed in the NetClock- starting with “0” representing the first feature
input. For example:
– IRIG 0: 1st IRIG input instance
– Frequency 1: 2nd frequency input instance
– NTP 2: 3rd NTP input instance
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The columns of the Reference Priority table are defined as follows:

Priority—Defines the order or priority for each index (row). The range is 1 to 16, with 1
being the highest priority and 16 being the lowest priority. The highest priority ref
erence that is available and valid is the reference that is selected.

Time—The reference selected to provide the necessary “Time” reference.

1PPS—The reference selected to provide the necessary “1PPS” reference.

Enabled—The reference is enabled.

Delete—Removes the Index (row) from the Reference Priority table.

3.4.5.1 Input Reference "User"

NetClock allows you as the "User" to override the System Time (whether it is synchronized to a
valid reference, or not) with a manually set time, and declare this manually set time to be a
valid System Time (i.e., it can be used as a reference).

To this end, the following needs to be done:

I. Assign the "User[x]" Time reference to the desired Reference Priority ("1", for example),
and assign a PPS reference to it. Click Enable.

II. In order for a "User" reference to become valid, user intervention is always required
(contrary to "Local System" time; see "Input Reference "Local System"" on the facing
page): Set the System Time manually (Edit System Time > Manual Time Set).

Your “User[x]” Reference will then become valid.

When to use the "User" reference

The "User" reference is designed to fulfill the following use cases:

a. Temporarily, no external references are available (e.g., during system setup, or for test
ing/simulation purposes), or

b. No external references are required (e.g. if NetClock is used solely to synchronize com
puters on a network, with no need for precise timing.)

Caution: Operating NetClock with a manually set "User" time bears the risk of
inadvertently outputting an illegitimate System Time thought to be a valid ref
erence time.

This is why the “User[x]” reference becomes invalid once NetClock is reset or reboots, or once
the Holdover Time expires (whichever occurs first), and needs to be manually set again (Edit
System Time > Manual Time Set).

In order to allow use case (b.) above, two additional steps are required to override NetClock's
default settings intended to avoid outputting an illegitimate System Time as a valid reference:
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i. In the Edit System Time window, the checkbox Synchronize to Battery Backed Time on
Startup must be checked. This will override NetClock's default setting to declare the Sys
tem Time valid only if it is synchronized to an external reference (or a Local System
time, see "Input Reference "Local System"" below.)

ii. In the Oscillator Settings window, the Holdover Timeout ought to be set to a duration
that meets your accuracy requirements (up to 5 years): Once this Holdover Timeout win
dow expires, NetClock goes out of sync, and you need to manually set a new System
Time.

Using the "User" reference with other reference priorities

If the “User[x]” Reference is used in conjunction with other, external reference priorities (such as
GNSS or IRIG), the System Time should be set as accurately as possible:

Otherwise, the large time correction that needs to be bridged when switching from a lost ref
erence to a valid reference, or from a valid reference to a higher-priority reference that has
become available again, will cause NTP to exit synchronization. If the difference is under 1000
seconds, NTP will remain in sync and will "slew" (over a period of time) to the new reference
time.

3.4.5.2 Input Reference "Local System"

The Local System Reference is a unique input reference in that it can be used as either the Time
reference or the PPS reference, but never both.

When the Time reference is configured as Local System , the Time that NetClock powers up
with is considered valid, as long as the PPS input reference is valid. The same applies the other
way round, i.e. with a Local System PPS reference.

The Local System configuration can be used, e.g. in a scenario with a high-quality PPS external
reference, but an external Time reference that is actually less accurate than NetClock's internal
oscillator (or the other way round): In this case, the oscillator will become the higher-priority
Local System reference, and the external Time reference will serve as a lower-priority backup
Time reference.

3.4.5.3 Reference Priorities: USE CASES

Example 1 – GNSS as Primary Reference, IRIG as Backup:

In this use case, the objective is to have:

GNSS as the primary time and 1PPS reference

IRIG as the backup time and 1PPS time reference.

Step-by-step procedure:

1. Move the reference which has “GPS 0” in the Time column and “GPS 0” in the 1PPS
column to the top of the table, with a Priority value of 1. Click the Enabled checkbox.
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2. Move the reference which has “GPS 0” in the Time column and “GPS 0” in the 1PPS
column to the top of the table, with a Priority value of 1. Click the Enabled checkbox.

3. Move the reference which has “GPS 0” in the Time column and “GPS 0” in the 1PPS
column to the top of the table, with a Priority value of 1. Click the Enabled checkbox.

Since both of these references are default references, no additional references need to be
added to the Reference Priority table.

Example 2 – IRIG as Primary Reference, NTP Input as Backup

In this use case, the objective is to have:

IRIG as the primary reference input

Another NTP server as backup reference, in case the IRIG input is lost.

Step-by-step procedure:

1. Move the reference which has “IRIG 0” in both the Time column and “IRIG 0” in the 1PPS
column to the top of the table, with a Priority value of 1. Click the Enabled checkbox.

2. Move the reference which has “NTP” in the Time column and “NTP” in the 1PPS column
to the second place in the table, with a Priority value of 2. Click the Enabled checkbox.

3. For all other references, uncheck the Enabled checkbox, so that they are all disabled.

Since both of these references are default references, no additional references need to be
added to the Reference Priority table.

Example 3 – NTP Input as Only Available Input (“NTP Stratum 2 Synchronization”)

In this use case, the objective is to have NTP provided by another NTP server as the only avail
able reference input.

Step-by-step procedure:

1. Move the reference which has “NTP” in the Time column and “NTP” in the 1PPS column
to the top of the table, with a Priority value of 1. Click the Enabled checkbox.

2. For all other references, uncheck the Enabled checkbox, so that they are all disabled.

Caution: When selecting NTP as an input reference, do not select another ref
erence (such as GNSS, IRIG, etc.) to work with NTP as a reference. NTP should
always be selected as both the Time and1PPS input when it is desired to use NTP
as an input reference.
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Example 4 – Time Set Manually by User. Other References May or May not be Available

Note: In order for a manually set time to be considered valid and used to syn
chronize NetClock, a “User” needs to be enabled in the Reference Priority table.
See"Input Reference Priorities" on page 146 .

In this use case, the objective is to have a manually set time reference.

Step-by-step procedure:

1. If necessary (see NOTE above), create a “User.”

2. Move the reference which has “User 0” in the Time column and “User 0” in the 1PPS
column to the top of the table, with a Priority value of 1. Click the Enabled checkbox.

3. For all other references, uncheck the Enabled checkbox, so that they are all disabled.

If the objective is to use a manually set time as a backup to other references (such as GNSS or
IRIG):

1. Move the reference which has “User 0” in both the Time column and “User 0” in the
1PPS column to a place in the table with a lower priority than the references the manu
ally set reference will be backing up. Click the Enabled checkbox.

2. With “User” enabled, if no other higher priority references are enabled or available (or
if the higher priority references have since been lost), you can simply set the System time
to the desired value. NetClock will go into synchronization using this set time.

3. The time can be manually set through the System Time panel located in the
MANAGEMENT/OTHER/Time Management page. See "Editing the System Time" on
page 167 for details on setting the time manually. Once you have set the date and time,
the front panel sync light will turn green.

Note: This procedure needs to be repeated each time NetClock is power-cycled
(with no other references available,) unless synchronizing to a battery backed
time on startup is enabled, or after each time all higher priority references are
lost.

Example 5—Time at Power-Up ("Local System Time") to be Considered "Valid". GNSS
Input to serve as 1PPS Reference

The objective of this use case is to use the time that NetClock uses as it powers up (without the
need for a user to manually set it, as would be the case with a “User” selected time). This is
referred to as “Local System” time.

Since “Local System” cannot be both Time, and 1PPS input together, in this use case example
the GNSS input will be set as the 1PPS reference (other use cases may require using different
references, e.g. IRIG.)
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As there is no default entry for “Local System” and “GPS”, a new entry needs to be added to
the Reference Priorities table in order to use this combination of references.

Step-by-step procedure:

1. Add a reference to the Reference Priority by clicking the PLUS icon. Use the following set
tings, then click Submit:

In the Priority Level text box, enter 1. This will give this reference the highest pri
ority.

In the Time field, select “Local System”

In the PPS field, select “GPS”.

Check the Enabled checkbox.

2. Confirm that the first reference in the Reference Priority table has “Local System” as the
Time input and "GNSS" as the 1PPS input.

3. After a power cycle or reboot, as soon as GNSS is declared valid, the System Time will
automatically be used as-is, with no manual intervention required.

3.4.5.4 Configuring Input Reference Priorities

NetClock can use numerous external time sources, referred to as "references". As external time
sources may be subject to different degrees of accuracy and reliability, the user can determine
in which order (= priority) NetClock calls upon its external time and 1PPS references.

For additional information, see "Input Reference Priorities" on page 146.

Accessing the Reference Priority Screen
To access the Reference Priority Setup screen:

1. Navigate to MANAGEMENT > OTHER: Reference Priority.

OR:

1. On the HOME screen, click the GEAR icon in the Reference Status panel:
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2. The Configure Reference Priorities screen will display.

The Reference Priority screen is divided into 3 areas:

a. The Actions panel, which provides a single action:

Restore Factory Defaults

b. The Configure Reference Priorities panel, which displays the priority of NetClock’s ref
erences in a table form.
In this panel you can:

Add and configure new references

Delete references

Enable/disable references

Reorder the priority of NetClock’s references

c. The Reference Status panel

The Reference Status panel provides a real time indicator of the status of the
NetClock’s references. It is the same as the Reference Status panel on the HOME
screen of the Web UI.

Adding an Entry to the Reference Status Table
To add a new entry to the Reference Status table:

1. Navigate to the Configure Reference Priorities screen via MANAGEMENT > OTHER:
Reference Priority.

2. Click the PLUS icon in the top right-hand corner of the Configure Reference Priorities
table.
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3. The Add Reference window will display:

4. In the Add Reference window, enter:

Priority Level: Assign a priority to the new reference.

Time: Select the time reference.

PPS: Select the PPS reference.

Enabled: Check this box to enable the new reference.

5. Click Apply or Submit. (Submit will close the window.)

Deleting a Reference Entry
To delete an entry from the Reference Status table:

1. Navigate to the Configure Reference Priorities screen via MANAGEMENT > OTHER:
Reference Priority.

2. In the Configure Reference Priorities table click the Delete button on the right-hand side
of the entry you wish to delete.

3. In the pop-up window that opens click OK to confirm.

Reordering Reference Entries
To reorder the priority of a reference entry:

1. Navigate to the Configure Reference Priorities screen via MANAGEMENT > OTHER:
Reference Priority.

2. Click and hold on the item whose priority you wish to reorder.
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3. Drag the item up or down to the desired place.

4. Click Submit.

Resetting Reference Priorities to Factory Defaults
To reset all references in the Reference Priority table to their factory default priorities:

1. Navigate to the Configure Reference Priorities screen via MANAGEMENT > OTHER:
Reference Priority menu.

2. In the Actions panel, click the Restore Factory Defaults button.

3.4.6 Notifications

3.4.6.1 Accessing the Notifications Page

1. Navigate to MANAGEMENT > OTHER: Notifications. The Notifications page will dis
play:
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The Notifications page is divided into two panels:

The Actions panel, offering two options:

SNMP Setup: Clicking this button will open the SNMP Setup screen. See
"Configuring SNMP and Notifications" on page 86.

Edit Setup: The Email Setup screen provides the means to configure NetC
lock with the necessary settings to interface it with Exchange email servers
and Gmail.

The Events panel, which includes 3 tabs:

Timing: This tab contains events for Sync Status and Holdover, Frequency
error, Input references and the internal oscillator

GPS : This tab contains events related to the GNSS receiver, including
antenna cabling, tracking less than the minimum number of satellites and
GNSS receiver faults.

Systems: This tab contains events related to the system operation, including
minor and major alarms being asserted, reboot, timing system errors and
option cards.

3.4.6.2 Utilizing Notifications

NetClock events (such as going into or out of Time Sync, into or out of Holdover mode, an
antenna problem when a short or open occurs in the GNSS antenna cable, etc.) can cause a
trigger to notify users that a specific event has occurred.

In some situations, two events are generated. One event occurs in the transition to a specified
state and then another event occurs when transitioning back to the original state. Examples of
these are losing sync and then regaining sync, or going into Holdover mode and then going
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out of Holdover mode. Other situations may only consist of one event. An example of this situ
ation is switching from one input reference to another.

Notifications of each event that may occur can be via alarms, via SNMP Traps being sent to
one or more SNMP Managers, via an email being sent to a specified email recipient, or a com
bination of the three. The Notifications page allows a user to configure whether the occurrence
of each event automatically triggers an alarm to be generated, an SNMP trap to be sent out,
an email to be sent out, or a combination of the three.

Also, this page allows the desired email recipient’s address for that particular event to be spe
cified. Each event can be configured with the desired email address that is specific to just that
one event only. Note that only one email address can be specified in each Email Address field.
If desired, the same email address can be used in all of the fields, or different addresses can be
used for different events.

Note: Whether or not notifications are enabled/disabled for a given event, the
occurrence of the event is always logged.

All available NetClock events that can generate a notification to be sent are located in different
tabs in the Notification Setup table: Timing, GPS, and System. The NetClock Events that can
automatically trigger a notification are listed in the Event column. If applicable for each specific
event, the user can mask alarm generation (prevent the alarm), enable “SNMP” (to send out an
SNMP trap) and/or “Email” to send an email to the address specified in the corresponding
“Email Address” column.

3.4.6.3 Configuring Notifications

To configure Notifications:

1. Navigate to MANAGEMENT > OTHER: Notifications.

2. In the Events table, choose the Timing, GPS or System tab. Configure your Notifications
(see below), and click Submit.
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The columns under each tab are:

Event—This is the event that will trigger the notification. The events under each tab
will vary according to context.

Mask Alarm—Check here to enable an alarm mask. Enabling an alarm mask for
a given notification will prevent that notification from generating an alarm con
dition. Other notifications for that event and logging of the event will still occur.

SNMP Trap—Check here to configure the event to trigger an SNMP Trap.

Email—Check here to configure the event to trigger an email notification.

Email Address —Enter the address to which the email should be sent when
triggered by the event.

Note: Each event can be configured with the desired email address that is
specific to just that one event only. Note that only one email address can
be specified in each Email Address field.

For each event choose the notification you want and the email, if any, to which you want a noti
fication to be sent. See "Configuring SNMP and Notifications" on page 86 for details about
setting up SNMP. See "Setting Up Notification Emails" on page 161 for information on setting
up notification email.

For each event, only the notification options available can be configured. For example, a mask
alarm can be set for an In-Sync event, and a Not- in-Sync event, but not for an In-Holdover
event.

Notification Events: Timing tab

Notifications can be sent upon the following Timing Events:
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In Sync

Not In Sync

In Holdover

No Longer in Holdover

Frequency Error

Frequency Error Cleared

1PPS Not In Specification

1PPS Restored to Specification

Oscillator Alarm

Oscillator Alarm Cleared

Reference Change (Cleared)

Reference Change

Notification Events: GPS tab

Notification events can be sent upon the following GPS Events:

Too Few GPS Sat, Minor Alarm—See "Setting GPS Minor and Major Alarm Thresholds"
on the next page

Too Few GPS Sat, Minor, Cleared

Too Few GPS Sat, Major Alarm—See "Setting GPS Minor and Major Alarm Thresholds"
on the next page

Too Few GPS Sat, Major, Cleared

GPS Antenna Problem

GPS Antenna OK

GPS Receiver Fault

GPS Receiver Fault Cleared

Under the GPS Events tab, the user also configures the Minor and Major Alarm Threshold for
GNSS fault events. See the following section for information on setting these thresholds.

Notification Events: System tab

Notification events can be sent upon the following System Events:

Minor Alarm Active

Minor Alarm Inactive

Major Alarm Active

Major Alarm Inactive

Unit Reboot
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Timing System Software Error

Timing System Hardware Error

High Temperature, Minor Alarm

High Temperature, Minor, Cleared

High Temperature, Major Alarm

High Temperature, Major, Cleared

3.4.6.4 Setting GPS Minor and Major Alarm Thresholds

The GPS Events panel contains the definition of user-defined Minor and Major alarms for the
GNSS receiver falling below a user-specified number of GNSS satellites. NetClock itself has a
pre-defined minimum number of satellites that must be tracked in order for GNSS to be con
sidered a valid reference. However, this section allows a user to setup alerts if NetClock tracks
less than a user-specified number of satellites. This event can cause either a Minor or a Major
alarm (or both) to be asserted, depending on the configuration.

Each of the two Minor and Major alarms sections contains a field to define the desired
threshold for the minimum number of satellites that must be tracked that before the particular
alarm is asserted. Note that the GNSS receiver must initially be tracking more than the con
figured number of satellites in order for this alarm to be triggered (the alarm is triggered when
the receiver falls below the minimum number specified).

The Duration Below Threshold (s) field provides the ability to define a period of time (in
seconds) that the GNSS receiver is allowed to fall below the minimum number of satellites
before the particular alarm is asserted.

Figure 3-4: Alarm Threshold panel

To set the Minor Alarm Threshold and/or Major Alarm Threshold:

1. If necessary, navigate to MANAGEMENT/OTHER/Notifications and choose the GPS
tab.

2. At the bottom of the screen, locate the ALARM THRESHOLD panel.

3. In the Minimum Satellites field enter the minimum number of satellites that must be avail
able before the alarm is triggered. The alarm will be triggered when the number of satel
lites available is BELOW this number.
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4. In the Duration Below Threshold(s) field, enter the time that the system must be below the
threshold set in the Minimum Satellites field before an alarm is triggered. The alarm will
be triggered when this time is reached.

3.4.6.5 SNMP Notification Setup

To configure SNMP notifications:

1. Navigate to MANAGEMENT > OTHER: Notifications.

2. Near the top-left of the screen, click SNMP Setup in the Actions panel.

For details about setting up SNMP, see "Configuring SNMP and Notifications" on page 86.

3.4.6.6 Setting Up Notification Emails

The Email Setup window provides the means to configure NetClock with the necessary settings
to interface it with Exchange email servers and Gmail.

To set up email:

1. Navigate to MANAGEMENT/OTHER/Notifications.

2. Click the Edit Setup button in the Actions panel in the top-left corner of the Notifications
screen.

3. The Email Setup window will display:

The Email Configuration box provides two example configuration files. One is for interfacing
NetClock with an Email Exchange server; and the other is for sending emails via Gmail:
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4. To configure the applicable example email configuration, delete the comments (“#”)
from each line and replace the “<>” with the appropriate values for your particular
email server (such as the user name and password for your Email server).

E x a m p l e I : S M T P i n t e r f a c e t o M S E x c h a n g e

#set smtp=<server name, example: exchange.example.com>
#set smtp-auth-user=<user name>
#set smtp-auth-password=<password>
#set smtp-auth=login

E x a m p l e I I : S M T P i n t e r f a c e t o G m a i l

#set smtp=smtp.gmail.com:587
#set smtp-use-starttls
#set ssl-verify=ignore
#set smtp-auth-user=<user name, example user_xyz123@gmail.com>
#set smtp-auth-password=<password>
#set smtp-auth=login

5. Click the Submit button at the bottom of the window.

6. To test your settings:

In the Test Email Address field, enter an email address.

Click the Send Test Email button.

A notification that your email has been sent will appear at the top of the window.

Additional information on this subject can be found in the Spectracom Technical Note "Email
Notification Setup with SecureSync, NetClock".

3.4.7 System Time
The time that NetClock maintains is referred to as the System Time. By default, the System Time
is synchronized to NetClock’s input references (such as GNSS, IRIG, ASCII data, NTP, PTP,
etc.).

Alternatively, the System Time can be manually configured by the user to a desired time/date,
or it can be operated without external time reference (but with an external PPS reference)—this
is called Local System reference.

The System Time is used to generate all of the available time-of-day outputs (such as the front
panel LED display, NTP time stamps, time stamps in the log entries, ASCII data outputs, etc.)
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Figure 3-5: System time

The figure above illustrates how NetClock obtains the highest available and valid reference pri
ority, depending on whether an external source is chosen as reference, or an internal (User[x],
or Local System).

To configure the System Time, go to the System Time panel, which is located in the top- left
corner of the Time Management screen (see "System Time" on the previous page).

Note: System time must be set in UTC timescale, not local time.

Note: In order for the time to be set manually by a user, and to qualify as a valid
reference, the Input Reference Priority table on the Setup/Reference Priority
screen must include an "Enabled" “User[x]” Time and PPS reference.

See "Input Reference Priorities" on page 146 for more information.

3.4.7.1 Timescales, Offsets and Leap Seconds

The System Time can be configured to operate in various timescales, such as UTC, GPS and TAI
(Temps Atomique International). All of these times are offset from each other by varying
amounts, so the times are not all exactly the same.
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Note: UTC Timescale is also referred to as “ZULU” time. GPS timescale is the raw
GPS time as transmitted by the GNSS satellites (as of September, 2013, GPS time
is currently 16 seconds ahead of UTC time. UTC timescale observes leap seconds
while GPS timescale does not).

Note: The TAI timescale also does not observe leap seconds. The TAI timescale is
fixed to always be 19 seconds ahead of GPS time. As of July, 2015, TAI time is
36 seconds ahead of UTC.

The System Timescale is configured through the MANAGEMENT/OTHER/Time Management
page.

Some of the available NetClock inputs (such as the IRIG option module’s input, ASCII data mod
ule’s inputs, etc.) won’t necessarily provide time to NetClock in the same timescale selected in
the System Time’s Timescale field. These inputs have internal conversions that allow the timescale
for the inputs to also be independently defined, so that they don’t have to be provided in the
same timescale. For example, the System timescale can be configured as “UTC”, but the IRIG
input data stream can provide NetClock with “local” time, with no time jumps occurring when
the reference is selected.

If an output reference is using the GPS or TAI timescale, and the System Time is set to “UTC”,
then the GPS Offset box in the Edit GPS Offset window must be populated with the proper
timescale offset value in order for the time on the output reference to be correct. Some ref
erences (like GNSS) provide the timescale offset to the system. In the event that the input ref
erence being used does not provide this information, it must be set in through the Offsets panel
of the Time Management page. See also "System Time" on page 162.

Since the GPS and TAI offsets have a fixed relationship, only the GPS offset can be set. If only
the TAI offset is known, subtract 19 from it to get the GPS offset.

Note: If the System Time is set to the UTC timescale, and all output references
either use the UTC or “local” timescale, then it is not necessary to set the GPS and
TAI Timescale Offsets.

Caution: It is imperative to configure any input reference’s timescales appro
priately. Otherwise, a System Time error may occur!

Some of the available NetClock outputs (such as the front panel LED display, the IRIG option
module’s outputs, ASCII data module’s outputs, etc.) won’t necessarily output in the same times
cale selected in the System Time’s Timescale field. These outputs have internal conversions that
allow the timescale for the outputs to also be independently defined, so that they don’t have to
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be provided in the same timescale. For example, the System timescale can be configured as
“UTC”, but the front panel LED display can be configured to still show “local” time, if desired.

Other NetClock outputs will be provided in the same timescale that is selected in the System
timescale field. The NTP output for network synchronization and the time stamps included in all
log entries will be in the same timescale as the configured System Timescale. For example, if
“GPS” is selected as the System timescale, the log entries and the time distributed to the network
will all be in GPS time (time broadcasted directly from the GNSS constellation). But, the LED dis
play can still be configured to show the current “local” time.

In most cases, “UTC” will be the desired Timescale to select.

3.4.7.2 DST Rule Configurations

The following examples are provided to illustrate the configuration of Daylight Savings Time
(DST) when setting up NetClock.

E x a m p l e 1 :

To create a Local System Clock to UTC+1 with no DST rule:

In the Local Clock pop-up window:

1. Assign the clock a meaningful name in the Local Clock Name field.

1. Select “UTC +01:00” from the UTC Offset pull down menu.

2. Confirm that the Use DST Rules checkbox is not selected.

3. Review the changes made and click the Submit button.

4. The NetClock will display the status of the change.

E x a m p l e 2 :

To create a Local System Clock for a NetClock installed in the Eastern Time Zone of the US, and desir
ing the Local Clock to automatically adjust for DST (using the post 2006 DST rules for the US).

In the Local Clock pop-up window:

1. Assign the clock a meaningful name in the Local Clock Name field.

2. Select “UTC -05:00” from the UTC Offset pull-down menu.

3. Select the Use DST Rules checkbox.

4. Select the Set DST Rules by Region checkbox.

5. From the DST Region drop-down list, select “US-Canada.”

6. Review the changes made and click the Submit button.

7. The NetClock will display the status of the change.
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3.4.7.3 Daylight Savings Time

Information about time zones and DST can be found on the following web site: http://www.
worldtimeserver.com/, http://webexhibits.org/daylightsaving/b.html.

3.4.7.4 The Time Management Screen

To access the Time Management screen:

1. Navigate to MANAGEMENT > OTHER: Time Management.

2. The Time Management screen opens. It is divided into 4 panels:

System Time panel

The System Time panel displays the time scale and the year, and allows access to the Edit Sys
tem Time window via the GEAR icon in the top-right corner. This window is used to select the
time scale, and to manually set a user- time, if so required.

See also: "The Time Management Screen" above

Offsets panel

The time scales UTC, TAI, and the GPS-supplied time are offset by several seconds, e.g. to
accommodate leap seconds. The GPS offset may change over time, and can be managed via
the GEAR icon in the top-right corner of this panel.

See also: "The Time Management Screen" above

Leap Second Info panel

From time to time, a leap second is applied to UTC, in order to adjust UTC to the actual pos
ition of the sun. Via the Leap Second Info panel, leap second corrections can be applied to
NetClock’s time keeping. It is also possible to enter the exact day and time when the leap
second is to be applied, and to delete a leap second.
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See also: "The Time Management Screen" on the previous page

See also: "Leap Second Occurrence" on page 268

Local Clocks panel

Multiple Local Clocks with different configurations can be created, as needed. The names of all
Local Clocks that have already been created are displayed table rows in the Local Clocks
panel.

3.4.7.5 Editing the System Time

In order to edit the System Time, NetClock allows you to:

Change the System Timescale

Manually set a user-defined time, e.g. for simulation purposes, or if no external ref
erence is available, and you want to use the unit as a valid NTP server

Maintain the user-defined time after a system reboot by means of battery backup.

To edit the System Time:

1. Navigate to MANAGEMENT > OTHER: Time Management.

2. In the System Time panel located in the top-left corner of the Time Management screen,
click the GEAR icon.

3. The Edit System Time pop-up window will display.
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4. In the System Timescale field select a timescale from the drop-down list. The options are:

UTC: Coordinated Universal Time (Temps Universel Coordonné); your local time
zone determines the difference between UTC and local time

TAI: International Atomic Time (Temps Atomique International); the TAI time scale
is based on the SI second and is not adjusted for leap seconds. As of July 2015,
TAI is ahead of UTC by 36 seconds. TAI is always ahead of GPS by 19 seconds.

GPS: Global Positioning System time is the time scale maintained by the GPS
satellites. The time signal is provided by atomic clocks in the GPS ground control
stations. GPS time follows TAI by 19 seconds.

If you want to set the System Time manually, proceed with Step 5.

If you want NetClock to use the battery-backed system time upon startup, proceed to
Step 6.

Otherwise, the editing process is complete, and you can proceed to Step 7.

5. In order to override the system time with a manually set User Time, check the Manual
Time Set checkbox.
Two additional fields will appear:

Set Year Only—Some legacy time formats do not support years. Setting this check
box will open a data entry field to manually set the year.

System Time—If you do not select Set Year Only, this box will show the current
time in the format: Year-Month-Day Hour:Minute:Second. To set the time manu
ally, click anywhere in the System Time field. A drop-down calendar with time-set
ting sliders will appear:

The time in the System Time field will default to the current date and time. Except for test
ing purposes, you should not choose a date other than the current day. If you wish, you
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can choose an alternate day by clicking on that day in the calendar, and choose
another month by using the navigation arrows on either side of the month in the cal
endar’s heading.

To set the time, use the sliders below the calendar. The time will display between the cal
endar and the sliders, and also next to the chosen date in the field directly above the cal
endar.
To close the calendar, click anywhere in the Edit System Time window.

If you want NetClock to use the battery-backed system time upon startup, proceed to
"Using Battery Backup Time as Startup Time" below.

Otherwise, the editing process is complete, and you can proceed to Step 7.

3. Click the Submit button to update the System Time, and close the window.

See also: "The Time Management Screen" on page 166.

3.4.7.6 Using Battery Backup Time as Startup Time

Upon system startup, NetClock will, per default, not synchronize until one of the pre-defined ref
erences becomes available and valid. The functino Synchronize to Battery Backed Time on
Startup overrides this default by declaring the battery backed time a valid reference, allowing
NetClock to transition into synchronization upon system startup, without user intervention, or
waiting for external references to become available.
This may be useful for simulation or testing purposes, or if the synchronization state is to be
reached as quickly as possible, even though the battery backed time may be less accurate than
an extenal time reference.

Please note that higher priority references will take precedence over the battery backed time as
soon as they become available.

Please also note that the internally maintained system time should be relatively close to the
actual time, to prevent NTP synchronization problems when transitioning from one input ref
erence to another, see also "Input Reference Priorities" on page 146.

To use battery backup time as the synchronized time at start-up:

1. Navigate to MANAGEMENT/OTHER/Time Management.

2. Click the GEAR icon in the System Time panel in the top-right corner of the System Time
panel located on the left-hand side of the Time Management screen.
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3. The Edit System Time pop-up window will display.

4. Select the checkbox Synchronize to Battery Backed Time on Startup.

5. Click the Submit button.

3.4.7.7 Configuring System Time Offsets

To configure offsets to the system time:

1. Navigate to MANAGEMENT/OTHER/Time Management.

2. Click the GEAR icon in the top-right corner of the Offsets panel located on the left-hand
side of the Time Management screen.

3. The Edit GPS Offset pop-up window will display:

4. In the GPS Offset field enter the desired GPS Offset in seconds.

5. Since the GPS and TAI offsets have a fixed relationship, only the GPS offset can be set. If
only the TAI offset is known, subtract 19 from it to get the GPS offset.

See also: "The Time Management Screen" on page 166.

3.4.7.8 Configuring a Leap Second Correction

To correct the System Time for a leap second:
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1. Navigate to MANAGEMENT/OTHER/Time Management.

2. Click the GEAR icon in the Leap Second Information panel on the left-hand side of the
Time Management screen.

3. The Edit Leap Second pop-up window will display.

4. In the Leap Second Offset field enter the desired GPS Offset.

5. In the When field, enter the date that the desired leap second should occur.

6. Click the Submit button at the bottom of the window.

See also: "Leap Second Occurrence" on page 268.

See also: "The Time Management Screen" on page 166.

3.4.7.9 Deleting a Leap Second Correction

To delete a leap second correction:

1. Navigate to MANAGEMENT/OTHER/Time Management.

2. Click the GEAR icon in the Leap Second Information panel on the left side of the Time
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Management screen.

3. The Edit Leap Second pop-up window will display:

4. Click the Delete button at the bottom of the window.

Note: The Delete button in the Edit Leap Second window will only be vis
ible, if a leap second has been set in the first place.

3.4.7.10 Setting up a Local Clock

The Local Clock feature allows maintaining several times which reflect a time offset, thereby
accounting for Time Zone and DST (Daylight Savings Time) correction.

1. Navigate to MANAGEMENT/OTHER/Time Management.

2. Click the PLUS icon in the Local Clocks panel in the Time Management screen.
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3. The Local Clock pop-up window will display.

4. Enter a Name for your local clock.

The name must be between 1 and 64 characters long; spaces are allowed.

The name can be any meaningful name that helps you know your point of ref
erence (for example: “New York”, “Paris” or “Eastern HQ”, etc.).

This name will be used as cross-reference drop-down in the applicable Input or
Output port configuration. Please note the following limitations apply to this
option:

Acceptable characters for the name include: A-Z, a-z, 0-9 and (-+_) and
spaces are converted to underscores because the name must be a single
word.

5. In the UTC Offset field, choose a UTC Offset from the drop-down list.

All of the UTC Offset drop-downs are configured as UTC plus or minus a set number of
hours.

Examples for the US: For Eastern, choose UTC–05:00; for Central, choose UTC-06:00;
for Mountain, choose UTC-07:00; and for Pacific, choose UTC-08:00.

If you wish to use DST (Daylight Savings Time ["Summer Time"]) rules, click the Use DST
Rules box. Otherwise the time for the local clock will always be standard time.
DST options will appear in the Local Clock window:
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Set DST Rules by Region—Check this box to apply regional DST rules. A regions drop-
down menu with the following options will display:

EU (Europe)—For if your location complies with the European DST Rule. This rule
differs from all other rules because the DST changes occur based on UTC time,
not local time (all time zones in Europe change for DST at precisely the same time
relative to UTC, rather than offset by local time zone).

US-Canada—For if your location complies with the USA’s DST Rule (as it was
changed to back in 2006, where the “DST into” date is the Second Sunday of
March and the “DST out” date is the first Sunday of November).

Australia.

Note: If a pre-configured rule DST rule happens to be changed in the future (like
the change to the US DST rule in 2006), this option allows the DST rules to be
edited without the need to perform a software upgrade for a new DST rule to be
defined. Select this drop-down and enter the DST parameters for the new rule.

DST Start Date & End Date—Click anywhere in the DST Start Date field to manually
select a start day&time, and/or end day&time for DST.

Note: The option of a manually defined DST is provided for those customers who
may be in a location that does not follow any of the pre-configured DST rules.
You can input start time, end time and the hour to change for the daylight saving.
By selecting this option, the DST rule can be custom defined based on the week
day, week, and month of the local time you defined for this interface.
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A calendar and an hour slider will display:

Choose a date in the calendar, and an hour with the slider.

The date followed by the time will display in the DST Start Date field. The time will
display in the Time field between the calendar and the Hour slider.

Clicking the Now button will make the current time the start of DST.

Clicking the Done button will close the calendar, and accept the chosen day&time.

Offset—In seconds. Use this field to manually define your local clock’s DST offset.

DST Reference—When using a Local Clock with an input reference (such as IRIG input,
in order to provide proper internal conversion from one Timescale to another, NetClock
needs to know if the input time is in Local Timescale or UTC Timescale. Select “Reference
is Local time” or “Reference is UTC” depending on the Timescale of the Input reference
this Local Clock is being used with. Additional Local Clocks may need to be created if
multiple input Timescales are being submitted.

6. Click the Submit button at the bottom of the window. Your local clock will appear in the
Local Clocks panel.

3.4.7.11 Local Clock: Changing Settings/Deleting

To change the settings of a Local Clock, or delete a Local Clock:

1. Navigate to MANAGEMENT/OTHER/Time Management.

2. In the Local Clocks panel, click the desired GEAR icon.
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3. The Local Clock pop-up window will display.

4. Apply the desired changes (see "Setting up a Local Clock" on page 172 for more inform
ation.)

5. Click Submit, or Delete.

6. The Local Clocks panel will reflect the change(s).

3.4.8 Front Panel Configuration

Note: This Section applies to NetClock 9483 only.

The front panel of the NetClock unit comprises three elements which can be configured via the
NetClock Web UI:

The keypad, which—in conjunction with the information display—can be used to access
NetClock's main functions directly via the unit's front panel. To prevent inadvertent
keypad operation, it can be locked and unlocked from the Web UI. Learn more about
front panel keypad operation: "Using the Keypad and Information Display" on
page 33.

The information display: A 4-line LCD display that can be configured to display dif
ferent screens, and that is used in conjunction with the keypad.

The LED time display which can be configured to show the current time (UTC, TAI, GPS
or Local time scale) in either 12- or 24-hour format. By factory default, the LED will dis
play UTC time in 24-hour format (such as displaying “18” at 6 PM).

3.4.8.1 Accessing the Front Panel Setup Screen

NetClock's Web UI allows you to configure the main elements on the front panel of the unit,
and to see an image of the information currently displayed on the 4-line front panel inform
ation display.

To access the front panel configuration window:
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1. Navigate to MANAGEMENT > OTHER: Front Panel.

2. The Front Panel configuration window will display:

Next to the graphical near-real time representation of the 4-line front panel information
display, the following functionality can be accessed in this window:

Show Content—A drop-down of the options that can be shown on the information
display. This field determines what is normally displayed in the information dis
play when the keypad is not in use. The desired screen to display can be selected
with either the keypad or with this drop-down field. While switching from one
screen to another either “Keypad Locked” or “Keypad Unlocked” will be dis
played on the LCD (depending on the setting of the keypad “Lock” field).

Clock Hour Format—This option configures the time display on the front panel as
either in 12-hour or 24-hour format.

Timescale/Local Clock—This option configures the time scale for the LED time dis
play. The available options are:

UTC (temps universel coordonné)

TAI (Temps Atomique International)

GPS: the raw GPS time as transmitted by the GNSS satellites (as of July,
2015, GPS time is 17 seconds ahead of UTC time).

The Local timescale, which allows a Local Clock to apply a time offset for
Time Zone and DST correction. This option is only available, if a Local
Clock has been enabled under MANAGEMENT/OTHER/Time Man
agement.

Note: If GPS or TAI time is used, then the proper timescale offsets must be
set on the MANAGEMENT/OTHER/Time Management page.

Lock Keypad—If desired, the front panel keypad can be locked to prevent inad
vertent operation. Locking and unlocking of the keypad can be performed either
with the keypad itself, or by means of this check box. [DEFAULT = this box is NOT

3.4  OTHER Setup Pages

CHAPTER 3 • NetClock User Reference Guide Rev. 12 177



checked, i.e. the keypad is NOT locked]

Allow Position Display—As per DEFAULT, NetClock allows to display the geo
graphic position of your antenna in the information display, if so configured
under the Show Content selection menu. The option to display the position can be
disabled by unchecking this box. This will cause the information display on the
front panel of the unit to show the message “Not Enabled” when selecting and
applying the Position option via the keypad.

3.4.8.2 Configuring the Front Panel Information Display

To configure the NetClock 4-line LCD information display on the front panel of the unit:

1. Navigate to the MANAGEMENT/OTHER/Front Panel configuration window.

2. In the Show Content field, select the display you want from the drop-down list. The
options are:

Rotate—This option enables sequential rotation of the content displayed in the
information display as long as the keypad is not in use. Content will rotate
through all enabled content for installed options. When Rotate is selected, a fur
ther option appears on the screen:

Rotation Delay—This option sets the duration in seconds for content display
during rotation before the next content screen is displayed. [Range =
between 1 and 30 seconds]

Network (the default)—This option displays the current network settings. If an
option card is installed that provides additional network interfaces, there will be
additional network choices (i.e., Network: eth0, Network: eth1, etc.).

Status—This option displays current key status indications (such as NTP Stratum
level, TFOM –“Time Figure of Merit”, Sync status and Oscillator lock status).

Position—This option displays latitude, longitude and elevation of the antenna.

Day of Year—This option displays the day of year (such as “Day of Year 104”).

GNSS—This option displays the number of satellites currently being used (and the
strongest signal strength out of all these satellites) and their relative signal
strengths of all the receiver channels that are tracking satellites as a bar graph.

Date—This option displays the current date (such as “16 November 2014”).

Note: The date is based on the timescale configured for the information dis
play. It is possible that a date other than “today’s local date” may be
shown, if the configured time scale has already rolled over to its new date,
though local time has not yet rolled over to its new date.

Keys—This option is applicable to the SAASM GPS receiver option module only.
The front panel will display “NOT SUPPORTED” unless a SAASM receiver is
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installed.

None—This option configures the front panel 4-line information display to remain
blank unless the keypad is unlocked and in use.

3. In the Timescale/Local Clock field, choose the timescale or local clock you wish to use
as the time reference for the time shown on the front panel time display. The options
available are:

UTC

TAI

GPS

Any Local Clocks you have set up. The Time Zone and DST rules, as configured
underTime Management/Local Clocks will now be applied to the front panel
time display. For more information on Local Clocks see "Setting up a Local Clock"
on page 172.

Note: With Timescale configured as “Local” and during DST (Daylight Saving
Time, as configured in the Local Clock), a “DST indicator” (decimal point) will be
displayed to the bottom-right of the minutes portion of the LED time display. The
“DST indicator” extinguishes during “Standard” time. If the Local Clock is con
figured as “No DST/Always Standard Time”, the DST indicator won’t ever be lit.

4. Select the Lock Keypad check box if you want to lock the front panel keypad. [DEFAULT
= unlocked (unchecked)]

5. Deselect the Allow Position Display checkbox if you do not want to enable the option to
display position data on the front panel information display. See also Allow Position
Display.

3.4.8.3 Locking/Unlocking the Front Panel Keypad

To lock or unlock the keypad on the front panel of the unit (see illustration Front Panel):

1. Navigate to the MANAGEMENT/OTHER/Front Panel configuration window.

2. Depending on whether you want to enable or disable the keypad, check or uncheck the
Lock Keypad checkbox.

3. Click the Submit button or the Apply button at the bottom of the window.

Note: If the keypad is unlocked, pressing any keypad key will temporarily return
the information display to the “Home” menu display for keypad operation. One
minute after the last keypad press, the information display will return to its con
figured screen.
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3.4.8.4 Enabling/Disabling the Position Display Screen

To enable or disable [DEFAULT = enable] the option to display geographic position data on
the information display, if so configured (see also Allow Position Display):

1. Navigate to the MANAGEMENT/OTHER/Front Panel configuration window.

2. Check or uncheck the Allow Position Display checkbox.

3. Click the Submit button or the Apply button at the bottom of the window.

3.4.9 Backing-up and Restoring Configuration Files
Once NetClock has been configured, it may be desired to back up the configuration files to a
PC for off-unit storage. If necessary in the future, the original configuration of the NetClock can
then be restored into the same unit.

The capability to backup and restore configurations also adds the ability to “clone” multiple
NetClock units with similar settings. Once one NetClock unit has been configured as desired,
configurations that are not specific to each unit (such as NTP settings, log configs, etc.) can be
backed up and loaded onto another NetClock unit for duplicate configurations.

There are several configuration files that are bundled in one file for ease of handling.

Note: For security reasons, configurations relating to security of the product, such
as SSH/SSL certificates, cannot be backed up to a PC.

3.4.9.1 Accessing the System Configuration Screen

To access the System Configuration screen:
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1. Navigate to TOOLS > SYSTEM: Upgrade/Backup.

2. The System Configuration screen will display:

The System Configuration screen consists of 5 panels:

The Actions panel

The Actions panel is used for updating the system software, managing license files, saving and
restoring the configuration files, and restoring the factory defaults.

The System Configuration panel

The System Configuration panel provides the following information:

System—The model name of this unit, and the software version currently installed.

Model—The model number of this unit.

Serial Number—The serial number of this unit.

Power Supply—The type of power supply installed in this unit. This can be AC, DC or
both.

Oscillator—The type of internal timing oscillator installed in this unit.

GNSS Receiver—The GNSS receiver in use with this unit.

HW Slots 1–6—The Option Cards installed in this unit.
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The Upgrade Log panel

The upgrade log is a running log of system upgrades, used for historical and troubleshooting
purposes. It can be expanded by clicking on the DIAGONAL ARROWS icon in the top-right
corner:

Each log entry is comprised of a unique ID, the date the entry was created, the originator of the
entry, and the actual message. Refresh the log by clicking the CIRCLE ARROWS icon in the top-
right corner. Go to the First, Last, or Previous entries by clicking the corresponding buttons in
the bottom-right corner.

The Disk Status panel

The Disk Status panel provides information on the Compact Flash card memory usage. This
information is relevant for troubleshooting purposes, and when preparing the system for a soft
ware update.

The Software Versions panel

This panel provides version information on the different SW components utilized by the system.

3.4.9.2 Backing Up the System Configuration Files

To back up the system configuration files:

1. Navigate to TOOLS > SYSTEM: Upgrade/Backup.
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2. In the Actions panel, click the Save Configuration button.

3. Click OK in the message window that displays.

4. Save the configuration file to a directory where it will be safe. NetClock simultaneously
saves a file at /home/spectracom/xfer/config/NetClock.conf.

3.4.9.3 Uploading Configuration Files

To upload configuration files from a PC:

1. Navigate to TOOLS > SYSTEM: Upgrade/Backup.

2. In the Actions panel, click the Upload Configuration button.

3. Click Choose File in the window that displays, and navigate to the directory on your PC
where the bundled file is stored.
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4. Click the Upload button. NetClock saves the uploaded bundled file in the
/home/spectracom/xfer/config/ directory.

Note: When uploading files remotely via long distances, or when uploading mul
tiple files via several browser windows simultaneously, the upload process may
fail to complete. In this case, cancel the upload by clicking X, and go back to
Step 2.

5. To use the new configuration file for this NetClock, click the Restore Configuration but
ton, and follow the procedure described under "Restoring the System Configuration"
below.

3.4.9.4 Restoring the System Configuration

1. Navigate to TOOLS > SYSTEM: Upgrade/Backup.

2. In the Actions panel, click Restore Configuration.

3. Click OK in the message window that displays. The system will restore the configuration
using the bundled file stored at
/home/spectracom/xfer/config/NetClock.conf, then reboot in order to
read the new configuration file. Once powered back up, NetClock will be configured
with the previously stored file.
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3.4.9.5 Restoring the Factory Defaults

For instructions on how to restore the NetClock's configuration files to their factory default set
tings, see: "Resetting All Configurations to their Factory Defaults" on page 218.

3.4.9.6 Cleaning the Configuration Files and Halting the System

To restore the configuration files to the factory defaults and immediately halt the system:

1. Navigate to TOOLS > SYSTEM: Upgrade/Backup.

2. In the Actions panel, click *Clean Configuration and Halt*.

3. NetClock restores the configuration files to the factory default, and halts the system so
that no changes are made to the factory default condition.

3.4.10 Oscillator Disciplining
The purpose of the internal oscillator is to provide NetClock with an accurate and very stable
frequency source. This allows NetClock to go into a holdover mode in the event that external
time or frequency references are lost or become invalid. However, the oscillator can also be
used as a legitimate PPS reference during normal operation, in conjunction with an external
time reference (for more information, see "Configuring Input Reference Priorities" on
page 152.)

NetClock’s internal oscillator is normally disciplined to an input reference (such as GNSS, IRIG
input, 1PPS input, etc.) in order to provide the highest degree of oscillator accuracy and to
account for oscillator drift. While disciplining (with a 1PPS input reference input present and
valid), the oscillator’s output frequency is monitored and based on the measured frequency, the
oscillator is steered to maintain a very accurate 10 MHz output. If no valid 1PPS input ref
erences are present (or input references are present but not considered valid), the oscillator will
be in Freerun mode instead.

If no external input reference such as GNSS, IRIG, etc. is available (or is temporarily lost),
NetClock may become an NTP Stratum 2 or higher reference. If so configured, NetClock can
use a reference such as an NTP daemon, or TimeKeeper, referred to as a Host Reference. If the
Host Reference becomes active, it will automatically take over the disciplining of the oscillator.
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This built-in functionality is referred to as Host Disciplining. (See also Phase Error Limit under
"Oscillator Status Panel" on page 188 for more information on how it is possible to influence
the Host Disciplining.)

Figure 3-6: Host disciplining

Note: Host disciplining is not supported with NetClock units that are equipped
with Rubidium oscillators.

The Oscillators Settings page provides the user with some control of the disciplining process.
This page is also used to configure the length of time NetClock is allowed to remain in the Hol
dover mode when all references are lost.

3.4.10.1 Oscillator Types

NetClock units are available with different types of internal oscillators:

TCXO (Temperature-Compensated Crystal Oscillator)

one of two different types of OCXO (Oven-Controlled Crystal Oscillator) oscillators, or

one of two different types of Rb (Rubidium) oscillators.

The two different types of OCXO oscillators are a precision OCXO oscillator and a high-pre
cision (low phase noise) OCXO oscillator. The two different types of Rubidium oscillators are a
precision Rubidium oscillator and a low-phase noise Rubidium oscillator. All of these internal
oscillators are self-calibrating and can be disciplined to a 1PPS input reference for maximum
accuracy.

186 CHAPTER 3 • NetClock User Reference Guide Rev. 12

3.4  OTHER Setup Pages



Because of its high degree of stability, the Rubidium oscillator provides the greatest ability to
extend the hold-over period when input references are not present. Extending the hold-over
period allows the unit to provide very accurate and useable time stamps and a 10 MHz output
for a longer period of time once time synchronization has been lost.

Note: Oscillators are installed at the factory, in accordance with order spe
cifications; an oscillator cannot be swapped/retrofitted later in the product life
cycle.

The Rubidium oscillator is atomic in nature but requires no MSDS (Material Safety Data Sheet).

Note: External Oscillator: It is possible for an external oscillator to be locked to
NetClock's 10 MHz output via an external PLL, with the lock state of the external
PLL monitored by NetClock. Contact Spectracom for more information.

3.4.10.2 The Oscillator Disciplining Screen

1. Navigate to MANAGEMENT > OTHER: Disciplining.

2. The Oscillator Management screen will display. It consists of two panels:

3.4  OTHER Setup Pages

CHAPTER 3 • NetClock User Reference Guide Rev. 12 187



Oscillator Status Panel
This panel provides comprehensive information on the current status of NetClock's timing state.

Oscillator Type: See "Oscillator Types" on page 186.

Disciplining State: State of oscillator control and disciplining; indicates whether or not the
internal oscillator is currently being disciplined (steered to an input reference). The states
are: "Warm up", "Calibration", "Tracking Setup", "Lock State", "Freerun", and "Fault".

1PPS Phase Error: A tracking measurement [scaled time, in ns, or ms] of the internal
1PPSs' phase error with respect to the selected input reference. Long holdover periods
or an input reference with excessive jitter will cause the phase error to be high. The oscil
lator disciplining control will gradually reduce the phase error over time. Alternatively,
restarting the tracking (see "Restart Tracking" under "Oscillator Disciplining" on
page 185) manually, or automatically via a pre-set Phase Error Limit, will quickly reduce
the phase error.

10 MHz Frequency Error: An internal estimated calculation (in Hertz) of the internal oscil
lator's frequency error, based on the phase accuracy error at the beginning and end of
a frequency measurement window (the length of this window will vary depending upon
the type of oscillator installed and the oscillator adjustment algorithm).

Current DAC Setting: Current DAC value, as determined by the oscillator disciplining sys
tem. The value is converted into a voltage that is used to discipline the oscillator. A stable
value over time is desirable and suggests steady oscillator performance (see also the
graph in the History Panel).

DAC Step: Step size for adjustments to the internal oscillator, as determined by the oscil
lator disciplining system. Larger steps = quicker, but coarser adjustments. The step size is
mainly determined by the type of oscillator.

TFOM: The Time Figure of Merit is NetClock’s estimation of how accurately the unit is syn
chronized with its time and 1PPS reference inputs, based on several factors, known as
the Estimated Time Error or ETE. The larger the TFOM value, the less accurate NetClock
believes it is aligned with its 1PPS input that is used to perform disciplining. If this estim
ated error is too large, it could adversely affect the performance of oscillator dis
ciplining. The available TFOM range is 1 through 15.

Max TFOM for Sync: Value, as set under "Oscillator Disciplining Setup" on the facing
page

Temperature(s): Three temperatures are displayed:

Oscillator temperature, which has an effect on oscillator accuracy, and therefore
can be used to interpret oscillator performance.

Board temperature (measured on the main board, also referred to as 'System tem
perature')

CPU temperature

Ambient temperature has an effect on the accuracy of the oscillator, and therefore—in
conjunction with other relevant parameters—can be used to interpret oscillator per
formance. The temperature data is also logged. Note that a temperature sensor started
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being added to NetClock Model 9483s in 2012 (the Model 9489s do not have this
sensor installed). Model 9483s purchased prior to this hardware change being imple
mented will not be able to report the internal temperature, even with software update ver
sions 5.2.0 or above installed.

Last Time Reference Change: [Timestamp: Last occurrence]

Last 1PPS Reference Change: [Timestamp: Last occurrence]

Last TFOM Change: [Timestamp: Last occurrence]

Last Sync State Change: [Timestamp: Last occurrence]

Last Holdover State Change: [Timestamp: Last occurrence]

Oscillator History Panel
The graphs in the History Panel plot key oscillator-relevant data over time. See also above, and
under "Oscillator Monitoring via Graphs" on page 191.

Phase Error Magnitude

Frequency Error

DAC Value

Oscillator Temperature (if equipped with temperature sensor).

3.4.10.3 Oscillator Disciplining Setup

1. To configure the oscillator settings, navigate to MANAGEMENT > OTHER: Disciplining.

2. Click the GEAR icon at the top of the Status panel. The Oscillators Settings window dis
plays:

3. Populate the fields:

Maximum TFOM for Sync: When TFOM (Time Figure of Merit, see below) is
greater than Max TFOM, disciplining will still be attempted against the selected
reference to improve the TFOM. If the condition persists, the system will transition
to holdover, and eventually out of sync. When disciplining is performed such that
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TFOM is no longer greater than max TFOM, the system will transition back into
sync.
TFOM is NetClock’s estimation of how accurately it is synchronized with its time
and 1PPS reference inputs, based on several factors, known as the
Estimated Time Error or ETE. The larger the TFOM value, the less accurate NetC
lock believes it is aligned with its 1PPS input that is used to perform disciplining. If
this estimated error is too large, it could adversely affect the performance of oscil
lator disciplining. The available TFOM range is 1 through 15. You may refer to
the following for the TFOM to ETE conversions:

Reported TFOM Value Estimated Time Error (ETE)

1 <= 1 nsec

2 1 nsec < ETE <= 10 nsec

3 10 nsec < ETE <= 100 nsec

4 100 nsec < ETE <= 1 μsec

5 1 μsec < ETE <= 10 μsec

6 10 μsec < ETE <= 100 μsec

7 100 μsec < ETE <= 1 msec

8 1 msec < ETE <= 10 msec

9 10 msec < ETE <= 100 msec

10 100 msec < ETE <= 1 sec

11 1 sec < ETE <= 10 sec

12 10 sec < ETE <= 100 sec

13 100 sec < ETE <= 1000 sec

14 1000 sec < ETE <= 10000 sec

15 ETE > 10000 sec

Figure 3-7: TFOMè ETE conversion

Holdover Timeout(s): The default is 7200 s (= 2 hours).
For more information on holdover timeouts, see "Typical Holdover lengths in
seconds" on page 194. For additional information on holdover, see "Holdover
Timeout" on page 193.

Phase Error Limit: Setting a limit (valid for +/-) for the phase error between
external 1PPS reference and system 1PPS will cause the disciplining tracking to
restart automatically (after a few minutes delay), if the limit is exceeded, in order
to quickly re-align the system 1PPS with a reference.
[Default=0 (disables the feature)].
For more information on phase error, see under "Oscillator Status Panel" on
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page 188.
If you are using a Host Reference as a primary or backup reference, for
improved performance it is recommended to set the phase error limit for NTP to a
suggested value of 100000 nsec. Adjust this value as needed, based on your
accuracy requirements.

Restart Tracking: Check this box, and click Submit if you want to manually restart
disciplining tracking.
This option causes the disciplining algorithm to stop tracking the input reference
and start over (as if it was just acquired). This can be useful if there is a large
phase offset between reference 1PPS and system 1PPS, as it may occur when
going back into sync to the external reference after a long holdover. A Restart
Tracking will re-align the system 1PPS with the reference 1PPS very quickly, but
may cause the 1PPS output to jump.

Recalibrate: In rare cases, existing calibration data may no longer be suitable to
calibrate the oscillator. This function will delete the existing calibration data, and
begin a new calibration process (not applicable for low phase-noise Rubidium
oscillators).

4. Click the Submit button.

3.4.10.4 Oscillator Monitoring via Graphs

The Oscillator Management page offers real-time graphical monitoring of NetClock’s internal
timing in the History panel.
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This panel provides the following graphs:

Phase Error Magnitude: See 1PPS Phase Error

Frequency Error: See 10_MHz_Frequency_Error

Scaled DAC Value: See DAC Step

Oscillator Temperature: For more information, see "Oscillator Status Panel" on
page 188.

You can zoom in on any of the graphs by grabbing the handles at either end and pulling them
inwards. The graph will focus in on the time interval you choose in real time.

Clicking on the Delete icon in the top-right hand corner will erase all current oscillator
log data.

Clicking on the Download arrow icon will download the latest oscillator log data as a
.csv file.

3.4.10.5 Oscillator Logs: Exporting/Deleting

To export, or delete the oscillator logs:

1. Navigate to MANAGEMENT > OTHER > Disciplining.

2. To download the log file: In the History panel, click the downwards pointing ARROW
icon. in the top-right corner. The log file will be downloaded onto your local computer.
Its name is oscillatorStatusLog.csv. Depending on the operating system you
can open the file, or save it locally.
To delete the log file, click the TRASH CAN icon, and confirm.

3.4.11 Holdover Mode
When input references have been supplying input to NetClock and input from all the references
has been lost, NetClock will not immediately declare loss of time synchronization, but first will
go into Holdover mode. While the unit is in Holdover mode, the time outputs are derived from
an internal oscillator incrementing the System Time.

Because of the stability of the internal oscillator, accurate time can still be derived even after all
the primary references are no longer valid or present. The more stable the oscillator is without
an external reference, the longer this holdover period can be and have it still maintain very
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accurate outputs. The benefit of Holdover is that time synchronization and the availability of the
time outputs is not immediately lost when input references are no longer available.

NetClock will remain in Holdover mode until either:

a. any enabled and valid input reference becomes available again. If one or more
references return and are declared valid before the Holdover period has
expired (even momentarily), NetClock exits the Holdover mode and returns to its
fully synchronized state.

b. the Holdover Timeout period expires. When the Holdover Timeout period
expires, declares loss of synchronization.

Holdover Mode does not persist through reboots or power cycles. If a reboot or power cycle
was to occur while NetClock is in Holdover mode, it will power-up and remain in a “not syn
chronized” state until at least one valid Time and 1PPS input reference becomes available
again. While in this state, NTP will be Stratum 15 and outputs will not be usable. If the input ref
erences are restored and then lost or declared not valid again, NetClock will then go back into
the Holdover mode again.

Also, if the only available input reference is a manually set “user” time and NetClock is sub
sequently rebooted or power cycled, time sync will be lost when NetClock powers back-up. The
time will need to be set manually again in order for NetClock to return to its fully synchronized
state. Refer to "Editing the System Time" on page 167 for more information on manually setting
the time.

Holdover Timeout

Holdover Timeout is a user-configurable allowable time period in which NetClock remains in
Holdover mode before it declares loss of synchronization. Holdover Timeout can be adjusted
according to personal requirements and preferences. The factory default Holdover period is 2
hours. The Holdover Timeout value can be managed from the Oscillators Settings page,
accessed through the Oscillator Management screen. See "Oscillator Disciplining Setup" on
page 189 for instructions on setting the Holdover Timeout value.

Note: Changes made to the Holdover Timeout always take effect immediately. If
NetClock is in holdover and the Holdover Timeout is changed to a value that is
less than the current time period that NetClock has been Holdover Mode, the unit
will immediately transition to out of sync.

The estimated error rates for each oscillator type, after losing the input references, are listed in
the table Estimated Oscillator Error Rates during Holdover, below. Estimated typical rates are
based on the oscillator being locked to a reference for 2 weeks and the ambient temperature
remaining stable.

Oscillator Type Typ. Error Rates after 4 hrs Typ. Error Rates after 24 hrs

Low Phase noise Rb (Rubidium) 0.2 μs (nominal) 1 μs (nominal)
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Oscillator Type Typ. Error Rates after 4 hrs Typ. Error Rates after 24 hrs

Rb (Rubidium) 0.2 μs (nominal) 1 μs (nominal)

High performance OCXO 0.5 μs (nominal) 10 μs (nominal)

Standard OCXO 1 μs (nominal) 25 μs (nominal)

TXCO 12 μs (nominal) 450 μs (nominal)

Table 3-6: Estimated oscillator error rates during Holdover
The length of the allowed Holdover Timeout period is displayed and configured in seconds.
The table below provides example conversions for typically desired Holdover periods.

Desired Holdover Length Holdover Length (in seconds) to be entered

2 hours 7200 seconds (default value)

24 hours 86 400

7 days 604 800

30 days 2 419 200

1 year 29 030 400

Table 3-7: Typical Holdover lengths in seconds

Note: Due to Leap Seconds that are periodically inserted into the UTC and Local
timescales, it is not normally recommended to exceed 30 days of Holdover
without an external reference that can supply Leap Second information being
applied (such as GNSS).

Configuring a Holdover value exceeding 30 days could result in a one second time error in
the UTC or Local timescales until an external reference (GNSS or IRIG input) is restored or a
manually configured Leap Second is asserted by a user (leap seconds do not affect the GPS
and TAI time scales).

If no external references (such as GNSS or IRIG) are available when a Leap Second is sched
uled to occur, manual Leap Seconds can also be applied to the UTC or Local time base in the
“Set Leap Second” table located in the MANAGEMENT/OTHER/Time Management page.

For more information on Leap Seconds, refer to "Leap Second Occurrence" on page 268 and
"Configuring a Leap Second Correction" on page 170.

3.4.12 1PPS and 10 MHz Outputs

Note: NetClock 9489 only has a 1PPS output; therefore, information pertaining
to the 10 MHz output only applies to NetClock 9483.
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The NetClock 9483 includes one 1PPS output and one 10 MHz output. To configure these out
puts, navigate to:

INTERFACES/OUTPUTS, or

and select the 1PPS Output or 10 MHz Output you would like to see, or configure.

NetClock’s 1PPS output is generated from the oscillator’s 10 MHz output and is aligned to the
on-time point. The on-time point of the 1PPS output can be configured to be either the rising or
falling edge of the 1PPS signal (by default, the rising edge is the on-time point).

There is a fixed phase relationship between the 1PPS and the 10 MHz outputs, as described
below:

NetClock equipped with TCXO/OCXO/Low-Phase-Noise Rubidium oscillator: With
oscillator disciplining active (one or more 1PPS references available and valid) and
after the on-time point has been initially slewed into alignment with the selected ref
erence, there will always be exactly 10 million counts of the oscillator between each
1PPS output, even while in the Holdover mode (= input references are currently unavail
able) and even after input references have become available again.

NetClock equipped with Rubidium (Rb) oscillator: With oscillator disciplining active
(one or more 1PPS references available and valid), after the on-time point has been
slewed into alignment with the selected reference, with the exception of 1PPS input ref
erence changes occurring, there will always be exactly 10 million oscillator counts
between each PPS output pulse.
With the Rubidium oscillator installed, when a 1PPS input reference change occurs (such
as switching from IRIG input to GNSS input, or switching from a reference being valid to
no reference being present or valid—known as the Holdover mode), the oscillator counts
between two 1PPS outputs may momentarily not be exactly 10 million counts. Once the
reference transition has occurred, however, the counts between each PPS output pulse
will return to exactly 10 million counts.

Like other types of NetClock's signal outputs, a 1PPS output can be configured in several ways:

Signature Control allows you to determine under which conditions an output signal shall
be present, i.e. what NetClock will do about a given output when an external reference
is lost. See also "Signature Control" on page 197.

The on-time point of the 1PPS signal: rising or falling edge

The pulse width

An offset can be entered to account for cable delays or other latencies.

3.4.12.1 Configuring 1PPS/10 MHz Outputs

The 1PPS and 10 MHz Configuration Screens
To access the 1PPS and 10 MHz Configuration screens:
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1. Navigate to INTERFACES > OUTPUTS.

2. The Outputs configuration screen will display:

Note: If you have only one output of any type, NetClock will number that
output 0. Additional outputs will be numbered 1 or above.

Configuring a 1PPS Output
To configure the 1PPS output of the main unit (i.e., not that of an option card):

1. Navigate to the 1PPS edit screen, for example by choosing INTERFACES/OUTPUTS (or
INTERFACES/OPTION CARDS for PPS outputs other than 0) to directly access the desired
output, or by clicking OUTPUTS or OPTION CARDS.

2. In the latter case, click the GEAR button next to the PPS Output 0. Otherwise, click the Edit
button.
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3. The PPS Output 0 Edit window will display, allowing the following items to be configured:

Signature Control: Determines when the output is enabled. See "Signature Control"
below.

Offset [ns]: Allows to offset the system's 1PPS on-time point, e.g. to compensate for cable
delays and other latencies [range = –500000000 to 500000000 ns = ±0.5 s]

Edge: Used to determine if the on-time point of the 1PPS output is the rising or the falling
edge of the signal.

Rising

Falling

Pulse Width [ns]: Configures the Pulse Width of the 1PPS output.
[range= 20 to 900000000 ns = 0.0s μs to 0.9 s]
[default = 200 ms]

Configuring a 10 MHz Output (NetClock 9483 Only)
To configure the 10 MHz output:

1. Click the GEAR icon next to the 10 MHz output you wish to configure.

2. The 10 MHz 0 screen will display. Choose a value from the Signature Control field drop-
down list to determine what NetClock shall do with the output when its input reference is
lost. See also "Signature Control" below.

3.4.13 Signature Control
Signature Control is a user-set parameter that controls when a NetClock output (for example,
1PPS) will be present. This feature allows you to determine how closely you want to link an
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output to its input. This not only allows you to determine the quality of your output signal (e.g.,
by deactivating it, when the holdover period expires), but also offers the capability to indir
ectly send an input-reference-lost alarm to a downstream recipient via the presence of the sig
nal.

E X A M P L E S :

If you so wish, you can set signature control up such that NetClock's built in 1PPS output goes away
the moment its input reference is lost (e.g., if a valid GNSS signal is lost). Or, you can maintain your
output signal while NetClock is in holdover mode, but not in free run.

The signature-control drop-down list with its four different signature states can be found by click
ing the GEAR button for any output. The available options are:

I. Output Always Enabled—The output is present, even if NetClock is not synchronized to
its references (NetClock is free running).

II. Output Enabled in Holdover—The output is present unless NetClock is not synchronized
to its references (NetClock is in Holdover mode).

III. Output Disabled in Holdover—The 1PPS output is present unless the NetClock references
are considered not qualified and invalid (the output is NOT present while NetClock is in
Holdover mode.)

IV. Output Always Disabled—The output is never present, even if NetClock references are
present and valid.

Table 3-8: Signature control output-presence states

Ref.
Out-of-sync,
no holdover

In holdover
In-sync with

external reference

I.

II.

III.

IV.

3.4.14 Configuring the GNSS Reference
With most applications, NetClock will be setup such that it utilizes a GNSS signal as the
primary (if not the only) timing reference, because the time derived from a GNSS signal is
likely to be by far the most accurate time reference available. GNSS satellites (GNSS = Global
Navigation Satellite System e.g., GPS, GLONASS, Beidou, Galileo, QZSS) transmit a time sig
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nal as part of their data stream, because a very precise time is required to accurately determ
ine your position on earth.

NetClock has an onboard GNSS receiver that the GNSS signal received by the antenna will
be supplied to.

The GNSS receiver analyzes the incoming GNSS data stream and supplies the GNSS time and
1PPS (Pulse-Per-Second) signal to NetClock's timing system where it is processed further e.g., to
enhance its stability and reliability, among other things.

While NetClock’s default GNSS receiver configuration will likely be adequate for most cus
tomer applications, it is advisable that you familiarize yourself with the basic configuration fea
tures so as achieve the best possible results. This is particularly true if you have only poor
GNSS reception.

The GNSS Receiver settings or status can be found in these Web UI windows:

GNSS (0) Edit window, and the

GNSS (0) Status window.

3.4.14.1 Accessing the GNSS Reference Windows

1. Navigate to INTERFACES > REFERENCES: GNSS Reference.

2. To access the GNSS Status window, in the GNSS Reference panel, click the INFO button
for the GNSS reference.

3. To access the GNSS Edit window, in the GNSS Reference panel, click the GEAR button.

3.4.14.2 GNSS Reference Settings: Overview

The illustration below provides an overview of the available GNSS settings.

Note that the options shown on your screen may be different, depending on which type of
GNSS receiver is installed in your NetClock, Res-T, Res-GG, or M8T.
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For information on the individual settings, see "Viewing the Status of the GNSS Reference"
below, and the other GNSS topics below.

3.4.14.3 Viewing the Status of the GNSS Reference

To view the current status of your GNSS reference:

1. Via INTERFACES > REFERENCES: GNSS Reference, navigate to the GNSS Reference
(typically,"GNSS 0", additional GNSS references require custom hardware con
figuration).

2. Click the INFO button next to the GNSS 0 reference.

3. The GNSS 0 Status window will display. It contains two tabs:

Main (the default)
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Satellite Data

Main tab

Under the Main tab, the following information will display (for details, see the subsequent
GNSS topics):

Manufacturer/Model: The manufacturer and/or model of the GNSS receiver in your
NetClock unit.

Validity: Status indicator lights for TIME and 1PPS signals: “On” (green) indicates a
valid signal, “Off” (red) indicates that no valid signal is available.

Receiver Mode:

Single Satellite

Standard

Mobile

Survey Progress: Current status:

ACQUIRING (x Satellites)—red

SURVEYING (x %)—yellow; remains at 1% if no satellites are in view

COMPLETE—green

Number of Tracked Satellites: The number of satellites currently being tracked.
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Offset: As set by the user, in nanoseconds.

Antenna Sense:

OK (green)

Open: Check the antenna for the presence of an open.

Short:Check the antenna for the presence of a short.

Position: NetClock’s geographic position by:

Latitude: In degrees, minutes, seconds

Longitude: In degrees, minutes, seconds

Altitude: In meters

Receiver Constellation: GPS/GLONASS/Beidou/QZSS

Client A-GPS Status: A-GPS is ENABLED and running, or DISABLED

Client A-GPS Data: External A-GPS data is AVAILABLE, or UNAVAILABLE

Identified Satellite Signal Strengths: Bar graphs for all satellites detected. Color indic
ates signal strength. With your mouse pointer, hover over a bar graph to display tool
tip information about satellite constellation, satellite number, and signal strength.

Letter symbol GNSS Constellation

G GPS

R GLONASS

E Galileo (not yet enabled)

J QZSS

C BeiDou

I IRNSS
(not yet enabled)

Satellite Data tab

Under the Satellite Data tab, there are two graphs:

Number of Satellites over Time: A graphical track of how many satellites were being
tracked over time.

SNR over Time: A graphical track of maximum SNR, and minimum SNR.
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In both graphs, to see a legend of the graphical data, and time-specific status data, click
inside the graph, choosing the desired point in time. If necessary, increase the time res
olution by dragging the time sliders. A pop-up window will display the legend for that
graph, and the status information for the selected time.

3.4.14.4 GNSS Receiver Modes

When connected to a GNSS antenna that can receive a GNSS signal, NetClock can use GNSS
as an input reference. The factory default configuration allows GNSS satellites to be
received/tracked with no additional user intervention required.

However, there are a few available user-configured settings for GNSS that allow a user to alter
the operation of NetClock's built-in GNSS receiver. These settings include:

the ability to place the GNSS receiver in a mobile mode of operation (by default, NetC
lock is optimized to operate in a stationary environment)
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the ability to apply an offset to account for antenna cable delays and other latencies, as
well as

the ability to erase the stored GNSS position information (latitude, longitude and
antenna height).

The Receiver Mode option allows the GNSS receiver to operate in either a stationary mode
(“Standard” or “Single Satellite” modes), or in a mobile mode environment (such as in an auto
mobile, boat, airplane, etc.).

The Receiver Mode options are:

Standard GNSS Receiver Mode

Summary

Min. 4 satellite signals are required to determine the position and time. A survey takes 2000
seconds.

Detailed Information

The Standard Mode is also referred to as Stationary Mode. It is the most accurate, and hence
the preferred GNSS receiver mode.

It therefore should always be selected, provided NetClock's GNSS receiver will remain sta
tionary at all times, and it will be able to track at last four satellites at all times.

In this mode a GNSS survey – taking about 33 minutes (2000 seconds)– will initially be per
formed when at least four GNSS satellites become available. During the GNSS survey, the
GNSS receiver must continuously track at least four satellites. Otherwise the GNSS survey will
have to start over.

Upon completion of the GNSS survey, NetClock will go into time synchronization. Also, the
GNSS receiver will lock-in the calculated GNSS position and will enter Stationary Mode. Once
in Stationary Mode, the GNSS survey will only be performed again, should the equipment be
relocated to another location (or if the GNSS location is manually cleared by a user).

Upon a power cycle, if the equipment has NOT been relocated, NetClock will automatically
return to Stationary Mode without the need to perform another GNSS survey.

In this mode, the GNSS receiver will be considered a valid input reference as long as a valid
location is entered (either automatically via the GNSS survey, or manually entered by a user)
and the GNSS receiver continues to track at least four qualified satellites.

Mobile GNSS Receiver Mode

Summary

NetClock attempts to compute time in areas with poor satellite reception (such as "urban
canyons"). You need to enter the antenna position under Manual Position Set. The calculated
time may be less accurate, and less reliable than the time determined in Standard Mode .
(NOTE: The minimum number of satellites depends on the GNSS receiver type installed in your
unit.)
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Detailed Information

This Mobile Mode (also referred to as Continuous Mode) should only be selected if your NetC
lock unit will NOT remain stationary at all times, i.e. instead of the unit being operated in a
building, it is installed in a mobile platform (such as a vehicle, ship, plane, etc.).

In this mode, no GNSS survey is performed, i.e. NetClock will go into synchronization shortly
after tracking satellites.

Note: With NetClock's GNSS Receiver configured in Mobile Mode, the specified
accuracies of NetClock will be degraded to less than three times that of Stationary
Mode. Stationary Mode accuracy of the receiver is less than 50 ns to GPS/UTC
(1 sigma), hence Mobile Mode is less accurate than 150 ns to GPS/UTC time
(1 sigma).

Single Satellite GNSS Receiver Mode

Summary

For non-stationary applications (e.g., marine).

Detailed Information

This mode should only be used if:

NetClock's GNSS receiver will remain stationary at all times, and if

it is not possible for the GNSS receiver to track at least four GNSS satellites for at least
33 minutes continuously (in order to complete the GNSS survey).

The Single Satellite Mode does require a position, which the GNSS receiver most likely will not
be able to obtain, if it could not complete the GNSS survey. You must therefore enter your
receiver's position manually.

Note: If the current position (i.e. latitude and longitude) is not known, you need to
determine it by other means (see "Determining Your Position" on page 208).

NetClock's GNSS receiver is designed to provide the most accurate time in Standard Mode
(see above), which can only be achieved if NetClock completed a GNSS Survey, or NetClock's
location has been entered manually, AND while tracking at least four satellites.

Hence, Single Satellite Mode should only be used if the GNSS survey cannot be completed.

In this mode, the GNSS receiver will be considered a valid input reference as long as:

a. a valid location has been entered by a user, and

b. the GNSS receiver continues to track at least one qualified satellite.
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3.4.14.5 GNSS Receiver Offset

The Offset option allows you to enter an offset to the GNSS time and 1PPS reference to
account for antenna cable delays or other latencies (entered and displayed in nanoseconds).

By setting the correct Offset value, you can offset the system’s on-time point by the Offset value
to compensate for the antenna and in-line amplifier delays. Under typical conditions, the expec
ted cable and amplifier delays are negligible. You can calculate the delay based on the man
ufacture’s specifications.

The range of the cable delay is ±50,000,000 nanoseconds. The default value is 0 nanoseconds
and the resolution is 1 nanosecond.

The following formula is used to calculate the cable delay:

D = ( L * C ) / V

Where:

D = Cable delay in nanoseconds

L = Cable length in feet

C = Constant derived from velocity of light: 1.016

V = Nominal velocity of propagation expressed as decimal, i.e. %66 = 0.66 Value is provided by
cable manufacturer.

When using LMR-400 or equivalent coax cable (such as the coax cable offered by Spec
tracom), this formula equates to approximately 1.2 nanoseconds of delay per every foot of
cable. To calculate the Offset value (cable delay), multiply the length of the entire cable run by
“1.2” and then enter this value into the Offset field.

E x a m p l e s o f L M R - 4 0 0 ( o r e q u i v a l e n t ) c o a x c a b l e
d e l a y s :

100 feet of cable = 120 nanoseconds of cable delay

200 feet of cable = 240 nanoseconds of cable delay

300 feet of cable = 360 nanoseconds of cable delay

3.4.14.6 Resetting the GNSS Receiver

The Reset Receiver command is used to erase all GNSS-relevant data from receiver memory
(equivalent to a receiver cold start).
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Caution: Resetting the receiver may become necessary in the rare event of
internal communication issues, and is typically ONLY required if Spectracom Tech
nical Support advises you to execute this command.

3.4.14.7 Deleting GNSS Receiver Position

The Delete Position option deletes the position data of the GNSS receiver in your NetClock
unit, initiating a GNSS Self Survey with the objective to re-determine the position of your NetC
lock unit.

This function may need to be used if a NetClock unit is relocated, and it did not self-initiate a
new survey.

To ensure that no trace of position data remains on the unit, perform the following steps:

1. Disconnect NetClock’s GNSS antenna.

2. Change the Delete Position value to “Enabled” (the box is clicked).

3. Click the Submit button. NetClock will initiate a GNSS self-survey.

Note: In Mobile Receiver Mode it is NOT possible to delete the position and start
the GNSS Self Survey. This feature is only available in the Standard Mode, and
the Single Satellite Mode (see "GNSS Receiver Modes" on page 203).

3.4.14.8 Manually Setting the GNSS Receiver Position

The exact geographic position (location and elevation) of your NetClock unit—and thus its
onboard GNSS receiver—is a major factor for NetClock to calculate an accurate GNSS time.

Normally, the onboard GNSS receiver will track and adjust the antenna position during the so-
called GNSS survey, which is performed during initial commissioning of your NetClock unit,
or re-commissioning it after it had been powered down for some time ("cold start").

Depending on where your GNSS antenna is installed and thus, how good the reception is, this
survey may take several hours. With good reception, this procedure is adequate for most
applications.

Setting a Manual Position, however, i.e. manually applying your current geographic position
data (Latitude, Longitude, and Altitude) may be necessary if your GNSS receiver could not com
plete its survey, due to poor reception.

In some cases, setting the position manually may also help to reduce the amount of time needed
for the initial position "fix", i.e. for NetClock to synchronize with the satellites in view.
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Note: When manually setting a position, NetClock must be in one of the sta
tionary modes, Standard or Single Satellite (see "GNSS Receiver Modes" on
page 203).

Note that this position will also be used if Apply A-GPS Data is checked.

To manually set your position:

1. Determine your geographic position. For more information, see "Determining Your Pos
ition" below.

2. Navigate to INTERFACES > REFERENCES: GNSS 0. In the GNSS 0 status window, click
Edit in the lower lef-hand corner.

3. Under Manual Position Set accurately enter latitude, longitude (both in decimal
degrees), and altitude (in meters) of your GNSS antenna, NetClock can use this data
during the satellite tracking/adjustment process, which typically leads to a quicker "fix".
It is recommended to enter the position as accurately as possible.

Determining Your Position
In case your position is not already known, there are several ways to determine it, e.g., using a
GPS-enabled device, such as a smart phone. GoogleMaps is another option, described below.

R e a s o n s f o r m a n u a l l y e n t e r i n g y o u r p o s i t i o n

Manually entering your position may not only reduce the time to “first fix” during initial installation, it
will also enable the unit to synchronize to satellite timing signals in the event that signals from less
than four satellites can be received.

After manually entering the position data, NetClock will automatically check the status of the GNSS
receiver:

If no GNSS-based position data is available (yet), NetClock will provide the internal GNSS receiver
with the manually entered position.

1. Locate the building and the relative location in the building, using GoogleMaps™. The
satellite photos may help locate the building.

2. With newer versions of GoogleMaps™, obtain the coordinates by left-clicking on the loc
ation: A popup window will display your coordinates. (Note: This does not work with a
red pin).

3. With older versions, right-click the location and select “What’s Here?”
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a. This will add a green arrow to the page.

b. Next, left-click the green arrow to expose the coordinates.

4. Take note of your decimal position.

Note: Should you prefer to determine your position in a different way,
and as a result, have your latitude & longitude data in
degrees/minutes/seconds,
you need to convert this data, e.g. by using a conversion tool, such as
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Earth Point: www.earthpoint.us:

5. Determine your altitude: Finding the altitude of your NetClock's antenna position is not
as crucial as finding the latitude and longitude. Looking up the altitude for the general
area, the city in which the NetClock is located in for example should be sufficient. If a
more exact altitude is desired, then use a topographical map that supplies altitude
information.

6. Click Submit to apply any changes you may have made.

3.4.14.9 Selecting GNSS Constellations

NetClock allows you to select which GNSS constellations shall be tracked, i.e. you can determ
ine if you want e.g., GLONASS satellites to be tracked (besides GPS). The options offered
depend on the type of GNSS receiver installed in your NetClock unit, and if a Multi-GNSS
license file is installed.

To review your current GNSS constellation selection:

1. Navigate to INTERFACES > REFERENCES: GNSS Reference.

2. Click the GEAR button next to GNSS 0. (For an illustration, see "Configuring the GNSS
Reference" on page 198.)

3. In the newly opened GNSS 0 window, look for the Selected Constellations menu.

Determining Your GNSS Receiver Model
To find out which GNSS receiver type is installed in your NetClock:
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1. Navigate to TOOLS > Upgrade/Backup.

2. In the System Configuration panel, look for GNSS Receiver:

Determining if Multi-GNSS Option Is Installed
To check if the Multi-GNSS license is installed on your NetClock:

1. Navigate to TOOLS > SYSTEM: Upgrade/Backup (same menu as shown in the illus
tration above).

2. Under System Configuration, look for the Option OPT-GNS Multi-GNSS (you may need
to scroll to the bottom of the screen).

If the license is installed, proceed to "Selecting GNSS Constellations" on the next page.

If the license is not installed, and you are interested in purchasing it, contact your local Spec
tracom office, or Spectracom Technical Support ("Technical Support" on page 376).

Determining Which GNSS Satellites Are Received
To see which GNSS satellites your NetClock is currently receiving:
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1. Navigate to INTERFACES > REFERENCES: GNSS 0.

2. Click on the INFO button next to GNSS (0).

3. In the newly opened GNSS 0 window, under Identified Satellite Signal Strengths hover
with your cursor over the bars: The letter provided in each pop up text window indicates
which constellation the displayed satellite belongs to:

Letter symbol GNSS Constellation

G GPS

R GLONASS

E Galileo (not yet enabled)

J QZSS

C BeiDou

I IRNSS (not yet enabled)

Selecting GNSS Constellations
To review or change which GNSS constellations NetClock's GNSS receiver shall track:

1. Navigate to INTERFACES > REFERENCES > GNSS Reference.

2. Click the GEAR button next to GNSS 0.

3. In the newly opened GNSS Window, under Selected Constellations, review which con
stellations are currently tracked, and apply your changes. Note the following:

The LEA-M8T GNSS receiver offers concurrent dual constellation reception, i.e. at
any given time, 2 + QZSS constellations can be received:
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GPS + GLONASS (plus QZSS)

GPS + BeiDou (plus QZSS).

GPS + Galileo (plus QZSS) [Q4 2016]

Should you select more than 2 + QZSS constellations, you will receive a
Constellation Error once you click Submit (ConstError).

With an M8T receiver and a Multi-GNSS license file installed, the following GNSS con
stellations are available:

GPS

GLONASS

Beidou

QZSS.

As of autumn 2016, also Galileo will be receivable (a GNSS receiver software update will be
required for this).

Per default both GPS, and GLONASS will be enabled, in order to obtain as many satellite sig
nals as possible. Either selection can be disabled, but not both of them (if both are turned off,
no changes will be saved and the last constellation setting will be preserved).

To verify if satellite signals for the selected GNSS constellations are received, follow the pro
cedure outlined above under "Determining Which GNSS Satellites Are Received" on
page 211.

QZSS

QZSS is disabled by default. For further information, research QZSS online. In order to
receive QZSS signals, you must either be located in the Japan region, or use a GNSS sim
ulator (such as Spectracom GSG-5 or -6 Series).

QZSS is considered not a standalone constellation and while NetClock allows you to enable
only QZSS, it is recommended to use it in combination with GPS.

3.4.14.10 Assisted GPS

A-GPS stands for Assisted GPS . This widely used technology involves providing additional
data to the GNSS receiver by an alternative means of communication (e.g., via IP, or by
manual data entry), thereby reducing the time for the receiver to acquire and track the actual
satellite signals. This may lead to a significantly shorter time for NetClock to deliver a GNSS-
based timing signal upon a “cold start” of the unit.

The A-GPS client is used to send assistance data to the GPS receiver. This is most useful in areas
with poor GPS reception.

Note: The concept of an A-GPS server also exists: This functionality allows a NetC
lock to operate as a server, providing A-GPS ephemeris and almanac data to
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other devices e.g., a Spectracom GSG-series GNSS simulator. Contact Spec
tracom for further information.

The A-GPS functionality is only available with the following GNSS receiver models:

RES-SMT GG

U-blox M8T

To determine which GNSS receiver is installed in your NetClock unit, navigate to INTERFACES
> REFERENCES: GNSS Reference, and click the INFO button next to GNSS 0. The first line item
under the Main tab shows the type of receiver.

Enable A-GPS Client
The feature Enable A-GPS Client will schedule assistance data to be collected and updated
every hour. On startup, if data is present, it will be sent to the receiver.

Apply A-GPS Data
When this option is selected, NetClock will immediately apply the time, position and satellite
data to the receiver once you click Submit.

Time and position are user- configurable; NetClock collects A- GPS satellite data from an
external source automatically. 

Note: Once you click Submit, any parameters entered under Apply A-GPS Data
will override the system Time and Position data. Exercise caution when using this
feature, since this could negatively impact the GNSS receiver operation.

Use Current System Time
Apply NetClock's currently used system time to the GNSS receiver.

Set System Time
Enter a specific date and time, instead of the system time. This may be useful if the system time is
known to be incorrect, or if you need a time in the past or future, e.g. for simulation purposes.
Enter the date and time using the displayed calendar and time sliders.

Manual Position Set
By accurately entering latitude, longitude (both in decimal degrees), and altitude (in meters) of
your antenna, NetClock can use this data during the satellite tracking/adjustment process,
which typically leads to a quicker "fix". It is recommended to enter the position as accurately as
possible. For more information, see "Manually Setting the GNSS Receiver Position" on
page 207.
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Note: When manually setting a position, NetClock must be in one of the sta
tionary modes, Standard or Single Satellite (see "Receiver Mode" above).

3.5 The Administrator Login Password
The factory default administrator password value of admin123 can be changed from the
default value to any desired value. If the current password is known, it can be changed, using
the NetClock Web UI.

Note: To follow this procedure, the user must be logged in as the spadmin
user. If you are unable to login as spadmin, follow the procedure outlined in
"Resetting the Administrator Password When Forgotten/Lost" on the next page.

If the password has already been changed from the default value, but the current value is no
longer known, the administrator password can be reset back to the factory default value. Once
reset, it can then be changed to a new desired value via the web interface.

To change the admin password from a known value to another desired value using a web
browser:

1. Navigate to MANAGEMENT > OTHER: Change My Password.

2. The Change Password pop-up window will display.

3. In the Old Password field, type in the current password you wish to replace.

4. In the New Password field, type in the new password you wish to use.

Note: The new password can be from 8 to 32 characters in length.
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5. In the Repeat New Password field, retype the new password you wish to use.

6. Click the Submit button at the bottom of the screen.

3.5.1 Resetting the Administrator Password When Forgotten/Lost
If the current spadmin account password has been changed from the default value and has
been forgotten or lost, you can reset the spadmin password back to the factory default value of
admin123.

Resetting the spadmin account password does not reset any user-created account passwords.
This process only resets the spadmin account password.

Any user with administrator rights can reset the spadmin password through the
MANAGEMENT/OTHER/Authentication window.

To reset the spadmin password through the MANAGEMENT/OTHER/Authentication window:

1. Navigate to the MANAGEMENT/OTHER/Authentication window.

2. Locate the spadmin entry in the Users table.

3. Click the CHANGE button.

4. In the Add or Change User window:

a. Enter a new password.

b. Confirm the new password.
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Note: The new password can be from 8 to 32 characters in length.

5. Click the Submit button at the bottom of the window.

If you do not have access to NetClock through another admin account, the spadmin password
must be reset via the front panel keypad or using the front panel serial port.

To reset the spadmin account password using the keypad:

1. Use the front panel LCD and the keypad to perform a “RESETPW”. See also "Using the
Keypad and Information Display" on page 33. (“Resetpw” is located in the Home/Sys
tem menus).

2. You will be prompted to confirm the operation before the password is reset. The spad
min account password is now reset to “admin123”.

To reset the spadmin account password using the serial port:

1. Connect a PC to the front panel serial port, and log in using an account with admin
group rights (such as the spadmin account).

2. Type: resetpw <Enter>. The spadmin account password is now reset.

After resetting the password follow the procedure above to change the spadmin password in
the MANAGEMENT/OTHER/Authentication window.

3.6 Resetting the Unit to Factory Configuration
In certain situations, it may be desired to reset all NetClock configurations back to the factory
default configuration. The GNSS location, any NetClock configurations and the locally stored
log files can be cleared via the Web UI.

Caution: It is not possible to clear the Authentication logs and NTP logs.

Note: Restoring configurations (reloading a saved configuration), erasing the
stored GNSS location and clearing the log files are separate processes. You may
restore one without restoring the others.

If NetClock was assigned a static IP address before cleaning the configurations, it will be reset
to DHCP after the clean has been performed. If no DHCP server is available after the clean
operation, the static IP address will need to be manually reconfigured. See"Replacing a
Dynamic with a Static IP Address" on page 36 or "Assigning a Static IP Address" on page 37.
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3.6.1 Resetting All Configurations to their Factory Defaults
To restore the configuration files to their factory defaults:

1. Navigate to TOOLS > SYSTEM: Upgrade/Backup.

2. In the Actions panel, click the Restore Factory Defaults (Clean) button.

3. NetClock restores the configuration files to the factory settings, and then reboots in order
to read the new configuration files. Once powered back up, NetClock will be con
figured with the previously stored files.

Note: While the GNSS position is stored and retained through power
cycles, choosing Clean (Restore Factory Configuration) will erase the
stored GNSS position.

Erasing the GNSS location means that the next time the GNSS antenna is connected and the
GNSS receiver is able to continuously track at least four satellites, the 33 minute long GNSS sur
vey will be performed again, so the position can be recalculated and locked-in.

3.6.2 Resetting the GNSS Receiver Position
The position of the GNSS receiver your NetClock is using is stored in the unit’s memory. This
data can be erased.

Caution: Upon reconnecting the GNSS antenna and when the receiver is able to
track continuously at least four satellites (and as long as the GNSS receiver is con
figured for the Standard mode), the GNSS survey will be performed again. This
will take 33 minutes.

To reset the GNSS receiver position stored in your NetClock unit:

1. Disconnect the GNSS antenna cable from the back panel antenna jack.

2. Navigate to INTERFACES > REFERENCES: GNSS Reference.
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3. On the right side of the screen, the GNSS Reference panel will display.

4. Click the GEAR button for the GNSS Reference you wish to configure.

Note: If you choose the individual GNSS Reference directly through the
INTERFACES/REFERENCES drop-down menu, the GNSS Status window
will open directly. In this case, click the EDIT button at the bottom of the
GNSS Status window.

Note: If you have only one reference, NetClock will number that reference
0. Additional references will be numbered 1 or above.

5. The GNSS 0 Edit window will display.

6. Select the Delete Position check box.
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3.6.3 Clearing Locally Stored Logs: All Files

Note: Authentication and NTP logs cannot be cleared.

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

2. On the Logs screen, click the Clear All Logs button in the Actions panel.

3. In the message window that displays, click OK.

3.6.4 Clearing Locally Stored Logs: Selected Files

Note: Authentication and NTP logs cannot be cleared.

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

2. On the Logs screen, for the log you wish to clear (e.g., Alarm log), click the X-icon.
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3. In the message box that displays, click the OK button.

3.7 Issuing HALT Command Before Removing Power
Gracefully shutting down NetClock using the HALT command reduces the risk of damaging sys
tem files, and under some circumstances will allow for faster startup after the next power-up of
the unit.

The HALT command may be issued to the NetClock through the Web UI, the front panel serial
port, or the front panel keypad.

Note: Wait 30 seconds after entering the HALT command before removing
power.

Once the HALT process has been initiated via the Web UI or front panel, the front panel LCD
will display Power off NetClock, and the front panel LED time display will stop incrementing.

Issuing a HALT Command via the Web UI

1. Navigate to TOOLS > SYSTEM: Reboot/Halt.

2. The Reboot/Halt window will display. Select the Shutdown the Unit checkbox.

3. Click the Submit button.

4. Wait 30 seconds after entering the HALT command before switching off the NetClock
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unit.

Once the HALT process has been initiated, the front panel LCD will display Power off NetClock,
and the front panel LED time display will stop incrementing.

Issuing a HALT Command via Keypad/SerialPort/Telnet/SSS

The HALT command can be initiated not only via the NetClock Web UI, but also via the keypad
and LCD display. For more information on the keypad, see"Using the Keypad and Information
Display" on page 33.

With a serial connection to the front panel serial port, telnet connection or SSH connection,
type halt <Enter> to halt NetClock for shutdown. For more information on NetClock com
mands, see "CLI Commands" on page 329.

Once the HALT process has been initiated, the front panel LCD will display Power off NetClock,
and the front panel LED time display will stop incrementing.

Note: Wait 30 seconds after entering the HALT command before removing
power.

3.8 Rebooting the System
To reboot NetClock:

1. Navigate to TOOLS > SYSTEM: Reboot/Halt.

2. Select the Restart after Shutdown box in the Reboot/Halt window.

3. NetClock will now be rebooted and be accessible again shortly thereafter.
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Rebooting via LCD/Keypad, Serial Port, Telnet, SSH, SNMP
The Reboot command can be initiated not only via the NetClock Web UI, but also via the
keypad and LCD information display. See "Using the Keypad and Information Display" on
page 33 for information on using the keypad to perform a system reboot.

With a serial connection to the front panel serial port, telnet connection or SSH connection,
type reboot <Enter> to reboot NetClock.

Reboot is also is available to be performed through an snmpset operation. For more inform
ation on NetClock commands, see "CLI Commands" on page 329.

Once the Reboot process has been initiated, the front panel LCD will display a “Power off
NetClock” message, and the front panel LED time display will stop incrementing until NetClock
has started booting back up again.

Once the Reboot process has been initiated, the front panel LCD will display a “Power off
NetClock” message, and the front panel LED time display will stop incrementing until NetClock
has started booting back up again.

3.9 If a Secure Unit Becomes Inaccessible
Spectracom assumes that you are responsible for the physical security of the product. Spec
tracom secure products are recommended to be locked in a secure enclosure, cabinet or room.
Unauthorized persons are not to be given access to the product nor should a serial cable and
terminal program be attached unless the system administrator is configuring or performing
maintenance.

A secure NetClock may become inaccessible if:

your company disables HTTPS

you lose the system passwords

you allow the Certificate to expire

someone deletes the Certificate and Private Keys and deletes the Host Keys

you forget the Passphrase.

To regain access to the NetClock unit, you must utilize the front panel keypad and LCD in order
to restore the spadmin account’s default password.

The spadmin account can then be used to enable HTTPS using the “defcert” command. The
“defcert” command generates a new self-signed SSL certificate.

Refer to "Using the Keypad and Information Display" on page 33 for information on using the
keypad and LCD information display.
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4.1 Status Monitoring via Front Panel
When you have physical access to the NetClock front panel, you can see an overview of the
system status without the need for a computer workstation with a web browser.

4.2 Front Panel Status Indicator LEDs
Three Status LEDs are located on the unit's front panel:

POWER: Green, always on while power is applied to the unit

SYNC: Tri-color LED indicates the time data accuracy

FAULT: Two-color, three-state LED, indicating if any alarms are present.

At power up, the unit automatically performs a brief LED test run during which all three LEDs
are temporarily lit.

Table 4-1: Front panel status indications

LED Label Activity/Color Description

POWER
Off Both AC, and DC input popwer are disconnected.

OR: The unit's AC input switch is turned OFF, and DC input is not
present.

On/solid green AC and/or DC Power are supplied; the unit detects all power
inputs.

Red The unit is configured for two power inputs, but detects only one
power input. OR: Detects a power configuration error.

Green & blinking
orange 1/sec.

Power Error — general power configuration fault.

SYNC
Red Time Sync Alarm:

1) The unit has powered up, but has not yet achieved syn
chronization with its inputs.
2) The unit was synchronized to its selected input references, but
has since lost all available inputs (or the inputs were declared
invalid) and the Holdover period has since expired.

Solid green The unit has valid time and 1PPS reference inputs present and is syn
chronized to its reference.

Orange The unit is in Holdover Mode: It was synchronized to its selected
input references, but has since lost all available inputs (or the inputs
are not declared valid).The time and frequency outputs will remain
useable until the Holdover period expires.

226 CHAPTER 4 • NetClock User Reference Guide Rev. 12

4.1  Status Monitoring via Front Panel



LED Label Activity/Color Description

FAULT
Off No alarm conditions are currently active.

Blinking orange A GNSS antenna alarm has been asserted and is currently active.
A short or open circuit has been detected in the GNSS antenna
cable. The light will automatically turn off once the alarm condition
clears.
To troubleshoot this condition, see "Troubleshooting via Web
UI Status Page" on page 319.

Solid orange A Minor Alarm condition (other than an antenna problem alarm)
has been asserted and is currently active.
To troubleshoot this condition, see "Minor and Major Alarms"
on page 317.

Red A Major Alarm condition has been asserted and is currently active.
To troubleshoot this condition, see "Minor and Major Alarms"
on page 317.

4.3 Status Monitoring via the Web UI
While the NetClock front panel status LEDs provide an indication of the current operating status
of the system (see "Status Monitoring via Front Panel" on the previous page), more detailed
status information can be accessed via the NetClock Web UI, such as:

Time synchronization status, including references

GNSS satellites currently being tracked

NTP sync status and current Stratum level

Estimated time errors

Oscillator disciplining

Temperature monitoring

Status of outputs and presence of DC input power.

Real-time details about NetClock's system status can be accessed via:

the HOME screen, focusing on time server functionality status

the TOOLS > System Monitor screen, displaying NetClock's internal hardware status

4.3.1 Status Monitoring via the HOME Screen
The HOME screen of the NetClock Web UI provides a system status overview.
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The HOME screen is divided into four panels:

4.3.1.1 System Status panel

Reference—Indicates the status of the current synchronizing reference, if any.

Power—Indicates whether the power is on and which type of power is being used. If the
unit is configured for AC power, AC will appear in this panel. If the unit is configured
for DC power, DC will appear in this panel. If the unit is configured for both AC and
DC, AC and DC will appear in this panel.

Status—Indicates the status of the network’s timing. There are three indicators in the
Status field:

Sync—Indicates whether NetClock is synchronized to its selected input references.

Green indicates NetClock is currently synchronized to its references (The
front panel Sync light will also be green).

Orange indicates NetClock is not currently synchronized to its references
(The front panel Sync light will be red).

Hold—When lit, NetClock is in holdover mode.

Fault—Indicates a fault in the operation of the NetClock. See "Troubleshooting
via Web UI Status Page" on page 319 for instructions for troubleshooting faults.

Alarm Status: If a major or minor alarm is present, it will be displayed here.

NTP—Current STRATUM status of this NetClock unit.
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Temperature—Oscillator, Board, and CPU temperatures are displayed in real time; for
more information, see "Temperature Management" on page 249.

4.3.1.2 Reference Status panel

Reference—Indicates the name type of each reference. These are determined by the
inputs set up for the NetClock

Priority—Indicates the priority of each reference. This number will be between 1 and 15.
References in this panel appear in their order of priority. See "Configuring Input Refer
ence Priorities" on page 152 for more information.

Status—Indicates which available input reference is acting as the Time reference and
which available input reference is acting as the 1PPS reference.

Green indicates that the reference is present and has been declared valid.

Orange indicates the input reference is not currently present or is not currently
valid.

4.3.1.3 Performance panel

Disciplining State—Indicates whether or not the internal oscillator is currently being dis
ciplined (steered to an input reference).

1PPS Phase Error—An internal measurement (in nanoseconds) of the internal 1PPSs’
phase error with respect to the selected input reference (if the input reference has excess
ive jitter, phase error will be higher)

10 MHz Frequency Error—An internal estimated calculation (in Hertz) of the internal
oscillator’s frequency error, based on the phase accuracy error at the beginning and
end of a frequency measurement window (the length of this window will vary depending
upon the type of oscillator installed and the oscillator adjustment algorithm).

Events panel

The Events panel in the bottom-left corner of the HOME screen is a log of NetClock’s recent
activity. It updates in real time.

Note: If you know the individual reference or output whose status you wish to see,
you can access the Status window of that reference or output directly through the
INTERFACES/REFERENCES or INTERFACES/OUTPUTS drop-down menu.

4.3.2 Status Monitoring via the System Monitor Screen
To display status information pertaining mainly to NetClock's current hardware status, navigate
to TOOLS > SYSTEM > System Monitor.

The information provided on the System Monitor Screen is subdivided into three panels:
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4.3.2.1 System Status panel

See "System Status panel" on page 228.

4.3.2.2 Disk Status panel

This panel displays:

Total: [MB]

Used: [MB]

Free: [MB]

Percent: [%]

The last item refers to Percent used. If you need to update the System Software, and this number
is 70% or higher, it is recommended to clear logs and stats in order to free up memory space.
(Navigate to TOOLS > SYSTEM: Upgrade/Backup, and click the corresponding buttons in the
lower left-hand corner.)

4.3.2.3 System Monitor panel

Graphs are displayed for:

Board Temperature

CPU Temperature

Memory Used

CPU Used.

To delete the logged data used to generate the displayed graphs, click the TRASHCAN icon.
(Note that re-populating the graphs with fresh data generated at a 1/min. rate will take several
minutes.)

To download the logged data in .csv format, click the ARROW icon.

See also: "Temperature Management" on page 249

4.4 Status Monitoring of Input References
NetClock’s input references can be monitored in real time through the INTERFACES drop-down
menu. The menu will populate dynamically, according to which references are available.

To display all references, click on REFERENCES in the INTERFACES menu.

To display all references of a given type, click on the entry for that reference type (not
indented).

To display one particular reference, click on its entry (indented).

The Reference window will show the validity status for the chosen reference(s):
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You can also click on any of the connectors shown in the rear panel illustration to high
light/identify the corresponding reference:

To display more status information for a particular input reference, click the cor
responding INFO button:

The pop-up window being displayed will show additional status information and option-
card specific settings. A particular option card might have more than one setting that can
be viewed. The type of input reference, and the option card model determine which
status information and option card settings will be displayed.
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You can access the option card’s Edit window directly from the settings detail window
by clicking on the Edit button.

4.5 Ethernet Monitoring
To monitor Ethernet status and traffic:
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1. Navigate to TOOLS > SYSTEM: Ethernet Monitor. The Ethernet monitoring screen opens:

The data displayed is linked to a specific Ethernet port e.g, ETH0. If you enable additional Eth
ernet ports, their throughput data will also be displayed.

In the Traffic pane on the right the traffic throughput in Bytes per second is displayed in two
graphs. Drag the handles at the bottom of the graphs to zoom in on a particular time frame.

In the Actions panel on the left, you can clear or download monitoring data.

In the Status panel on the left, information pertaining to the given Ethernet port is displayed,
including throughput statistics and error statistics. The Mode field indicates which transmission
mode is being used for the given Ethernet port:

FULL duplex, or

HALF duplex.

Note that the Mode is auto-negotiated by NetClock. It can be changed only via the switch NetC
lock is connected to, not by using the NetClock Web UI.

4.6 Editing the Settings of an Input Reference
Depending on the type of input reference, some of its settings may be user-editable. To access
these settings for a given input reference, choose one of the two methods described below.
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Note: The illustrations shown below are only examples. The windows displayed in
your Web UI may look differently, depending on the type of input reference
(GNSS, IRIG, PNT, etc.).

There are two ways to access the settings Status window for an input reference:

Editing input reference settings, method 1:

1. Under INTERFACES/REFERENCES, click the desired reference.

2. The Status window for the specific reference you selected will be displayed. Click the Edit but
ton in the bottom-left corner.

3. The settings window for the chosen reference will be displayed. Edit the field(s) as desired.
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Editing input reference settings, method 2:

1. In the INTERFACES/REFERENCES drop-down menu, click REFERENCES, or an input reference
category ("GNSS reference", for example).

2. In the pop-up Status window, click the GEAR button next to the desired input reference.

3. The settings window for the chosen reference will be displayed. Edit the field(s) as desired.

4.7 Outputs Status Monitoring
Per standard configuration, NetClock is equipped with one 1PPS and 10 MHz output inter
face. Additional outputs can be added by means of output option cards.

Outputs can be monitored in real time via the INTERFACES drop-down menu. The menu will
populate dynamically, according to which outputs are installed

4.7.1 Monitoring the Status of All Outputs
To display a list of all the outputs installed in a NetClock unit:
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1. Select INTERFACES and click OUTPUTS in the menu heading.

2. The displayed Status window will list all the outputs installed, sorted by category.

To display more detailed information about a particular output, click the corresponding
INFO button.

To edit the settings of an output, click the GEAR button (see also "Editing Output Settings"
on page 238.)

To refresh the information displayed, click the REFRESH button (circling arrows icon).

In the illustration of the rear panel, click on a connector to highlight the corresponding
list entry.

4.7.2 Monitoring all Outputs of one Type
To monitor all the outputs of a particular category (PPS, for example) simultaneously:
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1. In the INTERFACES/OUTPUTS drop-down menu, click the desired output category (list items
that are not recessed).

2. The pop-up Status window will display a list of all outputs of the selected category.

To display more detailed information about a particular output, click the corresponding
INFO button.

To edit the settings of a given output, click the GEAR button (see also "Editing Output Set
tings" on the next page.)

To refresh the information displayed, click the REFRESH button (circling arrows icon).

In the illustration of the rear panel, click on a connector to highlight the corresponding
list entry.

4.7.3 Displaying Output Settings
The outputs installed in your NetClock unit have specific settings that can be reviewed, and—to
some extent—edited.
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To display the settings of an output:

1. In the INTERFACES/OUTPUTS drop-down menu, click the desired output.

2. The corresponding Status window will display.

Click the Edit button in the bottom-left corner to configure settings that are user-editable. See
also "Editing Output Settings" below.

4.8 Editing Output Settings
Depending on the type of output interface, some of its settings may be user-editable. To access
these settings for a given output, choose one of the two methods described below.

Note: The illustrations shown below are only examples. The windows displayed in
your Web UI may look differently, depending on the type of output (1PPS,
10 MHz, PTP, etc.).
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Editing output settings, method 1:

1. Under INTERFACES/OUTPUTS, click the desired output.

2. The Status window for the specific reference you selected will be displayed. Click the
Edit button in the bottom-left corner.

3. The settings window for the chosen output will be displayed. Edit the field(s) as desired.

Editing output settings, method 2:

1. In the INTERFACES/OUTPUTS drop-down menu, click OUTPUTS, or one of the output
categories (not indented)

2. In the pop-up Status window, click the GEAR button next to the desired output.

3. The settings window for the chosen output will be displayed. Edit the field(s) as desired.

4.9 Monitoring the Status of Option Modules

Note: This section applies to NetClock 9483 only.
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NetClock’s installed option modules can be monitored in real time through the
INTERFACES/OPTION CARDS drop-down menu. The menu will populate dynamically, accord
ing to which option cards are installed.

4.9.1 Monitoring the Status of ALL Options
To monitor all options installed in your NetClock:

1. Click on OPTION CARDS in the INTERFACES menu.
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2. The resulting screen will display all installed option cards, and their current status.

4.9.2 Monitoring the Status of a SPECIFIC Option
To monitor the status of a selected option:

1. Navigate to the specific option card in the INTERFACES/OPTION CARDS drop-down
menu.
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2. The options window will display for the specific option you chose.

4.9.3 Monitoring an Option’s References and Outputs
To view the status of an option’s references and outputs:

1. Navigate to the specific option card in the INTERFACES/OPTION CARDS drop-down
menu.

2. Click on the INFO button for the reference or output whose status you wish to see.

3. A Status window for that reference or output will display.

4.9.3.1 Editing an Option’s References and Outputs

To edit the settings of an option’s references or outputs:
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1. Navigate to the specific option in the INTERFACES/OPTION CARDS drop-down menu.

2. Click on the GEAR button for the reference or output you wish to edit.

3. The Edit window for that reference or output will display.

4. Edit the field(s) as desired.

Note: If you know the individual reference or output whose status you wish
to see, you can access the Status window of that reference or output dir
ectly through the INTERFACES/REFERENCES or INTERFACES/OUTPUTS
drop-down menu.

4.10 NTP Status Monitoring
NetClock's NTP Status Summary provides a means to monitor NTP status and performance
parameters relevant to your NetClock at a glance.

4.10  NTP Status Monitoring
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1. To access the NTP Status Summary panel, navigate to the
MANAGEMENT/NETWORK/NTP Setup screen.

2. The NTP Status Summary panel is at the lower left of the screen. The panel contains the
following information:

Selected Ref—The reference NetClock is currently using.

Stratum—This is the stratum level at which NetClock is operating.

Leap Indicator—The leap indicator bits (usually 00). See "Leap Second Alert Noti
fication" on page 269.

Delay (ms)—The measured one-way delay between NetClock and its selected ref
erence.

Time Offset—This is a graphical representation of the system time offset over
time. Clicking on this graph in the NTP Status Summary panel will open a win
dow in the main panel containing a larger, more detailed view of the graph. See
"The NTP Time Offset Performance Graph" on the facing page.

Offset (ms)—Displays the configured 1PPS offset values.

Frequency Offset—This is a graphical representation of the system frequency off
set over time. Clicking on this graph in the NTP Status Summary panel will open a
window in the main panel containing a larger, more detailed view of the graph.
See "The NTP Frequency Offset Performance Graph" on page 246.

Jitter (ms)—Variance (in milliseconds) occurring in the reference input time (from
one poll to the next).
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Jitter—This is a graphical representation of the system jitter over time. Clicking on
this graph in the NTP Status Summary panel will open a window in the main
panel containing a larger, more detailed view of the graph. See "The NTP Jitter
Performance Graph" on page 248.

Note: This panel is updated every 30 seconds, or upon clicking the
browser refresh button.

4.10.1 The NTP Time Offset Performance Graph
To view the NTP Time Offset performance graph:

1. Navigate to the MANAGEMENT/NETWORK/NTP Setup screen.

2. In the NTP Status Summary panel locate the Time Offset graph.
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3. Click the graph in the NTP Status Summary panel.

4. The NTP Performance Graph panel will appear.

5. To select the statistics for a particular day, select a date from the drop-down list in the
Select Day for Statistics field. The default date is the present date. Click Apply.

6. To display a higher resolution graph for a shorter time span, move one or both time
sliders at the bottom of the graph inwards.

4.10.2 The NTP Frequency Offset Performance Graph
To view the NTP Frequency Offset performance graph:
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1. Navigate to the MANAGEMENT/NETWORK/NTP Setup screen.

2. In the NTP Status Summary panel locate the Frequency Offset graph.

3. Click the graph in the NTP Status Summary panel.

4. The NTP Performance Graph panel will appear (the data may be displayed with a
delay). The X-axis represents time, the Y-axis shows the frequency offset in parts-per-mil
lion (PPM); e.g. 290 PPM is equivalent to .0290 percent.

5. To select the statistics for a particular day, select a date from the drop-down list in the
Select Day for Statistics field (highlighted in green in the illustration above). The default
date is the present date. Click the Apply button.

To display a higher resolution graph of a shorter time frame, move one or both
of the two sliders inwards.
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4.10.3 The NTP Jitter Performance Graph
To view the NTP Jitter performance graph:

1. Navigate to the MANAGEMENT/NETWORK/NTP Setup screen.

2. In the NTP Status Summary panel locate the Jitter graph.

3. Click the graph in the NTP Status Summary panel.

4. The NTP Performance Graph panel will appear.

5. To select the statistics for a particular day, select a date from the drop-down list in the
Select Day for Statistics field. The default date is the present date. Click the Apply but
ton.

To display a higher resolution graph for a shorter time span, move one or both
time sliders at the bottom of the graph inwards.
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4.11 Temperature Management
NetClock is equipped with one cooling fan, located behind the right-hand side of the front
panel, and several hardware temperature sensors, including:

the board temperature near the CPU

the CPU temperature

the air temperature near the oscillator.

Note: NetClock units produced before 2015 may not be equipped with the oscil
lator sensor. They can be retrofitted, if so requested. For additional information,
contact Technical Support (see "Technical Support" on page 376).

Temperature readings are performed once per minute. The temperature data is logged, and
can be visualized via graphs integrated into the Web UI. The temperature readings can also
be used to control the fan. For details see below.

4.11.1 Fan Control Feature
Fan Control allows you to define a temperature range for the fan to turn OFF and ON.

Note: NetClock units produced before Dec. 2015 are not equipped with the Fan
Control feature.

Does my NetClock have Fan Control?

To find out, navigate to the HOME screen. Your unit is equipped with the Fan Control
feature, if there is a GEAR icon displayed in the System Status panel:
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To enable user-defined Fan Control:

The default fan setting is ALWAYS ON. To apply custom fan temperature settings, navigate to
the HOME screen. Then, in the System Status panel, click the Gear icon in the upper right-hand
corner. The System Options window will open:

Here you can choose between the Fan Settings:

Always On [Default]: The fan runs all the time.

User Defined: You determine the:

Fan Max Temperature: The CPU temperature in °C at which the fan will turn ON.
It is advisable to set this temperature no higher than 40°C.

Fan Min Temperature: The CPU temperature in °C at which the fan will turn OFF
(the default is 30°C).

The temperature between the two threshold values is the range in which the temperature is
allowed to rise before the fan turns on again.

In addition there is a hardware temperature sensor that will automatically turn the fan ON if the
measured temperature is over 40°C.
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4.11.2 Temperature Monitoring
You can monitor the unit's measured temperatures actively by inspecting the temperature
graphs in the Web UI, or passively by setting up automatic alarm messages.

Alarm notifications can be generated via SNMP Traps and Emails, as well as log messages in
the Alarm and Event Logs. The alarms may optionally be masked.

Also, it is possible to implement a delay by setting the number of times the 1/minute readings
need to exceed a temperature threshold before an alarm is triggered.

4.11.2.1 Monitoring CPU and Board Temperature

Current readings for Oscillator/Board/CPU Temperature are displayed in the System Status
panel, which can be accessed via the HOME screen, or via TOOLS > System Monitor.

CPU and Board Temperature graphs are displayed under TOOLS > System Monitor:

The graph for the Oscillator Temperature is displayed under MANAGEMENT > OTHER: Dis
ciplining:
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Temperature readings are subject to environmental conditions and hardware configuration
e.g., oscillator type. Under normal operating conditions, all temperatures should remain fairly
constant. Drastic changes may indicate e.g., a problem with the fan. Note that the oscillator tem
perature will have a direct impact on its accuracy, i.e. there is a strong correlation between dis
ciplining performance and oscillator temperature.

4.11.2.2 Setting Temperature Monitoring Alarms

Navigate to MANAGEMENT > Notifications. In the Events panel, select the System tab:
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Under the System tab, you can set Notifications for Minor and Major Alarms/Clearances.

Also, you can set the temperature threshold value for Minor/Major alarms, and define a retry
value by determining how many readings (1/min.) the temperature must exceed the threshold
value before an alarm/clearance is triggered.

The default temperature threshold value for both Minor, and Major Alarms is 100°C. With sim
ultaneous alarm triggerings, the Major Alarm will override the Minor Alarm, i.e. you will be
notified only about the Major Alarm. If you want to be notified early about a rise in tem
perature, a recommended setting for the Minor Alarm temperature would be 90°C. Please note
that it is not advisable to set the Major Alarm temperature to a value higher than 100°C.

4.11.3 Downloading Temperature Data
It is possible to download the temperature data e.g., to plot your own temperature graphs, or
because Spectracom Technical Support inquires about this data for diagnostic purposes in the
event of technical problems.

To download the logged data used to generate the displayed graphs, navigate to any
panel that displays one or more graphs (see above), and click on the Arrow icon in the
top-right corner.
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A file named systemMonitorLog.csv file will be generated in your designated down
load folder.

4.11.4 Deleting Temperature Data
Temperature graphs (and other graphs as well) will display up to approximately 10000 read
ings, which are generated at a 1/min. rate, i.e. the data displayed covers about 7 days. There
after, the oldest data gets overwritten.

To delete the logged data used to generate the displayed graphs, click the TRASH CAN
icon in the top-right corner of the panel.

Note that re-populating the graphs with fresh data will take several minutes.

4.11.5 Further reading
See also: "Troubleshooting the Front Panel Cooling Fan" on page 325

4.12 Logs
NetClock maintains different types of event logs (see below) to allow for traceability, and for
record keeping. Should you ever require technical support from Spectracom, you may be
asked for a copy of your logs to facilitate remote diagnosis.

Logs stored internally are being kept automatically, while the storage of log files in a remote
location has to be set up by the user.

For each type of log, four 75 KB files are maintained internally on a revolving basis, i.e. the
oldest file will be overwritten, as soon as all four files have filled up with event data. The life
expectancy of a log file depends on the amount of data accumulating over time: Some types of
logs will fill up within days, while others can take months until they have reached their max
imum storage capacity.

Logs can be deleted by the user at any time, see "Clearing Logs" on page 268.

4.12.1 Types of Logs
NetClock generates log files for the following event categories:

System Log

Displays log entries related to the Timing System events and daemon events (such as the Alarms,
Monitor, Notification, or SNMP daemons starting or stopping, etc.)

Events Log

Displays log entries related to GNSS reception status changes, Sync/Holdover state changes,
SNMP traps being sent, etc. Examples include:
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Reference Change: NetClock has switched from one input reference to another (for
example, IRIG was the selected input being used, but now GNSS is the selected ref
erence).

GPS Antenna Problem: The GPS Antenna Problem alarm indicates the GNSS receiver
has detected an over-current or undercurrent condition (an open or short exists in the
GNSS antenna cable, or the GNSS antenna is not connected to NetClock). The receiver
will attempt to continue the normal acquisition and tracking process regardless of the
antenna status. The current draw measurements that will indicate an antenna problem
are:

Under-current indication < 8 mA

Over-current indication > 80 mA

Note: This alarm condition will also be present if a GNSS antenna splitter that
does not contain a load to simulate an antenna being present is being used.

GPS Antenna OK: The antenna coax cable was just connected or an open or short in the
antenna cable was being detected but is no longer being detected.

Frequency Error: The oscillator’s frequency was measured and the frequency error was
too large. Or, the frequency couldn’t be measured because a valid input reference was
not available.

Frequency Error cleared: The Frequency Error alarm was asserted but was then cleared.

In Holdover: Input references were available, but all input references have since been
lost. If the references are not restored before the Holdover period expires, time sync will
be lost.

No longer in Holdover: Input references were lost at one point (or declared not valid),
but have since been restored OR the Input references were not restored before the Hol
dover period expired (Time Sync alarm is asserted).

In Sync: NetClock is synchronized to its Time and 1PPS inputs.

Not In Sync: NetClock is not synchronized to its Time and 1PPS inputs and is not cur
rently in Holdover. NTP will indicate to the network that it is Stratum 15 and so the time
server likely be ignored as a time reference.

Sending trap for event 1 (SNMPSAD): An SNMP trap was sent by the SNMP agent to
the SNMP Manager. The event number in this entry indicates which SNMP trap was sent.

The Unit has Rebooted: NetClock was either rebooted or power cycled.

Alarms Log

Displays log entries for the Timing System, for example:
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The Unit has Rebooted: NetClock was either rebooted or power cycled.

In Holdover: Input references were available, but all input references have since been
lost. If the references are not restored before the Holdover period expires, time sync will
be lost.

No longer in Holdover: Input references were lost at one point (or declared not valid),
but have since been restored OR the Input references were not restored before the Hol
dover period expired (Time Sync alarm is asserted).

In Sync: NetClock is synchronized to its selected Time and 1PPS reference inputs.

Not In Sync: NetClock is not synchronized to its Time and 1PPS inputs and is not cur
rently in Holdover. NTP will indicate to the network that it is Stratum 15 and so the time
server likely be ignored as a time reference.

Frequency Error: The oscillator’s frequency was measured and the frequency error was
too large. Or, the frequency couldn’t be measured because a valid input reference was
not available.

Reference change: NetClock has selected a different Time and 1PPS input reference for
synchronization. Either the previously selected input reference was declared not valid (or
was lost), so a lower priority reference (as defined by the Reference Priority Setup table)
is now selected for synchronization OR a valid reference with higher priority than the
previous reference is now selected for synchronization.

E X A M P L E :

GNSS is the highest priority reference with IRIG input being a lower priority. NetClock is synced to
GNSS and so GNSS is the selected reference. The GNSS antenna is disconnected and IRIG
becomes the selected reference. The Reference change entry is added to this log.

Timing Log

Displays log entries related to Input reference state changes (for example, IRIG input is not con
sidered valid), antenna cable status. Examples include:

GRGR = GNSS Reference1 antenna fault: The GNSS Antenna Problem alarm indicates
the GNSS receiver has detected an over-current or undercurrent condition (an open or
short exists in the GNSS antenna cable, or the GNSS antenna is not connected to NetC
lock). The receiver will attempt to continue the normal acquisition and tracking process
regardless of the antenna status.

GR antenna ok: The antenna coax cable was connected at this time or an open or short
in the antenna cabling was occurring but is no longer being detected.

GPS Qualification Log

If NetClock is connected to a GNSS antenna and is tracking satellites, this log contains a run
ning hourly count of the number of GNSS satellites tracked each hour. This history data can be

1GR = GNSS Reference
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used to determine if a GNSS reception problem exists and whether this is a continuous or inter
mittent reception issue.

GNSS reception may be displayed as cyclic in nature. A cyclic 12 hour pattern of decreased
GNSS reception typically indicates that the GNSS antenna has an obstructed view of the hori
zon. The GNSS satellites are in a 12-hour orbit, so if part of the sky is blocked by large obstruc
tions, at the same time every day (at approximately 12 hour intervals), the GNSS reception
may be reduced or may vanish altogether. If this occurs, the antenna should be relocated to
afford it an unobstructed view of the sky.

Every hour (displayed in the log as UTC time), NetClock counts the total number of satellites that
were tracked during that hour. The GNSS qualification log shows the number of satellites that
were tracked followed by the number of seconds that the particular number of satellites were
tracked during the hour (3600 seconds indicates a full hour). The number to the left of the “=”
sign indicates the number of satellites tracked and the number to the right of the “=” sign indic
ates the number of seconds (out of a total of 3600 seconds in an hour) that the unit was track
ing that number of satellites. For example, “0=3600” indicates the unit was tracking 0 satellites
for the entire hour, while “0=2700 1=900” indicates the unit was tracking one satellite for 900
seconds, but for the remaining portion of the hour it was tracking zero satellites.

Every hourly entry in the log also contains a quality value, represented by “Q= xxxx” (where x
can be any number from 0000 through 3600). The Qualification log records how many satel
lites were tracked over a given hour. If for every second of the hour a tracked satellite was in
view, the Quality value will equal 3600. For every second NetClock tracked less than the min
imum number of satellites, the value will be less than 3600. The minimum requirement is one
satellite at all times after the unit has completed the GNSS survey and indicates “Stationary”. A
minimum of four satellites are required in order for the GNSS survey to be initially completed.

If all entries in the qualification log are displayed as “0=3600”, a constant GNSS reception
problem exists, so the cause of the reception issue is continuous. If the unit occasionally shows
0=3600 but at other times shows that 1 through 12 have numbers of other than “0000”, the
reception is intermittent, so the cause of the reception issue is intermittent. If the Quality value
normally equals 3600 but drops to lower than 3600 about every 12 hours, the issue is likely
caused by the GNSS antenna having an obstructed view of the sky.

E x a m p l e G P S Q u a l i f i c a t i o n L o g E n t r y :

6 = 151 7 = 1894 8 = 480 9 = 534 10 = 433 12 = 108 Q = 3600

In this example, NetClock tracked no less that 6 satellites for the entire hour. Out of the entire
hour, it was tracking 6 satellites for a cumulative total of 151 seconds (not necessarily in a
row). For the duration of the hour, it was tracking, 7, 8, 9, 10 and 12 satellites for a period of
time. Because it was tracking at least at least one satellite for the entire hour, this Quality value
is Q=3600.

Note: If NetClock is not connected to a GNSS antenna, this log will remain
empty.
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Oscillator Log

Displays log entries related to oscillator disciplining. Provides the calculated frequency error
periodically while synchronizing to a reference.

Journal Log

Displays log entries created for all configuration changes that have occurred (such as creating
a new user account, for example).

Update Log

Displays log entries related to software updates that have been performed.

Authentication Log

Displays log entries for authentication events (e.g., unsuccessful login attempts, an incorrectly
entered password, etc.) that are made to NetClock’s command line interfaces (such as the front
panel setup port, telnet, SSH, FTP, etc.).

NTP Log (Not Configurable)

The NTP log displays operational information about the NTP daemon, as well as NTP through
put statistics (e.g., packets/sec.). Examples for entries in this log include indications for when
NTP was synchronized to its configured references (e.g., it became a Stratum 1 time server), as
well as stratum level of the NTP references.

The NTP throughput statistics data can be utilized to calculate mean values and the standard
deviation.

Example log entries include:

Synchronized to (IP address), stratum=1: NTP is synchronizing to another Stratum 1
NTP server.

ntp exiting on signal 15: This log entry indicates NTP is now indicating to the network
that it is a Stratum 15 time server because it is not synchronized to its selected reference.

Time reset xxxxx s: These entries indicate time corrections (in seconds) applied to NTP.

No servers reachable: NTP cannot locate any of its configured NTP servers.

Synchronized to PPS(0), stratum=0: NTP is synchronized using the PPS reference clock
driver (which provides more stable NTP synchronization).

4.12.2 Local and Remote Logs
NetClock logs are all stored internally by default. With the exception of the NTP log, all logs
can also be configured to be stored externally, if desired.

The log entries for the logs can also be configured to be automatically sent to a Syslog Server
for external log storage. In order for these logs to be sent to a Syslog server, each desired log
needs to be configured for Syslog operation. With the exception of the Authentication and NTP
logs, all log setup options can be configured from the Logs Configuration page.
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Note: The NTP log has no available configuration options.

In each log, entries appear with the most recent events first (i.e., in reverse chronological order,
starting from the top).

To set up a remote log server, see "Setting up a Remote Log Server" on page 266.

4.12.3 The Logs Screen
The Logs Screen not only provides a status overview of all log types, but also allows for all logs
to be configured.

4.12.3.1 Accessing the Logs Screen

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

2. The Logs screen will appear. It is divided into three panels:

The Logs panel

The Logs panel on the right-hand side provides a logs overview, displaying the status of all
NetClock logs.

To read a log, click the corresponding INFO button.

To configure a log, click the corresponding PENCIL button.

To clear a log, click the X-button.

Note: The Clear File feature does not delete any of the logs that have been sent to
and stored in a Syslog server.
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A green indicator lamp shows if events of the corresponding log category are stored remotely
or locally.

The Logs Actions panel

The Actions panel on the upper- left corner of the Logs screen allows you to perform batch
actions on your logs:

Save and Download All Logs—Save and download all the logs on NetClock. See also:
"Saving and Downloading Logs" on page 262.

Clear All Logs—Clear all the logs on NetClock. See also: "Clearing Logs" on page 268.

Restore Configuration—Restore all log configurations to their factory settings. See also:
"Restoring Log Configurations" on page 267.

The Remote Log Server panel

The Remote Log Server panel, which is where you set up and manage logs on one or more
remote locations. See also: "Setting up a Remote Log Server" on page 266.

4.12.4 Displaying Individual Logs
Next to displaying a Logs overview (see "The Logs Screen" on the previous page), it is also pos
sible to access individual NetClock logs:

1. From the TOOLS drop-down menu, select the desired Logs category (for example,
“Alarms”, or “Events”) from the right-hand column.

OR
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1. Access the Logs screen through the MANAGEMENT/OTHER/Log Configuration drop-
down menu.

2. The Logs screen will be displayed:

3. Click on the INFO button for the desired log category.
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4. A short log will be displayed, showing recent entries. Click on the ARROWS icon in the
top-right corner to expand to the full Logs view:

4.12.5 Saving and Downloading Logs
The NetClock Web UI offers a convenient way to save, bundle, and download all logs in one
simple step. This feature may be useful when archiving logs, for example, or for troubleshoot
ing technical problems: Spectracom Technical Support/Customer Service may ask you to send
them the bundled logs to remotely investigate a technical concern.

To save, bundle, and download all logs:

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

2. On the left side of the screen, in the Actions panel, click on the Save and Download All
Logs button.

3. Select where to save the log bundle to. The default file name is netclock.log.

4. If so asked by Spectracom Technical Support, attach the bundled log files (typically
together with the oscillator status log, see: "Saving and Downloading the Oscillator Log"
on the facing page) to your email addressed to Spectracom Technical Support.
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4.12.5.1 Saving and Downloading the Oscillator Log

The oscillator status log captures oscillator performance data, such as frequency error and
phase error. The data can be retrieved as a comma-separated .csv file that can be read and
edited with a spreadsheet software, such as Microsoft Excel®. You may want to review and/or
keep this data for your own records, or you may be asked by Spectracom Technical Support to
download and send the oscillator status log in the event of technical problems.

To download the oscillator status log:

1. Navigate to MANAGEMENT > OTHER: Disciplining.

2. Click on the ARROW icon in the top-right corner of the screen. Save the .csv file to your
computer.

3. If so asked by Spectracom Technical Support, attach the oscillator status log file (typ
ically together with the bundled NetClock log files, see: "Saving and Downloading
Logs" on the previous page) to your email addressed to Spectracom Technical Support.

4.12.6 Configuring Logs

Note: The NTP log has no available configuration options.

To configure a log:

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

1. In the Logs panel select the log you wish to configure, then click the corresponding
PENCIL button.
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2. In the Log File window, fill in the available fields.

The following log configuration options are available:

a. Add/Remove Remote Server—The Syslog server(s) to which remote logs are sent. This
panel is only available if Remote Log is checked below in the Log Configuration panel.
If the log has a remote log server to which it writes, the name of the server will appear
here. Click Delete to remove the remote server.

Note: Clicking the Delete button in the Log File configuration window does
NOT remove the remote log server from the network. In this instance it
merely deselects the server as that particular log’s remote log server.

If the log does not have a remote log server assigned, there will be a drop-down list of
server choices. Click Add to add a remote server from the drop-down list.

If this list is empty, you will need to set up a remote log server through the Remote Log
Server panel. See "Setting up a Remote Log Server" on page 266.
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b. Log File—Displays the name of the log file being configured.

c. Facility—Value (defined by the Syslog server) to determine where the log is stored in the
Syslog server. Set this value to match the scheme used by the remote server.

d. Priority—Value (defined by the Syslog server) to determine where the log is stored in the
Syslog server. Set this value to match the scheme used by the remote server.

Note: About Facility and Priority values: In addition to configuring the log entries
to be sent to a specific location in the Syslog server, the combination of these two
values also determines which local log the entries are sent to inside NetClock.
Changing either or both of these values from the factory default values will alter
which log the entries are sent to inside NetClock.
The table below, Factory Default Facility and Priority Codes, indicates which Log
Tab the log entries will be sent to (by default), based on the configuration of these
two values.

If remote logging is not being used, the Facility and Priority values should not be changed from
the default values. Altering these values can cause log entries that have similar values to be sent
to the same log file (combining different types of log entries into one log). The factory default
settings for the Facility and Priority configurations of all logs that can be sent to a Syslog server
are as follows:

Log Tab Name Facility Priority

Event Local Use 7 Alert

Alarms Local Use 7 Critical

Oscillator Local Use 7 Debug

GPS Qualification Local Use 7 Warning

Journal Local Use 7 Notice

Update Local Use 7 Information

Timing Local Use 7 Error

System Local Use 7 Emergency

Table 4-2: Factory default facility and priority codes

e. Local Log—Enable or disable this particular log being stored inside NetClock. When
this box is checked, the log will be stored in NetClock.

f. Remote Log—Configure the desired Syslog servers. When this box is checked, the par
ticular log will be sent to a Syslog server.

In order for the logs to be formatted correctly for Syslog storage, all log entries are displayed
using Syslog formatting. Each log entry contains the date and time of the event, the source of
the log entry, and the log entry itself.
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The “time” of all log entries will be in UTC, Local, TAI or GPS time, as configured in the “Time
scale” field that is located in the System Time Setup page (Setup/Time Management). Refer to
"Timescales, Offsets and Leap Seconds" on page 163 for information on configuring the Sys
tem Timescale.

4.12.7 Setting up a Remote Log Server
Storing log files on remote log servers supports advanced logging functionality.

To add remote log servers:

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

2. In the Remote Log Server panel, click on the PLUS icon in the top-right corner of the
panel. The Add Remote Log Servers window displays.

3. Enter the IP address or host server name (e.g. “MyDomain.com”) you wish to use as a
remote log server.

4. Click the Submit button.

5. Your remote log server will appear in the Remote Log Server panel, and as a SERVER
NAME in any Log File configuration screen:
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4.12.7.1 Changing or Deleting a Remote Log Server

To change or delete a remote log server:

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

2. In the Remote Log Server panel locate the remote server you wish to change or delete.

3. Choose the MINUS button to delete the remote log server. Confirm by clicking OK in the
message window.

—OR—

2. In the Remote Log Server panel, click the GEAR button to change the remote log server.
Type in a new IP address or host domain server (e.g. MyDomain.com).

Note: Clicking the Delete button in any of the Log file configuration windows
does NOT remove the chosen remote log server from the network; it merely
deselects the server as that particular log’s remote log server.

4.12.8 Restoring Log Configurations
To restore log configurations:

1. Navigate to the MANAGEMENT > OTHER: Log Configuration.

2. In the Actions panel, click on the Restore Configurations button.

3. Click the Browse button.

4. Navigate to the directory where the configurations are stored and click Upload.
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4.12.9 Clearing Logs
To clear all logs:

1. Navigate to MANAGEMENT > OTHER: Log Configuration.

2. In the Actions panel, click on the Clear All Logs button.

3. In the message window that displays, click OK.

4.13 Leap Second Occurrence

4.13.1 Reasons for a Leap Second Correction
A Leap Second is an intercalary1 one-second adjustment that keeps broadcast standards for
time of day close to mean solar time. Leap seconds are required to synchronize time standards
with civil calendars, thus keeping UTC time in sync with the earth’s rotation.

If it has been determined by the International Earth Rotation and Reference Systems Service
(IERS) that a Leap Second needs to applied, this time correction occurs only at the end of a UTC
month, and has only ever been inserted at the end of June 30 or December 31. A Leap Second
may be either added or removed, but in the past, the leap seconds have always been added
because the earth’s rotation is slowing down.

Historically, Leap seconds have been inserted about every 18 months. However, the Earth's
rotation rate is unpredictable in the long term, so it is not possible to predict the need for them
more than six months in advance.

Note: Leap seconds only apply to the “UTC” and “Local” timescales. Leap seconds
do not affect the “GPS” and “TAI” timescales.  However, a leap second event will
change the GPS to UTC and TAI to UTC offsets.  When a leap second occurs,
NetClock will automatically change these offsets by the proper amount, no matter
which timescale is currently being used by the system.

1Intercalary: (of a day or a month) inserted in the calendar to harmonize it with the solar year, e.g., February 29 in
leap years.
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NetClock can be alerted of impending leap seconds by any of the following methods:

GNSS Receiver (if available as an input reference)—The GNSS satellite system transmits
information regarding a Leap second adjustment at a specific Time and Date an arbit
rary number of months in advance.

Input references other than GNSS—Some of the other available input references (e.g.,
IRIG) can also contain pending Leap Second notification in their data streams.

Manual user input—NetClock can be manually configured with the date/time of the next
pending leap second. On this date/time, the System Time will automatically correct for
the leap second (unless the System Time’s timescale is configured as either GPS or TAI).

The date/time of a pending leap second can be set manually. See "Configuring a Leap
Second Correction" on page 170.

4.13.2 Leap Second Alert Notification
NetClock will announce a pending Leap Second adjustment by the following methods:

1. Data Formats 2 and 7 available from the ASCII Data option modules contain a Leap
Second indicator. During the entire calendar month preceding a Leap Second
adjustment, these Formats indicate that at the end of the current month a Leap
Second Adjustment will be made by using the character ‘L’ rather than a ‘_ ‘ [space]
in the data stream. Note that this does not indicate the direction of the adjustment as
adding or removing seconds. These formats always assume that the Leap Second
will be added, not removed.

2. NTP Packets contain two Leap Indicator Bits. In the 24 hours preceding a Leap
Second Adjustment, the Leap Indicator Bits (2 bits) which normally are 00b for sync
are 01b (1) for Add a Leap Second and 10b (2) for remove a Leap Second. The bit
pattern 11b (3) indicates out of sync and in this condition NTP does NOT indicate
Leap seconds. The Sync state indicates leap seconds by indicating sync can be 00b,
01b, or 02b.

Note: It is the responsibility of the client software utilizing either the Data Formats
or NTP time stamps to correct for a Leap Second occurrence. NetClock will make
the correction at the right time. However, because computers and other systems
may not utilize the time every second, the Leap second correction may be
delayed until the next scheduled interval, unless the software properly handles the
advance notice of a pending Leap Second and applies the correction at the right
time.

4.13.3 Leap Second Correction Sequence
The following is the time sequence pattern in seconds that NetClock will output at UTC midnight
on the scheduled day (Note: This is NOT local time midnight; the local time at which the adjust
ment is made will depend on which Time Zone you are located in).
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A. Sequence of seconds output when adding a second ("positive leap second"):

56, 57, 58, 59, 60, 0, 1, 2, 3 …

B. Sequence of seconds output when subtracting a second ("negative leap second"):

56, 57, 58, 0, 1, 2, 3, 4 …

4.14 Upgrades and Licenses

4.14.1 Software Updates
Spectracom periodically releases new versions of software for NetClock. These updates1 are
offered for free and made available for download from the Spectracom website. If you
register your product, you will be notified of software updates.

To download a software update for your NetClock as it becomes available, click here.

This web page also offers detailed instructions on how to perform a software update.

General Notes:

NetClock will save system configurations across upgrades but will not save other information. In
particular, update files may not be retained after a successful update.

All system elements will be forced to the versions in the update file, and all configuration inform
ation will be erased as part of the update. See "Backing-up and Restoring Configuration Files"
on page 180 for details.

To “roll back” system elements to an earlier version, select the older Update File in the Choose
File pull-down, select both Update System and Force Update, and click Update. All system ele
ments will be “forced” to the version in the update file.

Step-by-Step Instructions:

Note: These instructions apply to updates to recent software. Updates to software
versions older than 5.0.x may require additional steps. These will be covered in
the SWUI (Software Update Instructions) documents, which can be found under
the above-mentioned link.

1The terms update and upgrade are both used throughout Spectracom technical literature, as software releases may
include fixes and enhancements, as well as new features.
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1. In the Web UI, under Tools > Upgrade/Backup, determine the System software version
and the type of GNSS receiver. Proceed if your existing software is V5.1.5 or higher,
AND you have a RES-SMT GG receiver.
(Otherwise, consult the above-mentioned instructions for updating NetClock software.)

2. Free up disk space, if needed:
Under Tools > Upgrade/Backup > Disk Status, check Percent Used: If the number is
greater than 70%, free up disk space.
(NOTE: If required, existing logs can be archived; for details consult the above-men
tioned instructions for updating NetClock software.)
To free up disk space:

a. Delete old log files: Tools > Upgrade/Backup > Disk Status > Clear All Logs.

b. Delete old statistics files: [~] > Clear All Stats.

c. Delete previous Upgrade files: : Tools > Upgrade/Backup > Actions > Update
System > Delete Upgrade File(s). Note that Delete Upgrade File and Update Sys
tem cannot be selected at the same time.

3. Download the upgrade software bundle onto your PC.

4. Check if you have any of the following option cards installed:

Simulcast (Model 1204-14)

PTP (Model 1204-12)

Gigabit Ethernet (Model 1204-06)

If this is the case, see above-mentioned instructions for updating NetClock software
(unless this has been addressed at an earlier update).
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5. Perform the actual upgrade by navigating to TOOLS > Upgrade/Backup > Actions:
Update System File: Upload the upgrade software bundle previously downloaded onto
your PC (updateXYZ.tar.gz), and carry out the upgrade, as instructed.

6. Verify that the upgrade was successful: Tools > Upgrade/Backup, confirm the new SW
version.

Note: In case the update failed, see "Troubleshooting Software Update" on
page 326 for additional information.

4.14.2 Applying a License File
Software options—if available for your product—must be activated by applying a license file:

Typically, NetClock units are shipped with the license file pre-installed, reflecting the system con
figuration as ordered. If a feature is to be activated after delivery of the NetClock unit, please
contact Spectracom Support or your local representative to have a license file generated.
License files are archive files with a tar.gz extension. One license file may contain multiple
licenses for multiple products.

To apply the license file, you need to upload it into your NetClock unit and install it:

1. Save the license file license.tar.gz to a location on your PC (which needs to be
connected to the same network NetClock is.)

2. Open the NetClock Web UI, and navigate to Tools > Upgrade/Backup:

3. In the Actions panel, click Apply License File.

4. In the Apply License File window, click Upload New File.
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5. In the Upload File window, click Choose File. Using the Explorer window, navigate to
the location mentioned under the first step, select the license file, and monitor the install
ation progress in the Status Upgrade window until the application has rebooted.

6. Refresh the browser window, and login to the Web UI again. Re-navigate to Tools >
Upgrade/Backup, and confirm that the newly installed Option is listed in the System
Configuration panel.

4.15 Changing the Web UI Timeout
For security reasons, the Web UI will automatically timeout after a set number of minutes, i.e.
you will be logged out by the system, regardless of activity, and need to actively login again.

Minimum timeout duration: 10 minutes

Maximum timeout duration: 1440 minutes (24 hours)

Default timeout duration: 60 minutes.

To change the time after which the Web UI will timeout:

1. Navigate to the MANAGEMENT > NETWORK screen.

2. In the Actions panel on the left, click on Web Interface Settings.

3. In the Web Interface Settings window, enter the desired value in minutes.

In order for a new setting to take effect, you need to log off, and then log back on again. This
setting affects all users, i.e. not just the user changing the value.

4.16 Show Clock
To display a large screen clock instead of the Web UI, navigate to TOOLS > SYSTEM/Show
Clock:
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Next to the system status, the screen clock will display the UTC time, and the NetClock front
panel time (if the front panel time is configured to display UTC, then only UTC will be shown—
see image below).

To configure the front panel time, navigate to MANAGEMENT > OTHER/Front Panel, and
under Timescale/Local Clock select UTC, TAI, GPS, or a local clock (see also "Front Panel Con
figuration" on page 176).
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5 Option Modules

Option modules allow for custom configuration of NetClock 9483
(NetClock 9489 is not designed for the installation of option mod
ules—see "NetClock 9489 Outputs" on page 312 for information on
NetClock 9489 standard outputs).

This Chapter lists all option modules currently available, their fea
tures and specifications.

The following topics are included in this Chapter:

5.1 NetClock 9483 Option Modules 276
5.2 Option Modules Quick Reference 276
5.3 NENA-Compliant Module 282
5.4 Gigabit Ethernet Module [Option 16] 292
5.5 T1/E1 Out Module [Option 13] 294
5.6 PTP Module, [Option 12] 298
5.7 NetClock 9489 Outputs 312



5.1 NetClock 9483 Option Modules
Spectracom offers several configurations for the NetClock 9483. This section contains technical
details and specifications for option modules that may have been selected at the time of pur
chase, and information regarding configuration and usage that can be used after installation.

Also covered are commonly used Web UI procedures for the configuration of option modules,
and the status review of option module inputs and outputs.

Table 5-1: Option Modules available for NetClock 9483

Option
Name Module/PN Description Refer to Section

NENA 1209-1F NENA-Compliant Module "NENA-Compliant Module" on
page 282

Option 16 1209-06 Gigabit Ethernet (3X,
10/100/1000BaseT)

"Gigabit Ethernet Module [Option 16]"
on page 292

Option 13 1209-0A T1/E1 – (100/20 Ω) "T1/E1 Out Module [Option 13]" on
page 294

Option 12 1209-12 Precision Time Protocol (PTP)
Input/Output

"PTP Module, [Option 12]" on
page 298

Contact sales@spectracom.com general inquiries regarding option module card functionality
or availability.

If you do not have a NetClock 9483 product that already shipped pre-configured with specific
option modules, or if you have purchased new option modules for your NetClock 9483, refer
to the Option Card Installation Guide for NetClock 9400 Series document for detailed
installation steps.

5.2 Option Modules Quick Reference
This section describescommonly used Web UI procedures for the configuration of installed
options.
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5.2.1 Web UI Navigation: Option Modules

Figure 5-1: Option module navigation

To view or edit option module settings in the NetClock Web UI (see also image above):

Status Summary panel

Under INTERFACES/OPTION CARDS, clicking the superordinate list entry will open the
Status Summary panel, which provides a status overview, as well as access to the Status
window and the Edit window.

Status window

Under INTERFACES/OPTION CARDS, clicking subordinate (indented) entries will open
the Status window, providing detailed option module status information.

Edit window

To edit option module settings, either click the Edit button in the lower-left corner of the
Status window, or click the GEAR button in the Status Summary panel: The Edit window will
open.

5.2.2 Viewing Input/Output Configuration Settings
The configurable settings of any NetClock input or output interface can be viewed in its Status
window. The Status window can be accessed in several ways; the procedure below describes
the standard way:
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1. Identify the name of the option module, (e.g., NENA) and the name of the input or out
put you want to configure (e.g., ASCII Output 0).

Note: If you have only one input or output of any type, NetClock will num
ber that input or output 0. Additional inputs or outputs will be numbered 1
or above.

2. Navigate to the INTERFACES/OPTION CARDS drop-down menu, and click the list entry
of the option module identified above. The option module’s Status Summary panel
opens:

3. Click on the INFO button next to the input or output whose settings you wish to review.
The Status window of the input or output opens:

4. Information about the settings of a specific interface can be found in the corresponding
option module section, see "NetClock 9483—Available Option Modules" on page 16,
or "NetClock 9489 Outputs" on page 312.
If you want to change any of the settings shown in the Status window, click the Edit but
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ton in the lower-left corner, in order to open the Edit window:

5.2.3 Configuring Option Module Inputs/Outputs
The configurable settings of any NetClock input or output interface are accessible through the
Edit window of the option module to which the input or output belongs. The Edit window can
be accessed in several ways; the procedure below describes the standard way:

1. Identify the name of the card, (e.g., NENA), and verify the name of the input or output
you want to configure (e.g., ASCII Output 0).

Note: If you have only one input or output of any type, NetClock will num
ber that input or output 0. Additional inputs or outputs will be numbered 1
or above.

2. Navigate to the INTERFACES/OPTION CARDS drop-down menu, and click the list entry
of the option module identified above. The option module’s Status Summary panel
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opens:

3. Click on the GEAR button next to the input or output you wish to configure (as verified in
Step 1 of this procedure). The Edit window of the input or output opens:

4. Information about the settings of a specific interface can be found in the corresponding
option module section, see "NetClock 9483—Available Option Modules" on page 16,
or "NetClock 9489 Outputs" on page 312.

5.2.4 Viewing an Input/Output Signal State
To view if an input or output is currently enabled or disabled, go to the option module’s Status
Summary panel:
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1. Identify the name of the option module, (e.g., NENA), and the name of the input or out
put you want to configure (e.g., ASCII Output 0).

Note: If you have only one input or output of any type, NetClock will num
ber that input or output 0. Additional inputs or outputs will be numbered 1
or above.

2. Navigate to the INTERFACES/OPTION CARDS drop-down menu, and click the list entry
of the option module identified above. The option module’s Status Summary panel
opens:

All the inputs and/or outputs of this option module are listed in the Status Summary panel.

In accordance with the Signature Control setting, and the Lock Status, the current signal state for
an output is indicated as:

ENABLED (green); or

DISABLED (orange)

The current state of an input signal is indicated as:

VALID (in green); or

INVALID (in red)

The Status Summary panel will be refreshed automatically every 30 seconds. Click the Refresh
button (circling arrows) on the right to refresh the status instantaneously. A slight refreshment
delay is normal (the duration depends on the configuration of your system.)

5.2.5 Verifying the Validity of an Input Signal
The HOME Page of the NetClock Web UI provides quick access to the status of all inputs via its
Reference Status panel.
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If an INPUT is not present, or not valid, and qualified, the 1PPS Validity and Time Validity fields
will be “Not Valid” (orange).

If an INPUT is present, and the signal is considered valid, and qualified, the two indicators will
then turn “Valid” (Green).

5.3 NENA-Compliant Module
NetClock 9483 is equipped with a NENA-compliant module which provides:

IRIG support (including support for all NENA formats)

ASCII RS-232 time code support

ASCII RS-485 time code

relay/alarms.

Note: This module is not available for NetClock 9489.

5.3.1 NENA-Compliant Module: Specifications
Outputs: (1) IRIG B/E, IEEE

1344/C37.118-2005
(AM/TTL) 

(1) ASCII RS-232 (1) ASCII RS-485 (2)
Relay/Alarm
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Connectors: BNC (J1) DB9F (J2) 3.81 mm Terminal block (J3)

Accuracy: ±20 to ±200 μs of UTC,
format-dependent

±100-1000 μs
(format-dependent)

±100-1000 μs
(format-dependent)

Switch time
4ms, max.

Table 5-2: NENA module specifications

Figure 5-2: Rear plate of NetClock 9483 NENA-compliant module

5.3.2 IRIG Output Specifications

AM IRIG Output:

Output impedance: 50 Ω nominal

Amplitude (adjustable):

500 mVp-p min, 6Vp-p max into 50 Ω

1Vp-p min, 12 Vp-p max into > 600 Ω

AM Carrier:

IRIG A – 10 kHz

IRIG B – 1kHz

IRIG E – 100 Hz, 1kHz

IRIG G – 100 kHz

Modulation Ratio: 3.3:1 nominal

DCLS IRIG Output:

Signal Level: 0V to 4.3 V (TTL compatible) into 50 Ω

Output impedance of buffer is ~7 to 10 Ω
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5.3.3 ASCII RS-232 Specifications
Outputs: ±5VDC minimum, ±5.4 VDC typical

Signal Type and Connector: RS-232 DB-9F

RS-232 Input:

-25 VDC to +25 VDC

+0.6VIL min, +1.2VIL TYP

+1.5VIH TYP, +2.4VIH MAX

Input impedance > 3kΩ

RS-232 Output:

±5VDC minimum

±5.4 VDC typical

Output impedance 300 Ω, minimum

-13.2 VDC to +13.2 VDC

1PPS Output:

Signal level: 0V to 4.3 V (TTL compatible) into 50 Ω

Output impedance of buffer is ~7 to 10 Ω

Rise/fall times of ~20 nsec.

Pin Assignments

Figure 5-3: DB-9 connector "J2"

Pin No. Signal Name Function

Top row of 5 pins

1 PPS_OUT 1PPS output

2 SERIAL_OUT_TX RS-232 Transmit data

3 SERIAL_OUT_RX RS-232 Receive data

4 NC No connection
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Pin No. Signal Name Function

5 GND Ground

Bottom row of 4 pins

6 NC No connection

7 NC No connection

8 NC No connection

9 NC No connection

Table 5-3: ASCII RS-232 Output connector pin assignments

5.3.4 ASCII RS-485 and Alarms/Relays Specifications
Inputs/Outputs: (2) Two contact relay connections (NC, common, NO)

Signal Type and Connector: Terminal block
Contacts Switch under max. load of 30 VDC, 2A
Contacts rated to switch 220 VDC
Breakdown voltage of 1000 VDC between contacts
Switch time 4ms, max.

RS-485 Differential Output:

+1.65 V Typical Common Mode Output Voltage

2V min Differential Output Voltage Swing with 100 Ω load,
3.3 V Differential Output Voltage Swing, No Load, with ESD protection

Pin Assignments

Figure 5-4: RS-485 connector "J3"

Connector Pin Signal Direction Characteristics

1 RS-485 TX+ Out 0V to 3VDC differential, 120 Ω load

5.3  NENA-Compliant Module

CHAPTER 5 • NetClock User Reference Guide Rev. 12 285



Connector Pin Signal Direction Characteristics

2 RS-485 TX- Out 0V to 3VDC differential, 120 Ω load

3 GROUND N/A GROUND

4 Relay 1 NO Out Normally Open 30 VDC, 2A max. switching power

5 Relay 1 NC Out Normally Closed 30 VDC, 2A max. switching power

6 Relay 1 COMMON Out Common Contact 30 VDC, 2A max. switching power

7 Relay 2 NO Out Normally Open 30 VDC, 2A max. switching power

8 Relay 2 NC Out Normally Closed 30 VDC, 2A max. switching power

9 Relay 2 COMMON Out Common Contact 30 VDC, 2A max. switching power

10 GROUND N/A GROUND

Table 5-4: Relay/RS-485 outputs pin assignments

Note: The last device on each of the RS-485 remote output should be terminated
into 120 Ω. Auxiliary Spectracom equipment (such as wall display clocks) include
a 120 Ω resistor for termination.

5.3.5 Configuring the IRIG Time Code Output
Via INTERFACES  >   OUTPUTS [ or : INTERFACES  >  OPTION CARDS ], navigate to IRIG
Output 0. Depending on which path you take, you will need to click the GEAR button, or the
Edit button in order to open the Edit window.
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Note: If you have only one input or output of any type, NetClock will number that
input or output 0. Additional inputs or outputs will be numbered 1 or above.

The IRIG output Edit window offers the following configuration fields:

Signature Control: Used to control when the IRIG modulation will be present. This func
tion allows the modulation to stop under certain conditions; see also "Signature Control"
on page 197.

Format: Defines the desired IRIG output formatting. Available options include: IRIG A, B,
G, NASA-36, IRIG E (100 Hz or 1kHz)

Modulation: Changes the type of output signal modulation:

IRIG AM is an amplitude modulated output. The amplitude of the output is determ
ined by the value entered in the “Amplitude” field.

IRIG DCLS is a TTL modulated output.

Frequency: If AM modulation is chosen above, the frequency is offered. Otherwise No
Carrier is displayed.

Coded Expression: Defines the data structure of the IRIG signal, where:

BCD = Binary Coded Decimal

TOY = Time of Year
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CF = Control Field

SBS = Straight Binary Seconds

Control Function Field: IRIG signals have an optional section in the data stream that can
be used to include additional information (such as the present year, for example). This
field allows the Control Field section of the IRIG output to be defined. The available con
figurations are as follows:

RCC-2004: IRIG spec 200-04 specified a location for year value, if included in
this field.

IEE 1344 (C37.118-2005): IRIG B format with extensions. Control Field contains
year, Leap Second and DST information.

Spectracom Format: Year is included in Control Field but not in the same loc
ation as RCC-2004 output (year is offset by one position).

Spectracom FAA Format: A unique IRIG output Control Field that contains satel
lite lock status and time error flags.

NASA: A variant of IRIG B.

Time Scale: Used to select the time base for the incoming time code data. The entered
Timescale is used by the system to convert the time in the incoming data stream to UTC
time for use by the System Time. The available choices are:

UTC: Coordinated Universal Time ("temps universel coordonné"), also referred to
as ZULU time

TAI: Temps Atomique International

GPS: The raw GPS time as transmitted by the GNSS satellites (as of July, 2015,
this is 17 seconds ahead of UTC)

A local clock set up through the Time Management Page: This option will appear
under the name of the local clock you have set up. See "Setting up a Local Clock"
on page 172 for more information. Local timescale allows a Local Clock to apply
a time offset for Time Zone and DST correction.

Amplitude: The peak-to-peak output voltage level into a 600 Ω load is adjusted by enter
ing a digital control value in this field. The level adjustment has no effect on TTL outputs,
only on AM formats. The value of 128 will cause the Mark amplitude to be about 5Vp-p

into high impedance. A value of 200 results in an output amplitude of about 9Vp-p into
high impedance.

Note: These are nominal values only. Actual values will vary from unit to
unit. To adjust the level precisely, connect an oscilloscope to the output con
nector when adjusting.

Offset: Provides the ability to account for IRIG cable delays or other latencies in the IRIG
input. The Offset value is entered and displayed in nanoseconds (ns). The available
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Offset range is -500 to +500 ms.

Each IRIG code specifies a carrier frequency that is modulated to encode date and time, as well
as control bits to time-stamp events. Initially, IRIG applications were primarily military and gov
ernment associated. Today, IRIG is commonly used to synchronize voice loggers, recall record
ers, and sequential event loggers found in emergency dispatch centers and power utilities.

For more information on IRIG frequency and output specifications, see "IRIG Standards and
Specifications" on page 362.

5.3.6 Configuring an ASCII Time Code Output (RS-232 or RS-485)

Note: The process of configuring the ASCII Time Code output is independent of
the communications protocol.

Via INTERFACES > OUTPUTS [or: INTERFACES > OPTION CARDS], navigate to the ASCII Out
put you want to configure. Depending on which path you take, you will need to click the GEAR
button, or Edit button in order to open the Edit window:

Note: If you have only one input or output of any type, NetClock will number that
input or output 0. Additional inputs or outputs will be numbered 1 or above.

The Edit window offers the following configuration fields:

5.3  NENA-Compliant Module

CHAPTER 5 • NetClock User Reference Guide Rev. 12 289



Format Group: Determines the time code message format category (see also "ASCII Time
Code Data Formats" on page 336). Choices are:

None

NENA-Spectracom (Formats 0, 1, 2, 3, 4, 7, 8, 9, 1S)

NMEA (GGA, RMC, ZDA message)

BBC (Formats 1, 2, 3 PSTN, 4, 5 RMC)

ICD-153 (Buffer Box, Time Transfer, Current Status)

EndRun (EndRun Time Format, Endrun X Format)

Format: Once a Format Group has been selected, one or more Format fields may
appear, allowing you to select one or more time code Formats. For more information
on time code formats, see "ASCII Time Code Data Formats" on page 336.

The choice of format group determines t he format choices available in the Format
1, Format 2 and Format 3 fields.

Format 1: Selects either the first of up to three, or the only format message
to be output. See "ASCII Time Code Data Formats" on page 336 for a
description of available formats.

Format 2: Selects the second consecutive format message to be outputted.
Select “None” if only one output format is desired. See "ASCII Time Code
Data Formats" on page 336 for a description of available formats.

Format 3: Selects the third consecutive format message to be outputted.
Select “None” if only one output format is desired. See "ASCII Time Code
Data Formats" on page 336 for a description of available formats.

Signature Control: Used to control when the IRIG modulation will be present. This func
tion allows the modulation to stop under certain conditions; see also "Signature Control"
on page 197.

Output Mode: This field determines when the output data will be provided. The avail
able Mode selections are as follows:

Broadcast: The format messages are automatically sent out on authorized con
dition (Signature control), every second a message is generated in sync with the
1PPS.

Request (On-time): A format message is generated in sync with 1PPS after the con
figured request character has been received.

Request (Immediate): A format message is generated as soon as the request char
acter is received. As this selection does not correlate the output data to the on-time
point for the message, in Data Formats that do not provide sub-second inform
ation (such as Formats 0 and 1 whereas Format 2 provides sub-second inform
ation), it should be noted that the output data can be provided immediately, but a
time error could occur when using the on-time point of the message in addition to
the data for timing applications.
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Timescale: Used to select the time base for the incoming ASCII time code data. The
entered Timescale is used by the system to convert the time in the incoming ASCII data
stream to UTC time for use by the System Time. The available choices are:

UTC: Coordinated Universal Time ("temps universel coordonné"), also referred to
as ZULU time

TAI: Temps Atomique International

GPS: The raw GPS time as transmitted by the GNSS satellites (as of July, 2015,
this is 17 seconds ahead of UTC time)

A local clock set up through the Time Management Page: This option will appear
under the name of the local clock you have set up. Refer to "The Time Man
agement Screen" on page 166 for more information on how to configure and
read the System Time. Local timescale allows a Local Clock to apply a time offset
for Time Zone and DST correction.
The incoming input time information may be provided as local time, but System
Time may be configured as UTC time, so internal computations need to be per
formed. With the Timescale field set to “Local”, select the name of a previously cre
ated Local Clock. The Time Zone and DST rules, as configured in the Local Clock
will be applied to the front panel time display. See "Setting up a Local Clock" on
page 172 for more information on Local Clocks.

Note: The Timescale of the ASCII input (as configured in the ASCII time
source) must be set correctly, especially if other input references are
enabled.

Failure to configure the Timescale of the ASCII input correctly could result
in time jumps occurring in the System Time when input reference changes
occur. These time jumps could affect NTP and normal operation of the sys
tem.

Baud Rate: Determines the speed that the output port will operate at.

Data Bits: Defines the number of data bits for the output port.

Parity: Configures the parity checking of the output port.

Stop Bits: Defines the number of stop bits for the output.

5.3.7 Configuring the Relay/Alarm Output
To manage the alarm relays:

1. Via the INTERFACES > Alarm Output drop-down menu, navigate to the Alarm Output
entry for the card you wish to configure. Depending on the path taken, …

5.3  NENA-Compliant Module

CHAPTER 5 • NetClock User Reference Guide Rev. 12 291



… click Edit or the GEAR button to edit the Alarm Output settings, or

… click Status or the INFO button to view the current settings for the Alarm
Output:

2. The Alarm Type options displayed/to choose from are:

None: Will not output for an alarm.

Minor: Will output on a minor alarm.

Major: Will output on a major alarm.

5.4 Gigabit Ethernet Module [Option 16]
This option module provides NetClock with three 10/100/1000 Base-T network interfaces, in
addition to the standard 10/100 Base-T network interface.

5.4.1 Gigabit Ethernet Module: Specifications
Inputs/Outputs: (3) Gigabit Ethernet (10/100/1000 Base-T)

Connectors: RJ-45 (3x)

Management: Enabled or Disabled (NTP server only)

Maximum Number of Cards: 1

Ordering Information: 1204-06: Gigabit Ethernet (3X) Module
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Figure 5-5: 1204-06 option module rear plate

5.4.2 Accessing the Network Management Screen
In order to monitor and manage Ethernet on NetClock:

Via MANAGEMENT > NETWORK, navigate to the Network Management screen: On
the right, the Ports panel will display the available Ethernet ports, and their connection
status:

Eth0 is the built- in NetClock Ethernet port. Eth1 through eth3 are the ports provided by the
1204-06 card.

For information on managing Ethernet on NetClock, see "The Network Management Screen"
on page 48.

5.4.3 Routing Tables
There are five (5) routing tables in the system: one for each network interface, and one main
routing table.

Main Routing Table: This routing table is used when network traffic is generated from
the server. It will generally have the same default gateway as the routing table for eth0,
unless configured otherwise.

Interface Routing Tables: These routing tables are specific to each interface. They are
named t0 (for eth0 interface) though t3 (for eth3 interface).
The system is configured by default with rules to use the individual routing table for each
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interface for all network traffic being received or transmitted from or to the cor
responding interface. For example, when an NTP request is received on interface eth2, it
is tagged as such and the response will use routing table t2 when sending the NTP
response packet.
Each routing table has a default gateway that is used when there is no explicit routing
table entry that matches the destination address for a given network packet.

For information on configuring routing tables see "Adding Static Routes to the Routing Table"
on page 56, and see Spectracom Tech Note Routing of Data with Multiple Networks.

5.4.3.1 Domains and Domain Name Servers (DNS)

Each network interface may exist on a separate domain and therefore have a different domain
name and domain name servers from the other interfaces.

The system supports a single domain name and up to 2 DNS addresses per network interface.
These may be assigned via DHCP or configured manually via the Web UI configuration screen
for each network interface.

5.4.3.2 Configuring Ethernet Ports

For information on configuring Ethernet ports, see "Configuring Network Ports" on page 50.

5.5 T1/E1 Out Module [Option 13]
The E1/T1 option modules provide 1.544 MHz or 2.048 MHz and E1 or T1 data outputs for
the NetClock platform (NetClock 9483 only). NetClock meets G.812 Type I when installed with
a Rubidium option, and G.811 when installed with a Rubidium option and synchronized with
GNSS.

Note: Rubidium oscillators are recommended for the E1/T1 option module.

5.5.1 Module Option 13 E1/T1 (120 Ω): Specifications
Outputs:

(1) 1.544/2.048 MHz RS-485 Outputs

(2) Balanced E1/T1Outputs
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T1 mode:

1.544 MHz (square wave) frequency output

(2) 1.544 Mb/sec data rate outputs:

Outputs are DS1 framed all ones

Supports Super Frame (SF or D4) and Extended Super Frame (ESF)

SSM support

E1 mode:

2.048 MHz (square wave) frequency output

(2) 2.048 Mb/sec data rate outputs:

Outputs are E1 frame all ones

Supports CRC4 and CAS Multiframe

SSM support

Connector and Signal Type: Terminal block

1.544/2.048 MHz RS-485

T1 according to GR-499-CORE (100 Ω)

E1 according to ITU-T G703 (120 Ω)

Maximum Number of Cards: 4

Ordering Information: Option 13: T1/E1 (100/120 Ω) module

Figure 5-6: Option 13 T1/E1 module rear plate

Pin Assignments

Pin No. Signal Function Description

1 GND Ground Ground

2 1.544MHz/2.048MHz RS-485 A Terminal Square wave

3 1.544MHz/2.048MHz RS-485 B Terminal Square wave

4 GND Ground Ground

5 T1/E1 output A1 GR-499/G.703 Tip

6 T1/E1 output B1 GR-499/G.703 Ring
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Pin Assignments

Pin No. Signal Function Description

7 GND Ground Ground

8 T1/E1 output A2 GR-499/G.703 Tip

9 T1/E1 output B2 GR-499/G.703 Ring

10 GND Ground Ground

Table 5-5: Option 13 pin assignments

5.5.2 E1/T1 Output: Edit Window
To configure an E1/T1 data output , navigate to its Edit window. For instructions, see: "Con
figuring Option Module Inputs/Outputs" on page 279.

The Edit window allows the configuration of the following settings:

Signature Control: Controls when the output will be present. For more information, see
"Signature Control" on page 197.

Mode: This option selects T1, E1, or disabled mode. For T1 mode, the clock output will
be 1.544 MHz, and for E1 the clock output will be 2.048 MHz.

SSM Enabled: Enables or disables Sync Status Messaging (SSM). T1 SSM is not valid
with D4/Superframe or AIS framing. E1 SSM is not valid with AIS framing.

E1 Encode: HDB3 only.
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E1 Framing: This option selects the framing standard (CRC-4, No CRC-4, or AIS).

T1 Framing: This option selects the framing standard (D4/Superframe, Extended Super
frame [CRC-6/no CR C-6], or AIS).

T1 Encoding: This option selects the encoding method (B8ZS or AMI).

T1SSM Value: This option selects the SSM quality level transmitted when SSM is
enabled.

E1 SSM Value: This option selects the SSM quality level transmitted when SSM is
enabled.

5.5.3 E1/T1 Output: Status Window
To view the configuration settings of the E1 OUT or T1 OUT output, go to its Status window.
For instructions, see: "Viewing Input/Output Configuration Settings" on page 277.

The E1/T1 Output 0 Status Screen will vary according to whether the output signal mode is E1
or T1.

The Status windows display the following settings:

Signature Control: Controls when the output will be present; see "Signature Control" on
page 197.

Mode: This option selects T1, E1, or disabled mode. For T1 mode, the clock output will
be 1.544 MHz, and for E1 the clock output will be 2.048 MHz.

SSM Enabled: Enables or disables Sync Status Messaging (SSM). T1 SSM is not valid
with D4/Superframe or AIS framing. E1 SSM is not valid with AIS framing.

E1 Encoding: HDB3 only.

E1 Framing: This option selects the framing standard (CRC-4, No CRC-4, or AIS).

T1 Framing: This option selects the framing standard (D4/Superframe, Extended Super
frame [CRC-6/no CR C-6], or AIS).

T1 Encoding: This option selects the encoding method (B8ZS or AMI).
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T1 SSM Value: This option selects the SSM quality level transmitted when SSM is
enabled.

E1 SSM Value: This option selects the SSM quality level transmitted when SSM is
enabled.

5.6 PTP Module, [Option 12]
Precision Time Protocol (PTP) is a protocol that can be used to synchronize computers on an Eth
ernet network. The 10/100 PTP Master/Slave option module supports PTP Version 2, as spe
cified in the IEEE 1588-2008 standard (PTP Version 1 is not supported), via one (1) Ethernet
port.

The PTP option card implements a PTP Ordinary Clock that can be configured to run as:

A Master Clock, in which case it transmits PTP packets via the Ethernet port, with inform
ation about the current time and synchronization reference selected by NetClock.

A Slave Clock, in which case it provides to the NetClock device a time and syn
chronization reference retrieved from information carried by the PTP packets received
via the Ethernet port.

A Master/Slave Clock, in which case the PTP option card can change mode according
to priority and quality criteria compared with the other PTP Clocks on the network.

5.6.1 PTP Option Module: Specifications
Inputs/Outputs: (1) Configurable as Input or Output

Signal Type and Connector: RJ-45

Management: Web UI

Resolution: 8ns (±4ns) packet time stamping resolution

Accuracy: 30 ns accuracy (3σ) Master to Slave, via crossover cable

Networking speeds: 10 Mb/s, 100 Mb/s

Supported PTP Versions: PTP 2 (IEEE 1588-2008)

PTP Profiles supported: Default

Transmission modes: Unicast, Multicast [default]

Maximum Number of Cards: 4

Ordering Information: Option 12: PTP/Precision Timing Protocol Option Module
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Figure 5-7: Model 1204-12 option card rear plate

5.6.2 PTP I/O: Edit Window
1. To configure this option module, go to its Edit window. For instructions, see "Con

figuring Option Module Inputs/Outputs" on page 279.

Note: If you have only one input or output of any type, NetClock will number that
input or output 0. Additional inputs or outputs will be numbered 1 or above.

2. The PTP Edit window will display. It offers access to four different tabs, described below:
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5.6.2.1 Main tab settings

Settings to configure under the Main tab:

Transmission Mode: (See also: "Transmission Modes" on page 311)

Unicast

Multicast

Minicast

Clock Mode: The Master/Slave Mode of the PTP Module. Will be one of:

Slave

Master

Disabled

The default value is Slave.

Domain Number: Sets the current PTP Domain Number, as defined in IEEE Std 1588-
2008 Section 7.1. Range: [0,255]. Default setting: 0

Master Clock IP Address: Static IP address of the unicast Master Clock. In the format
“#.#.#.#” with no leading zeroes or spaces, where each ‘#’ is a decimal integer from
the range [0,255].

5.6.2.2 Ethernet tab settings

Settings to configure under the Ethernet tab:
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Transport Protocol: Selects the transport protocol used for PTP Packets. Possible values
are:

IPv4 (The default): Internet Protocol version 4 (Layer 3 protocol).

802.3/Ethernet: IEEE802.3/Ethernet Protocol (Layer 2 protocol).

Operating limitations: The IEEE802.3/Ethernet Protocol is not supported in Unicast trans
mission mode.

Enable DHCP: This is a checkbox to enable or disable the delivery of IP addresses from
a DHCP Server. The default setting is enabled (the box is checked).

Static IP Address: When a DHCP server is not requested or is requested but not avail
able, the PTP Module will use this IP address. In the format “#.#.#.#” with no leading zer
oes or spaces, where each ‘#’ is a decimal integer from the range [0,255].

Network Mask: When a DHCP server is not requested or is requested but not available,
the PTP Module will use this Network Mask. In the format “#.#.#.#” with no leading zer
oes or spaces, where each ‘#’ is a decimal integer from the range [0,255].

Default Gateway: When a DHCP server is not requested or is requested but not avail
able, the PTP Module will use this Default Gateway. In the format “#.#.#.#” with no lead
ing zeroes or spaces, where each ‘#’ is a decimal integer from the range [0,255].

5.6.2.3 Contract tab settings

Note: The settings under this tab only apply to Unicast Mode.

Settings to configure under the Contract tab:

Min Sync Interval: The minimum value of Sync interval granted by the Master Clock. In
packets per second.

Max Sync Duration: The maximum value of Sync interval granted by the Master Clock.
In seconds.

Min Announce Interval: The minimum value of the Announce interval granted by the
Master Clock. In packets per second.

Max Announce Duration: The maximum value of the Announce interval granted by the
Master Clock. In seconds.

Min Delay_Req Interval: In packets per second.

Max Delay_Req Duration: In seconds.

Max Slaves: The maximum number of slaves the card will serve.

5.6.2.4 Advanced tab settings

Settings to configure under the Advanced tab:
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Synchronization Mode: Determines the number of steps in the PTP protocol. Will be
either 1-Step Mode, or 2-Step Mode.

Delay Mechanism: Determines how the protocol calculates delay [Default: End-to-End]

Time-To-Live (Packet Lifespan): Ethernet characteristic, determining the number of routers
a packet will go through [Spectracom default: 64].

Name: Assign a name to this option card (Note: Used only by Managament Profile]

Location: Assign a location to this option card (Note: Used only by Managament Profile]

5.6.3 PTP Master/Slave [-12]: Status Window
To view the status of a PTP interface, go to its Status window. For instructions, see "Viewing
Input/Output Configuration Settings" on page 277.

The GB PTP Status window contains two tabs: Main and Advanced.

5.6.3.1 Main tab: Status information

The Main tab provides the following information:
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Ethernet Status: Whether the module is connected to a network through Ethernet.

Green=Connected. The speed of the connection is indicated.

Orange=Not connected.

Status: Master/Slave mode of the card.

Transmission/Clock Mode: Transmission mode and master/slave mode.

Domain Number: The current PTP Domain Number.

Current IP Address: The IP address currently being used by the PTP interface.

MAC Address: The MAC address currently being used by the PTP interface.

5.6.3.2 Advanced tab: Status information

The Advanced tab provides the following information:

Time Properties:

UTC Offset: The Master’s current offset between UTC time and TAI time. Units: seconds.

UTC Offset Valid: Indicates whether or not the Master’s UTC Offset is valid.

Leap Second: The Leap second correction as set on the Time Management page.

Time Traceable: Indicates whether the Master’s time is traceable (Enabled) to a primary
reference or not (Disabled).

Frequency Traceable: Indicates whether the Master’s Frequency is traceable (Enabled) to
a primary reference or not (Disabled).
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PTP Time Scale: Indicates the timescale that the Master is using to broadcast its time. TAI
is the default PTP timescale.

Time source: The Time Source that the Master is using. Refer to IEEE Standard 1588-
2008, Section 7.6.2.6.

Clock Quality

Clock Accuracy: A number describing the accuracy of the oscillator in the Master rel
ative to its UTC reference. (See IEEE Standard 1588-2008, Section 7.6.2.5).

Offset Scaled Log Variance: (Defined in IEEE Standard 1588-2008, Section 1.6.3)

Clock Class: A number describing the state of the time and 1pps references of the PTP
Clock.
Refer to the following table for Clock Class information (see IEEE standard 1588-2008,
Table 5, Section 7.6.2.4).

PTP
Time
Scale

Arbitrary
Time
Scale

Clock Class Definition

6 13 Time and 1pps references are synchronized with the host references and PTP clock shall
not be a slave to another clock in the domain.

7 14 Time and 1pps references are in holdover state, within specifications and PTP clock shall
not be a slave to another clock in the domain.

52 58 Time and 1pps references are in holdover state, not within specifications, and PTP clock
shall not be a slave to another clock in the domain. Then, applied to Master Clocks who
have just powered on and have not yet achieved a suitable TFOM value.

187 193 Time and 1pps references are in holdover state, not within specifications, and PTP clock
may be a slave to another clock in the domain.

255 255 Class assigned to “Slave-Only” clocks.

248 248 “Unknown” class.

Table 5-6: Clock Class definitions

Ethernet Status

Current IP Address: The IP address currently being used by the PTP interface.

Note: If the PTP Module is set up for DHCP but fails to obtain an IP
address, it will use the Static IP instead. To reacquire a DHCP address,
reset the module via the Main tab in the PTP settings window.

Current Network Mask: The Network Mask currently being used by the PTP interface.

Current Gateway: The Gateway address currently being used by the PTP interface.
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Port Status

Port Number: The PTP Port Number, as defined in the IEEE 1588-2008 Specification,
Section 7.5.2.3. Always set to 1 for our Ordinary Clock.

Port Activity: Reports whether or not the network interface is active for PTP (Enabled) or
not (Disabled).

Port State: Reports the current state of the PTP State Machine:

Disabled: PTP Ethernet port is Disabled. See PTP Setup/Network page, PTP Net
work Settings options.

Initializing: Ethernet link is unplugged/PTP Module is in power-up state. A Master
Clock doesn’t leave this state while it can’t get the current time and syn
chronization references from the NetClock to synchronize with it.

Listening: PTP module is looking for a Master Clock.

Master: PTP Master has become the active Master Clock on the network.

Passive: PTP Module has become a Passive Master Clock. (There is another
Master Clock on the network with better quality or higher priority). This Master
will wait until the Best Master Clock Algorithm determines it should become the
best Master Clock, and then it will transition to the Master Clock state.

Uncalibrated: PTP Slave has selected a Master Clock on the network attempts to
synchronize with it using sync packets.

Link Status: Indicates whether or not the Ethernet link for PTP is active (Connected) or not
(Disconnected).

Slave Sync Mode: Determines the number of steps in the PTP protocol. Will be one of
the following:

Two-Step Mode

One-Step Mode

Note: One-Step mode is not supported with the Peer-to-Peer Delay
Mechanism.

The current implementation of one- step mode involves a software- oriented
timestamping. Two- step mode implements a hardware oriented timestamping,
insensitive to software execution time variations. Two- step mode is
recommended, as it increases the PTP Clock’s accuracy.

Note: Peer- to-Peer Delay Mechanism is only applicable on networks equipped
with Transparent Clocks (switches/routers IEEE 1588 compatible). Peer- to- Peer
Delay Mechanism is not supported in Unicast transmission mode.
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Grandmaster Properties

Reports information from the current Grandmaster Clock. If the PTP Module is currently a
Master, this will report information on the current module.

Clock Identity: Displays the clock identity of the current Grandmaster Clock on the net
work.

Clock Class: A number describing the state of the clock (see Table 5 of Section 7.6.2.4
of IEEE Standard 1588-2008).

Clock Accuracy: A number describing the accuracy of the oscillator in the Grandmaster
Clock (see IEEE Standard 1588-2008, Section 7.6.2.5).

Offset Scaled Log Variance: See IEEE Standard 1588-2008 Section 7.6.3.

Priority1: See IEEE Standard 1588-2008, Section 7.6.3.

Priority2: See IEEE Standard 1588-2008, Section 7.6.3.

Slave Properties

Negotiation Enabled: Reports whether the Unicast Negotiation option is Enabled or Dis
abled.

Contract State: Reports the unicast contract state.

NEGO_OFF: Unicast negotiation option is Disabled.

NEGO_ON: Unicast negotiation option is Enabled.

REQUESTED: Unicast contract has been requested to the PTP Master.

GRANTED: Unicast contract has been granted by the PTP Master.

RENEWED: Renewal of the unicast contract has been requested to the PTP Master.

CANCELED: Cancellation of the unicast contract has been requested to the PTP
Master.

Contract Duration: Duration of the unicast contract. Units: Seconds.

Contract Delay: Delay before the end of the unicast contract. Units: Seconds.

Message Interval: Announce Interval negotiated for the unicast mode. Units: log2
seconds.

Contract State: Reports the unicast contract state (see above ‘Announce Contract State’).

Contract Duration: Duration of the unicast contract. Units: Seconds.

Contract Delay: Delay before the end of the unicast contract. Units: Seconds.

Message Interval: Sync Interval negotiated for the unicast mode. Units: log2 seconds.

Contract State: Reports the unicast contract state (see above ‘Announce Contract State’).

Contract Duration: Duration of the unicast contract. Units: Seconds.

Contract Delay: Delay before the end of the unicast contract. Units: Seconds.
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Log Message Interval: Delay_Resp Interval negotiated for the unicast mode. Units: log2
seconds

Master Properties

Unicast Negotiation: Reports whether the Unicast Negotiation option is Enabled or Dis
abled.

Number of Slave Clocks Connected: Number of PTP Slaves that have been granted by
the PTP Master to run in unicast mode.

Module Info

PTP Version: Current version of PTP being used.

Software Version: Current software revision level

Hardware Version: Current hardware revision level.

Software Compilation Date: Date the software was compiled.

Software Compilation Time: Time the software was compiled

5.6.4 Configuring the PTP I/O Module

5.6.4.1 Configuration as a Slave Clock

By default, the PTP card is configured to function as a Multicast PTP Slave, which allows a NetC
lock to be able to synchronize to a Multicast PTP Master (such as another NetClock unit with a
PTP module option card configured as a Master) when configured with the following para
meters:

Announce Interval = once every 4 seconds or faster (This is set in the PTP Edit window,
under the Contract tab).

Delay Mechanism = End-to-End (This is set in the PTP Edit window, under the Advanced
tab).

Transmission Mode = Multicast (This is set in the PTP Edit window, under the Main tab).

Synchronization Mode = Two-Step Mode faster (This is set in the PTP Edit window,
under the Advanced tab).

When first connected to a network that contains an active Master Clock, it may take up to a
minute for the Port State to change to the “slave” state. After that, it will take up to two minutes
for the PTP connection to be accepted as a valid reference by NetClock.

If NetClock is not entering the “Slave” Port state (as reported by the Main tab on the PTP Status
page), check the following:

From the PTP Status window under the Main tab, check that Ethernet Status indicates
“Connected.”
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From the PTP Status window under the Advanced tab, check that Port Activity indicates
“Enabled.”

From the PTP Status window under the Main tab, check that the Ethernet Status indicates
a speed of 100 Mb/s.

From the PTP Status window under the Main tab, check that the clock is set to be a Slave
Only.

From the PTP Status window under the Main tab, check that the Transmission/Clock
Mode is a Slave mode and that multicast/unicast/minicast state is correct.

Check that the Ethernet Transport Protocol set for the Slave Clock is the same as the
Transport Protocol of the Master Clock to which the Slave Clock must be synchronized
with. (Check the Transport Protocol on the PTP Edit window, under the Ethernet tab.)

Check that the Domain Number set for the Slave Clock is the same as the Domain Num
ber of the Master Clock to which the Slave Clock must be synchronized with. (Check the
Domain Number on the PTP Status window, under the Main tab.)

From the PTP Status window, under the Advanced tab, check that the Current IP Address
is valid.

From the PTP Edit window under the Advanced tab, check that the Time To Live (TTL) for
PTP packets is compatible with the network.

If in Multicast mode, check that the switches/routers are transparent to multicast frames

From the PTP Status window under the Advanced tab, check that the Clock Class is
“Master, In Sync.”

Note: If DHCP is enabled and PTP was not successful in obtaining an IP address,
DHCP will need to be restarted to retry. To restart DHCP:

1. In the PTP Edit window under the Ethernet tab, select the Enable DHCP checkbox.

2. Click the Submit button at the bottom of the window.

5.6.4.2 Configuration as a Master Clock

To configure the IEEE-1588 (PTP) Module as a Master Clock, perform these steps:

General configuration steps:

Ensure the PTP port is connected to the network (check the Link Status in the PTP
Status/Network page).

Ensure the PTP port speed is 100 Mb/s (check the Port Speed in the PTP Status page
under the Advanced tab).

Be sure that valid time and 1PPS references are currently selected (go to
MANAGEMENT/OTHER/Time Management).
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In order to operate properly as a Master Clock, NetClock must be synchronized to a non-PTP
reference. Confirm that the chosen reference transmits the following information (as reported
by the Time Properties on the PTP Status page, under the Advanced tab):

The proper TAI or UTC time (including the current year)

The current TAI to UTC offset (required even if the reference’s time is in TAI)

Pending leap second information at least a day in advance.

If the reference does not transmit this information, it must be provided by the user in order for
the Master Clock to function properly.

The built-in GNSS reference provides all information needed with no user intervention.

PTP-specific configuration steps:

Confirm that:

From the PTP Status window under the Advanced tab, check that PTP Port Activity is
enabled (if not, enable it from the PTP Edit window, under the Ethernet tab).

From the PTP Edit window under the Main tab, check that the clock is set to be a Master.

From the PTP Status window under the Main tab, check that a valid IP address is cur
rently being used.

When the PTP Module is set to be a Master Clock, the module will immediately attempt to
become the active Master Clock on the network (Port State = Master). If it does, it will start to
transmit PTP packets (even if the NetClock is not yet synchronized).

There are several reasons why the PTP Module may not become the active Master Clock, or
may not be broadcasting the correct time, even if it is set to be a Master Clock:

a. If using any reference other than self for 1PPS, the NetClock will not become an active
Master Clock until the Time Figure of Merit (TFOM) value of the system is less than 15.
After first going into sync after power-up, it may take a minute or two for the Time Figure
of Merit (TFOM) value to fall to an acceptable level. The current Time Figure of Merit
(TFOM) value is available in the Time Properties panel under the Advanced tab on the
PTP Status window page.

b. PTP uses the TAI timescale to transfer time. Many timing references communicate time in
the UTC timescale. UTC is offset from TAI by a small amount which changes every time a
leap second occurs. The TAI to UTC Offset is part of the PTP Specification and must be
provided to a Master Clock. If no active reference can provide that information, the off
set must be provided by the Host. The TAI to UTC Offset can be set from the
MANAGEMENT/OTHER/Time Management page (while setting the GPS to UTC Off
set).

c. The PTP Protocol also provides for the transfer of Leap Second information. If the active
time reference does not provide Leap Second information, it must be added by the user
through the MANAGEMENT/OTHER/Time Management page. If this is not done, the
PTP network will have the incorrect UTC time after a leap second event.

d. If there are multiple multicast Master Clocks on the network, the PTP Module uses the Best
Master Clock (BMC) algorithm specified in the PTP Specification to decide whether or
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not to become the active Master Clock. The BMC algorithm selects the Best Master Clock
on the network from the following criteria:

i. The BMC algorithm first selects the clock having the higher Priority1 parameter (a
lowest value means a higher priority)

ii. If the BMC cannot be determined from the previous parameter, the BMC
algorithm selects the clock having the higher Clock Quality (Clock Class, Clock
Accuracy, Clock Variance)

iii. If the BMC cannot be determined from the previous parameters, the BMC
algorithm selects the clock having the higher Priority2 parameter

The Master Clock selected by the BMC algorithm as the Best Master Clock will transition into the
Master state to become the active Master Clock on the network. It will then start to transmit Sync
packets to the Slave Clocks. The other Master Clocks will transition into the Passive state.

5.6.4.3 Configuring Unicast Mode

For information on Unicast mode, see "Transmission Modes" on the facing page.

The unicast mode is activated at the initiative of the Slaves. Each Slave, which wants to run in
unicast mode, shall first negotiate unicast contracts with the Master.

To enter the Unicast mode, perform the following steps:

On the Master side:

In the PTP Edit window under the Main tab, select Multicast for the Transmission Mode.
Enable the Unicast mode.

On the Slave side:

In the PTP Edit window under the Main tab, select Multicast for the Transmission Mode.
Enable the Unicast mode.

When the Master Clock is set in multicast mode, this one will deny the requests from the Slaves
Clocks to run in Unicast mode.

When the Master Clock is set in Unicast mode, it does not transmit any PTP messages until a
Slave has been granted to run in Unicast mode.

The Model 1204-12 card can grant up to 128 Unicast contracts (i.e., it can handle up to a total
of 128 PTP clients). [Note that the 1204-32 Gb PTP card can handle up to 4000 Unicast con
tracts.]

The Model 1204-12 does not support mixing Unicast and Multicast clients on the same domain
(Unlike the 1204-32 Option Card). When using the 1204-12 PTP card with Unicast clients, all
clients need to be configured to use Unicast mode.

Note: The Unicast mode is only implemented for the following PTP packets:

- Announce
- Sync and Follow-Up
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- Delay_Req and Delay_Resp

5.6.4.4 Configuring Master/Slave Mode

The PTP Master/Slave option card [-12] also supports a combined Master/Slave mode. The
Master/Slave mode works best in a NetClock which is not synchronized to any other reference.
When the module is plugged into the PTP network, it will become a slave to the Best Master
Clock on the network.

If all Master Clocks are removed from the network, the NetClock containing the Master/Slave
module will go into Holdover mode. However, the module will use that Holdover time to
become the Best Master Clock on the network, and it will provide time to the network until the
NetClock’s Holdover Timeout expires. If another Master Clock comes online and becomes the
Best Master Clock, the Master/Slave module will become a Passive Master Clock until the NetC
lock’s Holdover Timeout expires.

For more information on Holdover Mode, refer "Holdover Mode" on page 192.

Note: The Master/Slave mode is NOT supported in Unicast transmission mode.

5.6.4.5 Configuring Minicast Mode

For information on Minicast mode, see "Transmission Modes" below.

On the Master side:

In the PTP Edit window under the Main tab, select Multicast for the Transmission Mode.
Enable the Minicast mode.

On the Slave side:

In the PTP Edit window under the Main tab, select Multicast for the Transmission Mode.
Enable the Minicast mode.

5.6.5 Transmission Modes

Multicast Mode

This is the default mode. PTP packets are transmitted to all PTP Clocks by means of multicast IP
addresses dedicated to the PTP protocol (224.0.1.129, 224.0.0.107). PTP packets received by
the PTP Clocks are then filtered from the Domain Number, the Port Identity (Clock Identity + Port
Number) of the transmitter, the packet identifier (Sequenced).
When the Master Clock is set in multicast mode, this module will deny the requests from the
Slaves Clocks to run in unicast mode.

When the Master Clock is set in Unicast mode, it doesn’t transmit any PTP messages until a
Slave has been granted to run in unicast mode.
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Unicast Mode

This is a Point-to-Point transmission mode between two PTP Clocks by means of the unique IP
address assigned to each PTP Clock.

Note: The Unicast mode is only implemented for the following PTP packets:

- Announce
- Sync and Follow-Up
- Delay_Req and Delay_Resp

The Unicast mode is activated at the initiative of the Slaves. Each Slave, which wants to run in
unicast mode, shall first negotiate Unicast contracts with the Master.

Minicast/Hybrid Mode

 The Minicast/Hybrid mode is a method to minimize the PTP packets payload on the network,
where:

The transmissions initiated by the Master (Announce, Sync/Follow-Up) run in multicast
mode.

The transmissions initiated by the Slaves (Delay_Req/Delay_Resp) run in unicast mode.

5.7 NetClock 9489 Outputs

Figure 5-8: Rear panel NetClock Model 9489

5.7.1 1PPS Output
The NetClock 9489 1PPS Output is identical to the NetClock 9483. See "1PPS Output" on
page 13.

5.7.2 ASCII RS-485 Outputs
NetClock 9489 provides two (2) ASCII RS-485 Outputs.
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Table 5-7: ASCII RS-485 pin assignment

Pin Signal Function

1 RS-485 TX+ ASCII Output 1

2 RS-485 TX-

3 GND

4 RS-485 TX+ ASCII Output 2

5 RS-485 TX-

6 GND

5.7  NetClock 9489 Outputs

CHAPTER 5 • NetClock User Reference Guide Rev. 12 313



BLANK PAGE.

5.7  NetClock 9489 Outputs

314 CHAPTER 5 • NetClock User Reference Guide Rev. 12



CHAPTER 6 • NetClock User Reference Guide 315

C
H

A
PT

ER
6 Troubleshooting

The front panel LEDs and the Web UI provide NetClock status inform
ation that can be used to help troubleshoot failure symptoms that
may occur.

The following topics are included in this Chapter:

6.1 Troubleshooting Using the Status LEDs 316
6.2 Troubleshooting: System Configuration 318
6.3 Troubleshooting – Unable to Open Web UI 318
6.4 Troubleshooting via Web UI Status Page 319
6.5 Troubleshooting GNSS Reception 321
6.6 Troubleshooting – Keypad Is Locked 321
6.7 Troubleshooting – 1PPS, 10 MHz Outputs 322
6.8 Troubleshooting – Blank Information Display 323
6.9 Troubleshooting the Front Panel Serial Port 324
6.10 Troubleshooting the Front Panel Cooling Fan 325
6.11 Troubleshooting – Network PCs Cannot Sync 325
6.12 Troubleshooting Software Update 326



6.1 Troubleshooting Using the Status LEDs
The front panel Status LEDs can provide “local” status information about NetClock. Observe the
front panel Status LEDs and use the table below to find the recommended troubleshooting steps
or procedure for the observed condition.

LED Current
Status Indication Troubleshooting

Power LED is
blank
(not lit).

NetClock has no AC and/or DC
input power applied.

1) Verify AC power is connected to an AC source
and AC power switch is ON.
2) Verify DC power (within the correct voltage
range, as stated on the DC connector) is applied
to the DC power connector.
3) See "Unpacking and Inventory" on
page 21

Sync LED is
off

No valid Reference inputs avail
able since power-up.

1) Make sure the Input Reference Priority table has
the desired inputs enabled, based on desired pri
ority.
2) Make sure the desired input references are con
nected to the correct port of NetClock.
3) See "Configuring Input Reference Pri
orities" on page 152

Sync LED is
orange

Holdover mode: All available
inputs have been lost.

1) Make sure the Input Reference Priority table still
has the desired inputs enabled, based on desired
priority. See "Configuring Input Reference Pri
orities" on page 152.
2) Make sure desired input references are still con
nected to the correct port of NetClock.
4) Verify GNSS antenna installation (if applic
able).
See "Troubleshooting GNSS Reception" on
page 321.

Sync LED is
red

Time Sync alarm: NetClock was
just powered-up and has not yet
synced to its references. Or, all
available reference inputs have
been lost and the Holdover mode
has since expired.

Note: If NetClock was just recently powered-up or
rebooted and input references are applied, no
troubleshooting may be necessary. Allow a few
minutes for the input reference to be declared valid
(allow 35 – 40 minutes for a new install with
GNSS input).
1) Make sure the Input Reference Priority table still
has the desired inputs enabled, based on desired
priority. Refer to "Configuring Input Reference
Priorities" on page 152.
2) Make sure desired input references are still con
nected to the correct port of NetClock.
3) Verify GNSS antenna installation (if applic
able). Make sure the antenna has a clear view of
the sky.
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LED Current
Status Indication Troubleshooting

Fault LED is
blinking
orange

GNSS Antenna problem alarm is
asserted

1) Verify GNSS antenna is connected to NetClock
GNSS input connector

2) Check antenna cable for presence of an open
or a short. Refer to XXX for additional information.

Fault LED is
solid
red

Major alarm is asserted Refer to XXX

Fault LED is
solid
orange

Minor alarm is asserted Refer to XXX

Table 6-1: Troubleshooting NetClock, using the front panel Status LED indications

6.1.1 Minor and Major Alarms

Major Alarm

There are several conditions that can cause the front panel Fault lamp, or Web UI status lights to
indicate a Major alarm has been asserted. These conditions include:

Frequency error: Indicates a jump in the oscillator’s output frequency has been detected.
Contact Tech Support for additional information.

1PPS is not in specification: The 1PPS input reference is either not present or is not qual
ified.

System Sync: A Major alarm is asserted when the Timing System is not in sync (Input ref
erences are not available and the unit is not in Holdover). Examples of not being synced
include:

When the Timing System has just booted-up and has not yet synced to a ref
erence.

When all input references were lost and Holdover Mode has since expired.

Timing System Error: A problem has occurred in the Timing System. Contact Spectracom
technical support if the error continues.

Minor Alarm

There are several conditions that can cause the front panel Fault lamp, or Web UI status lights to
indicate a Minor alarm has been asserted. These conditions include:

Too few GPS satellites, 1st threshold: The GNSS receiver has been tracking less than the
minimum number of satellites for too long of a duration. Refer to "Troubleshooting
GNSS Reception" on page 321 for information on troubleshooting GNSS reception
issues.

6.1  Troubleshooting Using the Status LEDs

CHAPTER 6 • NetClock User Reference Guide Rev. 12 317



6.2 Troubleshooting: System Configuration
One of the first tasks when troubleshooting a unit is to read out the current system configuration
(you may also be asked for this when contacting Spectracom Technical Support.)

Select TOOLS > Upgrade/Backup: The screen displayed will provide information on:

System configuration

Disk status, memory status

Software versions, and

Recent log entries.

6.2.1 System Troubleshooting: Browser Support
Spectracom recommends using one of the following Web browsers to run the NetClockWeb UI
on: Google Chrome, Mozilla Firefox, Internet Explorer > Ver. 8.

Using different or older browsers may lead to some incompatibility issues.

6.3 Troubleshooting – Unable to Open Web UI
With NetClock connected to either a stand-alone or networked PC and with the network con
figuration correct, it should be possible to connect to the Web UI.
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Verify Current Status Indication Troubleshooting

LEDs on
network
connector

Green “Good link”
is not solid green

NetClock ICMP test
is failing. NetClock
is not connected to
PC via Ethernet con
nection

1) Verify one end of standard network cable is
connected to NetClock’s Ethernet port and other
end is connected to a hub/switch. Or a network
cable is connected to NetClock and a stand-
alone PC.
2) Verify network settings of NetClock are valid
for the network/PC it is connected with (IP
address is on the same subnet as the other PC).

Green “Good Link”
is solid green on
both NetClock and
other end of network
cable.

NetClock ICMP test
is passing. NetClock
is connected to PC
via Ethernet con
nection

1) Disconnect NetClock’s network cable and
ping its assigned address to ensure no response
(no duplicate IP addresses on the network).
2) Try accessing NetClock from another PC on
the same network.
3) Network Routing/firewall issue. Try con
necting directly with a PC and network cable.

Table 6-2: Troubleshooting network connection issues

6.4 Troubleshooting via Web UI Status Page
NetClock’s Web UI includes pages that provide current “remote” status information about NetC
lock. The following table includes information that can be used as a troubleshooting guidance
if status fault indications or conditions occur.

Web UI Page loc
ation Current Status Indication Troubleshooting

HOME page, Sys
tem Status panel,
Status row

SYNC indicator is not “lit”
(not Green).HOLD indic
ator is “lit” (Orange).—
OR—FAULT indicator is
“lit” (Red). Below the Sys
tem Status panel there is an
Out of Sync alarm state
ment

NetClock is in
Holdover
mode—OR—
NetClock is now
out of Time Sync

All available Input References have
been lost. The Reference Status table
on the HOME page will show the cur
rent status of all inputs (Green is valid
and Red is invalid or not present).
1. Make sure the Input Reference Pri
ority table still has the desired ref
erence inputs Enabled, based on the
desired priority. See "Configuring
Input Reference Priorities" on
page 152.
2. Make sure the desired input ref
erences are still connected to the cor
rect input port of NetClock.
3. Verify GNSS antenna installation (if
applicable). See "Troubleshooting
GNSS Reception" on page 321.
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Web UI Page loc
ation Current Status Indication Troubleshooting

HOME page, Sys
tem Status panel,
Power row

AC and/or DC indicator is
red instead of greenNOTE:
The AC indicator will only
display on the HOME
screen if NetClock is
equipped with an AC
power input.The DC indic
ator will only display on
the HOME screen if NetC
lock is equipped with a DC
power input.

Specified AC
and/or DC input
power is not
present.

Refer to Section "Power Con
nection" on page 27 for AC and
DC power connection information:
If AC indicator is red:
1. Verify AC power cord is connected
to an AC outlet.
2. Verify AC power input switch is ON.
3. Check the two fuses in the AC
power module.
If DC indicator is red:
1. Verify DC power source is within
range specified at the DC power con
nector.
2. Verify DC power is present at the
input connector.
3. Verify DC input polarity.

MANAGEMENT/
NTP Setup page

NTP Status Sum
mary panel

Stratum row

Stratum 15 NTP is not syn
chronized to its
available input
references
(NetClock may
have been in
Holdover mode,
but Holdover
has since
expired without
the return of
valid inputs)

Note: If NetClock was just recently
powered-up or rebooted and input ref
erences are applied, no troubleshoot
ing may be necessary. Allow at least
10-20 minutes for the input references
to be declared valid and NTP to align
to the System Time (allow an addi
tional 35-40 minutes for a new install
with GNSS input).
1. Verify in the Configure Reference Pri
orities table that all available ref
erences enabled. See "Configuring
Input Reference Priorities" on
page 152.
2. Verify that the Reference Status on
the HOME page shows “OK” (Green)
for all available references.
3. Verify NTP is enabled and con
figured correctly. See "NTP Stratum
Configuration" on page 129.

MANAGEMENT/
NETWORK page

Cannot login or access the
Web UI.

The following
error message is
displayed:
“Forbidden You
don’t have per
mission to
access/ on this
server”

This message is displayed when any
value has been added to the Network
Access Rules table and your PC is not
listed in the table as an Allow From IP
address.To restore access to the
Web UI, either
1. Login from a PC that is listed as an
Allow From in this table; or
2. If it is unknown what PCs have been
listed in the Access table, perform an
unrestrict command to remove all
entries from the Network Access Rules
table. This will allow all PCs to be able
to access the Web UI.
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Table 6-3: Troubleshooting using the Web UI Status indications

6.5 Troubleshooting GNSS Reception
If NetClock reports Holdover and/or Time Sync Alarms caused by insufficient GNSS reception:

When a GNSS receiver is installed in NetClock, a GNSS antenna can be connected to the rear
panel antenna connector via a coax cable to allow it to track several satellites in order for
GNSS to be an available input reference. Many factors can prevent the ability for the GNSS
receiver to be able to track the minimum number of satellites.

With the GNSS antenna installed outdoors, with a good view of the sky (the view of the sky is
not being blocked by obstructions), NetClock will typically track between 5-10 satellites (the
maximum possible is 12 satellites). If the antenna’s view of the sky is hindered, or if there is a
problem with the GNSS antenna installation, the GNSS receiver may only be able to a few
satellites or may not be able to track any satellites at all.

When GNSS is a configured time or 1PPS input reference, if the GNSS receiver is unable to
continuously track at least four satellites (until the initial GNSS survey has been completed) or at
least one satellite thereafter, the GNSS signal will not be considered valid. If no other inputs
are enabled and available, NetClock may not initially be able to go into time sync. Or, if
GNSS reception is subsequently lost after initially achieving time sync, NetClock will go into the
Holdover mode. If GNSS reception is not restored before the Holdover period expires (and no
other input references become available) NetClock will go out of sync. The GNSS reception
issue needs to be troubleshot in order to regain time sync.

For additional information on troubleshooting GNSS reception issues with NetClock, please
refer to the GNSS Reception Troubleshooting Guide, available here on the Spectracom web
site.

6.6 Troubleshooting – Keypad Is Locked
The NetClock 9483 front panel keypad can be locked in order to prevent inadvertent oper
ation. It can be locked and unlocked using either the keypad or the Web UI. When locked, the
keypad operation is disabled until it is unlocked using either of the two following processes:

To unlock the front panel keypad using the keypad (locally):

1. Perform the following key sequence:

6.5  Troubleshooting GNSS Reception
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To unlock the front panel keypad using the Web UI (remotely):

1. Open the NetClockWeb UI, and navigate to the Setup/Front Panel page.

2. Change the Lock from “Enabled” to “Disabled”.

3. Click the Submit button.

6.7 Troubleshooting – 1PPS, 10 MHz Outputs
If the 1PPS and/or the 10 MHz output(s) (the latter is only available on NetClock 9483) are not
present, input power may not be applied. Or NetClock is not synchronized to its input ref
erences and Signature Control is enabled.
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Web UI Page Current Status Indication Troubleshooting

HOME page Reference Status
Table

One or more
input references
indicate “Not
Valid” (red)

All available Input References have
been lost. The Reference Status table
on this same page will show the cur
rent status of all inputs (Green is valid
and red is not valid, or not present). If
Signature Control is enabled in this
state, the output may be disabled, see
"Configuring 1PPS/10 MHz Out
puts" on page 195.
1. Make sure the Input Reference Pri
ority table still has the desired inputs
enabled, based on desired priority.
2. Make sure desired input references
are still connected to the correct input
port of NetClock.
3. Verify GNSS antenna installation (if
applicable).

Navigate to
INTERFACES/OUTPUTS/
PPS Output page

Select the PPS
Output screen.
See "Con
figuring
1PPS/10 MHz
Outputs" on
page 195.

Signature Con
trol will show
"Output Always
Enabled",
"Output Enabled
in Holdover",
"Output Dis
abled in Hol
dover" or
"Output Always
Disabled".

1. With "Output Always Enabled"
selected, the selected output will be
present no matter the current syn
chronization state.2. Any other con
figured value will cause the applicable
output to be halted if NetClock is not
fully synchronized with its input ref
erences.

Table 6-4: Troubleshooting 1PPS and/or 10 MHz outputs not being present

6.8 Troubleshooting – Blank Information Display

Note: This section applies only to NetClock 9483.

If the front panel 4-line LCD Information Display is blank:

As long as input power is applied (as indicated by the power light being green and the LED
time display incrementing) the 4-line LCD Information Display is capable of displaying data.
The Information Display can be configured to display different data while the keypad is not in
use. One available configuration is to have the Information Display show a blank page when
not in use. The Information Display operation can be verified and can also be configured via
the Web UI, or the front panel keypad.
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CHAPTER 6 • NetClock User Reference Guide Rev. 12 323



A. Using the front panel keypad to verify the LCD Information Display is configured to dis
play a blank page:
To verify the front panel LCD Information Display is configured to display a blank page,
just press any keypad button. As long as the keypad is unlocked, the Home screen will
be displayed (after one minute of not pushing any keys, the screen will go back to
blank).

Note: The information that is selected, is the page that is normally displayed in
the LCD window, beginning one minute after the keypad is no longer being used.

B. Using the front panel keypad to change the information normally displayed in the LCD
when the keypad is not in use:
To use the front panel keypad to reconfigure the LCD Information Display to show some
thing other than a blank page (such as GNSS information, network configuration, etc.),
see "Using the Keypad and Information Display" on page 33.

C. Using the Web UI to change the information normally displayed in the LCD Information
Display when the keypad is not in use:
To use the Web UI to reconfigure the LCD Information Display to show something other
than a blank page (such as GNSS information, network configuration, etc.), refer to
"Front Panel Configuration" on page 176.

6.9 Troubleshooting the Front Panel Serial Port
The front panel serial port can be used for NetClock configuration or to obtain select data. The
serial port is a standard DB9 female port. Communication with this port is via a standard
DB9 F to DB9M serial cable (minimum pinout is pin 2 to 2, pin 3 to 3 and pin 5 to 5) con
nected to a PC running a terminal emulator program such as Tera Term or Microsoft Hyper
Terminal. The port settings of the terminal emulator should be configured as 9600, N, 8, 1
(flow control setting does not matter).

If the terminal emulator program does not display any data when the keyboard <Enter> key is
pressed, either NetClock is not powered up or there is a problem with the connection between
NetClock and the PC.

Using a multimeter, ring out the pins from one end of the serial cable to the other. Verify the
cable is pinned as a straight-thru serial cable (pin 2 to 2, pin 3 to 3 and pin 5 to 5) and not as
a null-modem or other pin-out configuration.

Disconnect the serial cable from NetClock. Then, jumper (using a wire, paperclip or car key,
etc.) pins 2 and 3 of the serial cable together while pressing any character on the PC’s key
board. The character typed should be displayed on the monitor. If the typed character is not
displayed, there is a problem with either the serial cable or with the serial COM port of the
PC.

Refer to "Setting up a Terminal Emulator" on page 328 for more information on using a ter
minal emulator software to communicate with NetClock via serial port.
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6.10 Troubleshooting the Front Panel Cooling Fan
The cooling fan (located on the front panel, to the right of the LED time display) is a tem
perature controlled cooling fan. Temperature sensor(s) determine when the cooling fan needs to
turn on and off. It is normal operation for the cooling fan to not operate the entire time NetC
lock is running. It may be turned off for long periods at a time, depending on the ambient and
internal temperatures.

To verify the cooling fan is still operational, power cycle NetClock unit (if AC and DC power
are both applied, momentarily turn off the AC power switch and disconnect the DC power con
nector).

Note: If the internal temperature in the unit is below 30 degrees Celsius, the fan
may not turn on as part of the power-up sequence. In this case, it is recommended
to let the unit “warm up” for approximately 30 minutes, in order to allow the unit
to get to the appropriate temperature.

See also: "Temperature Management" on page 249

6.11 Troubleshooting – Network PCs Cannot Sync
In order for clients on the network to be able to sync to NetClock, several requirements must be
met:

1. The PC(s) must be routable to NetClock. Make sure you can access NetClock Web
UI from a PC that is not syncing. If the PC cannot access the Web UI, a network issue
likely exists. Verify the network configuration.

2. The network clients have to be configured to synchronize to NetClock's address. For
additional information on syncing Windows PC's, visit the Support pages on the
Spectracom website (spectracom.com), and download/view the document titled
“Synchronizing Windows Computers”. The last section of this document also con
tains troubleshooting assistance for Windows synchronization. For UNIX/Linux com
puter synchronization, please visit http://www.ntp.org/.

3. If at least one PC can sync to NetClock, the issue is likely not with NetClock itself.
The only NetClock configurations that can prevent certain PCs from syncing to the
time server are the NTP Access table and MD5 authentication. Refer to Sections
"Configuring NTP Access Restrictions" on page 123 and "Configuring NTP Sym
metric Keys (MD5 Authentication)" on page 120 respectively. A network or PC issue
likely exists. A firewall may be blocking Port 123 (NTP traffic), for example.

4. NTP in NetClock must be “in sync” and at a higher Stratum level than Stratum 15
(such as Stratum 1 or 2, for example). This requires NetClock to be either synced to
its input references or in Holdover mode. Verify the current NTP stratum level and
the sync status.
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6.12 Troubleshooting Software Update
When experiencing slow data transmission rates, or other network issues, it may be possible
that a system software update will be aborted due to a web server timeout during the transfer.

In such an event, the Upload New File window will disappear, and the Upgrade System Soft
ware window will be displayed again instead.

Should this happen repeatedly, you can transfer the update file using a file transfer pro
tocol such as scp, sftp or ftp, if security is not a concern. The update can then be initiated
from the Web UI or Command Line.

Disk Status: In the event of an aborted update process, under Tools > Upgrade/Backup
> Disk Status, check Percent Used: If the number is greater than 70%, free up disk
space, before starting another attempt to update the System Software.

Software Versions older than 5.3.0:

Note that failed update attempts may result in lost Disk Space on the NetClock. Reboot the sys
tem to erase unwanted update files.

Software Version 5.3.0 and higher:

In the event that an update process becomes aborted, clicking Update System Software will
automatically erase unwanted update files.
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7 Command-Line Interface

A terminal emulation program is used to emulate a video terminal,
so as to access NetClock's CLI (Command-Line Interface) remotely
via a serial cable. This may be required, if no other means of
remotely accessing NetClock are available, for example if Ethernet
ports are used otherwise or have been disabled (for security reas
ons, or similar).

The following topics are included in this Chapter:

7.1 Setting up a Terminal Emulator 328
7.2 CLI Commands 329



7.1 Setting up a Terminal Emulator
If no other means are available to access NetClock, a terminal emulation program can be used
to carry out certain configuration changes by accessing NetClock's CLI (command-line inter
face) via a serial port connection. An application example for this scenario is to enable a net
work port so that the NetClock Web UI can be used. While it is also possible to retrieve
selected logs, a terminal emulator does not replace the NetClock Web UI.

Spectracom does not distribute or support its own terminal emulator, and newer Microsoft oper
ating systems no longer include HyperTerminal, however, there are several third-party open-
source programs available, such as Tera Term or PuTTY. The example below illustrates the use
of TeraTerm. The setup procedure is similar when using other terminal emulation programs.

Required tools and parts:

I. A standard, one-to-one pinned RS-232 serial cable; this cable has one male and one
female DB-9 connector. Do NOT use a Null Modem cable. If you do not have a stand
ard RS-232 cable at hand, follow the pin-out configuration described below when build
ing a cable. It is required to wire at least pins number 2, 3, and 5.

Figure 7-1: Serial port pin-out

II. Personal Computer with terminal emulator program installed.

Procedure:

1. Connect the personal computer to the NetClock front panel serial connector, using the
serial cable.

2. Configure your terminal emulation program, using the following settings:

Port: COM1

Bits per second: 9600

Data bits: 8

Parity: None
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Stop bits: 1

Flow control: None

3. Depending on which network protocol you are using (SSH, Telnet), you will need to
enter authentication upon establishment of the connection either in a separate authen
tication window, or the Terminal window: The default user name is spadmin, and the
password admin123.

4. Using the Terminal window, you can now configure the desired parameters. See
"CLI Commands" below for a list of commands.

7.2 CLI Commands
NetClock features a suite of command-line interface (CLI) commands that can be used to con
figure parameters and retrieve status information or log files via a remote connection, using the
telnet or ssh (if enabled) protocol.

This section includes a list of some of the supported commands.

Notes:

a. The command “helpcli” will provide a list of all available commands and their syn
tax (Note: Typing “help” will output bash shell help only and will not provide useful
information).

b. You can scroll up or scroll down through the output by using the Page Up/Page down
keys, or the arrow keys.

c. Type “q” (lower-case) to quit.

d. Pressing the up/down keys scrolls through previously typed commands.

e. Commands need to be typed in all lower-case letters.

7.2  CLI Commands
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f. Where eth0 is the base network port and eth1 (and higher) are used with the
optional Gigabit Ethernet module for multiple network interfaces.

g. User accounts with “user” group permissions can perform “get” commands but cannot
perform any “set” commands or change/reset passwords. Only user accounts with
“admin” group permissions can perform “set” commands or change/reset password.
Refer to "User Account Management" on page 132 for user account setup information.

Command Description

clean Restores NetClock configuration to factory defaults and reboots

cleanhalt Restores NetClock configuration to factory defaults and halts

clearlogs Clears all logs

clearstats Clears all statistical data (NTP, and oscillator/disciplining)

dateget Displays current date (for example, 15 APR 2015)

dateset Used to set the current date

defcert Used to create a new Spectracom self-signed SSL certificate for HTTPS in case of expir
ation of the original certificate

dhcp4get Displays whether DHCP is enabled

dhcp4set Used to enable or disable DHCP

dns4get Displays the configured DNS servers

dns4set Used to configure the DNS servers

dhcp6get Displays whether DHCPv6 is enabled

dhcp6set Used to enable or disable DHCPv6

doyget Used to obtain the current Day of Year

doyset Used to set the current Day of Year

gpsdop Displays GNSS receiver positional accuracy estimates

gpsinfo Applicable to SAASM-equipped NetClock units only

gpsloc Displays GNSS latitude, longitude and antenna height

gpsmdl Displays the GNSS Manufacturer and Model

gpssat Displays GNSS satellites tracked and maximum signal strength being received

gw4get Displays IPv4 gateway addresses

gw4set Used to configure the IPv4 gateway addresses

gw6get Displays IPv6 gateway address

gw6set Used to configure the IPv6 gateway address

halt Used to Halt the system for shutdown

helpcli Provides list of available commands and syntax
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Command Description

hostget Displays the DNS hostname

hostset Sets the DNS hostname

hotstart Initiate a hot start operation on the SAASM GPS receiver

ip4get Displays IPv4 Ethernet port information (IP address net mask and gateway)

ip4set Used to set IPv4 Ethernet port information (IP address net mask and gateway)

ip6add Used to add IPv6 Ethernet port information (IP address net mask and gateway)

ip6del Used to delete IPv6 IP address

ip6get Used to obtain the IPv6 IP address

iptables See "Network Services: En-/Disabling" on page 65 for more information.

licenses Displays configured licenses installed (if any)

list Outputs a list of commands

loadconf Restore a saved configuration and reboot

localget Used to obtain the configured local clock

locallist Used to display local clocks

localset Used to configure local clocks

model Displays the Serial Number of the unit

net Displays network settings

netnum Displays the number of general-purpose network interfaces

net4 Displays IPv4 network settings

net6 Displays IPv6 network settings

options Displays configured options installed (if any)

oscget Displays the installed system oscillator

portget Display whether network port is enabled (for example, "portget ETH2")

portset Enable or disable a network port:
"portset x on" where "x" is the port number (for example, "ETH2")
"portset X off"
[NOTE: Available since Web UI Revision no. 5.1.2]

portstate Display the current state for a network port

ppsctrl Enable/disable individual 1PPS output signals

priorset Sets the priority of an entry in the reference priority table

radius setretry <value> Sets how many radius login retries will be attempted

radius getretry <value> Gets the number of radius login retry attempts

radius server list Lists radius servers

7.2  CLI Commands
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Command Description

radius server
add

<host> <port> <key> <timeout>
Adds radius server

radius server del <id> Deletes radius server number <id>

reboot Used to warm-boot the unit without having to disconnect or reconnect power

reftable Displays reference priority table

release4 Used with DHCP to release the IPv4 address

release6 Used with DHCPv6 to release the IPv6 address

renew4 Used with DHCP to renew the assigned IPv4 address

renew6 Used with DHCPv6 to renew the assigned IPv6 address

resetpw Resets the administrator account (spadmin) password back to the default value
“admin123”

routes4 Displays the current IPv4 routing table(s)

routes6 Displays the current IPv6 routing table(s)

rt4add Adds an IPv4 static route

rt4del Deletes an IPv4 static route

rt4get Displays the configured IPv4 static routes

rt6add Adds an IPv6 static route

rt6del Deletes an IPv6 static route

rt6get Displays the configured IPv6 static routes

saveconf Generate archive of current configuration

savelog Generate archive of all log files

scaleget Displays configured system timescale

scaleset Used to configure the system timescale

services Displays the state of services (enabled/disabled)

servget Displays the state of individual services

servset Enable or disable specific services

slaacget Displays whether SLAAC is enabled

slaacset Used to enable or disable SLAAC

Stateset Enable or disable an entry in the reference priority table. index = 0...15. state = 0 (dis
able), 1 (enable)

status Displays information about the oscillator disciplining

syncstate Display timing system synchronization state

sysupgrade Performs system upgrade using the update bundle provided
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Command Description

testevent Generates SNMP events in the enterprise MIB

tfomget Displays current estimated system time error (TFOM – Time Figure of Merit)

timeget Displays current system time (time is displayed in the configured timescale – See scale-
get command to retrieve the configured timescale)

timeset Used to manually set the current time (hours, minutes in seconds); time is entered based
on the configured timescale – See scaleget command to retrieve the configured times
cale

unrestrict Used for clearing access control restrictions to NetClock

version Displays the installed main NetClock and timing system software versions

yearget Displays the current year

yearset Used to set the current year

zeroize Applicable to SAASM-equipped NetClock units only
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8.1 ASCII Time Code Data Formats
This section describes the different time code data format selections available for use with NetC
lock option cards that accept ASCII data streams as inputs or outputs via their RS-485 and RS-
232 interfaces.

Supported are formats like NMEA, BBC, Spectracom, GSSIP, and Endrun.

8.1.1 NMEA GGA Message
The GGA Format provides essential fix data which includes 3D location and accuracy data.

E x a m p l e m e s s a g e :

$GPGGA,123519.00,4807.038,N,01131.000,E,1,08,0.9,545.4,M,46.9,M,,*47

Where:
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GGA Global Positioning System Fix Data

123519.00 Fix taken at 12:35:19 UTC

4807.038,N Latitude 48 deg 07.038' N

01131.000, E Longitude 11 deg 31.000' E

1 Fix quality:
0 = Invalid
1 = GNSS fix (SPS)
2 = DGPS fix
3 = PPS fix
4 = Real Time Kinematic
6 = estimated (dead reckoning) (2.3 feature)
7 = Manual input mode
8 = Simulation mode

08 Number of satellites being tracked

0.9 Horizontal dilution of position

545.4,M Altitude, Meters, above mean sea level

46.9,M Height of geoid (mean sea level) above WGS84 ellipsoid

(empty field) Time in seconds since last DGPS update

(empty field) DGPS station ID number

*47 Checksum data, always begins with *

8.1.2 NMEA RMC Message
NMEA Message Format RMC, (Recommended Minimum) provides fix information, speed over
ground and Magnetic Variance information.

E x a m p l e m e s s a g e :

$GPRMC,123519.00,A,4807.038,N,01131.000,E,022.4,084.4,230394,003.1,W*6A

Where:

RMC Recommended Minimum Sentence C

123519.00 Fix taken at 12:35:19 UTC

A Status A=active or V=Void.

4807.038,N Latitude 48 deg 07.038' N
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01131.000,E Longitude 11 deg 31.000' E

022.4 Speed over the ground in knots

084.4 Track angle in degrees True

230394 Date - 23rd of March 1994

003.1,W Magnetic Variation

*6A Checksum data, always begins with *

8.1.3 NMEA ZDA Message
The Format ZDA Data message provides Date and Time information.

E x a m p l e m e s s a g e :

$GPZDA,HHMMSS.00,DD,MM,YYYY,XX,YY*CC

Where:

HHMMSS.00 HrMinSec(UTC)

DD,MM,YYYY Day, Month, Year

XX Local zone hours -13…13

YY Local zone minutes 0…59

*CC Checksum

8.1.4 Spectracom Format 0
Format 0 is the universal NENA format, along with formats 1, 2, and 3. Format 0 includes a
time synchronization status character, day of year, time reflecting Time Zone Offset and DST
corrections when enabled. Format 0 also includes the DST/Standard Time indicator, and the
Time Zone Offset value. Format 0 data structure is shown below:

E x a m p l e m e s s a g e :

CR LF I ^ ^ DDD ^ HH:MM:SS ^ DTZ=XX CR LF

Where:

CR Carriage Return
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LF Line Feed

I Time Sync Status (space, ?, *)

^ Space separator

DDD Day of Year (001-366)

HH Hours (00-23)

: Colon separator

MM Minutes (00-59)

SS Seconds (00- 60)

D Daylight Saving Time indicator (S,I,D,O)

TZ Time Zone

XX Time Zone offset (00-23)

The leading edge of the first character (CR) marks the on-time point of the data stream.

The time synchronization status character (I) is defined as described below:

(Space) Whenever the front panel time synchronization lamp is green.

? When the receiver is unable to track any satellites and the time synchronization lamp is red.

* When the receiver time is derived from the battery backed clock or set manually through the Setup
Port Interface.

The Daylight Saving Time indicator (D) is defined as:

S During periods of Standard time for the selected DST schedule.

I During the 24-hour period preceding the change into DST.

D During periods of Daylight Saving Time for the selected DST schedule.

O During the 24-hour period preceding the change out of DST.

E x a m p l e :

271 12:45:36 DTZ=08

The example data stream provides the following information:

Sync Status Time synchronized to GNSS
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Date Day 271

Time 12:45:36 Pacific Daylight Time

D DST, Time Zone 08 = Pacific Time

8.1.5 Spectracom Format 1
Format 1 converts the received day of year data (001-366) to a date consisting of day of
week, month, and day of the month. Format 1 also contains a time synchronization status char
acter, year, and time reflecting time zone offset and DST correction when enabled.

Available Formats 1 and 1S are very similar to each other. Most external systems utilizing Data
Format 1 will look for a single-digit day of the month for day 1 through day 9, with a space in
front of each digit ( ^1, ^2, ^3 … 10, 11… ), whereas other systems need to see a two digit
day of the month for all days 1 through 9 with a leading 0 instead of a space (01, 02, 03…
10, 11…).

If your device requires the two digit day of the month for days 1 through 9 (i.e. 01, 02
etc.), select Format 1.

If your device requires the single digit day of the month for days 1 through 9 (i.e. ^1,
^2, etc.), select Format 1S instead. Refer to "Spectracom Format 1S" on the facing page
for information on Format 1S.

F o r m a t 1 d a t a s t r u c t u r e :

CR LF I ^ WWW ^ DDMMMYY ^ HH:MM:SS CR LF

Where:

CR Carriage Return

LF Line Feed

I Time Sync Status (space, ?, *)

^ Space separator

WWW Day of Week (SUN, MON, TUE, WED, THU, FRI, SAT)

DD Numerical Day of Month (01-31)

MMM Month (JAN, FEB, MAR, APR, MAY, JUN, JUL, AUG, SEP, OCT, NOV, DEC)

YY Year without century (99, 00, 01, etc.)

HH Hours (00-23)
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: Colon separator

MM Minutes (00-59)

SS Seconds (00-60)

The leading edge of the first character (CR) marks the on-time point of the data stream.

The time synchronization status character (I) is defined as described below:

(Space) Whenever the front panel time synchronization lamp is green.

? When the receiver is unable to track any satellites and the time synchronization lamp is red.

* When the receiver time is derived from the battery backed clock or set manually through the Setup
Port Interface.

E x a m p l e :

FRI 20APR01 12:45:36

The example data stream provides the following information:

Sync
Status

The clock is not time synchronized to GNSS. Time is derived from the battery backed clock or
set manually

Date Friday, April 23, 2015

Time 12:45:36

8.1.6 Spectracom Format 1S
Format 1S (Space) is very similar to Format 1, with the exception of a space being the first char
acter of Days 1 through 9 of each month (instead of the leading “0” which is present in Format
1).

Most external systems utilizing Data Format 1 will look for a single digit day of the month for
day 1 through day 9, with a space in front of each digit (^1, ^2, ^3 … 10, 11…) whereas
other systems need to see a two digit day of the month for all days 1 through 9 with a leading
0 instead of a space (01, 02, 03… 10, 11…).

If your device requires the single digit day of the month for days 1 through 9 (i.e. 1, 2,
etc.), select Format 1S.

If your device requires the two digit day of the month for days 1 through 9 (i.e. 01, 02,
etc.), select Format 1 instead. Refer to "Spectracom Format 1" on the previous page for
information on Format 1.
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E x a m p l e m e s s a g e :

CR LF I ^ WWW ^ DDMMMYY ^ HH:MM:SS CR LF

Where:

CR Carriage Return

LF Line Feed

I Time Sync Status (space, ?, *)

^ Space separator

WWW Day of Week (SUN, MON, TUE, WED, THU, FRI, SAT)

DD Numerical Day of Month (1-31)

MMM Month (JAN, FEB, MAR, APR, MAY, JUN, JUL, AUG, SEP, OCT, NOV, DEC)

YY Year without century (99, 00, 01, etc.)

HH Hours (00-23)

: Colon separator

MM Minutes (00-59)

SS Seconds (00-60)

The leading edge of the first character (CR) marks the on-time point of the data stream.

The time synchronization status character (I) is defined as described below:

(Space) Whenever the front panel time synchronization lamp is green.

? When the receiver is unable to track any satellites and the time synchronization lamp is red.

* When the receiver time is derived from the battery backed clock or set manually through the Setup
Port Interface.

E x a m p l e :

FRI 20APR15 12:45:36

The example data stream provides the following information:

Sync
Status

The clock is not time synchronized to GNSS. Time is derived from the battery backed clock or
set manually.
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Date Friday April, 23, 2015

Time 12:45:36

8.1.7 Spectracom Format 2
This format provides a time data stream with millisecond resolution. The Format 2 data stream
consists of indicators for time synchronization status, time quality, leap second and Daylight
Saving Time. Time data reflects UTC time and is in the 24-hour format. Format 2 data structure
is shown below:

Note: Format 2 cannot be configured for a Time Zone Offset or with automatic
Daylight Saving Time adjustment. Attempting to configure a Local clock using
Data Format 2 with either a Time Zone Offset or automatic DST rule will result in
an error message.

E x a m p l e m e s s a g e :

CR LF IQYY ^ DDD ^ HH:MM:SS.SSS ^ LD

Where:

CR Carriage Return

LF Line Feed

I Time Sync Status (space, ?, *)

Q Quality Indicator (space, A, B, C, D)

YY Year without century (99, 00, 01, etc.)

^ Space separator

DDD Day of Year (001-366)

HH Hours (00-23 UTC time)

: Colon separator

MM Minutes (00-59)

: Colon separator

SS (00-60)

. Decimal separator
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SSS Milliseconds (000-999)

L Leap Second indicator (space, L)

D Daylight Saving Time Indicator (S,I,D,O)

The leading edge of the first character (CR) marks the on-time point of the data stream.

The time synchronization status character (I) is defined as described below:

(Space) Whenever the front panel time synchronization lamp is green.

? When the receiver is unable to track any satellites and the time synchronization lamp is red.

* When the receiver time is derived from the battery backed clock or set manually through the Setup
Port Interface.

The quality indicator (Q) provides an inaccuracy estimate of the output data stream. When the
receiver is unable to track any GNSS satellites, a timer is started. "Quality indicators" below
lists the quality indicators and the corresponding error estimates based upon the GNSS
receiver 1PPS stability, and the time elapsed tracking no satellites. The Tracking Zero Satellites
timer and the quality indicator reset when the receiver reacquires a satellite.

Quality Time (hours) TXCO Error (milliseconds) OCXO Error
(milliseconds)

Rubidium Error
(microseconds)

Space Lock <1 <0.01 <0.3

A <10 <10 <0.72 <1.8

B <100 <100 <7.2 <18

C <500 <500 <36 <90

D >500 >500 >36 >90

Table 8-1: Quality indicators
The leap second indicator (L) is defined as:

(Space) When a leap second correction is not scheduled for the end of the month.

L When a leap second correction is scheduled for the end of the month.

The Daylight Saving Time indicator (D) is defined as:

S During periods of Standard time for the selected DST schedule.

I During the 24-hour period preceding the change into DST.
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D During periods of Daylight Saving Time for the selected DST schedule.

O During the 24-hour period preceding the change out of DST.

E x a m p l e :

?A15 271 12:45:36.123 S

The example data stream provides the following information:

Sync
Status

The clock has lost GNSS time sync. The inaccuracy code of “A” indicates the expected time
error is <10 milliseconds.

Date Day 271 of year 2015.

Time 12:45:36 UTC time, Standard time is in effect.

8.1.8 Spectracom Format 3
Format 3 provides a format identifier, time synchronization status character, year, month, day,
time with time zone and DST corrections, time difference from UTC, Standard time/DST indic
ator, leap second indicator and on-time marker. The Format 3 data structure is shown below:

E x a m p l e m e s s a g e :

FFFFI^YYYYMMDD^HHMMSS±HHMMD L # CR LF

Where:

FFFF Format Identifier (0003)

I Time Sync Status (Space, ?, *)

^ Space separator

YYYY Year (1999, 2000, 2001, etc.)

MM Month Number (01-12)

DD Day of the Month (01-31)

HH Hours (00-23)

MM Minutes (00-59)

SS Seconds (00-60)
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± Positive or Negative UTC offset (+,-) Time Difference from UTC

HHMM UTC Time Difference Hours Minutes (00:00-23:00)

D Daylight Saving Time Indicator (S,I,D,O)

L Leap Second Indicator (space, L)

# On time point

CR Carriage Return

LF Line Feed

The time synchronization status character (I) is defined as described below:

(Space) Whenever the front panel time synchronization lamp is green.

? When the receiver is unable to track any satellites and the time synchronization lamp is red.

* When the receiver time is derived from the battery backed clock or set manually through the Setup
Port Interface.

The time difference from UTC, ±HHMM, is selected when the Serial Com or Remote port is con
figured. A time difference of -0500 represents Eastern Time. UTC is represented by +0000.
The Daylight Saving Time indicator (D) is defined as:

S During periods of Standard time for the selected DST schedule.

I During the 24-hour period preceding the change into DST.

D During periods of Daylight Saving Time for the selected DST schedule.

O During the 24-hour period preceding the change out of DST.

The leap second indicator (L) is defined as:

(Space) When a leap second correction is not scheduled for the end of the month.

L When a leap second correction is scheduled for the end of the month.

E x a m p l e :

0003 20150415 124536-0500D #

The example data stream provides the following information:

Data Format 3
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Sync Status Day 271 of year 2015.

Date April 15, 2015.

Time 12:45:36 EDT (Eastern Daylight Time). The time difference is 5 hours behind UTC.

Leap Second No leap second is scheduled for this month.

8.1.9 Spectracom Format 4
Format 4 provides a format indicator, time synchronization status character, modified Julian
date, time reflecting UTC with 0.1 millisecond resolution and a leap second indicator. Format 4
data structure is shown below:

E x a m p l e :

FFFFIMJDXX^HHMMSS.SSSS^L CR LF

Where:

FFFF Format Identifier (0004)

I Time Sync Status (Space, ?, *)

MJDXX Modified Julian Date

^ Space separator

HH Hours (00-23 UTC time)

MM Minutes (00-59)

SS.SSSS Seconds (00.0000-60.0000)

L Leap Second Indicator (space, L)

CR Carriage Return

LF Line Feed

The start bit of the first character marks the on-time point of the data stream.
The time synchronization status character (I) is defined as described below:

(Space) Whenever the front panel time synchronization lamp is green.

? When the receiver is unable to track any satellites and the time synchronization lamp is red.

* When the receiver time is derived from the battery backed clock or set manually through the Setup
Port Interface.

The leap second indicator (L) is defined as:
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(Space) When a leap second correction is not scheduled for the end of the month.

L When a leap second correction is scheduled for the end of the month.

E x a m p l e :

0004 50085 124536.1942 L

The example data stream provides the following information:

Data format 4

Sync Status Time synchronized to GNSS.

Modified Julian Date 50085

Time 12:45:36.1942 UTC

Leap Second A leap second is scheduled at the end of the month.

8.1.10 Spectracom Format 7
This format provides a time data stream with millisecond resolution. The Format 7 data stream
consists of indicators for time synchronization status, leap second and Daylight Saving Time.
Time data reflects UTC time and is in the 24-hour format. Format 7 data structure is shown
below:

Note: Format 7 cannot be configured for a Time Zone Offset or with automatic
Daylight Saving Time adjustment. Attempting to configure a Local clock using
Data Format 7 with either a Time Zone Offset or automatic DST rule will result in
an error message.

E x a m p l e m e s s a g e :

CR LF I^YY^DDD^HH:MM:SS.SSSL^D CR LF

Where:

CR Carriage Return

LF Line Feed
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I Time Sync Status (space, ?, *)

YY Year without century (99, 00, 01, etc.)

^ Space separator

DDD Day of Year (001-366)

HH Hours (00-23 UTC time)

: Colon separator

MM Minutes (00-59)

SS Seconds (00-60)

. Decimal Separator

SSS Milliseconds (000-999)

L Leap Second Indicator (space, L)

D Daylight Saving Time Indicator (S,I,D,O)

The leading edge of the first character (CR) marks the on-time point of the data stream.

The time synchronization status character (I) is defined as described below:

(Space) Whenever the front panel time synchronization lamp is green.

? When the receiver is unable to track any satellites and the time synchronization lamp is red.

* When the receiver time is derived from the battery backed clock or set manually through the Setup
Port Interface.

The leap second indicator (L) is defined as:

(Space) When a leap second correction is not scheduled for the end of the month.

L When a leap second correction is scheduled for the end of the month.

The Daylight Saving Time indicator (D) is defined as:
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S During periods of Standard time for the selected DST schedule.

I During the 24-hour period preceding the change into DST.

D During periods of Daylight Saving Time for the selected DST schedule.

O During the 24-hour period preceding the change out of DST.

E x a m p l e :

? 15 271 12:45:36.123 S

The example data stream provides the following information:

Sync Status The clock has lost GNSS time sync.
Date Day 271 of year 2015.
Time 12:45:36 UTC time, Standard time is in effect.

8.1.11 Spectracom Format 8
Format 8 includes a time synchronization status character, the four digit year, day of year, time
reflecting Time Zone Offset and DST corrections when enabled. Format 8 also includes the
DST/Standard Time indicator, and the Time Zone Offset value. Format 8 data structure is
shown below:

E x a m p l e :

CR LF I ^ ^YYYY^ DDD ^ HH:MM:SS ^ D+XX CR LF
or
CR LF I ^ ^YYYY^ DDD ^ HH:MM:SS ^ D-XX CR LF

Where:

CR Carriage Return

LF Line Feed

I Time Sync Status (space, ?, *)

YYYY Four digit year indication

^ Space separator

DDD Day of Year (001-366)

HH Hours (00-23)
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: Colon separator

MM Minutes (00-59)

SS Seconds (00-60)

D Daylight Saving Time indicator (S,I,D,O)

XX Time Zone Switch Setting (±00…12)

The leading edge of the first character (CR) marks the on-time point of the data stream. Time
sync status character (I) is described below:

(Space) When NetClock is synchronized to UTC source.

* When NetClock time is set manually.

? When NetClock has not achieved or has lost synchronization to UTC source.

The time and date can be set to either local time or UTC time, depending upon the con
figuration of the output port.

8.1.12 Spectracom Format 9
Format 9 provides Day-of-Year and Time information.

E x a m p l e m e s s a g e :

<SOH>DDD:HH:MM:SSQ<CR><LF>

Where:

SOH Start of header (ASCII Character 1)

DDD Day of Year (001-366)

: Colon Separator

HH Hours (00-23)

MM Minutes (00-59)

SS Seconds (00-59) (00-60 for leap second)
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Q Time Sync Status [as INPUT]
space = SYNC
‘.’ = SYNC
‘*’=NOT IN SYNC
‘#’ = NOT IN SYNC
“?” = NOT IN SYNC

Q Time Sync Status [as OUTPUT]
space = Time error is less than time quality flag 1's threshold (TFOM < or = 3)
“.” = Time error has exceeded time quality flag 1's threshold (TFOM = 4)
“*” = Time error has exceeded time quality flag 2's threshold (TFOM = 5)
“#” = Time error has exceeded time quality flag 3's threshold (TFOM = 6)
“?” = Time error has exceeded time quality flag 4's threshold OR a reference source is unavailable
(TFOM >=7)

CR Carriage Return (ASCII Character 13)

LF Line Feed (ASCII Character 10)

The leading edge of the first character (CR) marks the on-time point of the data stream.

8.1.13 Spectracom Epsilon Formats

8.1.13.1 Spectracom Epsilon TOD 1

This message corresponds to the TOD 1 format provided by EPSILON 2S/3S Series products
on RS232/422 ports.

The structure of this format is as follows:

<space>DD/MM/YYYY<space>HH:MM:SST(CR)(LF)

Length=23 bytes

Where:

<space> separator

DD 2-digit Day of month

</> separator

MM 2-digit Month

</> separator

YYYY 4-digit Year

<space> separator
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HH 2-digit Hour

: separator

MM 2-digit Minutes

: separator

SS 2-digit Seconds

T 1-digit Timescale (                   'N' None, 'G' GPS, 'U' UTC, 'A' TAI, 'L' Local, 'M' Manual)

(CR) Carriage Return (ASCII Character 13 0x0D)

(LF) Line Feed (ASCII Character 10 0x0A)

8.1.13.2 Spectracom Epsilon TOD 3

This message corresponds to the TOD 3 format provided by EPSILON 2S/3S Series products
on RS232/422 ports.

The structure of this format is as follows:

<space>DOY/YYYY<space>HH:MM:SS<space>T(CR)(LF)

Length=22 bytes

Where:

<space> separator

DOY 3-digit Day of year

</> separator

YYYY 4-digit Year

</> separator

YYYY 4-digit Year

<space> separator

HH 2-digit Hour

: separator

MM 2-digit Minutes

: separator

SS 2-digit Seconds

T 1-digit Timescale (                   'N' None, 'G' GPS, 'U' UTC, 'A' TAI, 'L' Local, 'M' Manual)
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(CR) Carriage Return (ASCII Character 13 0x0D)

(LF) Line Feed (ASCII Character 10 0x0A)

8.1.14 BBC Message Formats

8.1.14.1 Format BBC-01

This format is based on string ASCII characters, and is sent once per second. It provides year,
month, day, day of week, day of month, hours, minutes, and seconds.

Number of characters: 24 (including CRLF and '.')

E x a m p l e m e s s a g e :

T:ye:mo:da:dw:ho:mi:sc

Where:

T Indicates the synchronous moment for the time setting.

ye Year (00-99)

mo Month (01-12)

da Day of month (01-31)

dw Day of week (01=Monday to 7=Sunday)

ho Hours (00-23)

mi Minutes (00-59)

sc Seconds (00-59)

8.1.14.2 Format BBC-02

This is a hexadecimal frame/message sent twice per second. The message should be sent such
that the final “99” occurs at 0 msec and 500 msec.

Number of bytes: 26

Format:
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START Year Month Day Hour Min Sec.

AA AA 07 DA 06 16 13 59 01

Millisecond Time
Zone Daylight

Leap-
second
Sign

Leap- second
Month

Leap-
second
Zone

GPS
Week

02 BA 80 00 00 00 00 00 1A 2A

GPS Second GPS to UTC Offset Check-sum END

09 3A 7E 12 FE 99 99

Where:

Leap Second Sign:

01=Positive

FF=Negative

00=No leap second

Leap Second Month:

00=None scheduled

03=March

06=June

09=September

0C=December

Leap Second Zone:

0=Out of zone

1=Within zone

Zone is 15 minutes before to 15 minutes after a leap second.

GPS Week:

Up to FFFF
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GPS Second:

Second of week 000000 up to 093A7F (604799 decimal)

GPS to UTC offset:

2’s complement binary signed integer, seconds

Checksum:

Sum of all bytes up to and including the checksum (sum includes the AAAA start identifier
but excludes the 9999 end identifier)

8.1.14.3 Format BBC-03 PSTN

The third format is a string ASCII characters and is sent on a received character.

The message should be advanced by an appropriate number such that the stop bit of each
<CR> occurs at the start of the next second. For example, at 300 baud, 8 data bits, 1 stop bit,
and no parity, each byte takes 10/300 s=33 ms, so the <CR> byte should be advanced by
33 ms in order for the <CR>’s stop bit to line up with the start of the next second.

Time information is available in UTC format or UK TOD format.

‘t’ command
Input format: t<CR>

Output format:

Current Second Second + 1 Second + 2 Second + 3

<CR> HHMMSS<CR> HHMMSS<CR> HHMMSS<CR>

Number of characters: 7 (including CR)
Each HHMMSS filed refers to the time at the start of the next second. The data transmitted by
NetClock is timed so that the stop bit of each <CR> ends at the start of the next second.

‘d’ command
NetClock transmits the date on request.
Input format: d<CR>

Output format: YYMMDD<CR>

Number of output characters: 7 (including CR)
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‘s’ command
NetClock transmits the status information on request.
Input format: s<CR>

Output Format: status

Number of output characters: 1
Where returned, values for status are:

G = System Good

D = Failure of NetClock internal diagnostics

T = NetClock does not have correct time

‘l’ command
The loopback command will cause NetClockto echo the next character received back to the
caller. This may be used by a caller’s equipment to calculate the round trip delay across the
PSTN connection in order to apply a correction to the received time data.
Input format: l<CR>

Output format: (Next character received)

‘hu’ command
The hang up command will cause NetClock to drop the line immediately and terminate the call.
Input format: hu<CR>

8.1.14.4 Format BBC-04

This format is a string of ASCII characters and is sent once per second.

Number of characters: 18 (including CRLF)

E x a m p l e m e s s a g e :

T:ho:mi:sc:dw:da:mo:ye:lp:cs<CR><LF>

Where:

T Indicates the synchronous moment for the time set
ting.

ho Hours (00-23)
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mi Minutes (00-59)

sc Seconds (00-59)

dw Day of week (01=Monday to 7=Sunday)

da Day of month (01-31)

mo Month (01-12)

ye Year (00-99)

lp 0 (for 60s, no leap) or 1 (for 61s, leap)

cs Checksum. This is calculated from the start of the
message, including start identifier and excluding
CRLF. It is created by adding all the 1s. If the sum is
even, 0 is returned. If the sum is odd, 1 is returned.
This is mathematically the same as sequentially run
ning an XOR on each bit of each byte.

Standard Serial configuration is:

RS-232 format

9600 baud

8 data bits

1 stop bit

No parity

8.1.14.5 Format BBC-05 (NMEA RMC Message)

The NMEA Message Format RMC, (Recommended Minimum) provides fix information, speed
over ground and Magnetic Variance information. Note that this RMC Message is not 100%
identical to the official NMEA RMC MESSAGE (that corresponds to the 3.01 NMEA 0183 stand
ard and is another time code format supported by NetClock.)

The BBC RMC message (BBC-05) corresponds to Version 2 of the NMEA 0183 standard, fol
lowing the description below:

E x a m p l e m e s s a g e :

$GPRMC,123519,A,4807.038,N,01131.000,E,022.4,084.4,230394,003.1,W*6A

Where:
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RMC Recommended Minimum sentence C

123519 Fix taken at 12:35:19 UTC

A Status: A=active or V=Void.

4807.038,N Latitude 48 deg 07.038' N

01131.000,E Longitude 11 deg 31.000' E

22.4 Speed over the ground in knots

84.4 Track angle in degrees True

230394 Date—23rd of March 1994

003.1,W Magnetic Variation

*6A The checksum data, always begins with *

8.1.15 GSSIP Message Format
The GSSIP1 format includes 3 ICD-GPS-153C messages which are used to support emulation of
a SAASM GPS used in a SINCGARS interface. The messages are the Buffer Box (253), Time
Transfer (5101), and the Current Status (5040).

The ICD-GPS-153C protocol defines the format of these messages. The Current Status and Time
Transfer are sent once per second (1Hz). The Buffer Box is sent once every 6 seconds (1/6 Hz).

The purpose of these three messages is to emulate a SINCGARS interface connection to a
SAASM GPS. NetClock generates these messages emulating the Time and 1PPS transfer beha
vior of the SINCGARS interface. An external device compatible with the SINCGARS interface
can attach to an ASCII Output from NetClock and receive time and 1PPS as if communicating
with and ICD-GPS-153C compatible SAASM GPS.

These commands are emulated only and contain only time information; position and velocity
information is zeroed out. No controlled data is included in the messages, hence no SAASM
GPS receiver is required.

The ASCII Output supports two configurations for supporting SINCGARS:

A configuration of Time Transfer as Message Format1 and Current Status as Format2 causes the
SINCGARS protocol to be emulated and the machine state to be initializated.

1GSSIP = GPS STANDARD SERIAL INTERFACE PROTOCOL
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Format1: Time Transfer (5101)

Format2: Current Status (5040)

Format3: Buffer Box (253)

A configuration of Current Status as Message Format1 and Time Transfer as Format2 results in
broadcasting of the messages Current Status (1Hz), Time Transfer (1Hz), and Buffer Box
(1/6Hz) at their default rates.

Format1: Current Status (5040)

Format2: Time Transfer (5101)

Format3: Buffer Box (253)

8.1.16 EndRun Formats
The following formats provide compatibility with EndRun technology.

8.1.16.1 EndRun Time Format

E x a m p l e m e s s a g e :

T YYYY DDD HH:MM:SS zZZ m<CR><LF>

Where:

T Time Figure of Merit character (TFOM), limited to the range 6 to 9:
9 indicates error >±10 milliseconds, or unsynchronized condition
8 indicates error <±10 milliseconds
7 indicates error <±1 millisecond
6 indicates error <±100 microseconds

YYYY Year

DDD Day of Year (001-366)

HH Hour of the day (00-23)

: Colon Separator

MM Minutes of the hour

SS Seconds (00-59), (00-60 for leap second)

z The sign of the offset to UTC, + implies time is ahead of UTC
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ZZ The magnitude of the offset to UTC in units of half-hours.
If ZZ = 0, then z = +

m Time mode character, is one of:
G = GPS
L = Local
U = UTC
T = TAI

CR Carriage Return

LF Line Feed

8.1.16.2 EndRunX (Extended) Time Format

The EndRunX format is identical to the EndRun format, with the addition of two fields: the cur
rent leap second settings and the future leap second settings.

T h e f o l l o w i n g e x a m p l e m e s s a g e s t r i n g i s s e n t
o n c e e a c h s e c o n d :

T YYYY DDD HH:MM:SS zZZ m CC FF<CR><LF>

Where:

T Time Figure of Merit character (TFOM), limited to the range 6 to 9:
9 indicates error >±10 milliseconds, or unsynchronized condition
8 indicates error <±10 milliseconds
7 indicates error <±1 millisecond
6 indicates error <±100 microseconds

YYYY Year

DDD Day of Year (001-366)

HH Hour of the day (00-23)

: Colon Separator

MM Minutes of the hour

SS Seconds (00-59), (00-60 for leap second)

z The sign of the offset to UTC, + implies time is ahead of UTC

ZZ The magnitude of the offset to UTC in units of half-hours.
If ZZ = 0, then z = +
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m Time mode character, is one of:
G = GPS
L = Local
U = UTC
T = TAI

CC The current leap seconds

FF The future leap seconds, which will show a leap second pending
24 hours in advance

CR Carriage Return

LF Line Feed

8.2 IRIG Standards and Specifications

8.2.1 IRIG Carrier Frequencies
Each IRIG code specifies a carrier frequency that is modulated to encode date and time, as well
as control bits to time-stamp events. Initially, IRIG applications were primarily military and gov
ernment associated. Today, IRIG is commonly used to synchronize voice loggers, recall record
ers, and sequential event loggers found in emergency dispatch centers and power utilities.

Format Encoding Modulation Carrier Coded Expressions Bit rate Time Frame Inter
val

IRIG-A

IRIG-A A000 DCLS N/A BCDTOY, CF and SBS 1000 pps 0.1 sec

IRIG-A A001 DCLS N/A BCDTOY, CF 1000 pps 0.1 sec

IRIG-A A002 DCLS N/A BCDTOY 1000 pps 0.1 sec

IRIG-A A003 DCLS N/A BCDTOY, SBS 1000 pps 0.1 sec

IRIG-A A004 DCLS N/A BCDTOY, BCDYEAR, CF and
SBS

1000 pps 0.1 sec

IRIG-A A005 DCLS N/A BCDTOY, BCDYEAR, and CF 1000 pps 0.1 sec

IRIG-A A006 DCLS N/A BCDTOY, BCDYEAR 1000 pps 0.1 sec

IRIG-A A007 DCLS N/A BCDTOY, BCDYEAR, and
SBS

1000 pps 0.1 sec

IRIG-A A130 AM 10 kHz BCDTOY, CF and SBS 1000 pps 0.1 sec
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Format Encoding Modulation Carrier Coded Expressions Bit rate Time Frame Inter
val

IRIG-A A131 AM 10 kHz BCDTOY, CF 1000 pps 0.1 sec

IRIG-A A132 AM 10 kHz BCDTOY 1000 pps 0.1 sec

IRIG-A A133 AM 10 kHz BCDTOY, SBS 1000 pps 0.1 sec

IRIG-A A134 AM 10 kHz BCDTOY, BCDYEAR, CF and
SBS

1000 pps 0.1 sec

IRIG-A A135 AM 10 kHz BCDTOY, BCDYEAR, and CF 1000 pps 0.1 sec

IRIG-A A136 AM 10 kHz BCDTOY, BCDYEAR 1000 pps 0.1 sec

IRIG-A A137 AM 10 kHz BCDTOY, BCDYEAR, and
SBS

1000 pps 0.1 sec

IRIG-B

IRIG-B B000 DCLS N/A BCDTOY, CF and SBS 100 pps 1 sec

IRIG-B B001 DCLS N/A BCDTOY, CF 100 pps 1 sec

IRIG-B B002 DCLS N/A BCDTOY 100 pps 1 sec

IRIG-B B003 DCLS N/A BCDTOY, SBS 100 pps 1 sec

IRIG-B B004 DCLS N/A BCDTOY, BCDYEAR, CF and
SBS

100 pps 1 sec

IRIG-B B005 DCLS N/A BCDTOY, BCDYEAR, and CF 100 pps 1 sec

IRIG-B B006 DCLS N/A BCDTOY, BCDYEAR 100 pps 1 sec

IRIG-B B007 DCLS N/A BCDTOY, BCDYEAR, and
SBS

100 pps 1 sec

IRIG-B B120 AM 1 kHz BCDTOY, CF and SBS 100 pps 1 sec

IRIG-B B121 AM 1 kHz BCDTOY, CF 100 pps 1 sec

IRIG-B B122 AM 1 kHz BCDTOY 100 pps 1 sec

IRIG-B B123 AM 1 kHz BCDTOY, SBS 100 pps 1 sec

IRIG-B B124 AM 1 kHz BCDTOY, BCDYEAR, CF and
SBS

100 pps 1 sec

IRIG-B B125 AM 1 kHz BCDTOY, BCDYEAR, and CF 100 pps 1 sec

IRIG-B B126 AM 1 kHz BCDTOY, BCDYEAR 100 pps 1 sec

IRIG-B B127 AM 1 kHz BCDTOY, BCDYEAR, and
SBS

100 pps 1 sec
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Format Encoding Modulation Carrier Coded Expressions Bit rate Time Frame Inter
val

IRIG-E

IRIG-E E000 DCLS N/A BCDTOY, CF and SBS 10 pps 1 sec

IRIG-E E001 DCLS N/A BCDTOY, CF 10 pps 1 sec

IRIG-E E002 DCLS N/A BCDTOY 10 pps 1 sec

IRIG-E E003 DCLS N/A BCDTOY, SBS 10 pps 1 sec

IRIG-E E004 DCLS N/A BCDTOY, BCDYEAR, CF and
SBS

10 pps 1 sec

IRIG-E E005 DCLS N/A BCDTOY, BCDYEAR, and CF 10 pps 1 sec

IRIG-E E006 DCLS N/A BCDTOY, BCDYEAR 10 pps 1 sec

IRIG-E E007 DCLS N/A BCDTOY, BCDYEAR, and
SBS

10 pps 1 sec

IRIG-E E110 AM 100 Hz BCDTOY, CF and SBS 10 pps 1 sec

IRIG-E E111 AM 100 Hz BCDTOY, CF 10 pps 1 sec

IRIG-E E112 AM 100 Hz BCDTOY 10 pps 1 sec

IRIG-E E113 AM 100 Hz BCDTOY, SBS 10 pps 1 sec

IRIG-E E114 AM 100 Hz BCDTOY, BCDYEAR, CF and
SBS

10 pps 1 sec

IRIG-E E115 AM 100 Hz BCDTOY, BCDYEAR, and CF 10 pps 1 sec

IRIG-E E116 AM 100 Hz BCDTOY, BCDYEAR 10 pps 1 sec

IRIG-E E117 AM 100 Hz BCDTOY, BCDYEAR, and
SBS

10 pps 1 sec

IRIG-E E120 AM 100 Hz BCDTOY, CF and SBS 10 pps 1 sec

IRIG-E E121 AM 1kHz BCDTOY, CF 10 pps 10 sec

IRIG-E E122 AM 1kHz BCDTOY 10 pps 10 sec

IRIG-E E123 AM 1kHz BCDTOY, SBS 10 pps 10 sec

IRIG-E E124 AM 1kHz BCDTOY, BCDYEAR, CF and
SBS

10 pps 10 sec

IRIG-E E125 AM 1kHz BCDTOY, BCDYEAR, and CF 10 pps 10 sec

IRIG-E E126 AM 1kHz BCDTOY, BCDYEAR 10 pps 10 sec
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Format Encoding Modulation Carrier Coded Expressions Bit rate Time Frame Inter
val

IRIG-E E127 AM 1kHz BCDTOY, BCDYEAR, and
SBS

10 pps 10 sec

IRIG-G

IRIG-G G001 DCLS N/A BCDTOY, CF 10000
pps

10 msec

IRIG-G G002 DCLS N/A BCDTOY 10000
pps

10 msec

IRIG-G G005 DCLS N/A BCDTOY, BCDYEAR, and CF 10000
pps

10 msec

IRIG-G G006 DCLS N/A BCDTOY, BCDYEAR 10000
pps

10 msec

IRIG-G G141 AM 100
kHz

BCDTOY, CF 10000
pps

10 msec

IRIG-G G142 AM 100
kHz

BCDTOY 10000
pps

10 msec

IRIG-G G145 AM 100
kHz

BCDTOY, BCDYEAR, and CF 10000
pps

10 msec

IRIG-G G146 AM 100
kHz

BCDTOY, BCDYEAR 10000
pps

10 msec

NASA-
36

N/A AM 1msec UNKNOWN 100 pps 1 sec

NASA-
36

N/A DCLS 10 msec UNKNOWN 100 pps 1 sec

Table 8-2: Available IRIG output signals
The Spectracom IRIG formats use the control functions for BCD year information and a Time
Sync Status bit and in format E the control functions are used for straight binary seconds (SBS).
Refer to individual IRIG Time Code description figures and text. IRIG Standard 200-98 format B
had 27 control bits and format E had 45 bits for control functions. These control bits could be
used for any use and there was no defined function. Spectracom used the control function ele
ment at index count 55 as the TIME SYNC STATUS and the sub-frame after position identifiers
P6 and P7 as the year info and for format E the sub-frame after P8 and P9 for the straight bin
ary seconds (SBS). The position of the BCD year information does not conform to the newer
IRIG Standard 200-04. IRIG Standard 200-04 incorporated the year information after P5 and
reduced the allocated control bits to 18 for format B and 36 for format E.
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Note: DCLS is DC Level Shifted output, pulse width modulated with a position
identifier having a positive pulse width equal to 0.8 of the reciprocal of the bit
rate, a binary one (1) having a positive pulse width equal to 0.5 of the reciprocal
of the bit rate and a binary zero (0) having a positive pulse width equal to 0.2 of
the reciprocal of the bite rate.

NetClock can provide IRIG A, IRIG B, IRIG E and IRIG G code in amplitude modulated (AM) or
pulse width coded (TTL) formats. A signature control feature may be enabled for any IRIG out
put. Signature control removes the modulation code when a Time Sync Alarm is asserted.

8.2.2 IRIG B Output
The IRIG B Time Code description follows.
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Figure 8-1: IRIG B time code description

The IRIG B code contains the Binary Coded Decimal (BCD) time of year, Control Function (CF)
field and the Straight Binary Seconds time of day. The following figure illustrates the IRIG B
data structure. The BCD time of year provides the day of the year, 1-366, and the time of day
including seconds. The hour of the day is expressed in 24 hour format. The SBS time is the num
ber of seconds elapsed since midnight. The Control Function field contains year information
and a time synchronization status bit.

1. Time frame: 1.0 seconds.

2. Code digit weighting:

A. Binary Coded Decimal time-of-year.

Code word - 30 binary digits.

Seconds, minutes hours, and days.

Recycles yearly.

B. Straight Binary Seconds time-of-day.

Code word - 17 binary digits.

Seconds only, recycles daily.

3. Code word structure:

BCD: Word seconds digits begin at index count 1. Binary coded elements occur
between position identifier elements P0 and P5 (7 for seconds, 7 for minutes, 6 for
hours, and 10 for days) until the code word is complete. An index marker occurs
between decimal digits in each group to provide separation for visual resolution. Least
significant digit occurs first.

CF: IRIG formats reserve a set of elements known as Control Functions (CF) for the encod
ing of various control, identification, or other special purpose functions. IRIG B has 27
Control Functions located between elements 50 and 78. The NetClock uses the Control
Functions to encode year information and time synchronization status.

The table below lists the Control Function Field and the function of each element.

Element 55 is the time synchronization status bit. Element 55 is a Binary 1 when the front
panel time synchronization lamp is green, and a Binary 0 when the lamp is red.

Year information consists of the last two digits of the current year (i.e. 97, 98, 99 etc.).
Elements 60 through 63 contain the binary equivalent of year units. Elements 65 through
68 contain the binary equivalent of tens of years. In keeping with IRIG formats, the least
significant bit occurs first. All unused Control Functions are filled with a space (Binary 0).
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SBS: Word begins at index count 80. Seventeen Straight Binary Coded elements occur
with a position identifier between the 9th and 10th binary coded elements. Least sig
nificant digit occurs first.

Pulse rates:

Element rate: 100 per second.

Position identifier rate: 10 per second.

Reference marker rate: 1 per second.

Element identification: The "on time" reference point for all elements is the pulse leading
edge.

Index marker (Binary 0 or uncoded element): 2 millisecond duration.

Code digit (Binary 1): 5 millisecond duration.

Position identifier: 8 millisecond duration.

Reference marker, 1 per second. The reference marker appears as two consecutive pos
ition identifiers. The second position identifier marks the on-time point for the succeeding
code word.

Resolution:

Pulse width coded signal: 10 milliseconds.

Amplitude modulated signal: 1 millisecond.

Carrier frequency: 1 kHz when modulated.

C.F. Element # Digit # Function

50 1 Space

51 2 Space

52 3 Space

53 4 Space

54 5 Space

55 6 Time Sync Status

56 7 Space

57 8 Space

58 9 Space

59 PID P6 Position Identifier
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C.F. Element # Digit # Function

60 10 Years Units Y1

61 11 Years Units Y2

62 12 Years Units Y4

63 13 Years Units Y8

64 14 Space

65 15 Years Tens Y10

66 16 Years Tens Y20

67 17 Years Tens Y40

68 18 Years Tens Y80

69 PID P7 Position Identifier

70 19 Space

71 20 Space

72 21 Space

73 22 Space

74 23 Space

75 24 Space

76 25 Space

77 26 Space

78 27 Space

Table 8-3: IRIG B control function field

8.2.3 IRIG E Output
The IRIG E code contains the Binary Coded Decimal (BCD) time of year and Control Functions.
The figure IRIG E Time Code Description illustrates the IRIG E data structure. The BCD time of
year provides the day of year, 1-366, and time of day to tens of seconds. The hour of the day
is expressed in 24 hour format. The Control Function field includes a time synchronization
status bit, year information and SBS time of day.
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Time frame: 10 seconds.

Code Digit Weighting:

Binary Coded Decimal time of year.

Code world - 26 binary digits.

Tens of seconds, minutes, hours, and days.

Recycles yearly.

Code Word Structure: BCD word tens of seconds digits begin at index count 6. Binary
coded elements occur between position identifier elements P0 and P5 (3 for seconds, 7
for minutes, 6 for hours, and 10 for days) until the code word is complete. An index
marker occurs between decimal digits in each group to provide separation for visual res
olution. Least significant digit occurs first.

Control Functions : IRIG formats reserve a set of elements known as Control Functions
(CF) for the encoding of various control, identification, or other special purpose func
tions. IRIG E has 45 Control Functions located between elements 50 and 98. The NetC
lock uses the Control Function field to encode year data, time synchronization status,
and SBS time data. Table B-2 lists the Control Function Field and each element's function.

Element 55 is the time synchronization status bit. Element 55 is a Binary 1 when the front panel
time synchronization lamp is green, and a Binary 0 when the lamp is red.

Year information consists of the last two digits of the current year (i.e. 98, 99, etc.). Elements 60
through 63 contain the binary equivalent of year units. Elements 65 through 68 contain the bin
ary equivalent of tens of years. In keeping with IRIG formats, the least significant bit occurs first.

Elements 80 through 97 are encoded with the Straight Binary Seconds (SBS) time data. The
SBS time data is incremented in 10-second steps and recycles every 24 hours.

Pulse rates:

Element rate: 10 per second.

Position identifier rate: 1 per second.

Reference marker rate: 1 per 10 seconds.

Element identification: The "on time" reference point for all elements is the pulse leading
edge.

Index marker (Binary 0 or uncoded element): 20 millisecond duration.

Code digit (Binary 1): 50 millisecond duration.

Position identifier: 80 millisecond duration.
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Reference marker: 80 millisecond duration, 1 per 10 seconds. The reference marker
appears as two consecutive position identifiers. The second position identifier or ref
erence marker is the on-time point for the succeeding code word.

Figure 8-2: IRIG E time code description
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BIT No. CF ELEMENT No. FUNCTION

50 1 SPACE

51 2 SPACE

52 3 SPACE

53 4 SPACE

54 5 SPACE

55 6 TIME SYNC_STATUS

56 7 SPACE

57 8 SPACE

58 9 SPACE

59 PID P6 POSITION IDENTIFIER

60 10 YEAR UNITS Y1

61 11 YEAR UNITS Y2

62 12 YEAR UNITS Y4

63 13 YEAR UNITS Y8

64 14 SPACE

65 15 YEAR TENS Y10

66 16 YEAR TENS Y20

67 17 YEAR TENS Y40

68 18 YEAR TENS Y80

69 PID P7 POSITION IDENTIFIER

70 19 SPACE

71 20 SPACE

72 21 SPACE

73 22 SPACE

74 23 SPACE

75 24 SPACE

76 25 SPACE

77 26 SPACE
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BIT No. CF ELEMENT No. FUNCTION

78 27 SPACE

79 PID P8 POSITION IDENTIFIER

80 28 SBS 20

81 29 SBS 21

82 30 SBS 22

83 31 SBS 23

84 32 SBS 24

85 33 SBS 25

86 34 SBS 26

87 35 SBS 27

88 36 SBS 28

89 PID P9 POSITION IDENTIFIER

90 37 SBS 29

91 38 SBS 210

92 39 SBS 211

93 40 SBS 212

94 41 SBS 213

95 42 SBS 214

96 43 SBS 215

97 44 SBS 216

98 45 SPACE

99 PID P0 POSITION IDENTIFIER

Table 8-4: IRIG E control function field

8.2.4 IRIG Output Accuracy Specifications
The IRIG outputs of the Spectracom Option Cards 1204-15, -1E, -22, and 1204-05, -27 deliver
signals with the following 1PPS accuracy:
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IRIC DCLS

Signal Category Measured
Accuracy

IRIG A 30 ns

IRIG B 30 ns

IRIG G 30 ns

IRIG NASA 30 ns

IRIG E 30 ns

IRIG AM

Signal Category Measured
Accuracy

IRIG A 200 ns

IRIG B 800 ns

IRIG G 200 ns

IRIG NASA 800 ns

IRIG E 1.5 μs
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8.3 Technical Support
To request technical support, please navigate to the "Support" page of the Spectracom web
site, where you can not only submit a support request, but also find additional technical doc
umentation.

Phone support is available during regular office hours under the telephone numbers listed
below.

To speed up the diagnosis of your NetClock unit, please send us:

your current product configuration, and

the events log (if available).

Thank you for your cooperation.

8.3.1 Regional Contact
Spectracom operates globally and has offices in several locations around the world. Our main
offices are listed below:

Table 8-5: Spectracom contact information

Country Location Phone

China Beijing +86 10 8231 9601

France Les Ulis, Cedex +33 (0)1 64 53 39 80

USA Rochester, NY +1 585 321 5800

Additional regional contact information can be found on the Contact page of the Spectracom
website.

8.4 Return Shipments
Please contact Spectracom Technical Support before returning any equipment to Spectracom.
Technical Support must provide you with a Return Material Authorization Number (RMA#)
prior to shipment.

When contacting Technical Support, please be prepared to provide your equipment serial num
ber(s) and a description of the failure symptoms or issues you would like resolved.

Freight to Spectracom is to be prepaid by the customer.
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Note: Should there be a need to return equipment to Spectracom, it must be
shipped in its original packing material. Save all packaging material for this pur
pose.

8.5 License Notices

8.5.1 NTPv4.2.6p5
Copyright Notice
jpg "Clone me," says Dolly sheepishly.
Last update: 1-Jan-2011 08:34 UTC
_______________________________________________________
The following copyright notice applies to all files collectively called the Network Time Protocol Version 4 Dis
tribution. Unless specifically declared otherwise in an individual file, this notice applies as if the text was expli
citly included in the file.
***********************************************************************
* Copyright (c) University of Delaware 1992-2011 
Permission to use, copy, modify, and distribute this software and its documentation for any purpose with or
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
the copyright notice and this permission notice appear in supporting documentation, and that the name
University of Delaware not be used in advertising or publicity pertaining to distribution of the software without
specific, written prior permission. The University of Delaware makes no representations about the suitability
this software for any purpose. It is provided "as is" without express or implied warranty.
***********************************************************************
The following individuals contributed in part to the Network Time  Protocol Distribution Version 4 and are
acknowledged as authors of this work.
1. [1]Takao Abe <takao_abe@xurb.jp> Clock driver for JJY receivers
2. [2]Mark Andrews <mark_andrews@isc.org> Leitch atomic clock controller
3. [3]Bernd Altmeier <altmeier@atlsoft.de> hopf Elektronik serial line and PCI-bus devices
4. [4]Viraj Bais <vbais@mailman1.intel.com> and [5]Clayton Kirkwood <kirkwood@striderfm.intel.com>
port to WindowsNT 3.5
5. [6]Michael Barone <michael,barone@lmco.com> GPSVME fixes
6. [7]Karl Berry <karl@owl.HQ.ileaf.com> syslog to file option
7. [8]Greg Brackley <greg.brackley@bigfoot.com> Major rework of WINNT port. Clean up recvbuf and
iosignal code into separate modules.
8. [9]Marc Brett <Marc.Brett@westgeo.com> Magnavox GPS clock driver
9. [10]Piete Brooks <Piete.Brooks@cl.cam.ac.uk> MSF clock driver, Trimble PARSE support
10. [11]Nelson B Bolyard <nelson@bolyard.me> update and complete broadcast and crypto features in sntp
11. [12]Jean-Francois Boudreault <Jean-Francois.Boudreault@viagenie.qc.ca> IPv6 support
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12. [13]Reg Clemens <reg@dwf.com> Oncore driver (Current maintainer)
13. [14]Steve Clift <clift@ml.csiro.au> OMEGA clock driver
14. [15]Casey Crellin <casey@csc.co.za> vxWorks (Tornado) port and help with target configuration
15. [16]Sven Dietrich <sven_dietrich@trimble.com> Palisade reference clock driver, NT adj. residuals, integ
rated Greg's Winnt port.
16. [17]John A. Dundas III <dundas@salt.jpl.nasa.gov> Apple A/UX port
17. [18]Torsten Duwe <duwe@immd4.informatik.uni-erlangen.de> Linux port
18. [19]Dennis Ferguson <dennis@mrbill.canet.ca> foundation code for NTP Version 2 as specified in RFC-
1119
19. [20]John Hay <jhay@icomtek.csir.co.za> IPv6 support and testing
20. [21]Dave Hart <davehart@davehart.com> General maintenance, Windows port interpolation rewrite
21. [22]Claas Hilbrecht <neoclock4x@linum.com> NeoClock4X clock driver
22. [23]Glenn Hollinger <glenn@herald.usask.ca> GOES clock driver
23. [24]Mike Iglesias <iglesias@uci.edu> DEC Alpha port
24. [25]Jim Jagielski <jim@jagubox.gsfc.nasa.gov> A/UX port
25. [26]Jeff Johnson <jbj@chatham.usdesign.com> massive prototyping overhaul
26. [27]Hans Lambermont <Hans.Lambermont@nl.origin-it.com> or
[28]<H.Lambermont@chello.nl> ntpsweep
27. [29]Poul-Henning Kamp <phk@FreeBSD.ORG> Oncore driver (Original author)
28. [30]Frank Kardel [31]<kardel (at) ntp (dot) org> PARSE <GENERIC> driver (>14 reference clocks),
STREAMS modules for PARSE, support scripts, syslog cleanup, dynamic interface handling
29. [32]William L. Jones <jones@hermes.chpc.utexas.edu> RS/6000 AIX modifications, HPUX modifications
30. [33]Dave Katz <dkatz@cisco.com> RS/6000 AIX port
31. [34]Craig Leres <leres@ee.lbl.gov> 4.4BSD port, ppsclock, Magnavox GPS clock driver
32. [35]George Lindholm <lindholm@ucs.ubc.ca> SunOS 5.1 port
33. [36]Louis A. Mamakos <louie@ni.umd.edu> MD5-based authentication
34. [37]Lars H. Mathiesen <thorinn@diku.dk> adaptation of foundation code for Version 3 as specified in
RFC-1305
35. [38]Danny Mayer <mayer@ntp.org>Network I/O, Windows Port, Code Maintenance
36. [39]David L. Mills <mills@udel.edu> Version 4 foundation: clock discipline, authentication, precision ker
nel; clock drivers: Spectracom, Austron, Arbiter, Heath, ATOM, ACTS, KSI/Odetics; audio clock drivers:
CHU, WWV/H, IRIG
37. [40]Wolfgang Moeller <moeller@gwdgv1.dnet.gwdg.de> VMS port
38. [41]Jeffrey Mogul <mogul@pa.dec.com> ntptrace utility
39. [42]Tom Moore <tmoore@fievel.daytonoh.ncr.com> i386 svr4 port
40. [43]Kamal A Mostafa <kamal@whence.com> SCO OpenServer port
41. [44]Derek Mulcahy <derek@toybox.demon.co.uk> and [45]Damon Hart-Davis <d@hd.org> ARCRON
MSF clock driver
42. [46]Rob Neal <neal@ntp.org> Bancomm refclock and config/parse code maintenance
43. [47]Rainer Pruy <Rainer.Pruy@informatik.uni-erlangen.de> monitoring/trap scripts, statistics file handling
44. [48]Dirce Richards <dirce@zk3.dec.com> Digital UNIX V4.0 port
45. [49]Wilfredo Sánchez <wsanchez@apple.com> added support for NetInfo
46. [50]Nick Sayer <mrapple@quack.kfu.com> SunOS streams modules
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47. [51]Jack Sasportas <jack@innovativeinternet.com> Saved a Lot of space on the stuff in the html/pic/ sub
directory
48. [52]Ray Schnitzler <schnitz@unipress.com> Unixware1 port
49. [53]Michael Shields <shields@tembel.org> USNO clock driver
50. [54]Jeff Steinman <jss@pebbles.jpl.nasa.gov> Datum PTS clock driver
51. [55]Harlan Stenn <harlan@pfcs.com> GNU automake/autoconfigure makeover, various other bits (see
the ChangeLog)
52. [56]Kenneth Stone <ken@sdd.hp.com> HP-UX port
53. [57]Ajit Thyagarajan <ajit@ee.udel.edu>IP multicast/anycast support
54. [58]Tomoaki TSURUOKA <tsuruoka@nc.fukuoka-u.ac.jp>TRAK clock driver
55. [59]Paul A Vixie <vixie@vix.com> TrueTime GPS driver, generic TrueTime clock driver
56. [60]Ulrich Windl <Ulrich.Windl@rz.uni- regensburg.de> corrected and validated HTML documents
according to the HTML DTD
_______________________________________________________
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16. mailto:dennis@mrbill.canet.ca
17. mailto:glenn@herald.usask.ca
18. mailto:iglesias@uci.edu
19. mailto:jagubox.gsfc.nasa.gov
20. mailto:jbj@chatham.usdesign.com
21. mailto:Hans.Lambermont@nl.origin-it.com
22. mailto:H.Lambermont@chello.nl
23. mailto:phk@FreeBSD.ORG
24. http://www4.informatik.uni-erlangen.de/~kardel
25. mailto:Frank.Kardel@informatik.uni-erlangen.de
26. mailto:jones@hermes.chpc.utexas.edu
27. mailto:dkatz@cisco.com
28. mailto:leres@ee.lbl.gov
29. mailto:lindholm@ucs.ubc.ca
30. mailto:louie@ni.umd.edu
31. mailto:thorinn@diku.dk
32. mailto:mills@udel.edu
33. mailto:moeller@gwdgv1.dnet.gwdg.de
34. mailto:mogul@pa.dec.com
35. mailto:tmoore@fievel.daytonoh.ncr.com
36. mailto:kamal@whence.com
37. mailto:derek@toybox.demon.co.uk
38. mailto:d@hd.org
39. mailto:Rainer.Pruy@informatik.uni-erlangen.de
40. mailto:dirce@zk3.dec.com
41. mailto:wsanchez@apple.com
42. mailto:mrapple@quack.kfu.com
43. mailto:jack@innovativeinternet.com
44. mailto:schnitz@unipress.com
45. mailto:shields@tembel.org
46. mailto:pebbles.jpl.nasa.gov
47. mailto:harlan@pfcs.com
48. mailto:ken@sdd.hp.com
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49. mailto:ajit@ee.udel.edu
50. mailto:tsuruoka@nc.fukuoka-u.ac.jp
51. mailto:vixie@vix.com
52. mailto:Ulrich.Windl@rz.uni-regensburg.de
53. file://localhost/backroom/ntp-stable/html/index.htm
54. mailto:mills@udel.edu

8.5.2 OpenSSH
This file is part of the OpenSSH software.
The licences which components of this software fall under are as follows. First, we will summarize and say
that all components are under a BSD licence, or a licence more free than that.
OpenSSH contains no GPL code.
1) Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland
All rights reserved
As far as I am concerned, the code I have written for this software can be used freely for any purpose. Any
derived versions of this software must be clearly marked as such, and if the derived work is incompatible with
the protocol description in the RFC file, it must be called by a name other than "ssh" or "Secure Shell".
However, I am not implying to give any licenses to any patents or copyrights held by third parties, and the
software includes parts that are not under my direct control. As far as I know, all included source code is used
in accordance with the relevant license agreements and can be used freely for any purpose (the GNU license
being the most restrictive); see below for details. [However, none of that term is relevant at this point in time.
All of these restrictively licenced software components which he talks about have been removed from
OpenSSH, i.e.,
- RSA is no longer included, found in the OpenSSL library
- IDEA is no longer included, its use is deprecated
- DES is now external, in the OpenSSL library
- GMP is no longer used, and instead we call BN code from OpenSSL
- Zlib is now external, in a library
- The make-ssh-known-hosts script is no longer included
- TSS has been removed
- MD5 is now external, in the OpenSSL library
- RC4 support has been replaced with ARC4 support from OpenSSL
- Blowfish is now external, in the OpenSSL library
Note that any information and cryptographic algorithms used in this software are publicly available on the
Internet and at any major bookstore, scientific library, and patent office worldwide. More information can be
found e.g. at "http://www.cs.hut.fi/crypto".
The legal status of this program is some combination of all these permissions and restrictions. Use only at your
own responsibility. You will be responsible for any legal consequences yourself; I am not making any claims
whether possessing or using this is legal or not in your country, and I am not taking any responsibility on your
behalf.
NO WARRANTY
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BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE THE
PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO
USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO
OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
2) The 32-bit CRC implementation in crc32.c is due to Gary S. Brown. Comments in the file indicate it may be
used for any purpose without restrictions: COPYRIGHT (C) 1986 Gary S. Brown. You may use this program,
or code or tables extracted from it, as desired without restriction.
3) The 32-bit CRC compensation attack detector in deattack.c was contributed by CORE SDI S.A. under a
BSD-style license. Cryptographic attack detector for ssh - source code Copyright (c) 1998 CORE SDI S.A.,
Buenos Aires, Argentina.
All rights reserved. Redistribution and use in source and binary forms, with or without modification, are per
mitted provided that this copyright notice is retained.
THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES ARE DISCLAIMED.
IN NO EVENT SHALL CORE SDI S.A. BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR MISUSE OF THIS
SOFTWARE.
Ariel Futoransky <futo@core-sdi.com><http://www.core-sdi.com>
4) ssh- keygen was contributed by David Mazieres under a BSD- style license. Copyright 1995, 1996 by
David Mazieres <dm@lcs.mit.edu>.
Modification and redistribution in source and binary forms is permitted provided that due credit is given to the
author and the OpenBSD project by leaving this copyright notice intact.
5) The Rijndael implementation by Vincent Rijmen, Antoon Bosselaers and Paulo Barreto is in the public
domain and distributed with the following license: @version 3.0 (December 2000) Optimised ANSI C code
for the Rijndael cipher (now AES) @author Vincent Rijmen vincent.rijmen@esat.kuleuven.ac.be @author
Antoon Bosselaers antoon.bosselaers@esat.kuleuven.ac.be @author Paulo Barreto <paulo.bar
reto@terra.com.br>
This code is hereby placed in the public domain.
THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
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GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
6) One component of the ssh source code is under a 4-clause BSD license, held by the University of Cali
fornia, since we pulled these parts from original Berkeley code. The Regents of the University of California
have declared that term 3 is no longer enforceable on their source code, but we retain that license as is.Copy
right (c) 1983, 1990, 1992, 1993, 1995 The Regents of the University of California. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the fol
lowing disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol
lowing disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknow
ledgement: This product includes software developed by the University of California, Berkeley and its con
tributors.
4. Neither the name of the University nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
7) Remaining components of the software are provided under a standard 2- term BSD licence with the fol
lowing names as copyright holders:
Markus Friedl, Theo de Raadt, Niels Provos, Dug Song, Aaron Campbell, Damien Miller, Kevin Steves,
Daniel Kouril, Per Allansson
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the fol
lowing disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol
lowing disclaimer in the documentation and/or other materials provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS ORIMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIESOF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
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WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

8.5.3 OpenSSL
LICENSE ISSUES
==============
The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and the ori
ginal SSLeay license apply to the toolkit. See below for the actual license texts. Actually both licenses are
BSD-style Open Source licenses. In case of any license issues related to OpenSSL please contact openssl-
core@openssl.org.
OpenSSL License
====================================================================
Copyright (c) 1998-2003 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the fol
lowing disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol
lowing disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknow
ledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.
(http://www.openssl.org/)"
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact openssl-
core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their
names without prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment:
"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL
PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY,
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
====================================================================
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product
includes software written by Tim Hudson (tjh@cryptsoft.com).
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Original SSLeay License
-----------------------
/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared
to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc.,
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same
copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).
Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this
package is used in a product, Eric Young should be given attribution as the author of the parts of the library
used. This can be in the form of a textual message at program startup or in documentation (online or textual)
provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following dis
claimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol
lowing disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknow
ledgement: "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" The
word 'cryptographic' can be left out if the rouines from the library being used are not cryptographic related
:-).
4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application
code) you must include an acknowledgement: "This product includes software written by Tim Hudson
(tjh@cryptsoft.com)"
THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the
GNU Public Licence.]

---- Part 1: CMU/UCD copyright notice: (BSD like) -----
Copyright 1989, 1991, 1992 by Carnegie Mellon University
Derivative Work - 1996, 1998-2000
Copyright 1996, 1998-2000 The Regents of the University of California
All Rights Reserved
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Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to dis
tribution of the software without specific written permission.
CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES WITH
REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE
FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT,
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE
OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----
Copyright (c) 2001-2003, Networks Associates Technology, Inc
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met: Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the fol
lowing disclaimer in the documentation and/or other materials provided with the distribution. Neither the
name of the Networks Associates Technology, Inc nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----
Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met: Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copy
right notice, this list of conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution. The name of Cambridge Broadband Ltd. may not be used to endorse or pro
mote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
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HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----
Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.
Use is subject to license terms below.
This distribution may include materials developed by third parties. Sun, Sun Microsystems, the Sun logo and
Solaris are trademarks or registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met: Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copy
right notice, this list of conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution. Neither the name of the Sun Microsystems, Inc. nor the names of its contributors
may be used to endorse or promote products derived from this software without specific prior written per
mission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----
Copyright (c) 2003-2004, Sparta, Inc. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
the following conditions are met: Redistributions of source code must retain the above copyright notice, this
list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copy
right notice, this list of conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution. Neither the name of the Networks Associates Technology, Inc nor the names of
its contributors may be used to endorse or promote products derived from this software without specific prior
written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
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PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE
This open software is available for at least three  years, to give any third party, for a charge no more than
your  cost of physically performing source distribution, a complete  machine- readable copy of the cor
responding source code, to be  distributed under the terms of Sections 1 and 2 above on a medium  cus
tomarily used for software interchange.
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